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Resources

Welcome to the world of professional video and film grading 
and manipulation using Color.

What Is Color?
Color has been designed from the ground up as a feature-rich color correction 
environment that complements a wide variety of post-production workflows, whether 
your project is standard definition, high definition, or a 2K digital intermediate. If you�ve 
edited a program using Final Cut Pro, it�s easy to send your program to Color for 
grading, and then send it back to Final Cut Pro for final output. However, it�s also easy 
to reconform projects that originate as EDLs from other editing environments.

Color has the tools that professional colorists demand, including:

´ Primary color correction using three-way color balance and contrast controls with 
individual shadow, midtone, and highlight control

´ Curve controls for detailed color and luma channel adjustments
´ Up to eight secondary color correction operations per shot with HSL qualifiers, 

vignettes, user shapes, and separate adjustments for the inside and outside of each 
secondary

´ Color FX node-based effects for creating custom color effects
´ Pan & Scan effects 
´ Motion tracking that can be used to animate vignettes, user shapes, and other effects
´ Broadcast legal settings to guarantee adherence to quality control standards
´ Support for color-correction-specific control surfaces
´ And much, much more

All of these tools are divided among eight individual �rooms� of the Color interface, 
logically arranged in an order that matches the workflow of most colorists. You�ll use 
Color to correct, balance, and create stylized �looks� for each shot in your program as 
the last step in the post-production workflow, giving your programs a final polish 
previously available only to high-end facilities.
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Using the Color Documentation
The documentation that accompanies Color consists of a printed setup Guide and an 
onscreen user manual.

Color Setup Guide
The Color Setup Guide provides excerpts from the onscreen user manual that are 
designed to show you how Color fits into each of a variety of post-production 
workflows, and help you to configure the project settings and user preferences in Color 
to best suit your needs. If you�ve just installed Color and want to figure out how to set 
up your system to work most efficiently, this is the place to start.

Color Onscreen User Manual
The Color User Manual, available from the Help menu, provides comprehensive 
information about the application, and is written for users of all levels of experience.
´ Editors and post-production professionals from other disciplines who are new to the 

color correction process will find information on how to get started, with detailed 
explanations of how all controls work, and why they function the way they do. 

´ Colorists coming to Color from other grading environments can skip ahead to find 
detailed information about Color�s inner workings, and exhaustive parameter-by-
parameter explanations for every room of the Color interface.

Note:  The onscreen user manual provides all of the information contained in the Color 
Setup Guide, in an easily searchable form with full-color illustrations.

Tutorials
A collection of onscreen video tutorials on DVD-ROM is available to help you quickly 
get started using Color. These tutorials walk you through every major area of the 
interface, and are a good way to get an overview of where everything is prior to diving 
into the user manual.

Color Websites
The following websites provide general information, updates, and support information 
about Color, as well as the latest news, resources, and training materials.

For more information about Color, go to:

´ http://www.apple.com/finalcutstudio/color

For more information on the Apple Pro Training Program, go to:

´ http://www.apple.com/software/pro/training

To provide comments and feedback about Color, go to:

´ http://www.apple.com/feedback/color.html

http://www.apple.com/color
http://www.apple.com/software/pro/training
http://www.apple.com/feedback/color
http://www.apple.com/finalcutstudio/color
http://www.apple.com/feedback/color.html


Preface    Color Documentation and Resources 11

Apple Service and Support Website
The Apple Service and Support website provides software updates and answers to the 
most frequently asked questions for all Apple products, including Color. You�ll also have 
access to product specifications, reference documentation, and Apple product 
technical articles:
´ http://www.apple.com/support

For support information that�s specific to Color, go to:

´ http://www.apple.com/support/color

http://www.apple.com/support
http://www.apple.com/support/color
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1 Color Correction Basics

To better learn how Color works, it�s important to understand 
the overall color correction process and how images work 
their way through post-production in SD, HD, and film 
workflows.

If you�re new to color correction, the first part of this chapter provides a background in 
color correction workflows to help you better understand why Color works the way it 
does. The second part goes on to explain important color and imaging concepts that 
are important to the operation of the Color interface.

This chapter covers the following:

´ What Is Color Correction? (p. 13)
´ When Does Color Correction Happen? (p. 16)
´ Color Correction in Color (p. 22)
´ Image Encoding Standards (p. 24)
´ Basic Color and Imaging Concepts (p. 27)

What Is Color Correction?
In any post-production workflow, color correction is generally one of the last steps 
taken to finish an edited program. Color has been created to give you precise control 
over the look of every shot in your project by providing flexible tools and an efficient 
workspace with which to manipulate the contrast, color, and geometry of each shot in 
your program.

The Goals of Color Correction?
When color correcting a given program, you�ll be called upon to perform many, if not 
all, of the tasks described in this section. Color gives you an extremely deep feature set 
with which to accomplish all this and more. While the deciding factor in determining 
how far you go in any color correction session is usually the amount of time you have 
in which to work, the dedicated color correction interface in Color allows you to work 
quickly and efficiently.
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The Fundamentals
Every program requires you to take, at the very least, the following steps. With practice, 
most of these can be accomplished using the primary color correction tools (for more 
information, see Chapter 9, �Primary In,� on page 163).
´ Making sure that key elements in your program look the way they should:  Every scene of 

your program has key elements that are the main focus of the viewer. In a narrative 
or documentary video, the focus is probably on the individuals within each shot. In a 
commercial, the key element is undoubtedly the product (for example the label of a 
bottle or the color of a car). Regardless of what these key elements are, chances are 
you or your audience will have certain expectations of what they should look like, 
and it�s your job to make the colors in the program match what was originally shot. 
When working with shots of people, one of the guiding principles of color correction 
is to make sure that their skin tones in the program look the same as (or better than) 
in real life. Regardless of ethnicity or complexion, the hues of human skin tones, 
when measured objectively on a Vectorscope, fall along a fairly narrow range 
(although the saturation and brightness vary). Color gives you the tools to make 
whatever adjustments are necessary to ensure that the skin tones of people in your 
final edited piece look the way they should.

´ Correcting errors in color balance and exposure:  Frequently, images that are acquired 
digitally (whether shot on analog or digital video, or transferred from film) don�t have 
optimal exposure or color balance to begin with. For example, many camcorders and 
digital cinema cameras deliberately record blacks that aren�t quite at 0 percent in 
order to avoid the inadvertent crushing of data unnecessarily. 
Furthermore, accidents can happen in any shoot. For example, the crew may not 
have had the correctly balanced film stock for the conditions in which they were 
shooting, or someone may have forgotten to white balance the video camera before 
shooting an interview in an office lit with fluorescent lights, resulting in footage with 
a greenish tinge. Color makes it easy to fix these kinds of mistakes.

´ Balancing all the shots in a scene to match:  Most edited programs incorporate footage 
from a variety of sources, shot in multiple locations over the course of many days, 
weeks, or months of production. Even with the most skilled lighting and camera 
crews, differences in color and exposure are bound to occur, sometimes within shots 
meant to be combined into a single scene. 
When edited together, these changes in color and lighting can make individual shots 
stand out, making the editing appear uneven. With careful color correction, all the 
different shots that make up a scene can be balanced to match one another so that 
they all look as if they�re happening at the same time and in the same place, with the 
same lighting. This is commonly referred to as scene-to-scene color correction.
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´ Creating contrast:  Color correction can also be used to create contrast between two 
scenes for a more jarring effect. Imagine cutting from a lush, green jungle scene to a 
harsh desert landscape with many more reds and yellows. Using color correction, you 
can subtly accentuate these differences.

´ Achieving a �look�:  The process of color correction is not simply one of making all the 
video in your piece match some objective model of exposure. Color, like sound, is a 
property that, when subtly mixed, can result in an additional level of dramatic control 
over your program. 
With color correction, you can control whether your video has rich, saturated colors 
or a more muted look. You can make your shots look warmer by pushing their tones 
into the reds, or make them look cooler by bringing them into the blues. You can pull 
details out of the shadows, or crush them, increasing the picture�s contrast for a 
starker look. Such subtle modifications alter the audience�s perception of the scene 
being played, changing a program�s mood. Once you pick a look for your piece, or 
even for an individual scene, you can use color correction to make sure that all the 
shots in the appropriate scenes match the same look, so that they cut together 
smoothly.

´ Adhering to guidelines for broadcast legality:  If a program is destined for television 
broadcast, you are usually provided with a set of quality control (QC) guidelines that 
specific the �legal� limits for minimum black levels, maximum white levels, and 
minimum and maximum chroma saturation and composite RGB limits. Adherence to 
these guidelines is important to ensure that the program is accepted for broadcast, 
as �illegal� values may cause problems when the program is encoded for 
transmission. QC standards vary, so it�s important to check what these guidelines are 
in advance. Color has built-in broadcast safe settings (sometimes referred to as a 
legalizer) that automatically prevent video levels from exceeding the specified limits. 
For more information, see �Broadcast Safe Settings� on page 100.

Detail Work
If you have the time, the Color toolset allows you to go even further to adjust the look 
of your program:
´ Adjusting specific elements separately:  It�s sometimes necessary to selectively target a 

narrow range of colors to alter or replace only those color values. A common 
example of this might be to turn a red car blue or to mute the excessive colors of an 
article of clothing.These sorts of tasks are accomplished with what�s referred to as 
secondary color correction, and Color provides you with numerous tools with which to 
achieve such effects. For more information, see Chapter 10, �Secondaries,� on 
page 209.
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´ Making digital lighting adjustments:  Sometimes lighting setups that looked right 
during the shoot don�t work as well in post. Changes in the director�s vision, 
alterations to the tone of the scene as edited, or suggestions on the part of the 
director of photography (DoP) during post may necessitate alterations to the lighting 
within a scene beyond simple adjustments to the image�s overall contrast. Color 
provides powerful controls for user-definable masking which, in combination with 
secondary color correction controls, allow you to isolate multiple regions within an 
image and fine-tune the lighting. This is sometimes referred to as digital relighting. 
For more information, see Chapter 10, �Secondaries,� on page 209, and �Shapes Tab� 
on page 298.

´ Creating special effects:  Sometimes a scene requires more extreme effects, such as 
manipulating colors and exposure intensively to achieve a day-for-night look, 
creating an altered state for a flashback or hallucination sequence, or just creating 
something bizarre for a music video. In the Color FX room, Color provides you with 
an extensible node-based toolset for creating such in-depth composites efficiently, in 
conjunction with the other primary and secondary tools at your disposal. For more 
information, see Chapter 11, �Color FX,� on page 235.

If that sounds like a lot to do, it is. Fortunately, the Color interface helps you to keep 
these tasks organized.

When Does Color Correction Happen?
A program�s color fidelity shouldn�t be neglected until the color correction stage of the 
post-production process. Ideally, every project is begun with a philosophy of color 
management that�s applied during the shoot, is maintained through the various 
transfer and editing passes that occur during post-production, and concludes with the 
final color correction pass conducted in Color. This section elaborates on how film and 
video images have traditionally made their way through the post-production process.

Color Management Starts During the Shoot
Whether a program is shot using film, video, or high-resolution digital imaging of 
another means, it�s important to remember that the process of determining a 
program�s overall look begins when each scene is lit and shot during production. To 
obtain the maximum amount of control and flexibility over shots in post-production, 
you ideally should start out with footage that has been exposed with the end goals in 
mind right from the beginning. Color correction in post-production is no substitute for 
good lighting.

Optimistically, the process of color correction can be seen as extending and enhancing 
the vision of the producer, director, and director of photography (DoP) as it was 
originally conceived. Often, the DoP gets personally involved during the color 
correction process to ensure that the look he or she was trying to achieve is perfected.
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At other times, the director or producer may change his or her mind regarding how the 
finished piece should look. In these cases, color correction might be used to alter the 
overall look of the piece (for example, making footage that was shot to look cool look 
warmer, instead). While Color provides an exceptional degree of control over your 
footage, it�s still important to start out with clean, properly exposed footage.

Furthermore, choices made during preproduction and the shoot, including the film or 
video format and camera settings used, can have a profound effect on the amount of 
flexibility that�s available during the eventual color correction process.

Initial Color Correction When Transferring Film
When a project has been shot on film, the camera negatives must first be transferred to 
the videotape or digital video format of choice prior to editing and digital post using a 
telecine or datacine machine. A telecine is a machine for transferring film to videotape, 
while a datacine is set up for transferring film directly to a digital format, usually an 
image sequence.

Usually, the colorist running the film transfer session performs some level of color 
correction to ensure that the editor has the most appropriate picture to work with. The 
goals of color correction at this stage usually depend on both the length of the project 
and the post-production workflow that�s been decided upon.

´ Short projects, commercials, spots, and very short videos may get a detailed color 
correction pass right away. The colorist will first calibrate the telecine�s own color 
corrector to balance the whites, blacks, and color perfectly. Then the colorist, in 
consultation with the DoP, director, or producer, will work shot by shot to determine 
the look of each shot according to the needs of the project. As a result, the editor will 
be working with footage that has already been corrected.

´ Long-form projects such as feature-length films and longer television programs 
probably won�t get a detailed color correction pass right away. Instead, the footage 
that is run through the telecine will be balanced to have reasonably ideal exposure 
and color for purposes of having a good image for editing, and left at that. Detailed 
color correction is then done at another stage.

Camera Negative Telecine Video Tapes
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´ Projects of any length which are going through post-production as a digital 
intermediate are transferred with a color correction pass designed to retain the 
maximum amount of image data. Since a second (and final) digital color correction 
pass is intended to be performed at the end of the post-production process, it�s 
critical that the image data is high-quality, preserving as much highlight and shadow 
detail as possible. Interestingly, since the goal is the preservation of image data, and 
not to create the final look of the program, the highest quality image for grading 
may not be the most visually appealing image.

However the color correction is handled during the initial telecine or datacine transfer, 
once complete, the footage goes through the typical post-production processes of 
offline and online editorial.

Traditional Means of Final Color Correction
Once editing is complete and the picture is locked, it�s time for color correction 
(referred to as color grading in the film world) to begin. Traditionally, this process was 
accomplished either via a Color Timing session for film or via a Tape-to-Tape color 
correction session for video.

Color Correcting Film Versus Video
Color has been designed to fit into both video and film digital intermediate 
workflows. Since all footage must first be transferred to a QuickTime or image 
sequence format to be imported into Color, film and video images are corrected 
using the same tools and methods.

Three main attributes affect the quality of media used in a program, all of which were 
determined when the footage was originally captured or transferred prior to Color 
import:

´ The type and level of compression applied to the media
´ The bit depth at which it�s encoded
´ The chroma subsampling ratio used 

For color correction, spatial and temporal compression should be minimized, since 
compression artifacts can compromise the quality of your adjustments. Also, media at 
higher bit depths is generally preferable (see �Bit Depth� on page 26).

Most importantly of all, high chroma subsampling ratios, such as 4:4:4 or 4:2:2, are 
preferred to maximize the quality and flexibility of your corrections. There�s nothing 
stopping you from working with 4:1:1 or 4:2:0 subsampled footage, but you may find 
that extreme contrast adjustments and smooth secondary selections are a bit more 
difficult to accomplish with highly compressed color spaces.

For more information, see �Chroma Subsampling� on page 25.
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Color Timing for Film
Programs being finished and color corrected on film traditionally undergo a negative 
conform process prior to color timing. When editorial is complete, the original camera 
negative is conformed to match the workprint or video cut of the edited program 
using a cut list or pull list (if the program was edited using Final Cut Pro, this can be 
derived using Cinema Tools), which lists each shot used in the edited program, and 
shows how each shot fits together. This is a time-consuming and detail oriented 
process, since mistakes made while cutting the negative are extremely expensive to 
correct.

Once the camera negative has been conformed and the different shots physically glued 
together onto alternating A and B rolls, the negative can be color timed by being run 
through an optical printer designed for this process. These machines shine filtered light 
through the original negatives to expose an intermediate positive print, in the process 
creating a single reel of film that is the color-corrected print.

The process of controlling the color of individual shots and doing scene-to-scene color 
correction is accomplished using just three controls to individually adjust the amount 
of red, green, and blue light that exposes the film, using a series of optical filters and 
shutters. Each of the red, green, and blue dials is adjusted in discrete increments called 
printer points (with each point being a fraction of an f-stop, the scale used to measure 
film exposure). Typically there�s a total range of 50 points, where point 25 is the original 
neutral state for that color channel. Increasing or decreasing all three color channels 
together darkens or brightens the image, while making disproportionate adjustments 
to the three channels changes the color balance of the image relative to the 
adjustment.

The machine settings used for each shot can be stored (at one time using paper tape 
technology) and recalled at any time, to ease subsequent retiming and adjustments, 
with the printing process being automated once the manual timing is complete. Once 
the intermediate print has been exposed, it can be developed and the final results 
projected. 

While this system of color correction may seem cumbersome compared to today�s 
digital tools for image manipulation, it�s an extremely effective means of primary color 
correction for those who�ve mastered it.

Camera Negative Conform Negative Optical Color Timing Final Film Print
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Note:  Color includes printer points controls for colorists who are familiar with this 
method of color correction. For more information, see �Advanced Tab� on page 204.

Tape-to-Tape Color Correction
With projects shot on videotape (and those shot on film that can�t afford a second 
telecine pass), the color correction process fits into the traditional video offline/online 
workflow. Once the edit has been locked, the final master tape is assembled, either by 
being reconformed on the system originally used to do the offline or by taking the EDL 
and original source tapes to an online suite compatible with the source tape formats.

If the online assembly is happening in a high-end online suite, then color correction 
can be performed either during the assembly of the master tape or after assembly by 
running the master tape through a color correction session.

Note:  If the final master tape is color corrected, the colorist must carefully dissolve and 
wipe color correction operations to match video dissolves and wipes happening in the 
program.

Either way, the video signal is run through dedicated video color correction hardware 
and software, and the colorist uses the tape�s master timecode to set up and preserve 
color correction settings for every shot of every scene.

While video color correction started with controls as humble as those used by film 
colorists, the evolution of the online color correction suite introduced many more tools 
to the process, including separate corrections for discrete tonal zones, secondary color 
correction of specific subjects via keying and shapes controls, and many, many other 
creative options previously unavailable to the film colorist.

Color Correcting Via a Second Telecine Pass
Programs shot on film that are destined for video mastering, such as for an episodic 
broadcast series, may end up back in the telecine suite for their final color correction 
pass. Once editing is complete and the picture is locked, a cut list or pull list (similar to 
that used for a negative conform) is created that matches the EDL of the edited 
program.

TelecineVideo Tapes Offline Edit Final
Master Tape

Tape Suite
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Using the cut list, the post-production supervisor pulls only the film negative that was 
actually used in the edit. Since this is usually a minority of the footage that was 
originally shot, the colorist now has more time (depending on the show�s budget, of 
course) to perform a more detailed color correction pass on the selected footage that 
will be assembled into the final video program during this final telecine pass.

Although this process might seem redundant, performing color correction directly 
from the film negative has several distinct advantages. Since film has greater latitude 
from black to white than video has, a colorist working straight off the telecine 
potentially has a wider range of color and exposure from which to draw than when 
working only with video.

In addition, the color correction equipment available to the telecine colorist has 
evolved to match (and is sometimes identical to) the tools available to online video 
colorists, with the added advantage that the colorist can work directly on the 
uncompressed images provided by the telecine.

After the conclusion of the second color correction pass, the color-corrected selects are 
reassembled to match the original edit, and the project is mastered to tape.

Incidentally, even if you don�t intend to color correct your program in the telecine suite, 
you might consider retransferring specific shots to make changes that are easier or 
higher quality to make directly from the original camera negative. For example, after 
identifying shots you want to retransfer in your Final Cut Pro sequence, you can use 
Cinema Tools to create a selects list, for example, just for shots you want to optically 
enlarge, speeding the transfer process.

Camera Negative

Inexpensive 
One-Light

Telecine Pass Offline Media
Reconform
Final Master

Offline Edit Best-Light
Telecine Pass
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Color Correction in Color
You�ve seen how color correction is done in other post-production environments. This 
section describes how Color fits into a typical film or video post-production process.

Color provides many of the same high-end color correction tools on your desktop that 
were previously available in high-end tape-to-tape and telecine color correction suites. 
In addition, Color provides additional tools in the Color FX room that are more 
commonly found in dedicated compositing applications, which give you even more 
detailed control over the images in your program (for more information, see 
Chapter 11, �Color FX,� on page 235). 

Color has been designed as a color correction environment for either film or video. It�s 
resolution independent, supporting everything from standard definition video up to 2K 
film scans. It also supports multiple media formats and is compatible with image data 
using a variety of image sequence formats and QuickTime codecs.

Color also has been designed to be incorporated into a digital intermediate workflow. 
Digital intermediate refers to a high-quality digital version of your program that can be 
edited, color corrected, and otherwise digitally manipulated using computer hardware 
and software, instead of tape machines or optical printers.

Editors, effects artists, and colorists who finish video programs in a tapeless fashion 
have effectively been working with digital intermediates for years, but the term usually 
describes the process of scanning film frames digitally, for the purposes of doing all 
edit conforming, effects, and color correction digitally. It is then the digital image data 
which is printed directly to film or compiled as a file for digital projection.

Other Advantages to Telecine Transfers
In addition to color correction, a colorist working with a telecine has many other 
options available, depending on what kinds of issues may have come up during the 
edit. 
´ Using a telecine to pull the image straight off the film negative, the colorist can 

reposition the image to include parts of the film image that fall outside the action 
safe area of video.

´ With the telecine, the image can also be enlarged optically, potentially up to 50 
percent without visible distortion.

´ The ability to reframe shots in the telecine allows the director or producer to make 
significant changes to a scene, turning a medium shot into a close-up for dramatic 
effect, or moving the entire frame up to crop out a microphone that�s inadvertently 
dropped into the shot.
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Finishing film or video programs digitally frees colorists from the limitations of film and 
tape transport mechanisms, speeding their work by letting them navigate through a 
project as quickly as in a nonlinear editing application. Furthermore, working with the 
digital image data provides a margin of safety, by eliminating the risk of scratching the 
negative or damaging the source tapes.

When Does Color Correction in Color Happen?
Color correction using Color usually happens at or near the conclusion of the online 
edit or project conform, often at the same time the final audio mix is being performed. 
Waiting until the picture is locked is always a good idea, but it�s not essential, as Color 
provides tools for synchronizing projects that are still being edited via XML files or EDLs.

Color has been designed to work hand-in-hand with editing applications like 
Final Cut Pro; Final Cut Pro takes care of input, editing, and output, and Color allows 
you to focus on color correction and related effects.

About Importing Projects and Media into Color
To work on a program in Color, you must be provided with two sets of files:
´ The edited project file (or files, if the program is in multiple reels) in a format that can 

be imported into Color. Compatible formats include Final Cut Pro XML files and EDL 
files from nearly any editing environment. Final Cut Pro sequence data can also be 
sent to Color directly if you have Final Cut Pro installed on the same computer, using 
the �Send to Color� command.

´ You must also be given high-quality digital versions of the original source media, in a 
compatible QuickTime or image sequence format.

Project and media format flexibility means that Color can be incorporated into a wide 
variety of post-production workflows. For an overview of different color correction 
workflows using Color, see Chapter 2, �Color Correction Workflows,� on page 35.

About Exporting Projects from Color
As mentioned above, Color doesn�t handle video capture or output to tape on its own. 
Once you�ve finished color correcting your project in Color, you render every shot in 
the project to disk as an alternate set of color corrected media files, and you then send 
your Color project back to Final Cut Pro, or hand it off to another facility for tape layoff 
or film out. For more information, see Chapter 17, �Render Queue,� on page 321.

What Footage Does Color Work With?
Color can work with film or video shots as either QuickTime files or image sequences, 
at a variety of resolutions and compression ratios. This means you have the option of 
working on anything from highly compressed QuickTime DV-25 shots, up through 
uncompressed 2K .tif image sequences, at 8- or 10-bit (linear or log)�whatever your 
clients provide.
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Image Encoding Standards
The following section provides important information about the image encoding 
standards supported by Color. The image data you�ll be color correcting is typically 
encoded either using an RGB or Y·CBCR (sometimes referred to as YUV) format. Color is 
extremely flexible and capable of working with image data of either type.

The RGB Additive Color Model
In the RGB color model, three color channels are used to store red, green, and blue 
values in varying amounts to represent each available color that can be reproduced. 
Adjusting the relative balance of values in these color channels adjusts the color being 
represented. When all three values are equal, the result is a neutral tone, from black 
through gray to white.

More typically, you�ll see these ratios expressed as digital percentages in the Color 
parade scope or histogram. For example, if all three color channels are 0%, the pixel is 
black. If all three color channels are 50%, the pixel is a neutral gray. If all three color 
channels are 100% (the maximum value), the pixel is white.

While a few high-quality QuickTime codecs encode video using RGB (Animation is one 
of the most commonly used), RGB-encoded images are typically stored as 
uncompressed image sequences.

The Y�CBCR Color Model
Video is typically recorded using the Y·CBCR color model. Y·CBCR color coding also 
employs three channels, or components. A shot�s image is divided into one luma 
component (luma is image luminance modified by gamma for broadcast) and two 
color difference components which encode the chroma (chrominance). Together, these 
three components make up the picture that you see when you play back your video.
´ The Y· component represents the black-and-white portion of an image�s tonal range. 

Because the eye has different sensitivities to the red, green, and blue portions of the 
spectrum, the image �lightness� that the Y· component reproduces is derived from a 
weighted ratio of the (gamma-corrected) R, G, and B color channels. Viewed on its 
own, the Y� component is the monochrome image.

´ The two color difference components, CB and CR, are used to encode the color 
information in such a way as to fit three color channels of image data into two. A bit 
of math is used to take advantage of the fact that the Y� component also stores 
green information for the image. The actual math used to derive each color 
component is CB = B� � Y�, while CR = R� � Y�.

Note:  This scheme was originally created so that older black-and-white televisions 
would be compatible with the newer color television transmissions.
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Chroma Subsampling
In Y·CBCR encoded video, the color channels are typically sampled at a lower ratio than 
the luma channel. Because the human eye is more sensitive to differences in brightness 
than in color, this has been used as a way of reducing the video bandwidth (or data 
rate) requirements without perceptible loss to the image.

The sampling ratio between the Y·, CB, and CR channels is notated as a three value ratio. 
Common chroma subsampling ratios are:

´ 4:4:4 chroma subsampled video encodes completely uncompressed color, the 
highest quality possible, as the color difference channels are sampled at the same 
rate as the luma channel. 4:4:4 subsampled image data is typically obtained via 
telecine or datacine to a video mastering or image sequence format capable of 
containing it. RGB encoded images are always 4:4:4.
Few video acquisition formats are capable of recording 4:4:4 video, but those that do 
include HDCAM SR and certain digital cinema cameras, including the Thompson 
Viper FilmStream camera and the Genesis digital camera system.

´ 4:2:2 is a chroma subsampling ratio typical for high-quality video formats, including 
Beta SP, Digital Betacam, Beta SX, IMX, DVCPRO 50, DVCPRO HD, and HDCAM.

´ 4:1:1 is typical for consumer and prosumer video formats including DVCPRO 25 
(NTSC and PAL), DV and DVCam (NTSC).

´ 4:2:0 is another consumer-oriented subsampling rate, used by DV and DVCAM (PAL), 
HDV, XDCAM HD, and MPEG-2.

Note:  As their names imply, Apple Uncompressed 8-bit 4:2:2, Apple Uncompressed 10-
bit 4:2:2, Apple ProRes 422 (SQ), and Apple ProRes 422 (HQ) all use 4:2:2 chroma 
subsampling.

It�s important to be aware of the advantages of higher chroma subsampling ratios in 
the color correction process. Whenever you�re in a position to specify the transfer 
format with which a project will be finished, make sure you ask for the highest quality 
format your system can handle (for more information about high quality finishing 
codecs, see �A Tape-Based Workflow� on page 40).

As you can probably guess, more color information is better when doing color 
correction. For example, when you make large contrast adjustments to 4:1:1 or 4:2:0 
subsampled video, film grain or video noise in the image becomes exaggerated. This 
happens most often with underexposed footage. You�ll find that you can make the 
same or greater adjustments to 4:2:2 subsampled video, and the resulting image will 
have much less grain and noise. Greater contrast with less noise provides for a richer 
image overall.
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Furthermore, it�s common to use chroma keying operations to isolate specific areas of 
the picture for correction. This is done using the HSB qualifiers in the Secondaries 
room. These keying operations will have smoother and less noisy edges when you�re 
working with 4:2:2 subsampled video. The chroma compression used by 4:1:1 and 4:2:0 
subsampled video results in �blockiness� when you isolate the chroma, which affects 
the mattes that are created by the HSB qualifiers.

However, it�s important to bear in mind that it is definitely possible to aggressively 
correct highly compressed video. By paying attention to image noise as you stretch the 
contrast of poorly exposed footage, you can focus your corrections on the areas of the 
picture where noise is minimized. When doing secondary color correction to make 
targeted corrections to specific parts of the image, you may find it a bit more time 
consuming to pull smooth secondary keys. However; with care and patience, you can 
still achieve beautiful results.

Bit Depth
Another factor that affects the quality of video images, and can have an affect on the 
quality of your image adjustments, is the bit depth of the source media you�re working 
with. With both RGB and Y·CBCR encoded media, the higher the bit depth, the more 
image data is available, and the smoother both the image and your corrections will be.

The bit depth of your source media depends largely on how that media was originally 
acquired. 

Film Versus Video and Chroma Subsampling
In general, film footage is usually transferred with the maximum amount of image 
data possible, especially when transferred as a completely uncompressed image 
sequence (4:4:4) as part of a carefully managed digital intermediate workflow. This is 
one reason for the higher quality of the average film workflow.

Standard and high definition video, on the other hand, is usually recorded with lower 
chroma subsampling ratios (4:2:2 is typical even with higher quality video formats, 
and 4:1:1 and 4:2:0 are common with prosumer formats) and higher compression 
ratios, depending entirely upon the recording and video capture formats used. Since 
the selected video format determines compression quality at the time of the shoot, 
there�s nothing you can do about the lost image data, other then to make the best of 
what you have.

That said, with a bit of care you can color correct nearly any compressed video or 
image sequence format with excellent results, and Color gives you the flexibility to 
use highly compressed source formats including DV, HDV, and DVCPRO HD.
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Most of the media you�ll receive falls into one of the following bit depths, all of which 
Color supports:

´ 8-bit:  Most standard and high definition consumer and professional digital video 
formats capture 8-bit image data, including DV and DVCPRO-25, DVCPRO 50, HDV, 
DVCPRO HD, HDCAM, and so on.

´ 10-bit:  Many video capture interfaces allow the uncompressed capture of analog and 
digital video at 10-bit resolution.

´ 10-bit log:  By storing data logarithmically, rather then linearly, a wider contrast ratio 
(such as that of film) can be fit into a 10-bit data space. 10-bit log files are often 
recorded from datacine scans using the Cineon and DPX image sequence formats.

´ 16-bit:  It takes 16 bits of linear data to match the contrast ratio that can be stored 
with 10-bit log. Since linear data is easier for computers to process, this is another 
data space that�s available in some image formats.

Higher bit depths accommodate more image data by using a greater range of numbers 
to represent the tonal range that�s available. This is apparent when looking at the 
numeric ranges used by the two bit depths most commonly associated with video.

´ 8-bit images use a full range of 0�255 to store each color channel (Y·CBCR video uses 
a narrower range of 16�235 to accommodate super-black and super-white). 255 isn�t 
a lot of values, and the result can be subtly visible �stairstepping� in areas of the 
picture with narrow gradients (such as skies).

´ 10-bit images, on the other hand, use a full range of 0 to 1023 to store each color 
channel (again, Y·CBCR video uses a narrower range of 64�940 to accommodate 
super-black and super-white). The additional numeric range allows for smoother 
gradients, and virtually eliminates bit-depth related artifacts.

Fortunately, while you can�t always control the bit depth of your source media, you can 
control the bit depth at which you work in Color independently. That means that even 
if the source media is at a lower bit depth, you can work at a higher bit depth to make 
sure that the quality of your corrections is as high as possible. In particular, many 
effects and secondary corrections look significantly better when Color is set to render 
at higher bit depths. For more information, see �Playback, Processing, and Output 
Settings� on page 106.

Basic Color and Imaging Concepts
Color correction involves controlling both an image�s contrast and its color (exercising 
separate control over its hue and saturation). This section explains these important 
imaging concepts so that you can better understand how the Color tools let you alter 
the image.
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Contrast
Contrast adjustments are the most fundamental, and generally the first, adjustments 
made. Contrast is a way of describing an image�s tonality. If you eliminate all color from 
an image, reducing it to a series of grayscale tones, the contrast of the picture is seen 
by the distribution of dark, medium, and light tones in the image.

Controlling contrast involves adjustments to three aspects of an image�s tonality:
´ The black point is the darkest pixel in the image.
´ The white point is the brightest pixel in the image.
´ The midtones are the distribution of all tonal values in between the black and white 

points.

WhiteBlack Mids
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An image�s contrast ratio is the difference between the darkest and brightest tonal 
values within that image. Typically, a higher contrast ratio, where the difference 
between the two is greater, is preferable to a lower one. Unless you�re specifically going 
for a low-contrast look, higher contrast ratios generally provide a clearer, crisper image. 
The following two images, with their accompanying histograms which show a graph of 
the distribution of shadows, midtone, and highlights from left to right, illustrate this.

Furthermore, maximizing the contrast ratio of an image aids further color correction 
operations by more evenly distributing that image�s color throughout the three tonal 
zones that are adjusted with the three color balance controls in the Primary In, 
Secondaries, and Primary Out rooms. This makes it easier to perform individual 
corrections to the shadows, midtones, and highlights.

For more information about adjusting image contrast, see �Using the Primary Contrast 
Controls� on page 166.
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Luma
Luma (which technically speaking is gamma-corrected luminance) describes the 
exposure (lightness) of a video shot, from absolute black, through the distribution of 
gray tones, all the way up to the brightest white. Luma can be separated from the color 
of an image. In fact, if you desaturate an image completely, the grayscale image that 
remains is the luma.

Luma is measured by Color as a digital percentage from 0 to 100, where 0 represents 
absolute black and 100 represents absolute white. Color also supports super-white 
levels (levels from 101 to 109 percent) if they exist in your shot. While super-white video 
levels are not considered to be safe for broadcast, many cameras record video at these 
levels anyway.

Note:  Unadjusted super-white levels will be clamped by the Broadcast Safe settings if 
they�re turned on with their default settings, such that pixels in the image with luma 
above 100 percent will be set to 100 percent.

What Is Setup
Beginning colorists sometimes confuse the black level of digital video with setup. 
Setup refers to the black level of an analog video signal and is only an issue with 
analog video. If you are outputting to an analog tape format using a third-party 
analog video interface, you should check the documentation that came with that 
video interface to determine how to configure the video interface for the North 
American standard for setup (7.5 IRE) or the Japanese standard (0 IRE). Most vendors 
of analog video interfaces include a software control panel that allows you to select 
which black level to use. Most vendors label this as �7.5 Setup� versus �0 Setup,� or in 
some cases �NTSC� versus �NTSC-J.� 

Video sent digitally via SDI has no setup. The Y·CBCR black level simply remains at the 
appropriate digital value corresponding to the bit depth of the video signal 
(represented by 0 percent on a video scope).

Black

0% luminance 100% 109%

White

Superwhite



Chapter 1    Color Correction Basics 31

Gamma
Gamma refers to two different concepts. In a video signal, gamma refers to the 
nonlinear representation of luminance in a picture displayed on a broadcast or 
computer monitor. Since the eye has a nonlinear response to light (mentioned in 
�The Y�CBCR Color Model� on page 24), applying a gamma adjustment while recording 
an image maximizes the perceptible recorded detail in video signals with limited 
bandwidth. Upon playback, a television or monitor applies an inverted gamma 
function to return the image to its �original� state.

You want to avoid unplanned gamma adjustments when sending media from 
Final Cut Pro to Color. It�s important to keep track of any possible gamma adjustments 
that occur when exporting or importing clips in Final Cut Pro during the editing 
process, so that these adjustments are accounted for and avoided during the 
Final Cut Pro to Color round trip. For more information on gamma handling in 
Final Cut Pro, see the Final Cut Pro User Manual.

Gamma is also used to describe a nonlinear adjustment made to the distribution of 
midtones in an image. For example, a gamma adjustment leaves the black point and 
the white point of an image alone, but either brightens or darkens the midtones 
according to the type of adjustment being made. For more information on gamma and 
midtones adjustments, see Chapter 9, �Primary In,� on page 163.

Chroma (Chrominance)
Chroma (also referred to as chrominance) describes the color channels in your shots, 
ranging from the absence of color to the maximum levels of color that can be 
represented. Specific chroma values can be described using two properties, hue and 
saturation.

Hue
Hue describes the actual color itself, whether it�s red or green or yellow. Hue is 
measured as an angle on a color wheel.
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Saturation
Saturation describes the intensity of that color, whether it�s a bright red or a pale red. 
An image that is completely desaturated has no color at all and is a grayscale image. 
Saturation is also measured on a color wheel, but as the distance from the center of the 
wheel to the edge.

As you look at the color wheel, notice that it is a mix of the red, green, and blue 
primary colors that make up video. In between these are the yellow, cyan, and 
magenta secondary colors, which are equal mixes of the primary colors.

Color Relationships
Understanding color wheel interactions will help you to see how the Color controls 
actually affect colors in an image.

Primary Colors
In any additive color model, the primary colors are red, green, and blue. These are the 
three purest colors that can be represented, by setting a single color channel to 100 
percent and the other two color channels to 0 percent.

Secondary Colors
Adding any two primary colors produces a secondary color. In other words, you create 
a secondary color by setting any two color channels to 100 percent while setting the 
third to 0 percent.
´ Red + green = yellow
´ Green + blue = cyan
´ Blue + red = magenta

One other aspect of the additive color model:

´ Red + green + blue = white

All of these combinations can be seen in the illustration of three colored circles below. 
Where any two primaries overlap, the secondary appears, and where all three overlap, 
white appears.
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Complementary Colors
Two colors that appear 180 degrees opposite one another on the wheel are referred to 
as complementary colors.

Adding two complementary colors of equal saturation to one another neutralizes the 
saturation, resulting in a grayscale tone. This can be seen in the two overlapping color 
wheels in the illustration below. Where red and cyan precisely overlap, both colors 
become neutralized.

Understanding the relationship of colors to their complementaries is essential to 
learning how to eliminate or introduce color casts in an image using the Color Primary 
or Secondary color correction controls. For example, to eliminate a bluish cast in the 
highlights of unbalanced daylight, you add a bit of orange to bring all of the colors to a 
more neutral state. This is covered in more detail in Chapter 9, �Primary In,� on 
page 163.

The HSL Color Space Model
The HSL color space model is another method for representing color, typically used for 
user interface controls that let you choose or adjust colors. HSL stands for hue, 
saturation, and lightness (roughly equivalent to luminance) and provides a way of 
visualizing the relationships among luminance, hue, and saturation.
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The HSL color space model can be graphically illustrated as a three dimensional cone. 
Hue is represented by an angle around the base of the cone, as seen below, while 
saturation is represented by a color�s distance from the center of the cone to the edge, 
with the center being completely desaturated and the edge being saturated to 
maximum intensity. A color�s brightness, then, can be represented by its distance from 
the base to the peak of the cone.

Color actually provides a three-dimensional video scope that�s capable of displaying 
the colors of an image within an extruded HSL space, for purposes of image analysis. 
For more information, see �3D Color Space Scope� on page 157.
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2 Color Correction Workflows

Taking maximum advantage of Color requires careful 
workflow management. This chapter outlines where Color fits 
into your post-production workflow.

Color has been designed to work hand in hand with editing applications like 
Final Cut Pro via XML and QuickTime media support, or with other editorial 
environments via EDL and image sequence support. While video and film input and 
editing are taken care of elsewhere, Color gives you a dedicated environment with 
which to focus on color correction and related effects. 

This chapter gives you a quick overview of how to guide your project through a 
workflow that includes using Color for color correction. Information is provided about 
both standard and high definition broadcast video workflows, as well as 2K digital 
intermediate workflows.

This chapter covers the following:

´ An Overview of the Color Workflow (p. 35)
´ Limitations in Color (p. 37)
´ Video Finishing Workflows Using Final Cut Pro (p. 39)
´ Importing Projects from Other Video Editing Applications (p. 47)
´ Using Color in a Digital Intermediate Workflow (p. 49)
´ Using EDLs, Timecode, and Frame Numbers to Conform Projects (p. 56)

An Overview of the Color Workflow
The Color controls are divided into eight tabbed rooms, each of which corresponds to a 
different stage in a typical color-correction workflow. Each room that you select remaps 
the buttons, dials, and trackballs of your control surface (if you have one) to correspond 
to the controls in that room.
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Each room gathers all the controls pertaining to that particular step of the color-
correction process onto a single screen. The rooms are organized in the order of a 
typical color-correction workflow, so you can work your way across from the Primary 
controls, to the Secondary controls, Color FX, Primary Out, and finally Geometry as you 
work on each shot in your project.

´ Setup:  All projects begin in the Setup room. This is where you import and manage 
the shots in your program. The grade bin, project settings, and application 
preferences are also all found within the Setup room. For video colorists, the project 
settings area of the Setup room is where you find the Broadcast Safe controls, which 
allow you to apply gamut restrictions to the entire program.

´ Primary In:  Primary color corrections affect the entire image, so this room is where 
you make overall adjustments to the color and contrast of each shot. Color balance 
and curve controls let you adjust colors in the shadows, midtones, and highlights of 
the image. The lift, gamma, and gain controls let you make detailed contrast 
adjustments, which affect the brightness of different areas of the picture. There are 
also controls for overall, highlight, and shadow saturation, and printer point (or 
printer light) controls for colorists used to color timing for film.

´ Secondaries:  Secondary color corrections are targeted adjustments made to specific 
areas of the image. This room provides numerous methods for isolating, or 
qualifying, which parts of the image you want to correct. Controls are provided with 
which to isolate a region using shape masks. Additional controls let you isolate areas 
of the picture using a chroma keyed matte with individual qualifications for hue, 
saturation, and luminance. Each shot can have up to eight secondary operations. 
Furthermore, special-purpose secondary curves let you make adjustments to hue, 
saturation, and luma within specific portions of the spectrum.

´ Color FX:  The Color FX room lets you create your own custom effects via a node-
based interface more commonly found in high-end compositing applications, similar 
to Shake. These individual effects nodes can be linked together in thousands of 
combinations, providing a fast way to create many different types of color effects. 
Your custom effects can be saved in the Color FX bin for future use, letting you apply 
your look to future projects.

´ Primary Out:  The Primary Out room is identical to the Primary In room except that its 
color corrections are applied to shots after they have been processed by all the other 
color grading rooms. This provides a way to post-process your images after all other 
operations have been performed.
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´ Geometry:  The Geometry room lets you pan and scan, rotate, flip, and flop shots as 
necessary. The Geometry room also provides tools for creating custom masks and for 
applying and managing motion tracking analyses. How Geometry is handled 
depends on your workflow:
´ For projects being round-tripped from Final Cut Pro, Geometry room 

transformations are not rendered by Color when outputting the corrected project 
media. Instead, all the geometric transformations you create in Color are translated 
into Final Cut Pro Motion settings when the project is sent back to Final Cut Pro. 
You�ll then have the option to further customize those effects in Final Cut Pro prior 
to rendering and output.

´ For 2K digital intermediates, Geometry room transformations are processed by 
Color when rendering the output media.

Note:  When you send a project from Final Cut Pro to Color, compatible Motion tab 
effects are translated into Geometry room settings, which lets you preview and 
adjust these transformations as you color-correct. For more information, see 
Chapter 15, �Geometry,� on page 293.

´ Still Store:  You can save frames from anywhere in the Timeline using the Still Store, 
creating a reference library of stills from your program from which you can recall 
images to compare to other shots you�re trying to match. You can load one image 
from the Still Store at a time into memory, toggling between it and the current frame 
at the position of the Playhead using the controls in the Still Store menu. The Still 
Store also provides controls for creating and customizing split screens you can use to 
balance one shot to another. All Still Store comparisons are sent to the preview and 
broadcast monitor outputs.

´ Render Queue:  When you�ve finished grading your program in Color, you�ll use the 
Render Queue to manage the rendering of the shots in your project.

Limitations in Color
Color has been designed to work hand in hand with editing applications like 
Final Cut Pro; Final Cut Pro takes care of input, editing, and output, and Color allows 
you to focus on color correction and related effects. However, as feature rich as Color is, 
there are specific things it does not do:
´ Recording:  it�s incapable of either scanning or capturing film or video footage. This 

means that you need to import projects and media into Color from another 
application. 

´ Editing:  Color is not intended to be an editing application. The editing tools that are 
provided are primarily for colorists working in 2K workflows where the Color project 
is the final version that will become the digital master. By default, the tracks of 
imported XML project files are locked to prevent new edits from introducing errors 
when the project moves back to Final Cut Pro.
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To accommodate editorial changes, reconforming tools are provided to synchronize 
an EDL or Final Cut Pro sequence with the version of that project being graded in 
Color. For more information, see �Reconforming Projects� on page 79.

´ Filters:  Final Cut Pro FXScript or FxPlug filters are neither previewed nor rendered by 
Color. However, their presence in your project is maintained, and they show up again 
once the project is sent back to Final Cut Pro.

Note:  It�s not generally a good idea to allow color-correction filters to remain in your 
Final Cut Pro project when you send it to Color. Even though they have no effect as 
you work in Color, their sudden reappearance when the project is sent back to 
Final Cut Pro may produce unexpected results.

´ Transitions:  Color preserves transition data that might be present in an imported EDL 
or XML file, but does not play the transitions during previews. How they�re rendered 
depends on how the project is being handled:
´ For projects being round-tripped from Final Cut Pro, transitions are not rendered in 

Color during output. Instead, after the project�s return, Final Cut Pro is relied upon 
to render those effects.

´ For 2K digital intermediates, all video transitions are ignored. 
´ Superimpositions:  Superimposed shots are displayed in the Timeline, but 

compositing operations involving opacity are neither displayed nor rendered.
´ Speed effects:  Color doesn�t provide an interface for adding speed effects, instead 

relying on the editing application that originated the project to do so. Linear and 
variable speed effects that are already present in your project, such as those added in 
Final Cut Pro, are previewed during playback, but they are not rendered in Color 
during output. Instead, Final Cut Pro is relied upon to render those effects in round-
trip workflows.

´ Final Cut Pro generators, and Motion or LiveType project shots:  Final Cut Pro generators, 
Motion projects, and LiveType projects are completely ignored by Color. How you 
handle these types of effects also depends on your workflow:
´ If you�re round-tripping a project between Final Cut Pro and Color, and you want 

to grade these effects in Color, you should render these effects as self-contained 
QuickTime .mov files. Then, edit the new .mov files into your sequence to replace 
the original effects shots prior to sending your project to Color.

´ If you�re round-tripping a project between Final Cut Pro and Color, and there�s no 
need to grade these effects, you don�t need to do anything. Even though these 
effects aren�t displayed in Color, their position in the Timeline is preserved, and 
these effects will reappear in Final Cut Pro when you send the project back. Titles 
are a good example of effects that don�t usually need to be graded.

´ If you�re working on a 2K digital intermediate, you�ll need to use a compositing 
application like Shake or Motion to composite any effects using the image 
sequence data. 
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Important:  When you send frames of media to a compositing application, it�s vital 
that you maintain the frame number in the filenames of new image sequence media 
that you generate. Each image file�s frame number identifies its position in that 
program�s Timeline, so any effects being created as part of a 2K digital intermediate 
workflow require careful file management.

´ Freeze Frame clips and Still image files:  Still frames used in Final Cut Pro projects, 
including .tiff, .jpg, or Final Cut Pro created Freeze Frame clips, are also ignored by 
Color. If you want to grade still frames in Color, you need to render them as self-
contained QuickTime .mov files, and edit them back into your Final Cut Pro sequence 
to replace the original shot prior to sending the project to Color.

´ Video or film output:  While Color provides broadcast output of your project�s 
playback for preview purposes, this is not intended to be used to output your 
program to tape. This means that when you finish color correcting your project in 
Color, the rendered output needs to be moved to Final Cut Pro for output to tape or 
to another environment for film output.

Video Finishing Workflows Using Final Cut Pro
If a program has been edited using Final Cut Pro, the process of moving it into Color is 
fairly straightforward. After editing the program in Final Cut Pro, you must reconform 
the program, if necessary, to use the original source media at its highest available 
quality.

Once that has been accomplished, you can send the project data and files into Color 
for color correction. Upon completion of the color-correction pass, you�ll need to 
render the result and send the project back to Final Cut Pro for final output, either to 
tape or as a QuickTime file.
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Exactly how you conform your source media in Final Cut Pro depends on the type of 
media that�s used.

A Tape-Based Workflow
For a traditional offline/online tape-based workflow, the process is simple. The tapes are 
captured into Final Cut Pro, possibly at a lower quality offline resolution to ease the 
initial editing process by using media that takes less hard drive space, and is easier to 
work with using a wider range of computers.

After the offline edit is complete, the media used by the edited program must be 
recaptured from the source tapes at maximum quality. The resulting online media is 
what will be used for the Final Cut Pro to Color round trip.

The following steps break this process down more explicitly.

Step 1:  Capture the source media at offline or online resolution
How you approach capturing your media prior to editing depends on its format. 
Compressed formats, including DV, DVCPRO-50, DVCPRO HD, and HDV, can be captured 
at their highest quality without requiring enormous storage resources. If this is the 
case, then capturing and editing your media using its native resolution and codec lets 
you eliminate the time-consuming step of recapturing (sometimes called conforming) 
your media later on.
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Uncompressed video formats, or projects where there are many, many reels of source 
media, may benefit from being captured at a lower resolution or with a more highly 
compressed codec. This will save drive space and also enable you to edit using less 
expensive equipment. Later, you�ll have to recapture the media prior to color 
correction.

Step 2:  Edit the program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you�re planning 
on an extensive use of effects in your program during editorial, familiarize yourself with 
the topics covered in �Limitations in Color� on page 37.

Step 3:  Recapture the source media at online resolution if necessary
If you originally captured your source media using an offline format, you�ll need to 
recapture the media used in your project at the highest available quality prior to 
sending it to Color.
´ If your media was originally recorded using a compressed format (such as DV, 

DVCPRO-50, DVCPRO HD, or HDV), then recapturing it using the original source 
codec and resolution is fine; Color can work with compressed media, and 
automatically promotes the image data to higher uncompressed bit depths for 
higher quality imaging when monitoring and rendering.

´ If you�re capturing a higher bandwidth video format (such as Betacam SP, Digital 
Betacam, HDCAM, and HDCAM SR) and require high quality but need to use a 
compressed format to save hard drive space and increase performance on your 
particular computer, then you can recapture using the Apple ProRes 422 codec, or 
the higher quality Apple ProRes 422 (HQ) codec.

´ If you�re capturing high-bandwidth video and require the highest quality 
uncompressed video data available, regardless of the storage requirements, you 
should recapture your media using Apple Uncompressed 8-bit 4:2:2 or Apple 
Uncompressed 10-bit 4:2:2.

You may also want to take the opportunity to use the Final Cut Pro Media Manager to 
delete unused media prior to recapturing in order to save valuable disk space, 
especially when recapturing uncompressed media. For more information, see the 
Final Cut Pro documentation.

Note:  Some codecs, such as HDV, can be more processor intensive to work with than 
others. In this case, capturing or recompressing the media with a less processor-
intensive codec, such as Apple ProRes 422 or Apple ProRes 422 (HQ), will improve your 
performance while you work in Color, while maintaining high quality and low storage 
requirements.
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Step 4:  Pre-render any still images or effects you want to grade in Color
Color can�t display or process still images, certain motion settings, FXScript or FxPlug 
filters, Final Cut Pro generators (including titles), Motion project files, or LiveType 
project files. If you want to grade clips using these effects in Color, you need to render 
those shots in Final Cut Pro as self-contained QuickTime .mov files, and edit them back 
into your Final Cut Pro sequence to replace the original clips prior to sending the 
project to Color. For more information about effects and features that aren�t compatible 
with Color, see �Limitations in Color� on page 37.

Step 5:  Prepare your Final Cut Pro sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps 
outlined in �Before You Export Your Final Cut Pro Project� on page 75.

Step 6:  Send the sequence to Color, or export an XML file
When you�ve finished prepping your edited sequence, there are two ways you can send 
it to Color.
´ If Color is installed on the same computer as Final Cut Pro, you can use the �Send to 

Color� command to move an entire edited sequence to Color, automatically creating 
a new project file.

´ If you�re handing the project off to another facility, you may want to export the 
edited sequence as an XML file for eventual import into Color. In this case, you�ll also 
want to use the Final Cut Pro Media Manager to copy the project�s media to a single, 
transportable hard drive volume for easy handoff.

Step 7:  Grade your program in Color
Use Color to grade your program. When working on a round trip from Final Cut Pro, it�s 
crucial to avoid unlocking tracks or reediting shots in the Timeline. Doing so can 
compromise your ability to send the project back to Final Cut Pro.

If the client needs a reedit after you�ve started grading, you should instead perform the 
edit back in Final Cut Pro, and export an XML version of the updated sequence which 
you can use to quickly update the Color project in progress using the Reconform 
command. For more information, see �Reconforming Projects� on page 79.

Step 8:  Render new source media, and send the updated project to Final Cut Pro
When you�ve finished grading, you�ll use the Color Render Queue to render all the shots 
in the project as a new, separate set of graded media files.

Afterward, you�ll need to send the updated project to Final Cut Pro using one of the 
two following methods:

´ If Color is installed on the same computer as Final Cut Pro, you can use the �Send to 
Final Cut Pro� command.

´ If you�re handing the color-corrected project back to the originating facility, you need 
to export the Color project as an XML file for later import into Final Cut Pro.
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Important:  Some parameters in the Project Settings tab of the Setup room affect how 
the media rendered by Color is rendered. These settings include the Deinterlace 
Renders, QuickTime Export Codec, Broadcast Safe, and Handles settings. Be sure to 
verify these and other settings prior to rendering your final output.

Step 9:  Adjust transitions, superimpositions, and titles in Final Cut Pro
To output your project, you need to import the XML project data back into 
Final Cut Pro. This happens automatically if you use the �Send to Final Cut Pro� 
command. At this point, you can add or adjust other effects that you had applied 
previously in Final Cut Pro, before creating the program�s final master. Things you may 
want to consider while prepping the program at this stage include:
´ Do you need to produce a �textless� master of the program, or one with the titles 

rendered along with the image?
´ Are there any remaining effects clips that you need to import and color-correct 

within Final Cut Pro?

Step 10:  Output the final video master to tape, or render a master QuickTime file
Once you�ve completed making any last adjustments in Final Cut Pro, you can go ahead 
and use the Print to Video, Edit to Tape, or Export QuickTime Movie commands to 
create the final version of your program.

Reconforming Online Media in a Tapeless Digital Video Workflow
If a program uses a tapeless video format, the steps are similar to those described 
above; however, they likely involve multiple sets of QuickTime files:  the original media 
at online resolution, and perhaps a second set of media files that have been 
downconverted to an offline resolution for ease of editing. After the offline edit, the 
online conform involves relinking to the original source media, prior to going through 
the Final Cut Pro to Color round trip.
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Here�s a more detailed explanation of the offline-to-online portion of this workflow.

Step 1:  Shoot and back up all source media
Shoot the project using whichever tapeless format you�ve chosen. As you shoot, make 
sure that you�re keeping backups of all your media, in case anything happens to your 
primary media storage device.

Step 2:  Create offline resolution duplicates, and archive original resolution media
If necessary, create offline resolution duplicates of the source media in whatever format 
is most suitable for your system. Then, archive the original source media as safely as 
possible.

Important:  When you create offline duplicates of tapeless media, it�s vital that you 
duplicate and maintain the original filenames and timecode that the source files were 
created with. This is critical to guaranteeing that you�ll be able to easily relink to the 
original high-resolution source files once the offline edit is complete.

Step 3:  Edit the program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you�re planning 
on an extensive use of effects in your program during editorial, familiarize yourself with 
the topics covered in �Limitations in Color� on page 37.

Step 4:  Relink your edited sequence to the original source media
Once your offline edit is complete, you�ll need to restore the original online quality 
source media, and relink your project to the high-resolution files.

Step 5:  Pre-render effects, send the sequence to Color, and grade
At this point, the workflow is identical step 7 in �A Tape-Based Workflow� on page 40.
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Reconforming Online Media in a Film-to-Tape Workflow
If you�re working on a project that was shot on film, but will be mastered on video, it 
must be transferred from film to tape using a telecine (telecined) prior to being 
captured and edited in Final Cut Pro. At that point, the rest of the offline and online 
edit is identical to any other tape-based format.

Here�s a more detailed explanation of the offline-to-online portion of this workflow.

Step 1:  Shoot your film
Shoot the project as you would any other film project.

Step 2:  Telecine the dailies
After the film has been shot, process and telecine the dailies to a video format 
appropriate for your workflow. 
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´ Some productions prefer to save money up front by doing an inexpensive �one-light� 
transfer of all the footage to an inexpensive offline video format for the initial offline 
edit (a one-light transfer refers to the process of using a single color-correction 
setting to transfer whole scenes of footage). This can save time and money up front, 
but may necessitate a second telecine session to retransfer only the footage used in 
the edit at a higher level of visual quality.

´ Other productions choose to transfer all the dailies (or at least just the director�s 
selected takes) via a �best-light� transfer, where the color-correction settings are 
individually adjusted for every shot that�s telecined, optimizing the color and 
exposure for each clip. The footage is transferred to a high-quality video format 
capable of preserving as much image data as possible. This can be significantly more 
expensive up front, but saves money later since a second telecine session is not 
necessary.

Step 3:  Capture the source media at offline or online resolution
How you capture your media prior to editing depends on your workflow. If you 
telecined offline-quality media, then you might as well capture using an offline quality 
codec.

If you instead telecined online-quality media, then you have the choice of either 
pursuing an �offline/online� workflow, or capturing via an online codec, and working at 
online quality throughout the entire program.

Step 4:  Edit the program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you�re planning 
on the extensive use of effects in your program during editorial, familiarize yourself 
with the topics covered in �Limitations in Color� on page 37.

Step 5:  Recapture or retransfer the media at online resolution (if necessary)
How you conform your offline project to online-quality media depends on how you 
handled the initial video transfer.
´ If you originally did a high-quality telecine pass to an online video format, but you 

captured your source media using an offline format for editing, you�ll need to 
recapture the media from the original telecine source tapes using the highest quality 
uncompressed QuickTime format that you can accommodate on your computer 
(such as Apple ProRes 422, or Apple Uncompressed), and relink the new media to 
your project.

´ If you did an inexpensive one-light telecine pass to an offline video format, you�ll 
want to do another telecine pass where you transfer only the media you used in the 
program at high quality. Using Cinema Tools, you can generate a pull list, which you 
then use to carefully retransfer the necessary footage to an online-quality video 
format. Then, you�ll need to recapture the new online transfer of this media using the 
highest quality uncompressed QuickTime format that you can accommodate on your 
computer.
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Important:  Do not use the Media Manager to either rename or delete unused media in 
your project when working with offline media that refers to camera negative. If you do, 
you�ll lose the ability to create accurate pull lists in Cinema Tools.

Step 6:  Pre-render effects, send the sequence to Color, and grade
At this point, the workflow is identical to step 7 in �A Tape-Based Workflow� on page 40.

Importing Projects from Other Video Editing Applications
Color is also capable of importing projects from other editing environments, by 
importing Edit Decision Lists (EDLs). An EDL is an event-based list of all the edits and 
transitions that make up a program.

Once you�ve imported your project file into Color, and copied the program media onto 
a storage device with the appropriate performance, you can then link the shots on the 
Color Timeline with their corresponding media.

Importing EDLs in a Final Cut Pro to Color Round Trip
If you�ve been provided with an EDL of the edited program and a box of source media, 
you can import the EDL into Final Cut Pro to capture the project�s media and prepare 
the project for sending to Color. In addition to being able to recapture the footage, 
Final Cut Pro is compatible with more EDL formats than is Color. Also, Final Cut Pro is 
capable of reading superimpositions and audio edits, in addition to the video edits.

Note:  Although capable of importing EDLs directly, Color only reads the video portion 
of edits in track V1. Video transitions, audio, and superimpositions are ignored.

Step 1:  Import the project into Final Cut Pro
Import the EDL of the edited project into Final Cut Pro.
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Step 2:  Capture media at online resolution
You�ll need to recapture the sequence created when importing the EDL using the 
highest quality QuickTime format that you can accommodate on your computer (such 
as Apple ProRes 422 or Apple Uncompressed).

Step 3:  Pre-render effects, send the sequence to Color, and grade
At this point, the workflow is identical to step 7 in �A Tape-Based Workflow� on page 40.

Importing and Notching Preedited Program Masters
Another common way of obtaining a program for color correction is to be provided 
with an edited master, either on tape or as a QuickTime movie or image sequence, and 
an accompanying EDL. You can use the EDL to automatically add edits to the master 
media file in Color (called �notching� the media), to make it easier to grade each shot in 
the program individually.

Step 1:  Import the project into Final Cut Pro
Import the EDL of the edited project into Final Cut Pro.

Step 2:  Capture the program master (if necessary)
If you were given the program master on tape, you�ll need to capture the entire 
program using the highest quality QuickTime format that you can accommodate on 
your computer (such as Apple ProRes 422 or Apple Uncompressed). If you�re being 
given the program master as a QuickTime file, you should request the same from 
whomever is providing you with the media.

For this process to work correctly, it�s good if the timecode of the first frame of media 
matches the first frame of timecode in the EDL.

Step 3:  Import the EDL into Color, and relink to the master media file
Either select the EDL from the Projects dialog that appears when you first open Color, 
or use the File > Import > EDL command. When the EDL Import Settings dialog 
appears, choose the EDL format, project, EDL, and source media frame rates.
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To properly �notch� the master media file, you need to be sure to turn on �Use as Cut 
List,� and then choose the master media file that you captured or were given. For more 
information, see �Importing EDLs� on page 80.

Step 4:  Grade your program in Color
Use Color to grade your program.

Step 5:  Render new source media, and send the updated project to Final Cut Pro
When you�re finished grading, you�ll use the Color Render Queue to render all the shots 
in the project as a new, separate set of graded media files.

Afterward, you�ll need to send the updated project to Final Cut Pro using one of the 
two following methods:
´ If Color is installed on the same computer as Final Cut Pro, you can use the �Send to 

Final Cut Pro� command.
´ If you�re handing the color-corrected project back to the originating facility, you need 

to export the Color project as an XML file for later import into Final Cut Pro.

Note:  When you send a project to Final Cut Pro that was originally imported into Color, 
you�re only sending the shots that are available in Color, which are usually restricted to 
those on track V1. Color doesn�t support audio tracks or superimposed effects.

Step 6:  Adjust transitions, superimpositions, and titles in Final Cut Pro
To output your project, you need to import the XML project data back into 
Final Cut Pro. This happens automatically if you use the �Send to Final Cut Pro� 
command. At this point, you can add other effects in Final Cut Pro, before creating the 
program�s final master.

Step 7:  Output the final video master to tape, or render a master QuickTime file
Once you�ve completed making any last adjustments in Final Cut Pro, you can go ahead 
and use the Print to Video, Edit to Tape, or Export QuickTime Movie commands to 
create the final version of your program.

Using Color in a Digital Intermediate Workflow
Color supports grading for 2K digital intermediate workflows. Simply put, the term 
digital intermediate describes the process of performing all effects and color correction 
using high-resolution digital versions of the original camera negative. Color can work 
with the 2K 10-bit log image sequences produced by datacine scanners, processing the 
image data with extremely high quality, and rendering the result as an image sequence 
suitable for film output.

The following sections describe different 2K workflows that you can follow, and shows 
you how to keep track of your image data from step to step.
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A Tapeless DI Workflow Using Online/Offline Digital Duplicates
The easiest digital intermediate workflow is one where you scan all footage necessary 
for the offline edit and then create a duplicate set of offline media to edit your project 
with. Upon completion of the offline edit, you then relink the program to the original 
2K source frames in Color.

Deriving the offline media from the original digital media keeps your workflow simple 
and eliminates the need to retransfer the source film later on. The only disadvantage to 
this method is that it can require an enormous amount of storage space, depending on 
the length and shooting ratio of the project.

Color

Gather
Rendered 

Media

Conform

Color
Correction

Render

Camera Negative

Datacine
Transfers

2K Resolution
DPX Image
Sequence

Final Output
Sequence

Film Recorder Film Print

Offline
QuickTime
Conversion

Media
Data

Final Cut Pro

Offline
Edit



Chapter 2    Color Correction Workflows 51

The following steps break this process down more explicitly.

Step 1:  Shoot film
Ideally, you should do some tests before principal photography to see how the film 
scanner to Color to film recorder pipeline works with your choice of film formats and 
stocks. It�s always best to consult with the film lab you�ll be working with in advance to 
get as much information as possible.

Step 2:  Scan all film as 2K DPX image sequences
Depending on how the shoot was conducted, you could opt to do a best-light datacine 
of just the selects, or of all of the camera negative, if you can afford it. The scanned 2K 
digital source media should be saved as DPX or Cineon image sequences.

To track the correspondence between the original still frames and the offline 
QuickTime files that you�ll create for editing, you should ask for the following:
´ A non-drop frame timecode conversion of each frame�s number (used in that frame�s 

file name) be saved within the header of each scanned image.
´ It can also help organize all of the scanned frames into separate directories, saving all 

the frames from each roll of negative to separate directories (named by roll).

Step 3:  Convert the DPX image sequences to offline-resolution QuickTime files
Create offline-resolution duplicates of the source media in whatever format is most 
suitable for your editing system. Then, archive the original source media as safely as 
possible.

When you convert the DPX files to offline QuickTime files:

´ The roll number of each image sequence should be used as the reel number for each 
.mov file.

´ The timecode values stored in the header of each frame file should be used as the 
timecode for each .mov file.

You can use Color to perform this downconversion by creating a new project with the 
Render File Type set to QuickTime, and the Export Codec set to the codec you want to 
use. Then, simply edit all the shots you want to convert into the Timeline, add them to 
the Render Queue, and click Start Render. For more information, see �Converting 
Cineon and DPX Image Sequences to QuickTime� on page 88.

� Tip:  If you downconvert to a compressed high definition format, such as Apple ProRes 
422 or Apple ProRes 422 (HQ), you can offline your project on an inexpensively 
equipped computer system, and still be able to output and project it at a resolution 
suitable for high-quality client and audience screenings during the editorial process.

Step 4:  Do the offline edit in Final Cut Pro
Edit your project in Final Cut Pro, being careful not to alter the timecode or duration of 
the offline shots in any way.
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Step 5:  Prepare your Final Cut Pro sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps 
outlined in �Before You Export Your Final Cut Pro Project� on page 75.

Step 6:  Export an EDL
When you�ve finished with the edit, you�ll need to generate an EDL in either the CMX 
340, CMX 3600, or GVG 4 Plus formats.

Important:  You cannot use the �Send to Color� command to move 2K projects to Color.

Step 7:  Import the EDL into Color, and relink to the original DPX media
Use the File > Import > EDL command to import the EDL. In the Import EDL dialog, you 
also specify the directory where the original high-resolution source media is located, so 
that the EDL is imported and the source media is relinked in one step.

Step 8:  Grade your program in Color
Grade your program in Color as you would any other.

Important:  When grading scanned film frames, it�s essential to systematically use 
carefully profiled LUTs for monitor calibration, and to emulate the ultimate look of the 
project when printed out to film while you make adjustments in Color. For more 
information, see �Using Display LUTs� on page 115.

Step 9:  Conform transitions, effects, and titles
In a 2K workflow, you�ll also need to use a compositing application such as Shake to 
create any transitions or layered effects, including superimpositions, titles, and other 
composites, using the 2K image sequence data.

Important:  Each image file�s frame number identifies its position in that program�s 
Timeline. Because of this, when you send frames to a compositing application, it�s vital 
that the frame numbers in filenames of newly rendered media are identical to those of 
the original source media. This requires careful file management.

Step 10:  Render your media out of Color
Once you�ve finished grading the project in Color, use the Render Queue to render out 
the final media. The Render Queue has been set up to let you easily render your project 
incrementally; for example, you can render out all the shots of a program that have 
been graded that day during the following night to avoid rendering the entire project 
at once.

However, when you�re working on a project using 2K image sequence scans, rendering 
the media is only the first step. The rendered output is organized in the specified 
render directory in such a way as to easily facilitate managing and rerendering the 
media for your Color project, but it�s not ready for delivery to the film recording facility 
until the next step.
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Step 11:  Use the Gather Rendered Media command to assemble the final image 
sequence for delivery
Once every single shot in your program has been rendered, you�ll need to use the 
Gather Rendered Media command to consolidate all of the frames that have been 
rendered, eliminating handles, copying every frame used by the program to a single 
directory, and renumbering each frame as a contiguously numbered image sequence. 
Once this has been done, the rendered media is ready for delivery to the film recording 
facility.

A Digital Intermediate Using a Telecined Offline/Online Workflow
A more traditional way to go about editing and color-correcting a project is to do an 
offline edit using a less expensive telecine transfer of the dailies, and then do a 
datacine film scan of only the shots used in the edit to create the online media.
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The following steps break this process down more explicitly.

Step 1:  Shoot the film
Ideally, you should do some tests before principal photography to see how the film 
scanner to Color to film recorder pipeline works with your choice of film formats and 
stocks. It�s always best to consult with the film facility you�ll be working with in advance 
to get as much information as possible.

Step 2:  Telecine the dailies
Once the film has been shot, telecine the dailies to a video format that�s appropriate for 
the offline edit. Whether you telecine to a high definition video format for the offline or 
not depends on the configuration of the editing system you�ll be working with and on 
the amount of hard drive space available to you.

Of more importance is the frame rate at which you choose to telecine the dailies.
´ To eliminate an entire media management step, it�s recommended that you telecine 

the film directly to a 23.98 fps video format.
´ Otherwise, you can telecine to a 29.97 fps video format and use Cinema Tools in a 

second step to perform 3:2 pulldown removal.

To more easily maintain the correspondence between the telecined video and the 2K 
film frames that will be scanned later, you should request the following:

´ The timecode recorded to tape during the offline telecine must be non-drop frame.
´ Each roll of negative should be telecined to a separate reel of tape. This way, the reels 

specified by the EDL will match the rolls of camera negative from which the shots are 
scanned.

Step 3:  Use Cinema Tools and Final Cut Pro to perform the offline edit
As with any other film edit, generate a Cinema Tools database from the FLEx files 
provided by the telecine operator, then capture the corresponding media, and edit the 
program.

Important:  When working with offline media that refers to camera negative, do not 
use the Media Manager to either rename or delete unused media in your project. If you 
do, you�ll lose the ability to create accurate pull lists in Cinema Tools.

Step 4:  Prepare your Final Cut Pro sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps 
outlined in �Before You Export Your Final Cut Pro Project� on page 75.

Step 5:  Export an EDL for Color, and a pull list for datacine
Once the offline edit is complete, a pull list is generated for performing the final 
datacine transfer at 2K resolution, and the entire project is exported as an EDL for 
importing and conforming in Color.
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´ The pull list specifies which shots were used in the final version of the edit (this is 
usually a subset of the total amount of footage that was originally shot). Ideally, you 
should export a pull list that also contains the timecode In and Out points 
corresponding to each clip in the edited project. This way, the timecode data can be 
written to each frame that�s scanned during the datacine transfer to facilitate 
conforming in Color.

´ The EDL moves the project�s edit data to Color, and contains the timecode data 
necessary to conform the scanned image sequence frames into the correct order.

Step 6:  Do a datacine transfer of the selected shots from negative to DPX
Using the pull list generated by Cinema Tools, have a datacine transfer done of every 
shot used in the project.

During the datacine transfer, specify that the timecode of each frame of negative be 
converted to frames and used to generate the filenames for each scanned DPX file, and 
that the timecode also be written into the DPX header of each shot. The names of the 
resulting image sequence should take the following form:

reel_number.0632368.dpx

Each image sequence from the film scanner should be placed into a directory that is 
named after the roll of camera negative from which it was scanned. It�s a good idea to 
have a separate directory for each roll of camera negative that�s scanned.

Step 7:  Import the EDL into Color, and relink to the original DPX media
Use the File > Import > EDL command to import the EDL. In the Import EDL dialog, you 
also specify the directory where the original high-resolution source media is located, so 
that the EDL is imported and the source media is relinked in one step.

Step 8:  Grade your program in Color
Grade your program in Color as you would any other.

Important:  When grading scanned film frames, it�s essential to systematically use 
carefully profiled LUTs for monitor calibration and to emulate the ultimate look of the 
project when printed out to film while you make adjustments in Color. For more 
information, see �Using Display LUTs� on page 115.

Step 9:  Conform transitions, effects, and titles, render media, and gather rendered 
media
At this point, the process is the same as in �A Tapeless DI Workflow Using Online/Offline 
Digital Duplicates� on page 50.
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Using EDLs, Timecode, and Frame Numbers
to Conform Projects
Using careful data management, you can track the relationship of the original camera 
negative to the video or digital transfers that have been made for offline editing using 
timecode.

How Does Color Relink DPX/Cineon Frames to an EDL?
The key to a successful conform in Color is to make sure that the timecode data in the 
EDL is mirrored in the scanned DPX or Cineon frames you�re relinking to. Color 
attempts to relink to image sequence media in a number of different ways, depending 
on what information is available in the file:
´ First, Color looks for a timecode value in the header of the DPX or Cineon frame file. If 

this is found, it�s the most reliable method of relinking.
´ If there�s no matching timecode number in the header data, then Color looks for the 

timecode value in the filename, and for the corresponding reel number in the 
enclosing directory.

´ If there�s no reel number in the enclosing directory, then Color attempts to relink all 
the shots using the timecode number only.

Parsing EDLs for Digital Intermediate Conforms
This section explains how Color makes the correspondence between the timecode 
values in an EDL and the frame numbers used in the timecode header or file name of 
individual image sequence frames.

Here�s a sample line from an EDL:

001 004 V C 04:34:53:04 04:35:03:04 00:59:30:00 00:59:40:00

In every EDL, the information is divided up into eight columns:

´ The first column contains the edit number. This is the first edit in the EDL, so it is 
labeled 001.

´ The second column contains the reel number, 004. This is what the directory of the 
scanned 2K image files that correspond to that shot should be named.

´ The next two columns contain video/audio track and edit information that, while 
used by Color to assemble the program, isn�t germane to conforming the media.

The last four columns contain timecode�they�re pairs of In and Out points.

´ The first pair of timecode values are the In and Out points of the original source 
media (usually the telecined tape in ordinary online editing). In a digital intermediate 
workflow, this is used for naming and identifying the scanned frames that are output 
from the datacine.

´ The second pair of In and Out points identify that shot�s position in the edited 
program. This is used to place the media in its proper location on the Timeline.
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Image Sequence File Naming for Conforming Digital Intermediates
Here�s an example filename of the first image sequence file that corresponds to the EDL 
event shown above:

my_file_name.0494794.dpx

The first portion of the filename for each scanned frame (the alpha characters) is 
ignored, but the numeric extension listing that file�s frame number should equal the 
(non-dropframe) timecode conversion of that value appearing in the EDL.

For example, a frame with timecode 05:51:18:28 would have a numeric extension of 
632368. Numeric extensions should always be padded to seven digits; in this case, we 
would add one preceding 0, like this:

my_file_name.0632368.dpx

Only the numeric extension and the .dpx or .cin are strictly required, since the initial 
alpha characters of the filename are ignored by Color. For example, the above filename 
could also be:

0632368.dpx

Alternately, you could utilize the unused first portion of the filename to keep track of 
the reel number that frame file comes from:

reel_004.0632368.dpx
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3 Using the Color Interface

You can work in Color either by using a mouse with the on-
screen interface, or more directly by using a dedicated 
control surface that�s been designed for professional color 
correction work.

This chapter covers the general interface conventions used by Color. It describes the 
use of controls which are shared by multiple areas of the interface, as well as some of 
the specialized controls that are unique to color correction applications.

This chapter covers the following:

´ Setting Up a Control Surface (p. 60)
´ Using the Onscreen Controls (p. 60)
´ Organizational Browsers and Bins (p. 64)
´ Using Color with One or Two Monitors (p. 70)
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Setting Up a Control Surface
Color was designed from the ground up to support control surfaces specifically 
designed for color correction from manufacturers such as Tangent and JL Cooper 
Designs. These control surfaces typically include three trackballs that correspond to the 
three overlapping tonal zones of the Primary and Secondary color balance controls 
(shadows, midtones, and highlights), three rotary controls for the three contrast 
controls (black level, gamma, and white point), and a number of other rotary controls 
and buttons that support different functions depending on which room you�ve 
selected.

You can either choose a control surface to use when Color starts up, or you can click 
Show Control Surface Dialog in the User Prefs tab of the Setup room to choose an 
available control surface at any time. For more information on setting up a control 
surface, see Appendix C, �Setting Up a Control Surface.� For more information on 
configuring a control surface from within Color, see �Control Surface Settings� on 
page 103.

Using the Onscreen Controls
If you don�t have a control surface, you can still operate every feature in Color using the 
onscreen controls. In addition to the standard buttons, check boxes, and pop-up 
menus common to most applications, Color uses some custom controls that are 
described in this section.

F1 F2 F3

F4 F5 F6

F7 F8 F9

MEM

ALT

GRACE DELETE

OUTINMARK

CUE

DO UNDO

MORE

REDO 7

4

1

00 0

2 3 -

5 6 +

8 9

PREV NEXT

MODE

CLEAR

B3R3

B2

B1R1

R2

PAGE 5

PAGE 6

PAGE 8

PAGE 7

PAGE 1

PAGE 2

PAGE 4

PAGE 3

F1

M1

W1

W2

W3

W4

W5

W6

W7

JOG SHUTTLE

M2 M3

1 2 3 4 5 6 7 8 BANK 1

BANK 2

HOURS MINUTES SECONDS FRAMES

BANK 4

BANK 4

PAGE

ASSIGN
UTILITY

M4 M5

TIME CODE DISPLAYF2

F3

F4

F5

F6

F7

F8



Chapter 3    Using the Color Interface 61

Using the Mouse
Color supports the use of a three-button mouse, which provides quick access to 
shortcut menus and various navigational shortcuts. Color also supports the middle 
scroll wheel or scroll ball of a three-button mouse, either for scrolling or as a button.

Accelerating Controls Using the Option Key
Many controls can be accelerated to 10x their normal speed by pressing the Option key 
while you drag.

Tabs
Tabs are used to navigate among the eight different Color �rooms.� Each room is a 
distinct portion of the interface that contains all the controls necessary to perform a 
specific task. Changing rooms changes the available interface, the keyboard shortcuts, 
and the mapping of the control surface controls.

In addition, some rooms have additional functionality that can be revealed using 
additional sets of tabs within that room.

Text Fields and Virtual Sliders
There are four types of data that can populate edit fields in Color:
´ Timecode
´ Text, including filenames, directory paths, and so forth.
´ Whole numbers; fields that display whole numbers cannot accept either decimals or 

fractional values.
´ Percentages and fractional values, such 0.25 or 1.873.

There are three ways you can modify text fields.

To enter text into a field using the keyboard:
1 Click the text field you want to edit.

The text in that field becomes highlighted.

2 Type something new.

3 Press Return to accept the change.

Mouse button Documentation reference

Left mouse button Click

Middle mouse button Middle mouse button or Middle-click

Right mouse button Right-click (identical to Control-click with a single button mouse)
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To modify the value of a numeric or percentage-based text field with a virtual slider:
1 Move the pointer to the field you want to adjust.

2 Middle-click and drag to the left to decrease its value, or to the right to increase its value.

3 Release the mouse button when you�re finished.

To modify the value of a numeric or percentage-based text field with a scroll wheel:
1 Move the pointer to the field you want to adjust.

2 Without clicking in the field, roll the scroll wheel or ball up to increase that field�s value, 
or down to decrease that field�s value.

To adjust a field using a shortcut menu:
m Control-click or right-click any field, and choose one of the following options from the 

shortcut menu:

´ Reset:  Resets the field to its default setting.
´ Min:  Chooses the minimum value available to that field.
´ Max:  Chooses the maximum value available to that field.
´ Set as Default:  Sets that parameter to the default value.

Timecode Fields
Timecode fields display timing information, such as media In and Out points, and the 
position of the playhead. Time is represented in Color in one of two ways:
´ Within fields, most time values are represented with standard SMPTE timecode. 

SMPTE timecode is represented by four colon-delimited pairs of digits: hh:mm:ss:ff, 
where hh is hours, mm is minutes, ss is seconds, and ff is frames.

´ Time values in the Timeline Ruler may be displayed as non-drop frame timecode, 
drop frame timecode, or frames.

Note:  Drop-frame timecode appears with a semicolon between the seconds and 
frames positions.

Navigating with Timecode 
Here are some pointers for entering values into the hours, minutes, seconds, and 
frames positions of timecode fields:
´ Time values are entered from left to right (similar to entering a duration into a 

microwave); however, the last value you type is assumed to be the last digit of the 
frames position.

´ Press Return whenever you�ve finished typing a timecode value to confirm the new 
value you entered.

´ If you enter a partial number, the rightmost pair of numbers is interpreted as frames 
and each successive pair of numbers to the left populates the remaining seconds, 
minutes, and hours positions. Omitted numbers default to 00.
For example, if you enter 1419, Final Cut Pro interprets it as 00:00:14:19.
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´ When you enter timecode in a field, you don�t need to enter all of the separator 
characters (such as colons); they�re automatically added between each pair of digits.

´ You can type a period to represent a pair of zeros when entering longer durations.
For example, type �3.� (3 and a period) to enter timecode 00:00:03:00. The period is 
automatically interpreted by Color as 00.

´ To enter 00:03:00:00, type �3..� (3 and two periods).
These periods insert pairs of zeros into both the seconds and frames position.

´ Type 3... to enter 03:00:00:00.
´ Use the plus (+) symbol to enter a series of single-digit values for each time position.

For example, type �1+5+8� to enter timecode 00:01:05:08.

Color Controls
Color controls are used in several rooms in Color to let you choose and modify colors 
using the HSL model.

´ Dragging within the main color wheel lets you simultaneously adjust the hue and 
saturation of the selected color.

A crosshair within the color wheel shows the current color value that�s being selected. 
The remaining controls depend on the type of color control being displayed.

´ Dragging up and down within the multicolored Hue slider lets you adjust the hue.
´ Dragging up within the single-colored Saturation slider increases the saturation of 

the current hue, dragging down decreases its saturation.
´ Dragging up within the single-colored Brightness slider increases the brightness of 

the current color, dragging down decreases its brightness.

Customizing Color Controls
The angle at which colors appear on the color wheel of color controls can be 
customized to match the interface of other color correction systems you may be used 
to. In addition, the speed with which control surface joyballs adjust the corresponding 
Color color controls can be adjusted. For more information, see �Control Surface 
Settings� on page 103.
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Organizational Browsers and Bins
Color presents several browsers and bins for organizing shots, media, and grades which 
share some common controls. All these browsers and bins are used to manage files on 
your hard drive, rather then data that�s stored within the Color project file itself. As a 
result, their controls are used to navigate and organize the directory structure of your 
hard drive, much as you would in the Finder.

The File Browser
The browser that dominates the left half of the Setup room lets you navigate the 
directory structure of your computer�s disk drives (and by extension any RAID, DAS, 
and SAN volumes that are currently mounted), in order to find and import compatible 
QuickTime and Still Image media files.

It�s important to bear in mind that the file browser is not a project bin in any way. The 
files displayed within the file browser are not associated with your Color project in any 
way unless you drag them into the Timeline manually or relink the shots of an 
imported project to their associated media files on disk using the Relink Media or 
Reconnect Media commands.

Note:  The file browser displays only directories and media files that are compatible 
with Color.

When you select a media file in the file browser, a panel appears to the right displaying 
the first frame of that file along with information underneath, including:

´ Shot Name:  The filename
´ Duration:  Its total duration
´ Codec:  The codec used to encode that file
´ Resolution:  The frame size of the file, width by height
´ Frame Rate:  The frame rate of the file
´ Timecode:  The timecode value of the first frame in that file

At the bottom of this panel, an Import button appears that lets you edit the currently 
selected shot into the Timeline at the current position of the playhead.

Collapsing the file browser
If you like, the file browser can be collapsed to enable the tabbed area on the right to 
occupy the entire Color window.
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To hide the file browser:
m Move the pointer to the file browser divider at the right-hand side of the file browser, 

and when it�s highlighted in blue, click once to collapse it.

To uncollapse the file browser:
m Move the pointer to the file browser divider at the left-hand side of the window, and 

when it�s highlighted in blue, click once to uncollapse it.

For more information on the Setup room, see Chapter 5, �Setup,� on page 91.

The Shots Browser
The second browser in the Setup room is the Shots tab, which is inside of the Setup 
room. This browser lets you see all the shots that are in the current project in either list 
or icon view.

In icon view, you can also create groups of shots that you can use to copy and paste 
grades to multiple shots at once. For more information, see �Managing Grades in the 
Shots Browser� on page 274.
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In list view, you can sort all of the shots using different info fields. For more information 
on using the Shots browser, see �The Shots Browser� on page 92.

The Grades Bin
The Grades bin, in the Setup room, lets you save and organize grades combining 
primary, secondary, and Color FX corrections into a single unit.

You can use this bin to apply saved grades to other shots in the Timeline. The contents 
of the Grades bin are available to all Color projects opened while logged into that user 
account. For more information on saving and applying grades, see �Saving Grades into 
the Grades Bin� on page 265.

Correction Bins
The Primary, Secondaries, and Color FX rooms all allow you to save the corrections 
made inside those rooms as individual presets that you can apply to later shots. The 
contents of corrections bins are available to all Color projects opened while logged into 
that user account.
´ Primary In and Out:  Lets you save and organize primary corrections. The Primary In 

and Primary Out rooms both share the same group of saved corrections.
´ Secondaries:  Lets you save and organize secondary corrections.
´ Color FX:  Lets you save and organize Color FX corrections.
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Still Store
Although the Still Store isn�t a grade or correction bin, it�s managed in almost exactly 
the same way. This room is one big bin that�s designed to hold still frames from a 
variety of shots that you can use for purposes of comparison to other shots in your 
program. For more information on using the Still Store, see Chapter 16, �Still Store,� on 
page 315.

Browser, Grade and Correction Bin Controls
All browsers and bins share the following controls:

Display Controls
All browsers and bins have display controls that let you choose how you want to view 
and organize their contents.

´ List View button:  Displays the contents of the current directory as a list of filenames.
´ Icon View button:  Displays the contents of the current directory as icons.
´ Icon Size slider:  Appears only in icon view. Scales the size of icons.

Directory Navigation Controls
The file browser and Grades and Corrections bins also have directory navigation 
controls that you can use to organize and browse the grades and corrections that are 
saved on your hard drive.

Grades Versus Corrections
There is a distinct difference between grades and corrections in Color. Corrections refer 
to adjustments made within a single room. You have the option to save individual 
corrections inside the Primary, Secondaries, and Color FX rooms and apply them to 
shots individually.

A grade can include multiple corrections across several rooms, saving one or more 
primary, secondary, and Color FX corrections together. By saving a group of 
corrections as a grade, you can apply them all together as a single preset.
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´ Go Up:  Moves to and displays the contents of the parent directory.
´ Go Home:  Navigates to the appropriate home directory for that browser or bin. This 

is not your Mac OS X user home directory:
´ File browser:  The home button takes you to the currently specified Color media 

directory.
´ Primary In, Secondaries, Color FX, and Primary Out:  Home takes you to the 

appropriate subdirectory within the /Users/username/Library/Application Support/
Color directory. Each room has its own corresponding subdirectory, within which 
are stored all the corrections you�ve saved for future use.

´ Still Store:  Home takes you to the StillStore directory inside the current project 
directory structure.

File Controls
The file browser and Grades and Corrections bins also have directory creation and 
navigation controls at the bottom.
´ File field:  Displays the file path of the currently viewed directory.
´ Directory pop-up menu:  This pop-up menu gives you a fast way to traverse up and 

down the current directory hierarchy or to go to the default Color directory for that 
room.

´ New Directory button:  Lets you create a new directory within the currently specified 
path. You can create as many directories as you like to organize the grades and 
corrections for that room.

´ Save button:  This button saves the grade or correction settings of the shot at the 
current position of the playhead in the directory specified in the above text fields.

´ Load button:  Applies the selected grade or correction to the shot that�s at the current 
position of the playhead (if no other shots are selected), or to multiple selected shots 
(ignoring the shot at the playhead if it�s not selected). As with any Color bin, items 
displayed can be dragged and dropped from the bin into the Timeline.

How Are Grades and Corrections Saved?
Grades and corrections that you save using the grade and correction bins in Color are 
saved within the Color preferences directory in your /Users/username/Library/
Application Support/Color directory.

Saved grades and corrections in these bins are available to every project you open.

Saved correction category Location on disk

Grades /Users/username/Library/Application Support/Color/Grades/

Primary corrections /Users/username/Library/Application Support/Color/Primary/

Secondary corrections /Users/username/Library/Application Support/Color/Secondary/

Color FX corrections /Users/username/Library/Application Support/Color/Effects/
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Individual corrections in each of the above directories are saved as a pair of files; a .lsi 
file which contains a thumbnail for visually identifying that grade, and the specific file 
for that type of correction which actually defines its settings. Unless you customized 
the name, both these files have the same name, followed by a dot, followed by the 
date (day month year hour.minute.secondTimeZone), followed by the file extension 
that identifies the type of saved correction it is.

´ Grade_Name.date.lsi:  The thumbnail image used to represent that grade in icon view
´ Grade_Name.date.pcc:  Primary correction file
´ Grade_Name.date.scc:  Secondary correction file
´ Grade_Name.date.cfx:  Color FX correction file

Saved grades are, in fact, file bundles that contain all the correction files that make up 
that grade. For example, a grade that combines primary, secondary, and Color FX 
corrections would be a directory using the name given to the grade, 
�Grade_Name.date.grd,� containing the following files:

´ Grade_Name.date.lsi
´ Grade_Name.date.pcc
´ Grade_Name.date.scc
´ Grade_Name.date.cfx

Reorganizing Saved Corrections and Grades in the Finder
Each of the correction bins in Color simply mirrors the contents of the corresponding 
subdirectory in the /Users/username/Library/Application Support/Color directory. You 
can use the Finder to reorganize your saved corrections and grades by creating new 
subdirectories and moving previously saved grades and corrections into them.

When you move saved corrections from one directory to another, it�s important to 
make sure that you copy both the .lsi thumbnail image for that grade, and the .pcc, 
.scc, or .cfx file that contains the actual grade information, together.

If you reorganize saved grades and corrections in the Finder while Color is open, you�ll 
need to manually refresh the contents of the Grades and corrections bins you changed 
so that they correctly display the current contents.

To update the contents of the currently displayed correction bin:
m Click the Home button.

The contents of the correction bin update to show the current state of the Finder.



70 Chapter 3    Using the Color Interface

Moving Saved Corrections and Grades to Other Computers
If you have saved corrections and grades that you want to move to Color installations 
on other computers, you can simply copy the folders described on page 68 to a 
portable storage device, and then copy their contents into the corresponding folders 
on the new system. The next time you open Color, the saved corrections and grades 
will appear as they did before.

Using Color with One or Two Monitors
Color is compatible with both one- and two-monitor computer configurations. Most 
users will benefit from using Color in dual display mode with two monitors, as this 
provides the most screen real estate and also allows for the most flexible use of the 
preview and video scopes displayed on the Scopes window of the second monitor.

However, Color can also be used in single display mode, which lets you operate Color in 
situations where a second display is not available. Single display mode is only 
recommended on 30-inch Cinema Displays.

Note:  Color requires a minimum resolution of 1680x1050 in either single or dual display 
mode.

To switch between single and dual display modes, do one of the following:
m Choose Window > Single Display Mode or Dual Display Mode.

m Press Shift-0 to toggle between both modes.

You must quit Color and reopen it for this change to take effect.
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4 Importing and Managing Projects 
and Media

Color provides powerful tools for managing projects and 
media as you work.

As mentioned in Chapter 2, �Color Correction Workflows,� on page 35, there are three 
main ways you can import a project and its media. You can import (or send) XML 
project data from Final Cut Pro, you can import an EDL and reconnect its media, or you 
can place the media itself directly into the Timeline manually.

This chapter describes the commands and methods used to create and save projects, 
import project data and media from other applications, and manage your project 
within Color.

This chapter covers the following:

´ Creating and Opening Projects (p. 72)
´ Saving Projects and Archives (p. 72)
´ Moving Projects Between Final Cut Pro and Color (p. 75)
´ Reconforming Projects (p. 79)
´ Importing EDLs (p. 80)
´ Exporting EDLs (p. 82)
´ Relinking QuickTime Media (p. 82)
´ Importing Media Directly into The Timeline (p. 83)
´ Compatible Media Formats (p. 84)
´ Converting Cineon and DPX Image Sequences to QuickTime (p. 88)
´ Importing Color Corrections (p. 89)
´ Exporting JPEG Images (p. 89)
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Creating and Opening Projects
When you first run Color, you�re presented with a dialog with which you can open an 
existing project or create a new one.

To create a new project when Color is first opened:
1 Open Color.

2 When the Projects window opens, choose a location for the project.

By default, the Create Project dialog opens to the Default Project Directory you chose 
when you first launched Color.

3 Type a name for the project in the File field, and click Save.

A new project is created in the directory you chose, and is opened.

To create a new project while Color is running:
1 If necessary, save the current project.

Color can only have one project open at a time, so creating a new project will close the 
currently open project.

2 Choose File > New (Command-N).

3 Choose a name and location for the project from the Create Project dialog, and click Save.

An empty project appears, ready for use.

To open an existing project, do one of the following:
m Double-click a Color project file in the Finder.

m Choose File > Open (Command-O), choose a project from the Projects window, and 
click Open.

Color can only have one project open at a time, so opening a second project closes the 
one that was originally open.

Saving Projects and Archives
The essential process of saving files has been divided into two tasks: saving updates to 
the project file itself and saving archives of the project file.

Saving a project works the same way in Color as it does in any other application you�ve 
used. As with any application, you should save early and often as you work.

To save a project:
m Choose File > Save (Command-S).

Note:  Whenever you manually save a project, an archive is also automatically saved 
with the date and time as its name.
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To revert the project to the last saved state:
m Choose File > Revert (Command-R).

Saving and Opening Archives
An archive is a compressed duplicate of the project that�s stored within the project 
bundle itself. For efficiency, the archive file lacks the thumbnail and Still Store image 
files that the full version of the project has, saving only the state of the internal project 
file, Timeline, shot settings, grades, corrections, keyframes, and pan and scan settings, 
which are easily compressed and occupy little space.

Whenever you manually save your project, an archive is automatically created, named 
with the date and time at which it was saved. If you want to save an archive of your 
project at a particular state with a more easily identifiable name, you can use the Save 
Archive As command.

To save an archive of the project with a specific name:
1 Do one of the following:

´ Choose File > Save Archive As.
´ Press Command-Option-S.

2 Type a name into the Archive Name field, and click Archive.

There is no limit to the number of archives you can save, so the archives list can grow 
quite long. Archives are compressed using both .tar and gzip (a �tarball�) so they take 
up little room. All archive files for a particular project are saved in the Archives 
subdirectory inside of that project bundle.

Later, if anything should happen to your project file�s settings, or if you want to return 
the project to a previously archived state, you can load one of the archive files.

To open an archive:
1 Choose File > Load Archive (Command-Option-O).

2 Select an archive to open from the Load Archive window, then click Load Archive.

Opening an archive overwrites the current state of the project with that of the archive.

Automatic Saving
The Color automatic saving mechanism, when turned on, saves the current project at 
an interval set by the Auto Save Time (Minutes) parameter in the User Prefs tab of the 
Setup room. When a project is automatically saved, no archive is created. This prevents 
your archive list from being inundated with entries. By default, automatic saving is 
turned on, with the interval set to 5 minutes.

For more information, see �Auto Save Settings� on page 109.
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What Is a Color Project?
The only shots that are in your project are those in the Timeline (which are also 
mirrored in the Shots browser). Color projects only contain a single sequence of shots. 
Furthermore, Color projects have no organizational notion of shots that aren�t actually 
in the Timeline, and so they contain no unused media.

The Contents of Color Projects
Color projects are actually bundles. Inside each Color project bundle is a hierarchical 
series of directories, each of which contains specific components belonging to that 
project, which are either image or XML files. It�s possible to open a Color bundle using 
the Show Package Contents command in the Finder. This section outlines the 
directory structure and contents of these bundles.
´ Archives directory:  Contains all the saved archives of that project. Each archive is 

compressed using both .tar and .gzip compression (a �tarball�) and is identified with 
the .tgz extension.

´ .lsi file:  This is an image file that contains the frame at the position of the playhead 
when you last saved.

´ .pdl file:  This is the XML-based project file itself, which contains all the information 
that organizes the shots, timing, and grades used in that project.

´ Shots directory:  Each shot in your project�s Timeline has a corresponding 
subdirectory here. Each subdirectory contains some or more of the following:
´ Grade1 (through 4) subdirectories:  These directories contain all the correction files 

associated with that grade.
´ ShotName.lsi file:  This is that shot�s thumbnail as displayed in the Timeline.
´ ShotName.si file:  This file contains that shot�s name, media path, and timing 

information.
´ Grade_Name.date.pcc:  Primary correction description.
´ Grade_Name.date.scc:  Secondary correction description.
´ Grade_Name.date.cfx:  Color FX correction description.
´ PanAndScan subdirectory:  This directory contains a .kfd file that stores keyframe 

data, and a .pns file that stores pan and scan data.
´ shot_notes.txt file:  If a note is present for that shot, it�s saved here.

´ StillStore directory:  This directory contains all the Still Store images that you�ve 
saved for reference within that project. Each reference still has two corresponding 
files, a .lsi file which is that image�s thumbnail icon, and a .sri file which is the full-
resolution image (saved using the DPX image format).

Important:  It is not recommended to modify the contents of Color project files unless 
you know exactly what you�re doing. Making changes manually could cause 
unexpected problems.
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Moving Projects Between Final Cut Pro and Color
One of the easiest ways of importing a project is to send a Final Cut Pro sequence to 
Color using one of two XML-based workflows. This section discusses how to prepare 
your projects in Final Cut Pro and how to send them using XML.

For more general information on Final Cut Pro to Color round-trip workflows, see 
�Video Finishing Workflows Using Final Cut Pro� on page 39.

Before You Export Your Final Cut Pro Project
Whether you�re working on your own project, or preparing a client�s project in advance 
of a Color grading session, you should take some time to prepare the Final Cut Pro 
sequence you�ll be sending in order to ensure the best results and smoothest workflow. 
Here are some recommended steps.

Move Clips That Aren�t Being Composited to Track V1 in the Timeline
Editors often use multiple tracks of video to assemble scenes, taking advantage of the 
track ordering rules in Final Cut Pro to determine which clips are currently visible. It�s 
generally much faster and easier to navigate and work on a project that has all its clips 
on a single video track. It�s recommended that you move all video clips that aren�t 
being superimposed as part of a compositing operation down to track V1.

Divide Your Project into Reels
Projects with large numbers of edit points can slow down your performance in Color. 
As a general rule of thumb, projects that you�ll be sending to Color should have no 
more then 200 edit points for optimal performance.

To maximize performance while you work, you should consider breaking longform 
projects down into approximately 22-minute reels prior to sending them to Color. The 
length is arbitrary, but 22 minutes is the standard length of a film reel, and is a suitable 
length unless your project has a large number of edits, in which case you should 
consider dividing your program into shorter segments (some editors prefer to work 
with10-minute segments). Each segment should begin and end at a good cut point, 
such as the In point of the first shot or the Out point of the last shot of a scene, or the 
end of the last frame of a fade to black.

Important:  As you�re creating your reels, make sure you don�t accidentally omit any 
frames in between each reel.

Export Self-Contained QuickTime Files for Effect Clips You Want to Color Correct
Color is incapable of either displaying or working with any of the following types of 
clips:
´ Generators
´ Motion projects
´ LiveType projects
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´ Freeze Frames (created from a clip inside of Final Cut Pro)
´ Still Image files (such as .tiff, .jpg, or .bmp files)

If you want to grade such clips in Color, you need to export them as self-contained 
QuickTime files, and reedit them into the Timeline of your Final Cut Pro sequence to 
replace the original effects prior to sending the sequence to Color.

If you don�t need to grade these effects in Color, then you can simply send the project 
with these clips as they are, and ignore any gaps that appear in Color in place of these 
types of clips. Even though these effects don�t appear in Color, they�re preserved within 
the XML of the Color project and they will reappear when you send that project back 
to Final Cut Pro.

� Tip:  Prior to exporting a project from Final Cut Pro, you can also export a single, self-
contained QuickTime movie of the entire program, then reimport it into your project 
and superimpose it over all the other clips in your edited sequence. Then, when you 
export the project to Color, you can turn this �reference� version of the program on and 
off using track visibility whenever you want to have a look at the offline effects or color 
corrections that were created during the offline edit.

Media Manage Your Project
If you�re delivering a Final Cut Pro project to a Color suite at another facility, you may 
want to eliminate unused media to save drive space (especially if you�ll be recapturing 
uncompressed media), and consolidate all the source media used by your project into a 
single directory for easy transport and relinking. This is a good step to take prior to 
recapturing your media.

Recapture Offline Media At Online Quality
If the project was edited at an offline resolution, you need to recapture all the source 
media at the highest available quality. Be sure you choose a high-quality codec, either 
using the native codec that the source footage was recorded with or using one of the 
supported uncompressed codecs. For more information on which codecs are 
supported by Color, see �Compatible Media Formats� on page 84.

Important:  If you�re recapturing video clips that were originally recorded with a Y·CBCR 
format, be sure that the codec you use to recapture, and the export methods you use 
to export or consolidate your media, don�t clamp super-white and high-chroma 
components in the original, uncorrected media. It�s usually better to correct such clips 
within Color than it is to clamp these levels in advance, potentially losing valuable 
image data.

Using the �Send to Color� Command in Final Cut Pro
If you have Final Cut Pro and Color installed on the same computer, you can use the 
�Send to Color� command in Final Cut Pro to automatically move your sequence into 
Color.
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To send a sequence from Final Cut Pro to Color:
1 Open the project in Final Cut Pro.

2 Select a sequence in the Browser to send the entire sequence.

3 Do one of the following:

´ Choose File > Send To > Color.
´ Control-click the selection, then choose Send To > Color in the shortcut menu.

4 Chose a name for the project to be created in Color, then click OK.

A new Color project is automatically created in the default projects directory specified 
in User Preferences. The shots that appear on the Timeline should match the original 
Final Cut Pro sequence that was sent.

Importing an XML File into Color
If you need to deliver a Final Cut Pro sequence and its media to another facility to be 
graded using Color, you can also use the Export XML command in Final Cut Pro to 
export the sequence to be graded. For more information about exporting XML from 
Final Cut Pro, see the Final Cut Pro User Manual.

In Color, you then use the Import XML command to turn the XML file into a Color 
project. To make this process quicker, you can copy the XML file you want to import 
into the default projects directory specified by Color.

To import an XML file into Color:
1 Do one of the following:

´ Open Color.
´ Choose File > Import > XML.

2 Choose an XML file from the Projects window.

3 Click Load.

A new Color project is automatically created in the default projects directory specified 
in User Preferences. The shots that appear on the Timeline should match the original 
Final Cut Pro sequence that was exported.

Don�t Reedit Imported XML Projects in Color
By default, all the video tracks of imported XML projects are locked. When you�re 
grading a project, it�s important to avoid unlocking them or making any editorial 
changes to the shots in the Color Timeline if you�re planning on sending the project 
back to Final Cut Pro successfully.

If you need to make an editorial change, reedit the original sequence in Final Cut Pro, 
export a new XML file, and use the Reconform command to update the Color 
Timeline to match the changes.
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Sending Your Project Back to Final Cut Pro
If you�re doing a Final Cut Pro to Color round-trip, you�ll need to render the color-
corrected media out of Color (covered in Chapter 17, �Render Queue,� on page 321), and 
then export the Color project back to Final Cut Pro.

Important:  Projects using Cineon or DPX image sequences can�t be sent back to 
Final Cut Pro.

To use the �Send to Final Cut Pro� command in Color:
1 Go through the Timeline and choose which grade you want to use for each of the clips 

in your project.

Since each shot in your program may have up to four separately rendered versions of 
media in the render directory, the rendered media that each shot is linked to in the 
exported XML project file is determined by its currently selected grade.

2 Choose File > Send To > Final Cut Pro.

Note:  If you haven�t rendered every shot in Color at this point, you�ll be warned. It�s a 
good idea to click No to cancel the operation and render all of your shots prior to 
sending the project back to Final Cut Pro.

A new sequence is automatically added to the original Final Cut Pro project from which 
the program came. However, if the Final Cut Pro project the program was originally 
sent from is unavailable, has been renamed, or has been moved to another location, 
then a new Final Cut Pro project will be created to contain the new sequence. Either 
way, every clip in the new sequence is automatically linked to the color-corrected 
media you rendered out of Color.

Exporting XML for Final Cut Pro Import
If you�re exporting a project for someone at another facility, you�ll need to export an 
XML version of your Color project.

To export an XML file back to Final Cut Pro for final output:
1 Go through the Timeline and choose which grade you want to use for each of the clips 

in your project.

Since each shot in your program may have up to four separately rendered versions of 
media in the render directory, the rendered media that each shot is linked to in the 
exported XML project file is determined by its currently selected grade.

2 Chose File > Export > XML.

3 When the Export XML Options dialog appears, click Browse.

a Enter a name for the XML file you�re exporting in the File field of the Export XML File 
dialog.

b Choose a location for the file, then click Save.
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4 Click OK.

A new XML project file is created, and the clips within are automatically linked to the 
media directory specified in the project settings tab in the Setup room.

Note:  If you haven�t exported rendered media from your Color project yet, then the 
XML file is linked to the original project media.

Reconforming Projects
If your project was imported from an XML or EDL generated by Final Cut Pro, you have 
the option of automatically reconforming your Color project to match any editorial 
changes made to the original Final Cut Pro sequence, saving you hours of tedious labor.

To reconform an XML-based Color project:
1 Export an updated XML file of the reedited Final Cut Pro sequence from Final Cut Pro.

2 Open the Color project you need to update, then choose File > Reconform.

3 Select the XML file that was exported in step 1 using the Reconform XML dialog, then 
click Load.

The shots in the Timeline should update to reflect the imported changes, and the 
Reconform column in the Shots browser is updated with the status of every shot that 
was affected by the reconform operation.

You can also reconform projects that were originally imported using EDLs.

To reconform an EDL-based Color project:
1 Export an updated EDL of the reedited sequence from the originating application.

2 Open the Color project you need to update, then choose File > Reconform.

3 Select the EDL file that was exported in step 1 using the Reconform dialog, then click 
Load.

As when you reconform an XML based project, the Reconform column in the Shots 
browser in the Setup room is updated with the status of each shot that�s been 
modified by the reconform operation. This lets you identify shots that might need 
readjustment as a result of such changes, sorting them by type for fast navigation. For 
more information, see �Column Headers� on page 94.
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Importing EDLs
You can import an EDL directly into Color. There are two reasons to use EDLs instead of 
XML files:
´ To color correct a video master file:  You can approximate a tape-to-tape color 

correction workflow by importing an EDL, and using the Use As Cut List option to 
link it to a corresponding master media file (either a QuickTime .mov file or a DPX 
image sequence).

Note:  If you�re going to do work this way, it�s best to work with uncompressed media, 
and to work in reels of 20 minutes or less to avoid the potential performance 
bottlenecks caused by projects with over 200 edit points in the Timeline.

´ To import a 2K digital intermediate project:  EDLs are also the only way to import 
projects as part of a 2K digital intermediate workflow when you�re relinking the 
project to DPX image sequences from film scans. For more information, see �Using 
Color in a Digital Intermediate Workflow� on page 49.

Color imports the following EDL formats:

´ Generic
´ CMX 340
´ CMX 3600
´ GVG 4 Plus

To make the process of importing an EDL quicker, you can copy all EDL files to the 
default projects directory specified by Color.

To import an EDL:
1 Do one of the following:

´ Open Color.
´ Choose File > Import > EDL.

2 Choose an EDL file from the Projects window.
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The EDL Import Settings dialog appears, defaulting to the default project directory 
specified in the User Prefs tab of the Setup room.

3 Choose the following project properties from the available lists and pop-up menus:

´ EDL Format:  The format of the EDL file you�re importing.
´ Project Frame Rate:  The frame rate of the Color project you�re about to create. In most 

cases, this should match the frame rate of the EDL you�re importing.
´ EDL Frame Rate:  Choose the frame rate of the EDL you�re importing. If the EDL Frame 

Rate is 29.97 fps but you set the Project Frame Rate to 24 fps, Color will automatically 
do the necessary conversions to remove 3:2 pulldown from the shots in the project.

Note:  This lets you deal with workflows where the imported EDL was generated from 
an offline edit of a project using telecined 29.97 fps video, but the subsequent 
scanned 2K image sequences were reacquired at film�s native 24 fps.

´ Source Frame Rate:  The frame rate of the source media on disk that you�re linking to.
´ Use As Cut List:  This checkbox lets you specify that this EDL should be used as a cut 

list to �notch� a matching video master file.
´ Project Resolution:  The resolution of the Color project you�re creating. In general, this 

should match the resolution of the source media that you�re linking to.
´ Width:  The width of the selected frame size.
´ Height:   The height of the selected frame size.

´ Source Directory:  The directory specified here sets the EDL parser to the exact path 
where the DPX Scans or QuickTime files associated with that project are located.

4 You must specify the location of the source media to link the project to by doing one 
of the following:

´ Type the directory path into the Source Directory field.
´ Click Browse, select a directory using the Source Directory dialog, then click Choose.

Note:  The source directory you choose can be a local volume or on a SAN or LAN that 
has sufficient performance to accommodate the data rate of the project�s media.
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5 When you�ve finished choosing all the necessary settings, click Import.

A new project is created, and the EDL is converted into a sequence of shots in the 
Timeline. These shots should match the Timelines of the original project.

Exporting EDLs
You can export EDLs out of Color, which can be a good way of moving projects back to 
other editorial applications. When exporting an EDL, it�s up to the application with 
which you�ll be importing the EDL to successfully relink to the media that�s rendered 
out of Color.

Note:  To help facilitate media relinking, the media path is written to the comment 
column in the exported EDL, although not all editing applications support this 
convention.

To export an EDL:
1 Chose File > Export > EDL.

2 When the Export EDL dialog appears, click Browse.

3 Enter a name for the EDL you�re exporting in the File field of the Export EDL File dialog, 
choose a location for the file, and click Save.

4 If you didn�t change any of the shot names when you exported the final rendered 
media for this project, turn on �Use original media name.�

5 Click OK.

A new EDL file is created, and the clips within are linked to the media directory you 
specified.

Relinking QuickTime Media
If necessary, you can manually relink media to a Color project. When you use the relink 
command, Color matches each shot in the Timeline with its corresponding media file 
using the following criteria:
´ Starting timecode
´ Filename

If neither of these criteria matches, you�re given the following warning:
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If you click Yes and proceed with relinking to a different file, then the original Source In 
and Source Out values for that shot will be overwritten with those of the new clip.

To relink every shot in the Timeline:
1 Choose File > Reconnect Media.

2 Choose the directory where the project�s media is saved from the Choose Media Path 
dialog, and click Choose.

If that directory contains all the media used by the project, then every shot in the 
Timeline is automatically relinked. If there are still missing media files, you�ll be warned, 
and these shots will remain offline; you�ll need to use the Reconnect Media command 
again to relink them.

To relink a single shot:
1 Control-click or Right-click a shot in the Timeline, and choose Relink Media from the 

shortcut menu.

2 Choose a clip to relink to from the Select Media To Relink dialog, then click Load.

If the name and starting timecode of the media file matches that of the shot in the 
Timeline, the media link is restored.

Importing Media Directly into The Timeline
You also have the option of importing media files to the Timeline directly, although this 
is usually only useful for classroom situations and when doing digital dailies.

To import a shot to the Timeline:
1 Click the Setup tab, or choose File > Import > Clip, which opens the Setup tab.

2 Use the navigation controls at the top left of the file browser to find the directory 
containing the media you want to import.

3 Click to select the media file you want to import into the Timeline.

4 Do one of the following:

´ Double-click the shot in the file browser to edit the shot into the Timeline at the 
position of the playhead.
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´ Drag the shot directly into the Timeline.
´ Click the Import button below that shot�s preview to edit the shot into the Timeline 

at the position of the playhead.

Once shots have been placed into the Timeline, save your project.

Compatible Media Formats
Color is compatible with a wide variety of QuickTime files and image sequences.

Compatible QuickTime Codecs for Import
The list of codecs that are supported by Color is limited to high-quality codecs suitable 
for media exchange and mastering. Codec support falls into three categories:
´ QuickTime codecs that are supported by Color when importing projects and media.
´ A subset of codecs that may be used for rendering your final output when Original 

Format is chosen in the Export Codec pop-up menu of the Prjct Settings tab of the 
Setup Room. Original Format is only available when you�ve used the �Send to Color� 
command in Final Cut Pro, or when you�ve imported a Final Cut Pro file that�s been 
exported as an XML file.

´ By default, only four codecs are available in the Export Codec pop-up menu for 
upconverting your source media to a higher-quality format. These include the Apple 
ProRes 422 and Apple ProRes 422 (HQ) codecs, and the Apple Uncompressed 8-bit 
4:2:2 and Apple Uncompressed 10-bit 4:2:2 codecs.

Note:  If you�ve installed a video interface from AJA, you should see an additional 
option�AJA Kona 10-bit RGB.

Supported for import
Supported as original 
format

Supported as export 
codec

Animation No No

Apple Intermediate Codec Yes No

Apple Pixlet Yes No

Apple ProRes 422 (HQ) Yes Yes

Apple ProRes 422 (SQ) Yes Yes

DVCPRO 50 - NTSC Yes No

DVCPRO 50 - PAL Yes No

DV - PAL Yes No

DV/DVCPRO - NTSC Yes No

DVCPRO - PAL Yes No

DVCPRO HD 1080i50 Yes No

DVCPRO HD 1080i60 Yes No

DVCPRO HD 1080p25 Yes No
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Compatible Third-Party QuickTime Codecs for Import
Color also supports the following third-party codecs for import.
´ AJA Kona 10-bit Log RGB
´ AJA Kona 10-bit RGB

Note:  The AJA Kona codecs are not installed by QuickTime by default, and are only 
available from AJA.

DVCPRO HD 1080p30 Yes No

DVCPRO HD 720p50 Yes No

DVCPRO HD 720p60 Yes No

DVCPRO HD 720p Yes No

H.264 No No

HDV 720p24 No No

HDV 720p25 No No

HDV 720p30 No No

HDV 1080p24 No No

HDV 1080p25 No No

HDV 1080p30 No No

HDV 1080i60 No No

HDV 1080i50 No No

Photo - JPEG Yes No

MPEG IMX 525/60 (30 Mb/s) No No

MPEG IMX 525/60 (40 Mb/s) No No

MPEG IMX 525/60 (50 Mb/s) No No

MPEG IMX 625/50 (30 Mb/s) No No

MPEG IMX 625/50 (40 Mb/s) No No

MPEG IMX 625/50 (50 Mb/s) No No

Uncompressed 8-bit 4:2:2 Yes Yes

Uncompressed 10-bit 4:2:2 Yes Yes

XDCAM HD 1080i50 (35 Mb/s VBR) No No

XDCAM HD 1080i60 (35 Mb/s VBR) No No

XDCAM HD 1080p24 (35 Mb/s VBR) No No

XDCAM HD 1080p25 (35 Mb/s VBR) No No

XDCAM HD 1080p30 (35 Mb/s VBR) No No

Supported for import
Supported as original 
format

Supported as export 
codec
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Compatible QuickTime Codecs for Output
The purpose of Color is to create high-quality color-corrected media that can be 
reimported into Final Cut Pro for output to tape, QuickTime conversion, or compression 
for use by DVD Studio Pro. For this reason, the list of codecs that are supported for 
rendering out of Color is limited to high-quality codecs suitable for media exchange 
and mastering.
´ Apple ProRes 422:  A low-bandwidth, high-quality compressed codec for capture and 

output. Encodes video at 10 bits per channel with 4:2:2 chroma subsampling. 
Supports a variable bit rate (VBR) of 35 to 50 mbps, which is suitable for mastering 
standard definition video. Supports any frame size.

´ Apple ProRes 422 (HQ):  A higher-bandwidth version of Apple ProRes 422. Supports a 
variable bit rate (VBR) of 145 to 220 mbps, which is suitable for mastering high 
definition video. Supports any frame size.

´ Uncompressed 8-bit 4:2:2:  A completely uncompressed, 8-bit-per-channel codec with 
4:2:2 chroma subsampling. Supports any frame size. Suitable for mastering any 
format of video.

´ Uncompressed 10-bit 4:2:2:  A completely uncompressed, 10-bit-per-channel codec 
with 4:2:2 chroma subsampling. Supports any frame size. Suitable for mastering any 
format of video.

Color also supports the following third party codec for rendering.

´ AJA Kona 10-bit RGB

Note:  The AJA Kona codecs are not installed by QuickTime by default, and are only 
available from AJA.

You can render your project out of Color using one of several high-quality mastering 
codecs, regardless of the codec or level of compression that is used by the source 
media. You can take advantage of this to facilitate a workflow where you import 
compressed media into Color, and then export the corrected output as uncompressed 
media before sending your project to Final Cut Pro. This way, you reap the benefits of 
saving hard drive space and avoiding rerendering times up front, while preserving all 
the quality of your high-bit-depth adjustments when you render your output media 
prior to sending your project back to Final Cut Pro.
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Compatible Image Formats
The following RGB-encoded image formats are compatible with Color for importing 
image sequences: Only Cineon and DPX are supported for rendering image sequences.
´ Cineon (import and export):  A high-quality image format developed by Kodak for 

digitally scanning, manipulating, and printing images originated on film. Developed 
as a 10-bit log format to better contain the greater latitude of film for exposure.

´ DPX (import and export):  The Digital Picture eXchange format was derived from the 
Cineon format and is also used for high-quality uncompressed digital intermediate 
workflows. Color supports 8-bit and 10-bit log DPX and Cineon image files.

´ TIFF (import only):  The Tagged Image File Format is a commonly used image format 
for RGB graphics on a variety of platforms. Color is compatible with 16-bit TIFF 
sequences.

´ JPEG (import only):  A highly compressed image format created by the Joint 
Photographic Experts Group. The amount of compression that may be applied is 
variable, but higher compression ratios create visual artifacts, visible as discernible 
blocks of similar color. JPEG is usually used for offline versions of image sequences, 
but in some instances (with minimal compression) this format may be used in an 
online workflow. JPEG is limited to 8-bit encoding.

What Codec Should You Use for Export?
When choosing the codec you want to use for rendering the final output, there are 
three considerations:
´ If you�ll be outputting to a high-bandwidth video format (such as Betacam SP, 

Digital Betacam, HDCAM, and HDCAM SR) and require the highest quality video 
data available, regardless of storage or system requirements, you should export 
your media using the Apple Uncompressed 10-bit 4:2:2 codec.

´ If you�ll be outputting to one of the above video formats and require high quality, 
but need to use a compressed format to save hard drive space and increase 
performance on your particular computer, then you can export using the Apple 
ProRes 422 codec (good for standard definition), or the higher quality Apple ProRes 
422 (HQ) codec (good for high definition), both of which are 10-bit, 4:2:2 codecs.

´ If your system is not set up to output such high-bandwidth video, and your 
program uses a source format that�s supported by the Original Format option in the 
QuickTime Export Codecs pop-up menu in the Prjct Settings tab of the Setup room, 
you�ll be able to render back to the original codec used by your Final Cut Pro 
sequence. If your codec is unsupported, the QuickTime Export Codecs pop-up 
menu will default to Apple ProRes 422.
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´ JPEG 2000 (import only):  Developed as a high-quality compressed format for 
production and archival purposes, JPEG 2000 uses wavelet compression to allow 
compression of the image while avoiding visible artifacts. Advantages include higher 
compression ratios with better visible quality, options for either lossless or lossy 
compression methods, the ability to handle both 8- and 16-bit linear color encoding, 
error checking, and metadata header standardization for color space and other data.

Converting Cineon and DPX Image Sequences to QuickTime
You can use Color to convert Cineon and DPX image sequences to QuickTime files to 
facilitate a variety of workflows.
´ If your project is starting out with high-resolution 2K datacine film scans or digital 

camera output, you can downconvert matching QuickTime media files with which to 
do the offline edit.

´ If your project media is in the QuickTime format, but you want to output a series of 
Cineon or DPX image sequences, you can do this conversion as well.

When converting from Cineon and DPX to high definition or standard definition 
QuickTime video (and vice versa), Color automatically makes all necessary color space 
conversions. Log media will be converted to linear, and Rec. 701 and 601 color spaces 
are taken into account.

To convert Cineon or DPX image sequences to QuickTime:
1 Create an empty project.

2 Open the Prjct Settings tab of the Setup room, and do the following:

a Click Project Render Directory, choose a render directory for the converted media, 
then click Choose.

b Choose QuickTime from the Render File Type pop-up menu.
c Choose a resolution from the Resolution Presets pop-up menu.
d Choose the codec you want to convert the image sequences to from the Export 

Codec pop-up menu.

3 Using the file browser, edit all the shots you want to convert into the Timeline.

4 If necessary, grade the shots to make any corrections to the offline media that you�ll be 
generating.

Sometimes, the source media from a particular camera or transfer process has a specific 
color correction or contrast adjustment that must be made for the media to look 
acceptable during the edit. If this is the case, you can use a single correction to adjust 
every shot you�re converting (the equivalent of a one-light transfer). Other times, you�ll 
want to individually correct each shot prior to conversion to provide the best-looking 
media you can for the editing process (the equivalent of a best-light transfer).
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� Tip:  To quickly apply a single correction to every shot in the Timeline, grade a 
representative shot in the Primary In room, then click Copy to All.

5 Open the Render Queue, then click Add All.

6 Click Start Render.

All of the shots are converted, and the rendered output is written to the currently 
specified render directory.

Importing Color Corrections
The Import > Color Corrections command lets you apply the grades and color 
corrections from the shots of one project file to those within another project. It�s meant 
to be used with Color projects that are based on the same source, so that a newly 
imported version of a project you�ve already been working on can be updated with all 
the grades that were applied to the previous version.

To import the color corrections from one project to another:
1 Open the Color project into which you want to import the corrections.

2 Choose File > Import > Color Corrections.

3 In the Projects dialog, select the Color project containing the corrections you want to 
import, and then click Load.

The shots in the currently open project are updated with the color corrections from the 
other project file.

Exporting JPEG Images
Color also provides a way of exporting a JPEG image of the frame at the position of the 
playhead.

To export a JPEG image of the frame at the current position of the playhead:
1 Move the playhead to the frame you want to export.

2 Choose Export > JPEG Still.

3 Enter a name in the File field and select a directory using the Save Still As dialog.

Note:  This defaults to the Still Store subdirectory inside of the project bundle.

4 Click Save.

The frame is saved as a JPEG image to the location you selected.
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5 Setup

Before you start working on your project, take a moment to 
configure your Color working environment and project 
settings in the Setup room.

The Setup room serves many purposes. It�s where you import media files, sort and 
manage saved grades, organize and search through the shots used in your program, 
choose your project�s render and broadcast safe settings, and adjust user preferences.

This chapter covers the following:

´ The File Browser (p. 91)
´ The Shots Browser (p. 92)
´ Grades Bin (p. 97)
´ Project Settings Tab (p. 98)
´ Messages Tab (p. 102)
´ User Preferences Tab (p. 102)

The File Browser
The file browser, occupying the left half of the Setup room, lets you directly navigate 
the directory structure of your hard drive. It�s like having a miniature Finder right there 
in the Setup room. It�s important to bear in mind that the file browser is not a bin. The 
files displayed within the file browser are not associated with your Color project in any 
way unless you drag them into the Timeline manually, or relink the shots of an 
imported project to their associated media files on disk using the Relink Media or 
Reconnect Media commands.
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By default, it displays the contents of the default media directory when Color starts up.

´ Up Directory button:  Moves to the next directory up the current file path.
´ Home Directory button:  Moves to the currently specified default media directory.

For more information on how to use the file browser, see �Importing Media Directly 
into The Timeline� on page 83. For more information on importing project data from 
other applications, see Chapter 4, �Importing and Managing Projects and Media,� on 
page 71.

The Shots Browser
The Shots browser lists every shot used by the current program that appears in the 
Timeline. This bin can be used for sorting the shots in your program using different 
criteria, selecting a group of shots to apply an operation to, or selecting a shot no 
matter where it appears in the Timeline.

´ Icon View button:  Click to put the shot area into icon view.
´ List View button:  Click to put the shot area into list view.
´ Shots browser:  Each shot in your project appears here, either as a thumbnail icon or 

as an entry (in list view).
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The Current Shot and Selected Shots
Icons or entries in the Shots browser are colored based on their selected state.

´ Dark Gray:  The shot is not currently being viewed, nor is it selected.
´ Light Gray:  The shot at the current position of the playhead is considered to be the 

current shot and is highlighted with gray in both the Timeline and the Shots browser 
timeline. The current shot is the one that�s viewed and that�s corrected when the 
controls in any room are adjusted.

´ Cyan:  You can select shots other than the current shot. Selected shots are 
highlighted with cyan in both the Timeline and the Shots browser. To save time, you 
can apply grades and corrections to multiple selected shots at once.

Goto Shot and Find Fields
The Goto Shot and Find fields let you jump to and search for specific shots in your 
project. These fields work with the Shots browser in either icon or list view modes.

To go to a specific shot:
m Type a number into the Goto Shot field, and press Enter.

The list scrolls down to reveal the shot with that number, which is automatically 
selected, and the playhead moves to the first frame of that shot in the Timeline.

To search for a specific shot:
1 Click the header of the column of data you want to search.

2 Type a name into the Search field.

As soon as you start typing, the Shots browser empties except for those items that 
match the search criteria. As you continue to type, the Shots browser dynamically 
updates to show the updated list of corresponding items.

Note:  All searches are performed from the first character of data in the selected 
column, read from left to right. The find function is not case sensitive.
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To reveal all shots after a find operation:
m Select all of the text in the Find field, and press Delete.

All shots should reappear in the Shots browser.

Column Headers
When the Shots browser is in list view, up to nine columns of information are visible.
´ Number:  Lists a shot�s position in the edit. The first shot is 1, the second is 2, and so on.
´ Shot Name:  The name of that shot, based on its filename.
´ Colorist:  Lists the name that occupied the Colorist field in the Project Settings when 

that shot was last corrected. This column is useful for keeping track of who worked 
on which shots when multiple colorists are assigned to a project.

´ Status:  Shows that shot�s rendered status. You can right-click on this column for any 
selected shot and choose a new state from the shortcut menu. The five possible 
states of a shot are:
´ Queued:  The shot has been added to the render queue.
´ Rendering:  The shot is currently being rendered.
´ Rendered:  The shot has been successfully rendered.
´ To Do:  The shot has not yet been corrected in any room.
´ Aborted:  Rendering of this shot has been stopped.

´ Reconform:  Lists whether that shot has been affected by a Reconform operation. 
One example of its use is to sort by this column to quickly identify and navigate to 
new shots that aren�t yet graded because they were added to the Timeline as a result 
of a reconform operation. For more information on reconforming a project, see 
�Reconforming Projects� on page 79. The possible reconform messages are:
´ Shorten:  The shot has been shortened.
´ Content Shift:  The shot�s duration and position in the Timeline are the same, but its 

content has been slipped.
´ Moved:  The shot has been moved to another position in the Timeline.
´ Added:  This shot has been added to the project.

´ Time Spent:  This column only appears when the Show Time button below the Shots 
browser is turned on. It shows how much time has been spent grading that 
particular shot. Color keeps track of how long you spend working on each shot in 
each program, in order to let you track how fast you�ve been working.

´ Notes:  The Notes column provides an interface for storing and recalling text notes 
about specific shots. Shots with notes appear with a check in this column.
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Customizing the Shots Browser
The following procedures describe ways you can sort and modify the Shots browser.

To sort the Shots browser by any column:
m Click a column�s header to sort by that column. 

Shots are sorted in descending order only. Numbers take precedence over letters, and 
uppercase takes precedence over lowercase.

To resize a column in the Shots browser:
m Drag the right-hand border of the column you want to resize.

To reveal or hide the Time Spent column:
m Click Show Time, located underneath the Shots browser.

Adding Notes to Shots
Color provides an interface for keeping track of client or supervisor notes on specific 
shots as you work on a project.

To add a note to a shot, or to read or edit an existing note:
1 Open the Shots Browser in the Setup room.

2 Control-click or right-click on the Notes column of the Shots browser, and choose Edit 
File from the shortcut menu.

A plain-text editing window appears.

3 Enter whatever text you want.
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4 To save the note and close it, do one of the following:

´ Press Command-S, and close the window.
´ Close the window and click Save from the drop sheet.

When you�ve added a note to a shot, a check appears in the Notes column.

To remove a note from a shot:
m Control-click or right-click on the Notes column of the Shots browser, and choose 

Delete File from the shortcut menu.

Note:  Notes are saved within the subdirectory for that particular shot, within the 
/shots/ subdirectory inside that project bundle. Removing a note deletes the note file.

Selecting Shots and Navigating the Timeline Using the Shots Browser
You can use the Shots browser to quickly find and select specific shots (for example to 
apply a single grade to a group of shots at once). You can also use the Shots browser to 
quickly navigate to a particular shot in the Timeline. These procedures work whether 
the Shots browser is in icon or list view.

To select one or more shots, do one of the following:
m Click any shot in the Shots browser to select that shot.

m Command-click any group of shots to select a discontiguous group of shots.
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m Click any shot, and then Shift-click a second shot to select a contiguous range of shots 
from the first selection to the second.

Selected shots appear with a cyan overlay.

To navigate to a specific shot in the Timeline using the Shots browser:
m Double-click any shot.

m Type a number into the Goto Shot field.

The new current shot turns gray in the Shots browser, and the playhead jumps to the 
first frame of that shot in the Timeline. That shot is now ready to be corrected using any 
of the Color rooms.

Grades Bin
The Grades bin lets you save and manage grades that you can use in your programs. A 
grade, as described in Chapter 3, can contain one or more of the following individual 
corrections:
´ Primary
´ Secondary
´ Color FX
´ Primary Out

By applying a grade to one or more shots, you can apply multiple corrections all at 
once. Grades saved into the Grades bin are available to all Color projects opened while 
logged into that user account. The Grades bin can display grades in either icon or list 
view, and shares the same controls as the other bins in Color that allow you to organize 
them using subdirectories and navigate the resulting file structure. For more 
information on using the Grades bin controls, see �Organizational Browsers and Bins� 
on page 64.

For more information on saving and applying grades, see �Saving Grades into the 
Grades Bin� on page 265.
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Project Settings Tab
The options in the Project Settings tab are individually saved on a per-project basis. 
They let you store additional information about that project, adjust how the project is 
displayed, and how the shots in that project will be rendered.

Informational and Render Directory Settings
These settings provide information about Color and about your project and let you set 
up what directory media generated by that project is written into.
´ Project Name:  The name of the project. This defaults to the name of the project file 

on disk, but you can change this to anything you like. Changing the project name 
does not change the name of the project file.

´ Render Directory:  The render directory is the default directory path where media files 
rendered for this project are stored. For more information about rendering Color 
projects, see Chapter 17, �Render Queue,� on page 321.

´ Project Render Directory button:  Clicking this button lets you select a new project 
render directory using the Choose Project Render Directory dialog.

´ Colorist:  This field lets you store the name of the colorist currently working on the 
project. This information is useful for identifying who is working on what in multi-
suite post-production facilities, or when moving a project file from one facility to 
another.

´ Client:  This field lets you store the name of the client whose project this is.

Resolution and Codec Settings
These settings let you set up the display and render properties of your project. These 
settings affect how your program is rendered for display purposes, and when rendering 
the final output.
´ Display LUT:  A display LUT (Look Up Table) is a file containing color adjustment 

information that�s typically used to modify the monitored image that�s displayed on 
the preview and broadcast displays. LUTs can be generated to calibrate your display 
using hardware probes, and they also let you match your display to other 
characterized imaging mediums, including digital projection systems and film 
printing workflows. If you�ve loaded a display LUT as part of a color management 
workflow, this field lets you see which LUT file is being used. For more information on 
LUT management, see Chapter 6, �Monitoring,� on page 111.

´ Frame Rate:  This field displays the frame rate that the project is set to. Your project�s 
frame rate is set when the project is created, and it can be changed by a pop-up 
menu so long as no shots appear in the Timeline. Once one or more shots have been 
added to the Timeline, the project�s frame rate cannot be changed.

´ Resolution Presets pop-up menu:  This menu lists all of the project resolutions that 
Color supports, including PAL and NTSC standard definition, high definition, and 2K 
frame sizes. The options that are available in this menu are sometimes limited by the 
currently selected QuickTime Export Codec.
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If the currently selected QuickTime Export codec allows custom frame sizes, the 
width and height fields below can be edited. Otherwise, they remain uneditable. If 
these fields are set to a user-specified frame size, the Resolution Presets pop-up 
menu displays �custom.�

´ Width:  The currently selected width of the frame size.
´ Height:  The currently selected height of the frame size.

´ Printing Density:  This pop-up menu only appears when the current project is set to 
use Cineon or DPX image sequences. It lets you explicitly choose the numeric range 
of values that are used to process color to ensure compatibility with your post-
production pipeline. These options determine what the black and white points are 
set to in media that�s rendered out of Color. There are three options:
´ Film (95 Black � 685 White : Logarithmic)
´ Video (65 Black � 940 White : Linear)
´ Linear (0 Black � 1023 White)

´ Render File Type:  This parameter is automatically set based on the type of media your 
project uses. If you send a project from Final Cut Pro, this parameter is set to 
QuickTime, and is unalterable. If you create a Color project from scratch, this pop-up 
menu lets you choose the format with which to render your final media. When 
working on 2K film projects using image sequences, you�ll probably choose Cineon 
or DPX, while video projects will most likely be rendered as QuickTime files.

´ Deinterlace Renders:  Turning this option on deinterlaces all shots being viewed on 
the preview and broadcast displays, and also deinterlaces media that�s rendered out 
of Color.

´ Deinterlace Previews:  Turning this option on deinterlaces all shots being viewed on 
the preview and broadcast displays, but media rendered out of Color remains 
interlaced.

About Deinterlacing
Deinterlacing in Color is done very simply, by averaging both fields together to create 
a single frame. The resulting image may appear softened.

Note:  There is also a deinterlacing parameter available for each shot in the Shot 
Settings tab next to the Timeline, which lets you selectively deinterlace individual 
shots without deinterlacing the entire program. For more information, see �The 
Settings 2 Tab� on page 133.
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´ QuickTime Export Codecs pop-up menu:  If QuickTime is selected in the Render File 
Type pop-up menu, this menu lets you choose the codec with which to render 
media out of your project. If this menu is set to Original Format, the export codec will 
automatically match the codec specified in the sequence settings of the originating 
Final Cut Pro sequence (this option is only available when using the �Send to Color� 
command, or when importing an exported Final Cut Pro XML file).
The QuickTime Export codec does not need to match the codec used by the source 
media. You can use this to upconvert your media to a minimally compressed or 
uncompressed format. The options in this pop-up menu are limited to the QuickTime 
codecs which are currently supported for rendering media out of Color.

Broadcast Safe Settings
These settings let you set up Color to limit the minimum and maximum luma, chroma, 
and composite values of shots in your program. These settings are all completely 
customizable to accommodate any quality control (QC) standard, and prevent QC 
violations.
´ Broadcast Safe button:  Turning on Broadcast Safe enables broadcast legalization for 

the entire project, affecting both how it�s displayed on your secondary display and 
broadcast monitor and how it�s rendered for final output. This button turns the 
following settings on and off:
´ Ceiling IRE:  Specifies the maximum luma that�s allowable, in analog IRE units. 

Signals with luma above this limit will be limited to match this maximum value.
´ Floor IRE:  Specifies the minimum luma that�s allowable, in analog IRE units. Signals 

with luma below this limit will be limited to match this maximum value.
´ Amplitude:  This is not a limiting function. Instead, it lets you apply an adjustment 

to the amplitude of the chroma. The default value of 0 results in no change.

What QuickTime Codec Should You Use for Export?
You can render your project out of Color using one of several high-quality mastering 
codecs, regardless of the codec or level of compression that is used by the source 
media. You can use the QuickTime Export Codecs pop-up menu to facilitate a 
workflow where you import compressed media into Color, and then export the 
corrected output as uncompressed media before sending your project to 
Final Cut Pro. This way, you reap the benefits of saving hard drive space and avoiding 
rerendering times up front, while preserving all the quality of your high-bit-depth 
adjustments when you render your output media prior to sending your project back 
to Final Cut Pro.

The codecs most suitable for mastering include Apple Uncompressed 8-bit 4:2:2, 
Apple Uncompressed 10-bit 4:2:2, Apple ProRes 422, and Apple ProRes 422 (HQ) 
codecs. For more information, see �Compatible QuickTime Codecs for Output� on 
page 86.
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´ Phase:  Lets you adjust the phase of the chroma. If Amplitude is set to 0, no change 
is made.

´ Offset:  Lets you adjust the offset of a chroma adjustment. If Amplitude is set to 0, 
no change is made.

´ Chroma Limit:  Sets the maximum allowable saturation. The chroma of signals with 
saturation above this limit will be limited to match this maximum value.

´ Composite Limit:  Sets the maximum allowable combination of luma and chroma. 
Signals exceeding this limit will be limited to match this maximum value.

The broadcast safe settings limit the range of uncorrected source media in your 
project, and also prevent you from inadvertently introducing illegal values as you make 
corrections. There are three ways you can limit broadcast levels in your program.

Turn Broadcast Safe On, and Work with It Turned On the Whole Time
The safest way to work (and the default behavior of new projects) is to simply turn 
Broadcast Safe on at the beginning of your work, and leave it on through your entire 
color correction pass. With practice, you can tell if a highlight or shadow is being 
crushed too much by looking at the image on the monitor and watching for clumping 
exhibited at the top and bottom of the graphs in the Waveform scope. If the image is 
being clipped more then you prefer, you can make a correction to adjust the signal.

Turn Broadcast Safe Off While You Correct, Then Turn It Back On for Output
If you turn Broadcast Safe on right away, illegal portions of the signal are limited 
immediately, and it can be difficult to see exactly how much data is being clipped. 
When you�re color correcting media that was consistently recorded with super-white 
levels and high chroma, you may find that it�s a good idea to turn the Broadcast Safe 
settings off while you do your initial color correction pass, so that you can more easily 
see which parts of the signal are out of bounds, and make more careful judgments 
about how you want to legalize it. 

Once you�ve finished with your initial pass, you can turn Broadcast Safe back on to 
prevent stray levels, and you�ll have confidence that you�re not limiting the image 
too much.

Turn Enable Clipping On for Individual Shots in Your Program
The Enable Clipping button in the Basic tab of the Primary Out room lets you set ceiling 
values for the red, green, and blue channels for individual shots in your program. This 
lets you prevent illegal broadcast values in shots to which you�re applying extreme 
Primary, Secondary, or Color FX corrections, without turning on Broadcast Safe for the 
entire program. If Enable Clipping and Broadcast Safe are both on, the lowest standard 
is applied. For more information, see �Using the Ceiling Controls� on page 261.
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Important:  The broadcast-safe legalization employed by Color can only do so much to 
maintain detail in the image while preventing illegal levels. As in any color correction 
system, pushing adjustments past a certaIn point will result in uniformly crushed 
blacks, blown-out whites, and flat areas of color. It should be said, however, that this is 
often used for stylistic effect.

Rendering Settings
This setting affects how media is rendered out of Color.
´ Handles:  This field lets you specify a duration of extra media to be added to the head 

and tail of each media file that�s rendered out of Color. When a project is sent back to 
Final Cut Pro, handles allow editors to make small adjustments without running out 
of corrected media. The default value is 00:00:01:00.

Messages Tab
The Messages tab contains a running list of all the warnings and error messages that 
are generated by Color while it operates. Messages highlighted in yellow are warnings. 
Messages highlighted in red signify that an error has occurred (for example, �Directory 
not writable trying to re-save a project.�). There are no controls in the Messages tab.

User Preferences Tab
The User Preferences tab contains settings that affect the operation of Color with any 
project you open. It includes options for customizing control surface sensitivity, 
Timeline display, playback behavior, video output, and the bit depth that�s used for 
both display and rendering.

The state of each of these settings is automatically saved whenever they�re changed. If 
necessary, you can restore the settings to their original defaults.

To reset the default user preferences:
m Click Revert, at the bottom of the User Preferences tab.

About Broadcast Safe
When color correcting any program destined for broadcast, it�s important to obtain 
the specific quality control (QC) guidelines from the broadcaster. There are varying 
standards for the maximum and minimum allowed IRE, chroma, and composite 
amplitude, and some broadcasters are more conservative then others.

The broadcast safe parameters can be set to match the required QC guidelines. When 
enabled, they guarantee that your program will not exceed these standards while you 
monitor your program and when you render the finally corrected media. 
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Media and Project Directories
The Media and Project directories let you control where new files are saved by default.
´ Default Project Dir.:  The default directory where all new Color projects are saved. This 

is also the default directory that appears in the dialog boxes for the Import EDL and 
Import XML commands. Click the Browse button to choose a new directory.

´ Default Media Dir.:  The default directory for the file browser. This is also the default 
media location used by the Import EDL and Import XML commands. Click the Browse 
button to choose a new directory.

´ Default Render Dir.:  The default directory for media that�s rendered by Color for 
export. Click the Browse button to choose a new directory.

Control Surface Settings
If you�re using a control surface with Color, the following parameters let you adjust how 
motion applied to a particular control corresponds to the resulting adjustment that�s 
made.
´ Hue Wheel Angle:  This parameter specifies the angle at which colors appear on the 

color wheel of color controls in the Color interface, and the corresponding angle at 
which these colors are adjusted when using the joyballs of a control surface. This is 
customizable in order to accommodate colorists who are used to working with 
different systems:
´ 122 is the default angle of red for DaVinci color correction systems, which 

corresponds to the angle at which red appears on a Vectorscope. This is the default 
Color setting.

´ 0 is the default angle of red for Pogle color correction systems, which corresponds 
to the orientation of the controls of the older Mk III telecine.

´ Encoder Sensitivity:  This parameter controls the speed with which the rotation of 
knobs on a control surface change the value of their associated Color controls.

Hue wheel angle at 122 Hue wheel angle at 0
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´ Jog/Shuttle Sensitivity:  This parameter controls the speed at which the playhead 
moves relative to the amount of rotation that�s applied to a control surface�s Jog/
Shuttle wheel.

´ Joyball Sensitivity:  This parameter controls how quickly color controls are adjusted 
when using a control surface�s joyballs to adjust the Shadows, Midtones, and 
Highlights color controls in the Primary In, Secondary, and Primary Out rooms. The 
default setting is 1, which is extremely slow. Raise this value to increase the rate at 
which corrections are made with the same amount of joyball motion.

User Interface Settings
The following settings let you customize the Color interface.
´ UI Saturation:  This value controls how saturated the Color user interface controls 

appear. Many colorists lower the UI saturation to avoid eye fatigue and the potential 
for biasing one�s color perception during sessions. UI saturation also affects the 
intensity of colors displayed by the Scopes window when the Monochrome Scopes 
option is turned off.

´ Frames/Seconds/Minutes/Hours:  These buttons let you choose how time is displayed 
in the Timeline ruler. They do not affect how time is represented in the other 
timecode fields in Color.

´ Show Shots Name:  Turning this on displays each shot�s name in the Timeline.
´ Show Shots Number:  Turning this on displays the shot number for each shot in the 

Timeline.
´ Show Shots Beauty Frame:  With this setting turned on, single frame thumbnails 

appear within every shot in the Timeline.
´ Loop During Playback:  Turning this on loops playback from the current In point to 

the Out point of the Timeline. How this effects playback depends on how the 
Playback Mode is set. For more information, see �Toggling the Playback Mode� on 
page 127.

´ Maintain Framerate:  This setting determines whether or not frames are dropped in 
order to maintain the project�s frame rate during playback.
´ If Maintain Framerate is turned on (the default), the current framerate is 

maintained no matter what the current processing workload is. If the currently 
playing grade is processor intensive, then frames will be dropped during playback 
to maintain the project�s frame rate. If not, playback occurs in real time.

´ If Maintain Framerate is turned off, every frame is always played back. If the 
currently playing grade is processor intensive, playback will slow to avoid dropping 
frames. If not, playback may actually occur at faster than real time.

´ Synchronize Refresh (slower):  Turning this option on eliminates video refresh artifacts 
in the monitored image (these may appear as �tearing� of the video image). It affects 
playback performance, but only slightly, resulting in a playback penalty of 
approximately 1 fps.
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The following parameters use miniature color controls that operate identically to those 
described in �Using Color Balance Controls� on page 179.

´ Grade Complete color control:  The color that�s displayed in the Timeline render bar for 
rendered shots. The default color is green.

´ Grade Cued color control:  The color that�s displayed in the Timeline render bar for 
shots that have been added to the render queue, but that are not yet rendered. The 
default color is yellow.

´ Grade Aborted color control:  The color that�s displayed in the Timeline render bar for 
shots that have had their rendering stopped. The default color is red.

´ Monochrome Scopes:  Turning this option on draws the video scope graticules with a 
single color (specified by the Scope Color option, below). Many colorists prefer this 
display to avoid eye fatigue. On the other hand, it also eliminates the full-color 
display in the Vectorscope. Another option for those wishing to have color feedback 
in the scopes is to lower the UI Saturation setting to a less vivid intensity.

´ Scope Color:  This color control lets you adjust the color that�s used to draw the video 
scope graticules when Monochrome Scopes is turned on.

´ Limit Shadow Adjustments:  When this option is turned on, a falloff is applied to the 
Shadows color and contrast adjustments such that 0 percent values (pure black) 
receive 100 percent of the correction, while 100 percent values (pure white) receive 0 
percent of the correction. When this option is turned off, adjustments made to the 
Shadows color and contrast controls are applied uniformly to the entire image.

´ Show Control Surface Dialog:  Turning this option on immediately opens the Control 
Surface Startup dialog, from which you can choose a Color-compatible control 
surface with which to work. While this option is turned on, the Control Surface 
Startup dialog appears every time you open Color. If you don�t have a control 
surface, turn this option off.

Using Proxies
If you�re working with a project that uses Cineon or DPX image sequences, you can use 
a proxy mechanism to work faster at high resolutions. The proxy mechanism in Color is 
not available to projects using QuickTime media.
´ Enable Proxy Support:  Turning this button on enables the use of lower resolution 

substitute media, called proxies, in place of the source media in your project. Using 
proxies increases playback, grading, and rendering performance, albeit while viewing 
the shots in your project at lower quality. Proxies may only be used once they�ve 
been generated. For more information on how to generate proxies, see �Generating 
and Deleting Proxies� on page 106.
´ Render Proxy:  Lets you choose a proxy resolution with which to render your output 

media. This can be useful if you want to quickly render a set of media to test the 
return trip of a round-trip workflow. This menu defaults to �Full Resolution,� and, in 
most cases should be left at that setting.
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´ Grading Proxy:  Lets you choose a proxy resolution to use while adjusting the 
controls in any of the rooms. This increases the interactivity of the user interface 
and the speed with which the image being worked on updates while you adjust 
different grading controls. When you finish making an adjustment, the image goes 
back to its full resolution.

´ Playback Proxy:  Lets you choose a proxy resolution to use during playback, 
increasing your playback framerate by lowering the quality of the image. When 
playback stops, the image goes back to its full resolution.

Playback, Processing, and Output Settings
The following settings affect playback quality and speed.
´ Video Output:  The options in this pop-up menu correspond to the video output 

options available to the broadcast video interface that�s installed on your computer. 
Choose Disabled to turn off video output altogether.

Note:  Currently, Digital Cinema Desktop previews and Apple FireWire output are not 
available for monitoring the output from Color.

´ Force RGB:  This option is disabled for standard definition projects. This setting is 
meant to be used when you�re working with high definition Y·CBCR source media 
that you�re monitoring on an external broadcast monitor via a supported broadcast 
video interface. It determines how the RGB image data that�s calculated internally by 
Color is converted to Y·CBCR image data for display:
´ If Force RGB is turned off, this conversion is done by Color in software. This 

consumes processor resources, and may noticeably reduce your real-time 
performance as a result.

´ If Force RGB is turned on, Color sends RGB image data straight to the broadcast 
video interface that�s installed on your computer, and relies on the interface to do 
the conversion using dedicated hardware. This lightens the processing load on 
your computer, and is recommended to optimize your real-time performance.

When monitoring legalized video between 0 and 100 IRE, there should be a minimal 
difference between the image that�s displayed with Force RGB turned on or off.

Generating and Deleting Proxies
In order to use proxies while working on your project, you need to first generate a set 
of half- and quarter-resolution proxy media for your project.
´ To generate a set of proxy media for your project, choose File > Proxies > Generate 

Proxies.
´ To delete all of the proxies that have been generated for a project, choose File > 

Proxies > Delete Proxies.



Chapter 5    Setup 107

Important:  If Force RGB is turned on, super-white and out-of-gamut chroma values 
will not be displayed by your broadcast display, nor will they appear on external 
video scopes analyzing your broadcast video interface�s output. This limitation only 
affects monitoring; the internal image processing performed by Color retains this 
data.

As a result, you will always see super-white image data on the Color software scopes 
when it�s present, and uncorrected super-white and out-of-gamut chroma levels are 
always preserved when you export your final media.

If Broadcast Safe is turned on in the Project Settings, you may not notice any 
difference in the display of these �illegal� levels, since they�re being limited by Color.

´ Disable Vid-Out During Playback:  Turing this option on disables video output via your 
broadcast interface during playback. While paused, the frame at the position of the 
playhead is still output to video. This is useful if your project is so effects-intensive 
that video playback is too slow to be useful. With this option turned on, you can 
make adjustments and monitor the image while paused, and then get a look at the 
program in motion via the preview display, which usually plays faster.

´ Update UI During Playback:  Turning this option on enables selected windows of the 
Color interface to update dynamically as the project plays back. This updates the 
controls and scopes during playback from grade to grade, but potentially slows 
playback performance, so it�s off by default. There are two options:
´ Update Primary Display:  Updates the main interface controls in the Primary, 

Secondaries, Color FX, Primary Out, and Geometry rooms. Turning this option on 
lets you see how the controls change from grade to grade and how they animate if 
you have keyframed grades.

´ Update Secondary Display:  Updates the Scopes window. This is the way to get 
updated video scopes during playback. With this option turned off, the video 
preview still plays, but the video scopes disappear.

´ Radial HSL Interpolation:  This setting affects how keyframed color adjustments are 
interpolated from one hue to another. 
´ With this setting turned off (the default state), keyframed changes in hue are 

animated linearly, directly from one point on the color wheel to another. This 
results in the most direct animated adjustments and minimizes unwanted color 
cycling. This is the method that the DaVinci and Pogle use to animate color 
adjustments.
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´ Turning this setting on causes in keyframed changes in hue to be animated 
radially, with the hue cycling through all hues on the color wheel in between the 
current and target hues. This results in visible color cycling if you�re animating a 
change from one hue to any other that�s not directly adjacent on the color wheel. 
This is the method that Final Cut Pro uses when animating color adjustments in 
the Color Corrector and Color Corrector 3-way filters.

´ Internal Pixel Format:  The option you choose from this pop-up menu determines the 
bit depth Color uses for the internal processing of color, both during real-time 
playback and when rendering the final output. Bit depth is expressed as the number 
of bits per color channel, and describes the total number of values used to display 
the range of color by every pixel of an image. Higher bit depths result in a higher-
quality image, but are more processor intensive to play back and render.
´ 8-bit:  The lowest bit depth at which Color can operate, and the least processor-

intensive. 
´ 10-bit:  The minimum recommended bit depth recommended for projects 

incorporating secondary color correction and vignetting, regardless of the source.
´ 12-bit:  A higher bit depth supported by some video cards.
´ 16-bit:  An extremely high-quality bit depth. It has been suggested that 16-bit is the 

best linear equivalent to 10-bit log when working on images from film scans.
´ Float:  The highest level of image-processing quality available in Color. Float refers 

to the use of floating-point math to store and calculate fractional data. This means 
that values higher then 1 can be used to store data that would otherwise be 
rounded down using the integer-based 8-, 10-, 12-, and 16-bit depths. Float is an 
extremely processor intensive bit depth, so plan for longer rendering times.

Note:  Float is not available when using NVidia graphics cards.

Animated color control adjustment
with radial interpolation turned on

Animated color control adjustment
with radial interpolation turned off
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� Tip:  Depending on your system�s performance, you may find it advantageous to work 
at a lower bit depth in order to maximize real-time performance. Then, you can switch 
to the desired bit depth prior to rendering your final output to maximize image quality.

Auto Save Settings
Two settings let you enable or disable automatic saving in Color.
´ Auto Save Projects:  Turning this option on enables automatic saving.
´ Auto Save Time (Minutes):  Specifies how many minutes pass before the project is 

saved again. This is set to 5 minutes by default.

Auto Saving saves only the current project. It does not create an archived copy of the 
project. For more information about creating and recalling archives, see �Saving 
Projects and Archives� on page 72.

How Do Bit Depth and Channel Data Correspond?
The actual range of values used by each channel for every pixel at a given bit depth is 
calculated by taking 2 to the nth power, where n is the bit depth itself. For example, 
the range of values used for 8-bit color is 2 to the 8th power, or 256 values per 
channel. The range of values for 16-bit color is 2 to the 10th power, or 65536 values 
per channel.

However, this isn�t the whole story. How much of the available numeric range is 
actually used depends on how the image data is encoded.

´ Full Range:  Image data using the RGB color space encodes each color channel using 
the full numeric range that�s available. This means that 8-bit video color channels 
use a value in the range of 0�255 and 10-bit channels use a range of 1�1023.

´ Studio Range:  8- and 10-bit video image data that�s stored using the Y·CBCR color 
space uses a studio range of values for each channel. This means that a subset of 
the actual range of available values is used, in order to leave the headroom for 
super-black and super-white that the video standard requires.
For example, the luma of 8-bit Y·CBCR uses the range of 16�236, leaving 1�15 and 
235�254 reserved for headroom in the signal. The luma of 10-bit Y·CBCR uses the 
range of 64�940, with 4�63 and 941�1019 reserved for headroom.

Furthermore, the lowest and highest values are reserved for non image data, and 
the chroma components (CB and CR) use wider range of values (16�240 for 8-bit 
video, and 64�960 for 10-bit video).





6

     111

6 Monitoring

The equipment and methods with which you monitor your 
work are critical to producing an accurate result.

The importance of proper monitoring for color correction cannot be overemphasized. 
This chapter covers the monitoring options available in Color, including the 
configuration of the Scopes window, options for broadcast video output, the 
generation and use of LUTs for calibration and simulation, and how the Still Store is 
output to video for monitoring and evaluation.

This chapter covers the following:

´ The Scopes Window (p. 111)
´ Monitoring Broadcast Video Output (p. 113)
´ Using Display LUTs (p. 115)
´ Monitoring the Still Store (p. 120)

The Scopes Window
The simplest way to monitor your work in Color is with the Scopes window. This is the 
second of the two windows that comprise the Color interface. You can configure Color 
to use one or two displays.

Using two displays, the Scopes window is viewed on the second one, occupying its 
own display. Using one display, the Scopes window shares screen real estate with the 
Color window.

To switch between single and dual display modes, do one of the following:
m Choose Window > Single Display Mode or Dual Display Mode.

m Press Shift-0 to toggle between both modes.

The Scopes window provides a preview display of the image that you�re working on, 
and it can also show either two or three additional video scopes to aid you in image 
evaluation.
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The Preview Display
The preview display either shows you the frame at the current position of the playhead 
in the Timeline, as it appears with all the corrections you�ve applied in all rooms (unless 
you choose Grade > Disable Grade), or the currently enabled Still Store image. 

Whichever image is shown in the preview display is mirrored on the broadcast monitor 
that�s connected to the video output of your computer. The preview display is also 
affected by LUTs that you import into your Color project.

Note:  The only other time the current frame is not displayed is when one of the 
alternate secondary display methods is enabled in the Previews tab of the Secondaries 
room. For more information, see �Previews Tab� on page 219.

The preview display in the Scopes window can be toggled between full and partial 
screen modes.

To toggle the preview image between full and quarter-screen:
m Double-click the image preview in the Scopes window.

m Control-click or right-click the preview image in the Scopes window, then choose Full 
Screen from the shortcut menu.

All video scopes are hidden while the preview display is in full-screen mode.

Video Scopes
The number of scopes that can be displayed depends on the window layout you�re 
using; you can display two video scopes in single display mode and three video scopes 
in dual display mode. For more information, see Chapter 8, �Video Scopes,� on page 141.

Using the Preview Display as Your Evaluation Monitor
Whether or not the preview display in the Scopes window is appropriate to use as 
your evaluation monitor depends on a number of factors, the most important of 
which is the amount of confidence you have in the quality of your preview display.

Many users opt to use the preview display as an evaluation monitor, especially when 
grading scanned film in a 2K workflow, but you need to make sure that you�re using a 
monitor capable of displaying the range of contrast and color necessary for 
maintaining accuracy to your facility�s standards. Also, success depends on proper 
monitor calibration, combined with color profiling and simulation of the eventual film 
output using LUT management, which is covered later in this chapter.
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Monitoring Broadcast Video Output
For the most accurate monitoring of broadcast programs, Color ouputs standard and 
high definition video using supported third-party video interfaces. The drivers installed 
for the interface you have determine what resolutions, bit depths, and frame rates are 
available for outputting to an external monitor.

To turn on external video monitoring:
m Choose an option from the Video Output pop-up menu, in the User Prefs tab of the 

Setup room.

To turn off external video monitoring:
m Choose Disabled from the Video Output pop-up menu.

Mixing and Matching Program and Viewing Resolutions
Ideally, you should monitor your program at its native resolution (in other words, the 
resolution of its source media). However, Color will do its best to output the video at 
whatever resolution is set in the Video Output pop-up menu of the User Prefs tab. If the 
Video Output pop-up menu is set to a different resolution than the currently selected 
Resolution Preset, then Color will automatically scale the image up or down as 
necessary to fit the image to the display size.

Bit Depth and Monitoring
The working bit depth can have a significant impact on the quality of your monitored 
image. The monitored bit depth depends on three factors:
´ The bit depth of the source media
´ The bit depth selected in the Video Output pop-up menu
´ The bit depth selected in the Internal Pixel Format pop-up menu

Other then specifying or choosing the initial shooting or transfer format, the bit depth 
of the source media on disk is predetermined (usually 8-bit, 10-bit, or 10-bit log). Since 
low bit depths can be prone to banding and other artifacts during the color correction 
process (especially when gradients are involved), it�s usually advantageous to process 
the video at a higher bit depth than that of the original source media (secondary 
corrections and vignettes can especially benefit).

Color will process and output your video at whatever bit depth you select. However, 
most broadcast video interfaces max out at 10-bit resolution. For maximum quality 
while monitoring, you should set the Internal Pixel Format to the highest bit depth you 
want to work at, and make sure the Video Output pop-up is set to a 10-bit option.

Note:  Video noise and film grain often minimize the types of artifacts caused by color-
correction operations at low bit depths, so the advantages of working at higher bit 
depths are not always obvious to the naked eye.
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Monitoring at high bit depths is processor intensive, however, and can reduce your real-
time performance. For this reason, you also have the option of lowering the bit depth 
while you work and then raising it when you�re ready to render the project�s final output.

For more information about the monitoring options available in the User Prefs tab, see 
�Playback, Processing, and Output Settings� on page 106.

Choose Your Monitor Carefully
It�s important to choose a monitor that�s appropriate to the critical evaluation of the 
type of image you�ll be grading. At the high end of the display spectrum, you can 
choose from CRT-based displays, a new generation of flat-panel LCD-based displays, 
and high-end video projectors utilizing a variety of technologies.

You should choose carefully based on your budget and needs, but important 
characteristics for critical color evaluation include:

´ Compatibility with the video formats you�ll be monitoring
´ Compatibility with the video signal you�ll be monitoring, such as Y�PBPR, SDI, HD-SDI, 

or HDMI
´ Suitable black levels (in other words, solid black doesn�t look like gray)
´ A wide contrast range
´ Appropriate brightness
´ User-selectable color temperature
´ Adherence to the Rec. 601 (SD) or 709 (HD) color space standards as appropriate
´ Proper gamma (also defined by Rec. 709)
´ Controls suitable for professional calibration and adjustment

Note:  For all of these reasons, consumer televisions and displays are not typically 
appropriate for professional work, although they can be valuable for previewing how 
your program might look in an average living room.

Set Up Your Viewing Environment Carefully
The environment in which you view your monitor also has a significant impact on your 
ability to properly evaluate the image.
´ There should be no direct light spilling on the front of your monitor.
´ Ambient room lighting should be subdued and indirect, and there should be no 

direct light sources within your field of view.
´ Ambient room lighting should match the color temperature of your monitor (6500K 

in North and South America and Europe, and 9300K in Asia).
´ There should be indirect lighting behind the viewing monitor that�s from 10�25% of 

the brightness of the monitor displaying pure white.
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´ The ideal viewing distance for a given monitor is approximately five times the 
vertical height of its screen.

´ The color of the room within your working field of vision should be a neutral gray.

These precautions will help to prevent eye fatigue and inadvertent color biasing while 
you work and will also maximize the image quality you�ll perceive on your display.

Calibrate Your Monitor Regularly
Finally, calibrate your monitor regularly. For maximum precision, some monitors have 
integrated probes for automatic calibration. Otherwise, you can use third-party probes 
and calibration software to make the same measurements. In a purely broadcast 
setting, you can also rely on the standard color bars procedure you are used to.

Adjust the Color Interface for Your Monitoring Environment
The Color interface is deliberately darkened in order to reduce the amount of light spill 
on your desktop. If you want to subdue the interface even further, the UI Saturation 
setting in the User Prefs tab of the Setup room lets you lower the saturation of most of 
the controls in the Primary In, Secondaries, and Primary Out rooms, as well as the color 
displayed by the video scopes.

Using Display LUTs
Color supports the use of 3D look up tables (LUTs) for calibrating your display to match 
an appropriate broadcast standard, or to simulate the characteristics of a target output 
device (for example, how the image you�re correcting will look when printed to film).

Color is represented on CRTs, LCD flat panels, video projectors, and film projectors 
using very different technologies. If you show an identical test image on two different 
types of displays�for example, a broadcast display and a video projector�you can 
guarantee there will be a variation in color between the two. This variation may not be 
noticeable to the average viewer, but as a colorist, you need a predictable viewing 
environment that adheres to the standards required for your format, and to make sure 
that you aren�t driven crazy by changes being requested as a result of someone 
viewing the program on a display showing incorrect color.

As if that weren�t enough, there is also variation within a single category of device:

´ CRT monitors from different manufacturers use different phosphor coatings.
´ Digital projectors are available using many types of imaging systems.
´ Projected film is output using a variety of printing methods and film stocks.

All this inevitably results in significant color variation for any image going from one 
viewing environment to another. One solution to this is calibration using LUTs.
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What Is a LUT?
Simply put, look up tables (LUTs) are precalculated sets of data that are used to adjust 
the color of an image being displayed with the gamut and chromaticity of device A to 
match how that image would look using the gamut and chromaticity of device B.

The gamut of a particular device represents the total range of colors that can be 
displayed on that device. Some types of displays are capable of displaying a greater 
range of colors than others. Furthermore, different video and film standards specify 
different gamuts of color, such that colors that are easily represented by one imaging 
medium are out of bounds for another. For example, film is capable of representing far 
more color values than the broadcast video standard.

Chromaticity refers to the exact values a display uses to represent each of the three 
primary colors. Different displays use different primary values; this can be seen on a 
chromaticity diagram that plots the three primaries as points against a two-
dimensional graph representing hue and saturation within the visible spectrum. Since 
all colors represented by a particular display are a mix of the three primaries, if the 
three primary points vary from display to display, the entire gamut of color will shift.

While the chromaticity diagram shown above is useful for comparing displays on paper, 
to truly represent the hue (color), saturation (intensity of color), and lightness 
(luminance from black to white) that defines a complete gamut, you need to use a 3D 
color space.
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When extruded into 3D space, the gamut and chromaticity of different devices create 
different shapes. For example, the standard RGB color space can be represented with a 
simple cube (as seen in the ColorSync Utility application):

Each corner of the cube represents a different mix of the R,G,B tristimulus values that 
represent each color. The black corner is (0,0,0), the opposing white corner is (1,1,1), the 
blue corner is (0,0,1), the red corner is (1,0,0), and so forth. The RGB color cube is an 
idealized abstraction, however. Actual display devices appear with much different 
shapes, defined by their individual gamut and chromaticity.

To accurately transform one device�s gamut to match that of another involves literally 
projecting its gamut into a 3D representation and then mathematically changing its 
shape to match that of the other device or standard. This process is referred to as 
characterizing a device, and is the standard method used by the color management 
industry. Once calculated, the method of transformation is stored as a 3D LUT file.

Once a device has been characterized and the necessary LUT has been calculated, the 
hard computational work is done, and the LUT can be used within Color to modify the 
output image without any significant impact on real-time performance.
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When Do You Need a LUT?
The following examples illustrate situations where you should consider using LUTs:
´ If you�re matching multiple displays in a facility:  LUTs can be useful for calibrating 

multiple displays to match a common visual standard, ensuring that a program 
doesn�t look different when you move it to another room.

´ If you�re displaying SD or HD video on a nonbroadcast monitor:  You can use a LUT to 
emulate the Rec. 601 (SD) or 709 (HD) color space and gamma setting that�s 
appropriate to the standard of video you�re viewing.

´ If you�re displaying video or film images using a video projector:  You can use a LUT to 
calibrate your device to match, as closely as is possible, the gamut of the broadcast 
or film standard you�re working to.

´ If you�re grading images destined to be printed to film:  You can use a LUT to profile 
the characteristics of the film printing device and film stock you�ll be outputting 
the final prints with, in order to approximate the look of the final projected image 
while you work.

Important:  LUTs are no substitute for a high-quality display. In particular, they�ll do 
nothing to improve muddy blacks, an inherently low contrast range, or a too-narrow 
gamut.

When Don�t You Need a LUT?
If you�re color correcting video and monitoring using a properly calibrated broadcast 
display that�s compatible with the standard of video that you�re displaying, it�s not 
generally necessary to use a LUT.

Generating LUTs
There are several ways you can generate a LUT.

Create One Yourself Using Third-Party Software
There are third-party applications that work in conjunction with hardware monitor 
probes to analyze the characteristics of individual displays and then generate a LUT in 
order to provide the most accurate color fidelity possible. Because monitor settings and 
characteristics drift over time, it�s standard practice to periodically recalibrate displays 
every 1 to 2 weeks.

If you�re creating a LUT to bring another type of display into line with broadcast 
standards (such as a digital projector), you�ll then use additional software to modify the 
calibration LUT to match the target display characteristics you require.

Have One Created for You
At the high end of digital intermediate for film workflows, you can work with the lab 
that will be doing the film print and the company that makes your monitor calibration 
software to create custom LUTs based on profiles of the specific film recorders and film 
stocks that you�re using for your project.
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This process typically involves printing a test image to film at the lab and then 
analyzing the resulting image to generate a target LUT that, together with your display�s 
calibration LUT (derived using a monitor probe and software on your system), is used to 
generate a third LUT, which is the one that�s used by Color for monitoring your 
program as you work.

Creating LUTs in Color
In a pinch, you can match two monitors by eye using the controls of the Primary In 
room, and generating a LUT to emulate your match directly out of Color.

You can also export a grade as a �look� LUT to see how a particular correction will affect 
a digitally recorded image while it�s being shot. To do this, the crew must be using a 
field monitor capable of loading LUTs in the .mga format.

To create your own LUT:
1 Arrange your Color preview display and the target monitor so that both can be seen at 

the same time.

2 Load a good evaluation image (such as a Macbeth chart) into the Timeline.

3 Display the same image on the target display using a second reliable video source.

4 Open the Primary In room and adjust the controls appropriate to make the two images 
match.

5 Choose Export > Display LUT.

6 When the Save LUT As dialog appears, enter a name for that LUT into the File field, 
choose a location to save the file, and click Save.

By default, LUTs are saved to the /Users/username/Library/Application Support/Color/
LUTs directory.

Important:  If your project is already using a LUT when you export a new one, the 
currently loaded LUT is concatenated with your adjustments, and the combination is 
exported as the new LUT.

Using LUTs
All LUTs used and generated by Color are 3D LUTs. Color uses the .mga LUT format 
(originally developed by Pandora), which is compatible with software by Rising Sun 
Research, Kodak, and others. If necessary, there are also applications available to 
convert LUTs from one format into another.

LUTs don�t impact processing performance at all.

To use a LUT:
1 Choose File > Import > Display LUT.

2 Select a LUT file using the Load LUT dialog, and click Load.
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Note:  By default, LUTs are saved to the /Users/username/Library/Application Support/
Color/LUTs directory.

The LUT immediately takes effect, modifying the image as it appears on the preview 
and broadcast displays. LUTs that you load are saved in a project�s settings until you 
specifically clear the LUT from that project.

To stop using a LUT:
m Choose File > Clear Display LUT.

To share a LUT with other Color users, you must provide them with a copy of the LUT 
file. For ease of use, it�s best to place all LUT files into the /Users/username/Library/
Application Support/Color/LUTs directory.

Monitoring the Still Store
The Still Store lets you save and recall images from different parts of your project that you 
can use to compare to shots you�re working on. The Still Store is basically an image buffer 
that lets you toggle between the currently loaded Still Store image, and the current 
image at the position of the playhead. You have options for toggling between the full 
image and a customizable split-screen view that lets you see both images at once.

When you enable the Still Store, the full-screen or split-screen image is sent to both the 
preview and broadcast displays. To go back to viewing the frame at the position of the 
playhead by itself, you need to disable the Still Store.

Enabled Still Store images are analyzed by the video scopes, and they are affected 
by LUTs. For more information on using the Still Store, see Chapter 16, �Still Store,� on 
page 315.
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7 Timeline Playback, Navigation, 
and Editing

The Timeline provides you with an interface for navigating 
through your project, selecting shots to grade, and limited 
editing.

The Timeline and the Shots browser (in the Setup room) both provide ways of viewing 
the shots in your project. However, while the Shots browser gives you a way to 
nonlinearly sort and organize your shots, the Timeline provides a sequential display of 
how all of the shots in your program are arranged in time. In this chapter, you�ll learn 
how to use the Timeline to navigate and play through the shots in your program, as 
well as how to perform simple edits.

This chapter covers the following:

´ Basic Timeline UI Elements (p. 122)
´ Customizing the Timeline Interface (p. 123)
´ Working with Tracks (p. 125)
´ Selecting the Current Shot (p. 126)
´ Timeline Playback (p. 126)
´ Timeline Navigation (p. 128)
´ Selecting Shots in the Timeline (p. 129)
´ Working with Grades in the Timeline (p. 131)
´ The Settings Tabs (p. 132)
´ Editing Controls and Procedures (p. 133)



122 Chapter 7    Timeline Playback, Navigation, and Editing

Basic Timeline UI Elements
The Timeline is divided into a number of tracks, containing the shots, grades, and 
keyframes used by your program.

´ Render Bar:  The render bars above the Timeline Ruler show whether or not a shot is 
unrendered (red), or has been rendered (green).

´ Timeline Ruler:  Shows a time scale for the Timeline. Dragging within the Timeline 
ruler lets you move the playhead, scrubbing through the program.

´ Playhead:  Shows the position of the currently displayed frame in the Timeline. The 
position of the playhead also determines the current shot that�s being worked on.

´ Video Tracks and Shots:  Each shot in the program is represented within one of the video 
tracks directly underneath the Timeline Ruler. Color only allows you to create up to five 
video tracks when you�re assembling a project from scratch, but will accommodate 
however many superimposed video tracks there are in imported projects.

Note:  Color does not currently support compositing operations. During playback, 
superimposed clips take visual precedence over clips in lower tracks.

´ Track Resize Handles:  The tracks can be made taller or shorter by dragging their resize 
handles up or down.

´ Lock Icon:  The lock icon shows whether or not a track has been locked.
´ Grades Track:  Color allows you to switch among up to four primary grades applied to 

each shot. This lets you quickly preview different looks applied to the same shot, 
without losing your previous work. Each grade is labeled Grade 1�4.
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Each of the four grades may include one or more Primary, Secondary, Color FX, and 
Primary Out corrections. By default, each grade appears with a single primary grade 
bar, but additional correction bars appear at the bottom if you�ve made adjustments 
to any of the other rooms for that grade. Each correction bar has a different color.

´ P(rimary) bar:  Shows whether a primary correction has been applied.
´ S(econdary) bar:  Shows whether one or more secondary corrections have been 

applied.
´ CFX (color FX) bar:  Shows whether a Color FX correction has been applied.
´ PO (primary out) bar:  Shows whether a Primary Out correction has been applied.

´ Tracker Area:  If you add a motion tracker to a shot and process it, the tracker�s In and 
Out points appear in this area, with a green bar showing how much of the currently 
selected tracker has been processed. If no tracker is selected in the Tracking tab of 
the Geometry room, nothing appears in this area. For more information, see 
�Tracking Tab� on page 306.

´ Keyframe Graph:  This track contains both the keyframes and the curves that 
interpolate the change from one keyframe�s value to another. For more information 
about keyframing corrections and effects, see Chapter 14, �Keyframing,� on page 285.

Customizing the Timeline Interface
There are a number of ways you can customize the visual interface of the Timeline.

To change the units used in the Timeline Ruler, do one of the following:
m Click the Setup room tab, then click the User Prefs tab, and click the Frames, Seconds, 

Minutes, or Hours button corresponding to the units you want to use.

m Press one of the following keys:

´ Press F to change the display to frames.
´ Press S to change the display to seconds.
´ Press M to change the display to minutes.
´ Press H to change the display to hours.
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There are additional options in the User Prefs tab of the Setup room that let you 
change how shots are shown in the Timeline.

To customize the way shots are displayed in the Timeline:
1 Click the setup room tab, then click the User Prefs tab.

2 Turn the following settings on or off:

´ Show Shot�s Name:  Turning this on displays each shot�s name in the Timeline.
´ Show Shot�s Number:  Turning this on displays each shot�s number in the Timeline.
´ Show Shot�s Beauty Frame:  With this setting turned on, single frame thumbnails 

appear within every shot in the Timeline.

You can also resize the tracks in the Timeline, making them taller or shorter, as you 
prefer. Video tracks, the Grade track, and the Keyframe Graph are all resized individually.

To resize all video tracks, the Grade track, or the Keyframe graph:
m Drag the center handle of the gray bar at the bottom of any track in the Timeline until 

all tracks are the desired height.

To resize individual tracks:
m Hold the Shift key down, and drag the center handle of the gray bar at the bottom of 

the track you want to resize until it�s the desired height.

Note:  The next time you resize all video tracks together, individually resized tracks snap 
to match the newly adjusted track size.

m
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Working with Tracks
This section describes different ways you can change the state of tracks in the Timeline 
as you work.

To lock and unlock a track:
m Control-click or right-click anywhere within a track, then choose one of the following:

´ Lock Track:  Locks all the shots so that they can�t be moved or edited.
´ Unlock Track:  Allows shots to be moved and edited.

Note:  The tracks of imported XML projects are automatically locked. For the best 
round-trip results, these tracks should not be unlocked.

To toggle track visibility:
m Control-click or right-click anywhere within a track, then choose one of the following:

´ Hide Track:  Disables a track such that superimposed shots are neither visible nor 
selectable when the playhead passes over them.

´ Show Track:  Makes a track visible again. Superimposed shots take precedence over 
shots on lower tracks and are selected by default whenever that track is visible.

Note:  The Reverse Track Ordering setting in the Prjct Settings tab of the Setup room 
determines whether superimposed tracks and shots appear on top or underneath. 
Turning Reverse Track Ordering on displays superimposed video tracks the way they 
appear in Final Cut Pro.

� Tip:  Prior to exporting a project from Final Cut Pro, you can export a self-contained 
QuickTime movie of the entire program and superimpose it over the other clips in your 
edited sequence. Then, when you export the project to Color, you can turn this 
�reference� version of the program on and off using track visibility whenever you want 
to have a look at effects or color-corrections that were created during the offline edit.

To add a track:
m Control-click or right-click anywhere within a track, then choose New Track from the 

shortcut menu.

To remove a track:
m Control-click or right-click anywhere within a track, then choose Remove Track from the 

shortcut menu.

Note:  You cannot remove the bottom track.
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Selecting the Current Shot
Whichever shot you move the playhead to becomes the current shot. The current shot 
is the one that�s adjusted whenever you manipulate any of the controls in the Primary 
In, Secondary, Color FX, Primary Out, or Geometry rooms. There can only be one 
current shot at a time. It�s the only one that�s highlighted in light gray.

As you move the playhead through the Timeline, the controls and parameters of all 
rooms automatically update to match the grade of the current shot at the position of 
the playhead.

To make a shot in the Timeline the current shot, do one of the following:
m Double-click any shot in the Timeline.

m Move the playhead to a new shot.

Note:  When you double-click a shot, the Timeline moves so that shot is centered in the 
Timeline, and it becomes the current shot.

Timeline Playback
In general, the purpose of playback in Color is to preview how your various corrections 
look when the shot you�re working on is in motion, or how the grades that are 
variously applied to a group of clips look when they�re played together. For this reason, 
playback works somewhat differently than in applications like Final Cut Pro.

In Color, playback is always constrained to the area of the Timeline from the In point to 
the Out point. If the playhead is already within this area, then playback begins at the 
current position of the playhead, and ends at the out point. If the playhead happens to 
be outside of this area, it automatically jumps to the In point when you next initiate 
playback. This makes it faster to loop the playback of specific shot or scene in the 
Timeline, which is a common operation during color correction sessions.

Starting and Stopping Playback
The following controls let you play and stop your program.

To play the program, do one of the following:
m Click the Play Forward or Play Backward button.

m Press the Space bar.

m Press J to play backward, or L to play forward.
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Important:  When you start playback, you enter a mode in which you�re unable to work 
with the Color controls until you stop playback.

To stop the program, do one of the following:
m Press the spacebar while the program is playing.

m Press Escape.

m Press K.

Toggling the Playback Mode
The playback mode lets you choose whether the In and Out points are automatically 
changed to match the duration of the current shot whenever you move the playhead, 
or whether they remain set to a larger portion of your program.

Shot Mode 
Shot mode is the default playback method. Whenever the playhead moves to a new 
shot, the Timeline In and Out points are automatically changed to match that shot�s 
Project In and Project Out points. As a result, playback is constrained to just that shot. If 
Loop Playback is enabled, the playhead will loop repeatedly over the current shot until 
playback is stopped.

Note:  You can still click other shots in the Timeline to select them, but the In and Out 
points don�t change until the playhead is moved to intersect another shot.

Movie Mode 
When you first enter movie mode, the Timeline In point is set to the first frame of the 
first shot in the Timeline, and the Out point is set to the last frame of the last shot. This 
allows you to play through as many shots as you like, previewing whole scenes of your 
project. While in Movie Mode, you can also set your own In and Out points wherever 
you want, and they won�t update when you move the playhead to another shot.

Placing Your Own In and Out Points
Regardless of what playback mode you�ve chosen, you can always manually set new In 
and Out points wherever you want to. Setting your own In and Out points 
automatically changes the playback mode to movie mode.

To toggle the playback mode, do one of the following:
m Choose Timeline > Toggle Playback Mode.

m Press Shift-Control-M.

Color and JKL
Color has a partial implementation of the JKL playback controls that are so well used 
in other editing applications. However, the finer points of JKL, such as slow-motion 
and frame-by-frame playback, are not implemented.
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To customize the playback duration:
1 Move the playhead to the desired In point, then press I.

2 Move the playhead to the desired Out point, then press O.

Loop Playback
If Loop Playback is enabled, the playhead jumps back to the In point whenever it 
reaches the out point during playback.

To enable loop playback:
1 Click the setup room tab, then click the User Prefs tab.

2 Click the Loop Playback button to turn it on.

Maintain Framerate
The Maintain Framerate setting in the User Prefs tab of the Setup room determines 
whether or not frames are dropped in order to maintain the project�s frame rate during 
playback.
´ If Maintain Framerate is turned on (the default), the current framerate is maintained 

no matter what the current processing workload is. If the currently playing grade is 
processor intensive, then frames will be dropped during playback to maintain the 
project�s frame rate. If not, playback occurs in real-time.

´ If Maintain Framerate is turned off, then every frame is always played back. If the 
currently playing grade is processor intensive, playback will slow in order to avoid 
dropping frames. If not, playback may actually occur at faster then real time.

Timeline Navigation
The following controls let you navigate around your program in the Timeline, scrolling 
through it, zooming in and out, and moving the playhead from shot to shot.

To zoom into and out of the Timeline:
1 Move the playhead to a position in the Timeline upon which to center the zooming 

operation.

2 With the pointer positioned within the Timeline, do one of the following:

´ Choose Timeline > Zoom In, or press Command-� (minus) to zoom in.
´ Choose Timeline > Zoom Out, or press Command-= (equals) to zoom out.

Note:  You can also use the + and � keys in the numeric keypad to zoom the Timeline.

How far you can zoom into the Timeline depends on what units the Timeline Ruler is 
set to display. The larger the units the Timeline is set to display, the farther you can 
zoom out. For example, you can zoom out farther, in order to view more shots in the 
Timeline simultaneously, when the Timeline Ruler is set to Minutes then when it�s set to 
Frames.
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When there are more tracks than can be displayed within the Timeline at once, small 
white arrows appear either at the top, the bottom, or both, to indicate that there are 
hidden tracks in the direction that�s indicated.

When this happens, you can scroll vertically in the Timeline using the middle mouse 
button.

To scroll around the Timeline horizontally or vertically without moving the playhead:
m Middle-click and drag the Timeline to the left, right, up, or down.

m To scroll more quickly, hold the Option key down while Middle-clicking and dragging.

To move the playhead from shot to shot, do one of the following:
m Drag within the Timeline ruler to scrub the playhead from shot to shot.

m Press Up Arrow to move to the first frame of the next shot to the left.

m Press Down Arrow to move to the first frame of the next shot to the right.

m Click the Next Shot or Previous Shot buttons.

You can also move the playhead in single frame increments.

To move from frame to frame, do one of the following:
m Press Left Arrow to go to the previous frame.

m Press Right Arrow to go to the next frame.

To go to the first frame of your project:
m Press Home.

To go to the last frame of your project:
m Press End.

Selecting Shots in the Timeline
There are certain operations, such as copying Primary corrections, that you can perform 
on selected groups of shots. Color provides standard methods of selecting one or more 
shots in the Timeline.

Note:  You can also select shots using the Shots browser. For more information, see 
�The Shots Browser� on page 92.
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To select a shot in the Timeline:
m Click any shot.

Selected shots appear with a cyan highlight in the Timeline.

To select a contiguous number of shots:
1 Click the first of a range of shots you want to select.

2 Shift-click another shot at the end of the range of shots you�d like to select.

All shots in between the first and second shots you selected are also selected.

To select a discontiguous number of shots:
m Control-click any number of shots in the Timeline.

To deselect all shots in the Timeline:
m Select a previously unselected shot to clear the current selection.

m Click in an empty area of the Timeline.
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Working with Grades in the Timeline
Each shot in the Timeline can be switched among up to four different grades, shown in 
the grades track.

These four grades let you store different looks for the same shot. For example, if you�ve 
created a satisfactory grade, but you or your client would like to try �one other thing,� 
you can experiment with up to three different looks, knowing that you can instantly 
recall the original, if that�s what�s ultimately preferred.

Only one grade actually affects a shot at a time�whichever grade is selected in the 
Timeline is the grade you will see on your preview and broadcast displays. All 
unselected grades are disabled. For more information on creating and managing 
grades, see Chapter 13, �Managing Corrections and Grades,� on page 263.

By default, each shot in a new project starts off with a single empty grade, but you can 
add another one at any time.

To add a new grade to a shot, do one of the following:
m Move the playhead to the shot you want to add a new grade to, then press Control�1 

through 4.

m Control-click or right-click on the grade you want to switch to, and choose Add New 
Grade from the shortcut menu.

If there wasn�t already a grade corresponding to the number of the grade you entered, 
one will be created. Whenever a new grade is added, the grade track expands, and the 
new grade becomes the selected grade. New grades are clean slates, letting you begin 
working from the original state of the uncorrected shot.

To select the current grade:
1 Move the playhead to the shot you want to switch the grade of.

2 Do one of the following:

´ Click the grade you want to switch to.
´ Press Control�1 through 4.
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´ Control-click or right-click on the grade you want to switch to, and choose Select 
Grade X from the shortcut menu, where X is the number of the grade you�re 
selecting.

That shot in the Timeline is updated with the newly selected grade.

To reset a grade in the Timeline:
1 Move the playhead to the shot you want to switch the grade of.

2 Control-click or right-click the grade you want to reset to in the grade track of the 
Timeline, and choose Reset Grade X from the shortcut menu (where X is the number of 
the grade).

When you reset a grade, every room associated with that grade is reset, including the 
Primary In, Secondary, Color FX, and Primary Out rooms. The Geometry room is 
unaffected.

For more information, see Chapter 13, �Managing Corrections and Grades,� on page 263.

The Settings Tabs
The shot settings tabs display the properties of the current shot at the position of the 
playhead. Some of these properties are editable, and some are not.

The Settings 1 Tab
The timing properties listed in this tab are not editable. Instead, they�re dependent on 
each shot�s position in the Timeline and on the properties of the source media that 
each shot is linked to.
´ Project In and Project Out:  Defines the location of the shot in the Timeline.
´ Trim In and Trim Out:  Defines the portion of source media that�s actually used in the 

project, relative to the total available duration of the source media file on disk. The 
Trim In and Trim Out timecodes cannot be outside the range of Source In and Source 
Out parameters.

´ Source In and Source Out:  Defines the start and end points of the original source 
media on disk. If Trim In is equal to Source In and Trim Out is equal to Source Out, 
there are no unused handles available in the source media on disk�you are using all 
available media.

´ Frame Rate pop-up menu:  This pop-up menu lets you set the frame rate of each clip 
individually. This setting overrides the frame rate setting in the Project Settings tab. 
For most projects using source media in the QuickTime format, this should be left at 
the default settings. For projects using DPX image sequences as the source media, 
this pop-up menu lets you change an incorrect frame rate in the DPX header data.
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The Settings 2 Tab
This second tab contains additional settings that let you modify the header data of DPX 
image files.
´ Override Header Settings:  Turning this setting on overrides the following settings in 

the DPX header for the current shot.
´ Log:  This setting lets you enable or disable the log to linear image conversion that 

Color automatically performs to 10-bit log DPX and Cineon files.
´ Printing Density:  This pop-up menu is only selectable when the current project is set 

to use Cineon or DPX image sequences. It lets you explicitly choose the numeric 
range of values that are used to process color to ensure compatibility with your post-
production pipeline. These options determine what the black and white points are 
set to in media that�s rendered out of Color. There are three options:
´ Film (95 Black � 685 White : Logarithmic)
´ Video (65 Black � 940 White : Linear)
´ Linear (0 Black � 1023 White)

Important:  The default black point for DPX film scans is typically 95, and the default 
white point for DPX film scans is typically 685. It�s important to make sure that the 
Black Point and White Point settings aren�t filled with spurious data. Check with your 
lab to verify the appropriate settings.

´ DeInterlace:  Turning this button on lets you individually deinterlace clips. This setting 
overrides the Deinterlace Renders and Deinterlace Previews settings in the Project 
Settings tab. When DeInterlace is turned on, both video fields are averaged together 
to create a single frame.

Editing Controls and Procedures
Color is not intended to be an editing environment, and as a result its editing toolset 
isn�t as complete as that of an application like Final Cut Pro. In fact, most of the time 
you want to be careful not to make any editorial changes at all to your project in Color, 
for a variety of reasons:
´ Unlocking the tracks of projects that were imported via XML or sent from 

Final Cut Pro and that will be returning to Final Cut Pro risks disrupting the project 
data, preventing you from successfully sending the project back to Final Cut Pro.

´ If you make edits to an project that was sent from Final Cut Pro, you�ll only be able to 
send a simplified version of that project back to Final Cut Pro which contains only the 
shots and transitions in track V1, and the Pan & Scan settings in the Geometry room.

´ If you import an EDL and make edits, you can export an EDL from Color that 
incorporates your changes; however, that EDL will only contain the shots and 
transitions in track V1.

´ If the project you�ve imported is synchronized to an audio mix, then making any 
editorial changes risks breaking the audio sync.
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However, if you�re working on a project where these issues aren�t important, you can 
use the following tools and commands to edit shots in unlocked tracks in the Timeline.

� Tip:  If you need to make an editorial change, you can always reedit the original 
sequence in Final Cut Pro, export a new XML file, and use the Reconform command to 
update the Color Timeline to match the changes you made.

Select Tool
The select tool is the default state of the pointer in Color. As the name implies, this tool 
lets you select shots in the Timeline, move them to another position in the edit, or 
delete them.

It�s a good idea to reselect the Select tool immediately after making edits with any of 
the other tools, to make sure you don�t inadvertently continue making alterations in 
the Timeline that you don�t intend.

To reposition a shot in the Timeline:
m Drag the shot to another position in the Timeline.

When you move a shot in the Timeline, where it ends up depends on the In point�s 
relation to shots that are already there. Shots you move in Color never overwrite other 
shots. Instead, the other shots in the Timeline are moved out of the way to make way 
for the incoming shot, and the program is rippled as a result.

´ If the In point of the moved shot overlaps the first half of another shot, the shot 
you�re moving will be insert edited at that shot�s In point, and all other shots in the 
Timeline will be rippled to the right to make room.

´ If the In point of the moved shot overlaps the second half of another shot, the shot 
you�re moving will be insert edited after that shot�s Out point, and all other shots in 
the Timeline will be rippled to the right to make room.

´ If you�re moving a shot into an area of the Timeline where it doesn�t overlap with any 
other shot, it�s simply moved to that area of the Timeline without rippling any other 
shots.

To delete a shot in the Timeline:
1 Select one or more shots in the Timeline.

2 Do one of the following:

´ Press Delete.
´ Press Forward Delete.

This performs a lift edit, leaving a gap in the Timeline where that shot used to be. No 
other shots move as a result of deleting a shot.
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Roll Tool
The Roll tool lets you adjust the Out point and In point of two adjacent shots 
simultaneously. If you like where two shots are placed in the Timeline, but you want to 
change when the cut point happens, you can use the Roll tool. No shots move in the 
Timeline as a result; only the edit point between the two shots moves. This is a two-
sided edit, meaning that two shots� edit points are affected simultaneously; the first 
shot�s Out point and the next shot�s In point are both adjusted by a roll edit. However, 
no other shots in the sequence are affected.

Note:  When you perform a roll edit, the overall duration of the sequence stays the 
same, but both shots change duration. One gets longer while the other gets shorter to 
compensate. This means that you don�t have to worry about causing sync problems 
between linked shot items on different tracks.

In the example above, shot B gets shorter while shot C becomes longer, but the 
combined duration of the two shots stays the same.

To make a roll edit:
1 Do one of the following to choose the Roll edit tool:

´ Choose Timeline > Roll Tool.
´ Press Control-R.

2 Move the pointer to the edit point between two shots that you want to roll, and drag it 
either left or right to make the edit.

The Timeline updates to reflect the edit you�re making.

Ripple Tool
A ripple edit adjusts a shot�s In or Out point, making that shot longer or shorter, 
without leaving a gap in the Timeline. The change in duration of the shot you adjusted 
ripples through the rest of the program in the Timeline, moving all shots that are to the 
right of the one you adjusted either earlier or later in the Timeline.

A B C 

A B C 

Before edit 

After edit
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A ripple edit is a one-sided edit, meaning that you can only use it to adjust the In or 
Out point of a single shot. All shots following the one you�ve adjusted are moved�to 
the left if you�ve shortened it, or to the right if you�ve lengthened it. This is a significant 
operation that can potentially affect the timing of your entire program.

Important:  Ripple edits can be dangerous if you are trying to maintain sync between 
your program in Color, and the original audio in the Final Cut Pro sequence or source 
EDL that is being mixed somewhere else entirely, since the shots in your Color project 
may move forward or backward while the externally synced audio doesn�t.

To make a ripple edit:
1 Do one of the following to choose the Ripple edit tool:

´ Choose Timeline > Ripple Tool.
´ Press Control-T.

2 Move the pointer to the In or Out point of the shot you want to shorten or lengthen, 
and drag it either left or right to make the edit.

The Timeline updates to reflect the edit you�re making, with all of the shots following the 
one you�re adjusting moving to the left or right to accommodate the change in timing.

Slip Tool
Performing a slip edit doesn�t change a shot�s position or duration in the Timeline; 
instead it changes what portion of that shot�s media appears in the Timeline by letting 
you change its In and Out points simultaneously.

This means that the portion of the shot that plays in the Timeline changes, while its 
position in the Timeline stays the same. No other shots in the Timeline are affected by a 
slip edit, and the overall duration of the project remains unaffected.

In the example above, the slip edit changes the In and Out points of shot B, but not its 
duration or position with the sequence. When the sequence plays back, a different 
portion of shot B�s media will be shown.

A B C 

A B C 

Before edit 

After edit 

A B C 

A B C 

Before edit 

00:00:10:00 00:00:30:00

00:00:17:00 00:00:37:00

After edit 
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To make a slip edit:
1 Move the playhead to the shot you want to adjust, in order to be able to view the 

change you�re making as you work.

2 Do one of the following to choose the Slip edit tool:

´ Choose Timeline > Slip Tool.
´ Press Control-Y.

3 Move the pointer to the shot you want to slip, and drag it either left or right to make 
the edit.

Unlike Final Cut Pro, Color provides no visual feedback showing the frames of the new 
In and Out points you�re choosing with this tool. The only image that�s displayed is the 
frame at the current position of the playhead being updated as you drag the shot back 
and forth. This is why it�s a good idea to move the playhead to the shot you�re adjusting 
before you start making a slip edit.

Split Tool
The Split tool lets you add an edit point to a shot by cutting it into two pieces. This edit 
point is added at the frame you click in the Timeline. This can be useful for deleting a 
section of a shot or for applying an effect to a specific part of a shot.

To split one shot into two:
1 Do one of the following to choose the Split tool:

´ Choose Timeline > Split Tool.
´ Press Control-X.

2 Move the pointer to the Timeline ruler, and when the split overlay appears (a vertical 
white line intersecting the shots in the Timeline), drag it to the frame of the shot where 
you want to add an edit point.

3 Click to add an edit point.

The Timeline updates to reflect the edit you�ve made, with a new edit point appearing 
at the frame you clicked.

Splice Tool
Whenever you cut a shot with the Split tool, the original shot is split into two shots 
separated by a through edit. There is no visual indication of through edits in the Color 
Timeline, but any edit point that splits an otherwise contiguous range of frames is 
considered to be a through edit, which can be joined back together with the Splice tool.

Joining two shots separated by a through edit merges them back into a single shot. 
You cannot join two shots that aren�t separated by a through edit; if you try you�ll 
simply get a warning message.
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Important:  When you splice two shots that have different grades and corrections, the 
grades and corrections of the shot to the left overwrite those of the shot to the right.

To splice two shots into one:
1 Do one of the following to choose the Splice tool:

´ Choose Timeline > Splice Tool.
´ Press Control-Z.

2 Move the pointer to the Timeline ruler, and when the splice overlay appears (a vertical 
white line intersecting the shots in the Timeline), drag it to the edit point you want to 
splice.

3 Click to splice that edit point.

The Timeline updates to reflect the edit you�ve made, and the two shots that were 
previously separated by a through edit are spliced into one.

Create an Edit
The Create an Edit command in the Timeline menu (Control-V) is similar to the Split 
tool. It cuts a single shot in the Timeline into two at the current position of the 
playhead. Using this command eliminates the need to choose a tool.

To create an edit point:
1 Move the playhead to the frame where you want to add an edit point.

2 Do one of the following:

´ Choose Timeline > Create an Edit.
´ Press Control-V.
The Timeline updates to reflect the edit you�ve made, with a new edit point appearing 
at the position of the playhead.

Merge Edits
The Merge Edits command (Control-B) is similar to the Splice tool. It joins two shots 
separated by a through edit at the current position of the playhead into a single shot. 
Using this command eliminates the need to choose a tool.

To merge two shots into one at a through edit point:
1 Move the playhead to the frame at the through edit you want to merge.

2 Do one of the following:

´ Choose Timeline > Merge Edits.
´ Press Control-B.
The Timeline updates to reflect the edit you�ve made, and the two shots that were 
previously separated by a through edit are merged into one.
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Important:  When you splice two shots that have different grades and corrections, the 
grades and corrections of the shot to the left overwrite those of the shot to the right.

Snapping
When snapping is on, clips �snap to� the 00:00:00:00 time value in the Timeline.

To toggle snapping:
m Choose Timeline > Snapping to turn snapping on and off.
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8 Video Scopes

In addition to a well-calibrated broadcast display, video 
scopes are a fast and accurate way to quantitatively evaluate 
and compare images.

Color provides most of the video scope displays that you�d find in other online video 
and color correction suites, and includes a few that are unique to software-based 
image analysis. Together, these scopes provide graphic measurements of the luma, 
chroma, and RGB levels of the image currently being monitored, helping you to 
unambiguously evaluate the qualities that differentiate one shot from another. This lets 
you make more informed decisions while legalizing or comparing shots in Color.

This chapter covers the following:

´ What Scopes Are Available? (p. 141)
´ Video Scope Options (p. 144)
´ Analyzing Images Using the Video Scopes (p. 145)

What Scopes Are Available?
The following video scopes are available in the Scopes window:
´ Waveform monitor with the following options:

´ RGB Parade view
´ Overlay of red, green, and blue channels together
´ Red, Green, or Blue channel in isolation
´ Luma only
´ Chroma only
´ Y·CBCR presented in parade view
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´ Vectorscope
´ Histogram with the following options:

´ RGB presented simultaneously
´ Red, Green, or Blue channel in isolation
´ Luma only

´ 3D color analysis with the following color space options:
´ RGB
´ HSL
´ Y·CBCR

´ IPT

The location where the video scopes appear depends on whether Color is configured 
to single or double display mode:

´ In Single Display mode:  Two video scopes are displayed underneath the video 
preview in the Scopes window, which is positioned to the left of the Color interface 
window.
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´ In Double Display mode:  Up to three video scopes are displayed in the Scopes 
window, in addition to the video preview.

Video Scopes Accuracy
To create a real-time analysis of the video signal (even during adjustment and 
playback), Color downsamples the current image to a resolution of 384 x 192. The 
downsampled image is then analyzed, and the resulting data displayed by the 
currently selected scopes. This same downsampled resolution is used regardless of 
the original resolution of the source media.

Using this method, every pixel contributes to the final analysis of the image. In tests, 
the graphs produced by the Color video scopes closely match those produced by 
dedicated video scopes, and are extremely useful as an aid to evaluating and 
matching shots while you work in Color. However, you should be aware that the 
Color analysis is still an approximation of the total data. Dedicated video scopes are 
still valuable for critical evaluation.

Note:  If you�re concerned about catching stray out-of-gamut pixels while you make 
adjustments for QC purposes, you can turn on the Broadcast Safe settings to protect 
yourself from QC violations. For more information, see �Broadcast Safe Settings� on 
page 100.
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Video Scope Options
You have the following ways of modifying the display and behavior of the video 
scopes.

To enable real-time video scope updates:
1 Open the User Preferences tab located inside the Setup room.

2 Select Update UI During Playback.

3 To set the video scopes to update during playback, select Update Secondary Display.

� Tip:  You can turn off Update Primary Display to improve playback performance.

Some scopes have the option to be switched among different modes.

To change a scope to a different mode:
m Click the button corresponding to desired mode at the top of that scope.

Any quadrant containing a video scope can also be switched to a different kind of 
scope.

To switch which scope is displayed in a particular region of the Scopes window:
m Control-click or right-click within any scope, and choose a different scope from the 

shortcut menu.

All scopes can be zoomed into to get a closer look at the graph.

To zoom a scope�s display, do one of the following:
m Roll the scroll wheel or scroll ball of your mouse down to zoom into a particular scope�s 

display, and up to zoom out.

m Click one of the percentage buttons at the upper left corner of the Vectorscope to scale 
the scope�s display.

The 3D video scopes can also be rotated in space so that you can view the analysis 
from any angle.

To reposition any 3D scope, do one of the following:
m Drag horizontally or vertically to rotate the scope model in that direction.

m Hold the middle button down and drag to reposition the scope model in that direction.
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To reset any scope to its original scale and orientation:
m Control-click or right-click within any scope, and choose Reset from the shortcut menu.

Some scopes have the option to be displayed in color.

To toggle video scope color on and off:
1 Open the User Preferences tab, located inside the Setup room.

2 Click Monochrome Scopes to turn scope color off or on.

Scope color is affected by the following customizable parameters:
´ When Monochrome Scopes is turned off, the UI Saturation parameter determines 

how intense the scope colors are. 
´ When Monochrome Scopes is turned on, the Scope Color control directly underneath 

controls the color of the scope graticules.

Analyzing Images Using the Video Scopes
The following section describes the use of each scope that Color provides.

Waveform
The Waveform scope is actually a whole family of scopes that show different analyses 
of luma and chroma using waveforms.

What Is a Waveform?
To create a waveform, Color analyzes lines of an image from left to right, with the 
resulting values plotted vertically on the waveform graticule relative to the scale that�s 
used (for example, �20 to 110 IRE on the Luma graph). In the following image, a single 
line of the image is analyzed and plotted in this way.
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To produce the overall analysis of the image, the individual graphs for each line of the 
image are superimposed over one another.

Because the waveform�s values are plotted in the same horizontal position as the 
portion of the image that�s analyzed, the waveform mirrors the image to a certain 
extent. This can be seen if a subject moves from left to right in an image while the 
Waveform is playing in real time.

With all the waveform-style scopes, high luma or chroma levels show up as spikes on 
the waveform, while low levels show up as dips. This makes it easy to read the 
measured levels of highlights or shadows in the image.

Parade
The Parade scope displays separate waveforms for the red, green, and blue 
components of the image side by side. If Monochrome Scopes is turned off, the 
waveforms are tinted red, green, and blue so you can easily identify which is which.
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Note:  To better illustrate the Parade scope�s analysis, the examples in this section are 
shown with Broadcast Safe disabled so that image values above 100 percent and below 
0 percent won�t be clipped.

The Parade scope makes it easy to spot color casts in the highlights and shadows of an 
image, by comparing the contours of the top and the bottom of each waveform. Since 
whites, grays, and blacks are characterized by exactly equal amounts of red, green, and 
blue, neutral areas of the picture should display three waveforms of roughly equal 
height in the Parade scope. If not, the correction is easy to make by making 
adjustments to level the three waveforms.

Before color correction

After color correction
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The Parade scope is also useful for comparing the relative levels of reds, greens, and 
blues between two shots. If one shot has more red than another, the difference shows 
up as an elevated red waveform in the one and a depressed red waveform in the other, 
relative to the other channels. In the first screenshot, the overall image contains quite a 
bit of red. By comparison, the second shot has substantially less red and far higher 
levels of green, which can be seen immediately in the Parade scope. If you needed to 
match the color of these shots together, you could use these measurements as the 
basis for your correction.

The Parade scope also lets you spot color channels that are exceeding the chroma limit 
for broadcast legality, if the Broadcast Safe settings are turned off. This can be seen in 
waveforms of individual channels that either rise too high or dip too low.

An elevated red channel betrays the degree of the color cast

An elevated green channel reveals a different correction to be made
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Overlay
The Overlay scope presents information that�s identical to that in the Parade scope, 
except that the waveforms representing the red, green, and blue channels are 
superimposed directly over one another.

This can make it easier to spot the relative differences or similarities in overlapping 
areas of the three color channels that are supposed to be identical, such as neutral 
whites, grays, or blacks. 

Another feature of this display is that when the video scopes are set to display color (by 
turning off the Monochrome Scopes parameter), then areas of the graticule where the 
red, green, and blue waveforms precisely overlap appear white. This makes it easy to 
see when you�ve eliminated color casts in the shadows and highlights by balancing all 
three channels.

Red/Green/Blue Channels
These scopes show isolated waveforms for each of the color channels. They�re useful 
when you want a closer look at a single channel�s values.
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Luma
The Luma scope shows you the relative levels of brightness within the image. Spikes or 
drops in the displayed waveform make it easy to see hot spots or dark areas in your 
picture.

The difference between the highest peak and the lowest dip of the Luma scope�s 
graticule shows you the total contrast ratio of the shot, and the average thickness of 
the waveform shows its average exposure. Waveforms that are too low are indicative of 
images that are dark, while waveforms that are too high may indicate overexposure.

If you�re doing a QC pass of a program with the Broadcast Safe settings turned off, you 
can also use the scale to easily spot video levels that are over and under the 
recommended limits.

Overexposed waveform

Underexposed waveform Well-exposed waveform
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Chroma
This scope shows the combined CB and CR color-difference components of the image. 
It�s useful for checking whether or not the overall chroma is too high, and also whether 
it�s being limited too much, as it lets you see the result of the Chroma Limit setting 
being imposed when Broadcast Safe is enabled.

For example, the following graph shows extremely saturated chroma within the image:

When you turn Broadcast Safe on with the default Chroma Limit value of 50, you can 
see that the high chroma spikes have been limited to 50.

Y�CBCR
This scope shows the individual components of the Y·CBCR encoded signal in a parade 
view. The leftmost waveform is the luma (Y�) component, the middle waveform is the 
CB color difference component, and the rightmost waveform is the CR color difference 
component.
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Vectorscope
The Vectorscope shows you the overall distribution of color in your image against a 
circular scale. The video image is represented by a graph consisting of a series of 
connected points that all fall about the center of this scale. For each point within the 
analyzed graph, its angle around the scale indicates its hue (which can be compared to 
the color targets provided) while its distance from the center of the scale represents 
the saturation of the color being displayed. The center of the Vectorscope represents 
zero saturation, and the farther from the center a point is, the higher its saturation.

If the Monochrome Scopes option is turned off in the User Prefs tab of the Setup room, 
then the points of the graph plotted by the Vectorscope will be drawn with the color 
from that part of the source image. This can make it easier to see which areas of the 
graph correspond to which areas of the image.
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The Vectorscope is useful for seeing, at a glance, the hue and intensity of the various 
colors in your image. Once you learn to identify the colors in your shots on the graph in 
the Vectorscope, you will be better able to match two images closely because you can 
see where they vary. For example, if one image is more saturated than another, it�s 
graph in the Vectorscope will be larger.

You can also use the Vectorscope to spot whether there�s a color cast affecting portions 
of the picture that should be neutral (or desaturated). Since desaturated areas of the 
picture should be perfectly centered, an off-center Vectorscope graph representing an 
image with portions of white, gray, or black clearly indicates a color imbalance.

The Color Targets
The color targets of the Vectorscope scale match the colors in the Color Balance 
controls of the Final Cut Pro color correction filters. If the hues of two shots you�re 
trying to match don�t match, the direction and distance of their offset on the 
Vectorscope scale give you an indication of which direction to move the balance 
control indicator to correct for this.

A less saturated image A more saturated image
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How the color targets in the Vectorscope relate to the saturation of the Vectorscope 
graph depends on the scale the Vectorscope is set to:

´ If the Vectorscope scale is set to 75 percent, then 75 percent color bars will hit the 
targets.

´ If the Vectorscope scale is set to 100 percent, then 100 percent color bars will hit the 
targets.

Note:  All color is converted by Color to RGB using the Rec. 709 standard prior to 
analysis. As a result, color bars from both NTSC and PAL source video will hit the same 
targets.

The I Bar
The �I bar shows the proper angle at which the hue of the dark blue box in the color 
bars test pattern should appear. This dark blue box, which is located to the left of the 
100-percent white reference square, is referred to as the Inphase signal, or I for short.

The I bar (positive I bar) overlay in the Vectorscope is also identical to the skin tone line 
in Final Cut Pro. It�s helpful for identifying and correcting the skin tones of actors in a 
shot. When recorded to videotape and measured on a Vectorscope, the hues of human 
skin tones, regardless of complexion, fall along a fairly narrow range (although the 
saturation and brightness vary). When there�s an actor in a shot, you�ll know whether or 
not the skin tones are reproduced accurately by checking to see if there�s an area of 
color that falls loosely around the I bar.

If the skin tones of your actors are noticeably off, the offset between the most likely 
nearby area of color on the Vectorscope and the skin tone target will give you an idea 
of the type of correction you should make.
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The Q Bar
The Q bar shows the proper angle at which the hue of the purple box in the color bars 
test pattern should appear. This purple box, which is located at the right of the 100-
percent white reference square, is referred to as the +Quadrature signal, or Q for short.

When troubleshooting a video signal, the correspondence between the Inphase and 
+Quadrature components of the color bars signal and the position of the �I and Q bars 
shows you whether or not the components of the video signal are being demodulated 
correctly.

Histogram
The Histogram provides a very different type of analysis than the waveform-based 
scopes. Whereas waveforms have a built-in correspondence between the horizontal 
position of the image being analyzed and that of the waveform graph, histograms 
provide a statistical analysis of the image.

Histograms work by calculating the total number of pixels of each color or luma level in 
the image and plotting a graph that shows the number of pixels there are at each 
percentage. It�s really a bar graph of sorts, where each increment of the scale from left 
to right represents a percentage of luma or color, while the height of each segment of 
the histogram graph shows the number of pixels that correspond to that percentage.

RGB
The RGB histogram display shows separate histogram analyses for each color channel. 
This lets you compare the relative distribution of each color channel across the tonal 
range of the image.
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For example, images with a red color cast either have a significantly stronger red 
histogram, or conversely will have weaker green and blue histograms. In the following 
example, the red cast in the highlights can be seen clearly.

R, G, and B
The R, G, and B histograms are simply isolated versions of each channel�s histogram 
graph.

Luma
The Luma histogram shows you the relative strength of all luminance values in the 
video frame, from black to super-white. The height of the graph at each step on the 
scale represents the number of pixels in the image at that percentage of luminance, 
relative to all the other values. For example, if you have an image with few highlights, 
you would expect to see a large cluster of values in the Histogram display around the 
midtones.



Chapter 8    Video Scopes 157

The Luma histogram can be very useful for quickly comparing the luma of two shots so 
you can adjust their shadows, midtones, and highlights to match more closely. For 
example, if you were matching a cutaway shot to the one shown above, you can tell 
just by looking that the image below is underexposed, but the Histogram gives you a 
reference for spotting how far.

The shape of the histogram is also good for determining the amount of contrast in an 
image. A low-contrast image, such as the one shown above, has a concentrated clump 
of values nearer to the center of the graph. By comparison, a high-contrast image has a 
wider distribution of values across the entire width of the histogram.

3D Color Space Scope
This scope displays an analysis of the color in the image projected within a 3D area. You 
can select one of four different color spaces with which to represent the color data.

RGB
The RGB color space distributes color in space within a cube that represents the total 
range of color that can be displayed:
´ Absolute black and white lie at two opposing diagonal corners of the cube, with the 

center of the diagonal being the desaturated grayscale range from black to white.
´ The three primary colors red, green, and blue lie at the three corners connected to 

black. 
´ The three secondary colors yellow, cyan, and magenta, lie at the three corners 

connected to white.
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In this way, every color that can be represented in Color can be assigned a point in 
three dimensions using hue, saturation, and lightness to define each axis of space.

The sides of the cube represent color of 100-percent saturation, while the center 
diagonal from the black to white corners represents 0-percent saturation. Darker colors 
fall closer to the black corner of the cube, while lighter colors fall closer to the 
diagonally opposing white corner of the cube.

HSL
The HSL (Hue, Saturation, and Luminance) color space distributes a graph of points 
within a two-pointed cone that represents the range of color that can be displayed.
´ Absolute black and white lie at two opposing points at the top and bottom of the 

shape.
´ The primary and secondary colors are distributed around the familiar color wheel, 

with 100 percent saturation represented by the outer edge of the shape, and 0 
percent saturation represented at the center.
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In this way, darker colors lie at the bottom of the interior, while lighter colors lie at the 
top. More saturated colors lie closer to the outer sides of the shape, while less saturated 
colors fall closer to the center of the interior.

Y�CBCR
The Y·CBCR color space is similar to the HSL color space, except that the outer boundary 
of saturation is represented with a specifically shaped six-sided construct that shows 
the general boundaries of color in broadcast video.

The outer boundary does not identify the broadcast-legal limits of video, but it does 
illustrate the general range of color that�s available. For example, the following image 
has illegal saturation and brightness.

If you turn on the Broadcast Safe settings, the distribution of color throughout the 
Y·CBCR color space becomes constricted.
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IPT
The IPT color space is a perceptually weighted color space, the purpose of which is to 
more accurately represent the hues in an image distributed on a scale that appears 
uniformly linear to your eye.

While the RGB, HSL, and Y·CBCR color spaces present three-dimensional analyses of the 
image that are mathematically accurate, and allow you to see how the colors of an 
image are transformed from one gamut to another, they don�t necessarily show the 
distribution of colors as your eyes perceive them. A good example of this is a 
conventionally calculated hue wheel. Notice how the green portion of the hue wheel 
presented below seems so much larger then the yellow or red portion.

The cones of the human eye which are sensitive to color have differing sensitivities to 
each of the primaries (red, green, and blue). As a result, a mathematically linear 
distribution of analyzed color is not necessarily the most accurate way to represent 
what we actually see. The IPT color space rectifies this by redistributing the location of 
hues in the color space according to tests where people chose and arranged an even 
distribution of hues from one color to another, to define a spectrum that �looked right� 
to them.

In the IPT color space, I corresponds to the vertical axis of lightness (desaturated black 
to white) running through the center of the color space. The horizontal plane is defined 
by the P axis, which is the distribution of red to green, and the T axis, which is the 
distribution of yellow to blue.

Here�s an analysis of the test image within this color space.
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Sampling Color
The 3D video scope also provides controls for sampling and analyzing the color of the 
currently displayed image. Three swatches at the bottom of the video scope let you 
sample three different colors for analysis.

Note:  These controls are visible only when the 3D scope is occupying an area of the 
Scopes window.

To sample and analyze a color:
1 Click one of the three color swatch buttons at the bottom of the 3D scope.

2 Drag within the image preview area to move the color target to the area you want to 
analyze, and release the mouse button.

As you drag the color target over the image preview, three things happen:

´ The color swatch updates with that color.
´ The H, S, and L values of the currently analyzed pixel are displayed to the right of the 

currently selected swatch.
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´ Crosshairs identify that value�s location within the three-dimensional representation 
of color in the 3D scope itself.

Each color target is numbered to identify its corresponding color swatch.
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9 Primary In

The Primary In room provides your main interface for color 
correcting each shot. For every shot, this is where you begin, 
and in many cases this may be all you need.

Simply speaking, primary corrections are color corrections that affect the entire image at 
once. The Primary In room provides a variety of controls that will be familiar to anyone 
who�s worked with other image editing and color correction plug-ins and applications. 
Each of these controls manipulates the contrast and color in the image in a different 
way.

Note:  Many of the controls in the Primary In room also appear in the Secondaries and 
Primary Out rooms, in which they have identical functionality.

This chapter covers the following:

´ What Is the Primary In Room Used For? (p. 163)
´ Using the Primary Contrast Controls (p. 166)
´ Adjusting Contrast in the Shadows, Midtones, and Highlights (p. 168)
´ Using Color Balance Controls (p. 179)
´ Understanding Shadow, Midtone, and Highlight Adjustments (p. 183)
´ Curves Controls (p. 189)
´ Basic Tab (p. 201)
´ Advanced Tab (p. 204)
´ Auto Balance (p. 206)

What Is the Primary In Room Used For?
Typically, you�ll use the Primary In room to do tasks such as the following:
´ To adjust image contrast, so that the shadows are deep enough, the highlights are 

bright enough, and the overall lightness of the image is appropriate to the scene.
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´ To adjust color in the highlights and midtones to correct for unwanted color casts 
due to a video camera�s incorrect white balance settings, or lighting that was 
inappropriate for the type of film stock that was used.

´ To make changes to the overall color and contrast of an image in order to change 
the apparent time of day. For example, you might need to alter a shot that was 
photographed in the late afternoon to look as if it were shot at high noon.

´ To adjust the color and contrast of every shot in a scene so that there are no 
irregularities in exposure or color from one shot to the next.

All these tasks and more can be performed using the tools that are available in the 
Primary In room. In fact, when working on shows that require relatively simple 
corrections, you may do all your corrections right here, including perhaps a slight 
additional adjustment to warm up or cool down the image for purely aesthetic 
purposes.

On the other hand, you could also choose to perform different stages of these 
necessary corrections in other rooms for organizational purposes. For more information 
about how to split up and organize corrections in different ways, see �Using the 
Primary, Secondary, and Color FX Rooms Together to Manage Each Shot�s Corrections� 
on page 281.

The Primary In Room Lets You Make Specific Adjustments
Even though the Primary In room applies corrections to the entire image, that is not to 
say that these corrections can�t be targeted to specific aspects of the picture. Many of 
the controls in the Primary In room are designed to make adjustments to specific 
regions of tonality. In other words, some controls adjust the color in brighter parts of 
the picture, while other controls only affect the color in its darker regions.

Still other types of controls affect specific color channels, such that you can lower or 
raise the green channel without affecting the red or blue channels.

Where to Start?
This chapter covers all the controls for image adjustment that are found in the Primary 
In room. Many colorists use these tools in a specific order. This order is used to organize 
each section to provide you with a methodology with which to get started. In general, 
you�ll probably find that you work on most images using the following steps.



Chapter 9    Primary In 165

 

Step 1:  Adjust the contrast of the image
Most colorists always begin by correcting the contrast of an image, before moving on 
to adjusting its color. This adjustment can be made using the primary contrast controls, 
the Luma curve control, and the Master Lift, Master Gain, and Master Gamma controls 
in the Basic tab.

Step 2:  Adjust the color balance of the image
Once the black and white points of the image have been determined, the color balance 
is tackled. Fast adjustments to the color balance in the shadows, midtones, and 
highlights can be made using the primary color balance controls. More detailed 
adjustments can be made using the red, green, and blue curve controls, and specific 
numeric adjustments can be made using the Red, Green, and Blue Lift, Gamma, and 
Gain controls in the Advanced tab.

Step 3:  Adjust the saturation of the image
Once you�re happy with the quality of the color, you can make adjustments to raise or 
lower the saturation, or intensity, of the colors in the image. The Saturation, Highlight 
Sat., and Shadow Sat. controls in the Basic tab let you adjust the overall saturation, or 
only the saturation within specific tonal regions.
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Step 4:  Make more specific adjustments
If you still feel that there are specific aspects of the image that need further adjustment 
after steps one through three, you can turn to the curves controls, which let you make 
targeted adjustments to the color and contrast of the image within specifically defined 
zones of tonality. Past a certain point, however, it may also be easier to move on to the 
Secondaries room, covered in Chapter 10, �Secondaries,� on page 209.

Using the Primary Contrast Controls
If you strip away the color in an image (you can do this by setting the Saturation 
control to 0), the grayscale image that remains represents the luma component of the 
image, which is the portion of the image that controls the lightness of the image. As 
explained in �The Y�CBCR Color Model� on page 24, the luma of an image is derived 
from a weighted ratio of the red, green, and blue channels of the image which 
corresponds to the eye�s sensitivity to each color.

Although luma was originally a video concept, you can manipulate the luma 
component of images using the contrast controls in Color no matter what the 
originating format. These controls let you adjust the lightness of an image more or less 
independently from its color.

Note:  Extreme adjustments to image contrast may have an effect on image saturation.
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Contrast Ratio
One of the most important adjustments you can make to an image is to change its 
contrast ratio. The contrast ratio of an image is the difference between the darkest pixel 
in the shadows (the black point) and the lightest pixel in the highlights (the white 
point). The contrast ratio of an image is easy to quantify by looking at the Waveform 
monitor or Histogram set to Luma. High-contrast images have a wide distribution of 
values from the black point to the white point.

Low contrast images, on the other hand, have a narrower distribution of values from 
the black point to the white point.

The Shadow, Midtone, and Highlight contrast sliders let you make individual 
adjustments to each of the three defining characteristics of contrast. 

Note:  Contrast adjustments made with the primary contrast sliders can affect the 
saturation of the image. Raising luma by a significant amount can reduce saturation, 
while reducing luma can raise image saturation. This behavior is different from that of 
the Color Corrector 3-way filter in Final Cut Pro, in which changes to contrast have no 
effect on image saturation.

Using Contrast Sliders with a Control Surface
In the Primary In, Secondaries, and Primary Out rooms, the three contrast sliders usually 
correspond to three contrast rings, wheels, or knobs, on compatible control surfaces. 
Whereas you can only adjust one contrast slider at a time using the onscreen controls 
with a mouse, you can adjust all three contrast controls simultaneously using a 
hardware control surface.
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When using a control surface, the Encoder Sensitivity parameter in the User Prefs tab of 
the Setup room let you customize the speed with which these controls make 
adjustments. For more information, see �Control Surface Settings� on page 103.

Adjusting Contrast in the Shadows, Midtones, and Highlights
The primary contrast sliders consist of three vertical sliders, which are used to adjust 
the black point, the distribution of midtones, and the white point of the image.

Each slider is a vertical gradient. Dragging down lowers its value, while dragging up 
raises its value. A blue bar shows the current level at which each slider is set, while the 
third number in the Output display (labeled �L�) below each color control shows that 
slider�s numeric value.

Adjusting the Black Point with the Shadow Slider
The behavior of the shadows contrast slider depends on whether or not the Limit 
Shadow Adjustments preference is turned on (for more information, see �User Interface 
Settings� on page 104).

Adjusts black point Adjusts midtones distribution Adjusts white point

Output:  0.00h   0.00s   0.001 Output:  0.00h   0.00s   0.501 Output:  0.00h   0.00s   1.001

Shadow Midtone Highlight



Chapter 9    Primary In 169

 

´ If Limit Shadow Adjustments is turned off:  Contrast adjustments with the shadows 
slider are performed as a simple lift operation. The resulting correction uniformly 
lightens or darkens the entire image, altering the shadows, midtones, and highlights 
by the same amount. This can be seen most clearly when adjusting the black point of 
a linear black-to-white gradient, which appears in the Waveform Monitor as a straight 
diagonal slope. Notice how the entire slope of the gradient in the Waveform Monitor 
moves up.

´ If Limit Shadow Adjustments is turned on:  The black point is raised, but the white 
point remains at 100 percent. This means that when you make any adjustments with 
the Shadow contrast slider, all midtones in the image are scaled between the new 
black point and 100 percent. Notice how the top of the slope in the waveform 
monitor stays in place while the black point changes.
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You�ll probably leave the Limit Shadow Adjustments control turned on for most of your 
projects, since this provides the most control over image contrast (and color, as you�ll 
see later) in your programs.

You�ll find that contrast adjustments to the shadows are one of the most frequent 
operations you�ll perform. Lowering the blacks so that at the darkest shadows touch 0 
percent (seen in the bottom of the Waveform monitor�s graph or on the left of the 
Histogram�s graph when either is set to Luma) deepens the shadows of your image. 
Deeper shadows can enrich the image and accentuate detail that was being slightly 
washed out before.

Lowering the blacks even more, called crushing the blacks because no pixel can be 
darker then 0 percent, creates even higher-contrast looks. Crushing the blacks comes at 
the expense of losing detail in the shadows, as larger portions of the image become 
uniformly 0 percent black. This can be seen clearly in the black portion of the gradient 
at the bottom of the image.

Note:  Even if Limit Shadow Adjustments is turned on, you can still make lift 
adjustments to the image using the Master Lift parameter in the Basic tab. See 
�Master Contrast Controls� on page 204.
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Adjusting the Midtones
The Midtone contrast slider lets you make a nonlinear adjustment to the distribution of 
midtones in the image (sometimes referred to generically as a gamma adjustment). 
What this means is that you can adjust the middle tones of the image without 
changing the darkness of the shadows or the lightness of the highlights.

Here are two examples of using the Midtone contrast slider. The midtones have been 
lowered in the following image. Notice how the overall image has darkened, with more 
of the picture appearing in the shadows; however, the highlights are still bright, and 
the shadow detail has not been lost. The top and bottom of the gradient�s slope in the 
Waveform Monitor remain more or less in place, and the slope itself curves downward, 
illustrating the nonlinear nature of the adjustment.
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Next, the Midtone slider is raised. The image has clearly lightened, and much more of 
the picture is in the highlights; yet the deepest shadows remain rich and dark, and the 
detail in the highlights isn�t being lost since the highlights are staying at their original 
level. Again, the top and bottom of the gradient�s slope in the Waveform Monitor 
remain more or less in place, but this time the slope curves upward.

No matter what contrast ratio you decide to employ for a given shot, the midtones 
slider is one of your main tools for adjusting overall image lightness when creating 
mood, adjusting the perceived time of day, and even when simply ensuring that the 
audience can see the subjects clearly.

Note:  Even though midtones adjustments leave the black and white points at 0 and 
100 percent, respectively, extreme midtones adjustments will still crush the blacks and 
flatten the whites, eliminating detail in exchange for the creation of high-contrast 
looks.

Adjusting the White Point with the Highlight Slider
The Highlight slider is the inverse of the Shadows slider. Using this control, you can 
raise or lower the white point of the image, while leaving the black point relatively 
untouched. All the midtones of the image are scaled between your new white point 
and 0 percent.
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If the image is too dark and the highlights seem lackluster, you can raise the Highlight 
slider to brighten the highlights, while leaving the shadows at their current levels. 
Notice that the black point of the gradient�s slope in the Waveform Monitor remains at 
0 percent after the adjustment.

Note:  In this example, Broadcast Safe has been disabled, and you can see the white 
level of the gradient clipping at the maximum of 109 percent.

If the highlights are too bright, you can lower the Highlight slider to bring them back 
down, without worrying about crushing the blacks. 
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Overly bright highlights are often the case with images shot on video, where super-
white levels above the broadcast-legal limit of 100 percent frequently appear in the 
source media (as seen in the previous example). If left uncorrected, highlights above 
100 percent will be clipped by the Broadcast Safe settings when they�re enabled, 
resulting in a loss of highlight detail when all pixels above 100 percent are set to be 100 
percent.

By lowering the white point yourself, you can bring clipped detail back into the image.

Note:  Values that are clipped or limited by Color are preserved internally, and may be 
retrieved in subsequent adjustments. This is different from overexposed values in 
source media, which if clipped at the time of recording are lost forever.
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While modest adjustments made with the Highlight slider won�t affect the black point, 
they will have an effect on the midtones that is proportional to the amount of your 
adjustment. The influence of the Highlight slider falls off toward the shadows, but it�s 
fair to say that adjustments made with the highlight slider have a gradually decreasing 
affect on approximately the brightest 80 percent of the image.

For this reason, you may find yourself compensating for a highlight slider adjustment�s 
effect on the midtones of your image by making a smaller inverse adjustment with the 
Midtones slider.

The suitable white point for your particular image is highly subjective. In particular, just 
because something is white doesn�t mean that it�s supposed to be up at 100 percent. 
Naturally bright features such as specular highlights, reflected glints, and exposed light 
sources are all candidates for 100 percent luma (chances are these areas are at super-
white levels already, so you�ll be turning the brightness down if broadcast legality is an 
issue).

On the other hand, if you�re working on an interior scene with none of the previously 
mentioned features, the brightest subjects in the scene may be a wall in the room or 
the highlights of someone�s face, which may be inappropriately bright if you raise them 
to 100 percent. In these cases, the brightness at which you set the highlights depends 
largely on the kind of lighting that was used. If the lighting is subdued, you�ll want to 
keep the highlights lower then if the lighting is intentionally bright.

Expanding and Reducing Image Contrast
For a variety of reasons, it�s often desirable to stretch the contrast ratio of an image so 
that it occupies the widest range of values possible, without introducing unwanted 
noise (this can sometimes happen in underexposed images that require large contrast 
adjustments).
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Most images don�t start out with the highest contrast ratio they could have. For 
example, even in well-exposed shots, videocameras often don�t record black at 0 
percent, instead recording black levels at around 3�4 percent. For this reason alone, 
small adjustments to lower the black point often impress without the need to do much 
more. In other cases, an image that is slightly over or underexposed may appear 
washed out or muddy, and simple adjustments to lower the darkest pixels in the image 
and raise the brightest pixels in the image to widen the contrast ratio have an effect 
similar to �wiping a layer of grime off the image,� and are often the first step in simply 
optimizing a shot.

In other cases, you may choose to deliberately widen the contrast ratio even further to 
make extreme changes to image contrast. This may be because the image is severely 
underexposed, in which case you need to adjust the Highlight and Midtone sliders in 
an effort to simply make the subjects more visible. You might also expand the contrast 
ratio of an otherwise well-exposed shot to an extreme, crushing the shadows and 
clipping the highlights to create an extremely high-contrast look.
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Important:  When you expand the contrast of underexposed shots, or make other 
extreme contrast adjustments, you may accentuate film grain and video noise in the 
image. This is particularly problematic when correcting programs that use video 
formats with low chroma subsampling ratios. for more information, see �Chroma 
Subsampling� on page 25.

Of course, you also have the option to lower the contrast ratio of an image. This might 
be done as an adjustment to change the apparent time of day (dulling shadows while 
maintaining bright highlights for a noon-time look), or simply as a stylistic choice 
(lighter shadows and dimmer highlights for a softer look).
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Image Contrast Affects the Operation of the Color Balance Controls
There�s another reason to expand or otherwise adjust the contrast ratio of an image 
before making any other color corrections. Every adjustment you make to the contrast 
of an image changes which portions of that image fall into which of the three 
overlapping tonal zones the color balance controls affect (covered in the next section). 
For example, if you have a low-contrast image with few shadows, and you make an 
adjustment with the Shadow color balance control, the resulting correction will be 
small, as you can see in the following gradient.

What Exactly Is Image Detail?
Image detail is discussed frequently in this and other chapters, mainly within the 
context of operations that enhance perceived detail, and those that result in the loss 
of image detail. Simply put, image detail refers to the natural variation in tone, color, 
and contrast between adjacent pixels. 

Because they occur at the outer boundaries of the video signal, the shadows and 
highlights of an image are most susceptible to a loss of image detail when you make 
contrast adjustments. This results in the �flattening� of areas in the shadows or 
highlights when larger and larger groups of pixels in the picture are set to the same 
value (0 in the shadows and 100 in the highlights).

It�s important to preserve a certain amount of image detail in order to maintain a 
natural look to the image. On the other hand, there�s no reason you can�t discard a bit 
of image detail to achieve looks such as slightly crushed blacks, or widely expanded 
contrast for a �high-contrast look� with both crushed blacks and clipped whites. Just 
be aware of what, exactly, is happening to the image when you make these kinds of 
adjustments.
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If, afterward, you adjust the Shadow or Midtone contrast sliders to lower the shadows, 
you�ll find more of the image becoming affected by the same color correction, despite 
the fact that you�ve made no further changes to that color control.

This is not to say that you shouldn�t readjust contrast after making other color 
corrections, but you should keep these interactions in mind when you do so.

Using Color Balance Controls
A color cast is an unwanted tint in the image due to the lighting, the white balance of 
the videocamera, or the type of film stock used given the lighting conditions during 
the shoot. Color casts exist because one or more color channels is inappropriately 
strong or weak. Furthermore, color casts aren�t usually uniform across an entire image. 
Often, color casts are stronger in one portion of the image (such as the highlights) and 
weaker or nonexistent in others (the shadows, for example). 

If you examine an image with a color cast in the Waveform monitor set to Parade, you 
can often see the disproportionate levels of each channel that cause the color cast 
when you examine the tops of the waveforms (representing the highlights) and the 
bottoms of the waveforms (representing the shadows).

Note:  For clarity, the Parade scope is shown with the tinted red, green, and blue 
waveforms that appear when Monochrome Scopes is turned off in the User Prefs tab.
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The Color Balance controls (which are sometimes referred to as Hue Wheels) work as 
virtual trackballs on the screen; however, they consist of three separate controls. 

´ Color Balance wheel:  A virtual trackball that lets you adjust the hue (set by the 
handle�s angle about the center) and saturation (set by the handle�s distance from 
the center) of the correction you�re using to rebalance the red, green, and blue 
channels of the image relative to one another. A handle at the center of the 
crosshairs within the wheel shows the current correction. When the handle is 
centered, no change is made.

´ Hue slider:  This slider lets you change the hue of the adjustment without affecting 
the saturation.

´ Saturation slider:  This slider lets you change the saturation of the adjustment without 
affecting the hue. Drag up to increase the saturation, and down to decrease it.

´ Reset button:  Clicking the reset button resets both the color balance control and the 
contrast slider for that tonal zone. If you�re using a control surface, you�ll have 
separate reset controls for the color and contrast adjustments of each zone on the 
control surface itself.

´ Output display:  The output display underneath each color control shows you the 
current hue and saturation values of the color balance control and the lightness 
value of the contrast slider for that zone.

Note:  The color balance controls can be accelerated to10x their normal speed by 
pressing the Option key while you drag.

By dragging the handle of a color balance control, you can rebalance the strength of 
the red, green, and blue channels of an image to manipulate the quality of light in 
order to either correct such color casts or introduce them for creative purposes. The 
color balance controls always adjust all three color channels simultaneously.

Saturation slider

Hue slider

Output displayReset button
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In the previous example, the image has a red color cast in the highlights, which can be 
confirmed by the height of the top of the red channel in the Parade scope. 

To correct this, you need to simultaneously lower the red channel and raise the blue 
channel, which you can do by dragging the highlight color balance control. The easy 
way to remember how to make a correction of this nature is to drag the color balance 
control handle toward the secondary of the color that�s too strong. In this case, the 
color cast is a reddish/orange, so dragging the color control in the opposite direction, 
toward bluish/cyan, rebalances the color channels in the appropriate manner. The 
Midtone color balance control is used because the majority of the image that�s being 
adjusted lies between 80 and 20 percent.

If you watch the Parade scope while you make this change, you can see the color 
channels being rebalanced, while you also observe the correction affecting the image 
on your broadcast display.
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There are three color balance controls in the Primary In, Secondaries, and Primary Out 
rooms. Each one lets you make adjustments to specific tonal regions of the image.

Using Color Balance Controls with a Control Surface
The three color balance controls correspond to the three trackballs, or joyballs, on 
compatible control surfaces. Whereas you can only adjust one color balance control at 
a time using the onscreen controls with a mouse, you can adjust all three color balance 
controls simultaneously using a hardware control surface.

When using a control surface, the Hue Wheel Angle and Joyball Sensitivity parameters 
in the User Prefs tab of the Setup room let you customize the operation of these 
controls. For more information on adjusting these parameters, see �Control Surface 
Settings� on page 103.

When Is a Color Cast a Creative Look?
It�s important to bear in mind that color casts aren�t always bad things. In particular, if 
the Director of Photography is being creative with the lighting, there may in fact be 
color casts throughout the tonal range of the image. It�s important to distinguish 
between color casts that are there either accidentally or because of conditions of the 
shoot and the stylistic choices made when lighting each scene. In all cases, clear 
communication between the Director of Photography and the colorist is essential.
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Understanding Shadow, Midtone, and Highlight Adjustments
Like many other color correction environments, Color provides a set of three color 
balance controls for the specific adjustment of color that falls within each of three 
overlapping zones of image tonality. These tonal zones are the shadows, midtones, and 
highlights of the image, which were covered in the previous section on contrast. If you 
were to reduce the tonality of an image into these three zones, it might look 
something like the following illustration.

Three-zone controls allow you to make targeted adjustments to the color that falls 
within the highlights of an image, without affecting color in the shadows. Similarly, 
they allow you to make separate adjustments to differently lit portions of the image to 
either make corrections or achieve stylized looks.

Original color image Simulated tonal zones, shadows, midtones, and 
highlights

Areas most affected by the Midtone color 
balance control

Areas most affected by the Shadow color 
balance controlmidtones using the Luma curve

Areas most affected by the Highlight color balance control
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To prevent obvious banding or other artifacts, adjustments to the three tonal zones 
overlap broadly, with each color balance control�s influence over the image diminishing 
gradually at the edges of each zone. This overlap is shown in the following graph.

The ways in which these zones overlap are based on the OpenCDL standard, and their 
behavior is described below.

Important:  If you�re used to the way the Color Corrector 3-way filter works in 
Final Cut Pro, you�ll want to take some time to get used to the controls of the Primary 
In room, as they respond somewhat differently. Also unlike adjustments using the Color 
Corrector 3-way filter in Final Cut Pro, adjustments made using the color balance 
control affect the luma of the image, altering its contrast ratio.

Shadows Color Adjustments
The behavior of the Shadows color balance control depends on whether or not the 
Limit Shadow Adjustments preference is turned on (for more information, see �User 
Interface Settings� on page 104).

Shadow control influence

Midtone influence

Highlight control influence
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´ If Limit Shadow Adjustments is turned off:  Color adjustments made using the shadows 
control are performed as a simple add operation (the color that�s selected in the 
Shadow color control is simply added to that of every pixel in the image). The 
resulting correction affects the entire image (and can be seen clearly within the 
gradient at the bottom of the image), producing an effect similar to a tint.

´ If Limit Shadow Adjustments is turned on:  A linear falloff is applied to color 
adjustments made with the Shadow control such that black receives 100 percent of 
the adjustment and white receives 0 percent of the adjustment. This is the method 
to use if you want to be able to selectively correct shadows while leaving highlights 
untouched.
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Note:  To better illustrate the effect of the Shadow color control, the previous examples 
were shown with Broadcast Safe disabled so that image values below 0 percent 
wouldn�t be clipped.

Midtones Color Adjustments
Adjustments made with the Midtones color balance control apply the correction using 
a Power operation (the new pixel value = old pixel value ^ adjustment). The result is 
that midtones adjustments have the greatest effect on color values at 50 percent 
lightness, and fall off as color values near 0 and 100 percent lightness.

This lets you make color adjustments that exclude the shadows and highlights in the 
image. For example, you could add a bit of blue to the midtones to cool off an actor�s 
skin tone, while leaving your shadows deep and untinted and your highlights clean 
and pure.
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Highlights Color Adjustments
Adjustments made using the Highlight color balance control apply a multiply operation 
to the image (the color that�s selected in the Highlight color control is simply multiplied 
with that of every pixel in the image). By definition, multiply color correction 
operations fall off in the darker portions of an image and have no effect whatsoever in 
regions of 0 percent black.

The Highlight color control is extremely useful for correcting color balance problems 
resulting from the dominant light source that�s creating the highlights, without 
inadvertently tinting the shadows. In the following example, a bit of blue is added to 
the highlights to neutralize the orange from the tungsten lighting.

Color Balance Control Overlap
The broadly overlapping nature of color correction adjustments made with the three 
color balance controls is necessary to ensure a smooth transition from adjustments 
made in one tonal zone to another, in order to prevent banding and other artifacts. In 
general, adjustments made to the color in one tonal zone also affect other tonal zones 
in the following ways:
´ Adjustments made to the Shadow color controls overlap the midtones and the 

darker portion of the highlights, but exclude areas of the image at the highest 
percentages.
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´ Adjustments made to the midtones affect the broadest area of the image, but don�t 
affect the lowest percentages of the shadows or the highest percentages of the 
highlights.

´ Adjustments made to the highlights affect the midtones as well, but not the lowest 
percentages of the shadows.

Controlling Color Balance Control Overlap
While the tonal zones that are affected by the three color balance controls are 
predefined by the mathematical operations they perform, it is possible to exert some 
control over what areas of an image are being affected by the corrections of a 
particular color balance control. This is done by applying opposing corrections with 
other color balance controls.

The following example shows this principal in action. If you adjust the Highlight color 
balance control to add blue to a linear gradient, you�ll see the following preview.

As you can see, this change affects both the whites and midtones. If you want to 
restrict the correction that�s taking place in the midtones, while leaving the correction 
at the upper portion of the whites, you can take advantage of the previously described 
method of using complementary colors to neutralize one another, and make a less 
extreme, opposite adjustment with the Midtone color balance control.
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The result is that the highlights correction that had been affecting the midtones has 
been neutralized in the lower portion of the midtones.

Although making opposing adjustments to multiple color balance controls may seem 
contradictory, it�s a powerful technique. With practice, you�ll find yourself instinctively 
making adjustments like this all the time to limit the effect of corrections on 
neighboring zones of tonality.

Curves Controls
The curves controls, located underneath the color controls in the Primary In room, 
provide an additional method for adjusting the color and contrast of your images. If 
you�re familiar with image editing applications such as Photoshop, chances are you�ve 
used curves before.

The two main differences between the curves controls and the color balance 
controls are:
´ The curves controls let you make adjustments to as many specific tonal ranges that 

you choose to define, while the color balance controls affect three predefined tonal 
ranges.

´ The curves controls each affect only a single color channel, while the color balance 
controls let you quickly adjust all three color channels simultaneously.

´ Curves cannot be animated with keyframes, although every other parameter in the 
Primary In and Primary Out rooms can be.
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Color balance controls are usually faster to use when making broad adjustments to the 
shadows, midtones, and highlights of the image. Curves, on the other hand, often take 
more time to adjust, but they allow extremely precise adjustments within narrow tonal 
zones of the image, which can border on the kinds of operations typically performed 
using secondary color correction.

Important:  While the power of curves can be seductive, be wary of spending too much 
time finessing your shots using the curves controls, especially in client sessions where 
time is money. It�s easy to get lost in the minutiae of a single shot while the clock is 
ticking, and such detail work may be faster to accomplish with other tools.

How Curves Affect the Image
Curves work by remapping the original color and luma values to new values that you 
choose, simply by changing the height of the curve. The X axis of the graph represents 
the source values that fall along the entire tonal range of the original image, from black 
(left) to white (right). The Y axis of the graph represents the tonal range available for 
adjustment, from black (bottom) to white (top).

Without any adjustments made, each curve control is a flat diagonal line; in other 
words, each source value equals its adjustment value, so no change is made.
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If part of a curve is raised by one or more control points, then the tonal area of the 
image that corresponds to the source values within the curve are being adjusted to a 
higher value. In other words, that part of the image is lightened.

If part of a curve is lowered with one or more control points, then the tonal area of the 
image that corresponds to the source values within the curve are being adjusted to a 
lower value. In other words, that part of the image is darkened.

Editing Control Points and B-Splines
By default, each curve has two control points. The bottom-left control point is the black 
point and the top-right control point is the white point for that channel. These two 
control points anchor the bottom and top of each curve.

Effect of raising midtones using the Luma curve

Effect of lowering midtones using the Luma curve



192 Chapter 9    Primary In

 

Curves in Color are edited using B-Splines, which use control points that aren�t actually 
attached to the curve control to �pull� the curve into different shapes, like a strong 
magnet pulling thin wire. For example, here�s a curve with a single control point that�s 
raising the highlights disproportionately to the midtones:

The control point hovering above the curve is pulling the entire curve upward, while 
the ends of the curve are pinned in place.

The complexity of a curve is defined by how many control points are exerting influence 
on the curve. If two control points are added to either side, and moved down, the 
curve can be modified as seen below.

To make curves sharper, move their control points closer together. To make curves 
more gentle, move the control points farther away from one another.

The following procedures describe how to create, remove, and adjust the control points 
that edit curve controls.

To add control points to a curve:
m Click anywhere on the curve itself.

To adjust a control point:
m Drag it anywhere within the curve control area.
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To remove control points from a curve:
m Drag a point up or down until it�s outside the curve control area.

To remove all control points from a curve:
m Click the reset button (at the upper left-hand side of each curve graph) for the curve 

you want to clear control points from.

Using Curves to Adjust Contrast
One of the most easily understood ways of using curves is to adjust contrast with the 
Luma curve. The Luma curve actually performs a simultaneous adjustment to the red, 
green, and blue channels of the image (as you can see if you take a look at the Parade 
scope while making Luma curve adjustments), so the overall effect is to adjust the 
lightness of the image.

Note:  Adjustments made to the Luma curve may affect its saturation. Raising luma by a 
significant amount can reduce its saturation.

You can draw a general correspondence between the controls described previously in 
�Using the Primary Contrast Controls� and the black point, midtones, and white point 
of the Luma curve. For example, moving the black point of the curve up raises the 
black point.

Moving the white point of the curve down lowers the white point of the image.
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These two control points roughly correspond to the shadow and highlight contrast 
controls. If you add a third control point to the luma curve somewhere in the center, 
you can adjust the distribution of midtones that fall between the black and white 
points. This adjustment is similar to that using the Midtones contrast control. Moving 
this middle control point up raises the distribution of midtones, lightening the image 
while leaving the white and black points pinned in place.

Moving the same control point down lowers the distribution of midtones, darkening 
the image while leaving the white and black points pinned in place.

While these three control points can mimic the functionality of the Shadow, Midtone, 
and HIghlight contrast controls, the true power of curves comes from the ability to add 
several control points to make targeted adjustments to the lightness of specific tonal 
regions in the image.
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An Example of the Luma Curve in Use
The following example illustrates how to make very specific changes to the contrast of 
an image using the Luma curve. Looking at the waveform in the following image, you 
can see that the sky is significantly brighter then the rest of the image. In order to bring 
viewer attention more immediately to the subject sitting at the desk, you would want 
to darken the sky outside the window, without affecting the brightness of the rest of 
the image.

1 Before making any actual adjustments, pin down the midtones and shadows of the 
image by adding a control point to the curve without moving it either up or down.

Adding control points to a portion of a curve that you don�t want to adjust, and leaving 
them centered, is a great way to minimize the effect of other adjustments you�re 
making to specific areas of an image. When you add additional control points to adjust 
the curve, the unedited control points you placed will help to limit the correction.
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� Tip:  When adding multiple control points to a curve, you can use the grid to identify 
where to position parts of a curve you want to be at the original, neutral state of the 
image. At its uncorrected state, each curve passes through the diagonal intersections of 
the background grid.

2 To make the actual adjustment, drag the white point at the upper-right corner down to 
darken the sky.

You want to make sure that you don�t drag the new control point down too far, since 
it�s easy to create adjustments that look unnatural or solarized using curves, especially 
when part of a curve is inverted.

That was a very targeted adjustment, but you can go farther. Now that the sky is more 
subdued, you may want to brighten the highlights of the man�s face by increasing the 
contrast in that part of the image.
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3 Add a control point below the first control point you created, and drag it up until the 
man�s face lightens.

The man�s face is now brighter, but the shadows are now a bit washed out.

4 Add one last control point underneath the last control point you created, and drag it 
down just a little bit to deepen the shadows, without affecting the brighter portions of 
the image.

As you can see, the Luma curve is a powerful tool for making extremely specific 
changes.

Using Curves to Adjust Color
Unlike the color balance controls, which adjust all three color channels simultaneously, 
each of the color curve controls affects a single color channel. Additionally, the red, 
green, and blue color curves let you make adjustments within specific areas of tonality 
defined by the control points you add to the curve. This means that you can make very 
exact color adjustments that affect regions of the image that are as narrow or broad as 
you define.

The Luma Curve Limits the Range of the Primary Contrast Sliders
One important aspect of the curve controls is that they can limit the range of 
subsequent adjustments with the primary contrast sliders in the same room. This can 
be clearly seen when you make an adjustment to lower the white point of the image 
using the Luma curve. Afterward, you�ll find yourself unable to use the Highlight 
contrast slider to raise the image brightness above the level that�s set by the Luma 
curve. You can still make additional contrast adjustments in other rooms.
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An Example of Color Curves in Use
In the following example, you�ll see how to make a targeted correction to eliminate a 
color cast from the lower midtones, shadows, and extreme highlights of an image, 
while actually strengthening the same color cast in the lower highlights. 

The following image has a distinct red color cast from the shadows through the 
highlights, as you can see by the elevated red waveform in the Parade scope.

Note:  For clarity, Broadcast Safe has been disabled so you can better see the bottoms 
of the waveforms in the Parade scope.

In this particular shot, you want to keep the red fill light on the woman�s face, as it was 
intentionally part of the look of the scene. However, to deepen the shadows of the 
scene and make the subject stand out a little more from the background, you�d like to 
remove some of the red from the shadows.

1 Add a control point to the red curve near the bottom of the curve, and pull down until 
the red color cast becomes subdued. 

This should coincide with the bottom of the red waveform in the Parade scope lining 
up with the bottoms of the green and blue waveforms.
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This operation certainly neutralizes the red in the shadows; unfortunately, because this 
one control point is influencing the entire curve, this correction also removes much of 
the original red from the midtones as well.

� Tip:  If you�re wondering where you should place control points on a curve to make an 
alteration to a specific area of the image, you can use the height of the corresponding 
graphs in the Waveform monitor set to either Parade (if you�re adjusting color) or Luma 
(if you�re adjusting the Luma curve). For example, if you want to adjust the highlights of 
the image, you�ll probably need to place a control point in the curve at approximately 
the same height at which the highlights appear in the waveform graph.

2 Add another control point near the top of the red curve, and drag it up until some red 
�fill� reappears on the side of the woman�s face.

This adds the red back to the woman�s face, but now you�ve added red to the 
highlights of the key light source, as well.
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Since the key light for this shot is the sun coming in through the window, this is 
probably inappropriate and should be corrected.

3 Drag the control point for the white point in the red curve control down until the red in 
the brightest highlights of the face is neutralized, but not so far that the lighting begins 
to turn cyan.

At this point, the correction is finished. The red light appears in the fill light falling on 
the woman�s face, while the shadows and very brightest highlights from the sun are 
nice and neutral, enhancing the color contrast of the image.

Here is a before and after comparison so you can see the difference.
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Basic Tab
The Basic tab contains the controls for saturation, as well as master lift, gamma, and gain 
parameters that let you make additional adjustments to the contrast of your image.

Saturation Controls
Saturation describes the intensity of the color in an image. Image saturation is 
controlled using three parameters which, similarly to the other controls in the Primary 
In room, let you make individual adjustments to different tonal zones of an image. Like 
the contrast and color controls, tonality specific saturation adjustments fall off gently at 
the edges of each correction to ensure smooth transitions.

What Is Color Contrast?
Contrast in this document usually describes the differences between light and dark 
tones in the image. There is another way to describe contrast, however, and that is 
the contrast between different colors in an image. Color contrast is a complex topic, 
touching upon hue, color temperature, lightness, and saturation. To greatly simplify 
this diverse topic, color contrast can pragmatically refer to the difference in color that 
exists in different regions of the image.

In the previous example, the image started out with an indiscriminate color cast; in 
other words, there was red in the shadows, red in the midtones, and red in the 
highlights, so there weren�t many clearly contrasting colors in the different areas of 
the image. By removing this color cast from some parts of the image, and leaving it in 
others, you enhanced the color contrast between the main subject and the 
background. In images for which this is appropriate, color contrast can add visual 
sophistication to an otherwise flat image.



202 Chapter 9    Primary In

 

´ Saturation:  This parameter controls the saturation of the entire image. The default 
value of 1 makes no change to image saturation. Reducing this value lowers the 
intensity of the color of every pixel in the image; at 0 the image becomes a grayscale 
monochrome image showing only the luma. Raising the saturation increases the 
intensity of the color, up to a maximum value of 4. 

Beware of raising image saturation too much; this can result in colors that start to 
�bleed� into one another and a signal that�s illegal for broadcast.

If the Broadcast Safe settings are turned on, the legality of the image will be 
protected, but you may see some flattening in particularly colorful parts of the image 
that results from the chroma of the image being limited at the specified value. You 
can see this in the Vectorscope by the bunching up at the edges of the graph. Even if 
you�re not working on a project for video, severely oversaturated colors can cause 
problems and look unprofessional.

Saturation reduced by more than half

Original image

A dramatically oversaturated image
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´ Highlight Sat.:  This parameter controls the saturation in the highlights of your image. 
You can selectively desaturate the highlights of your image, which can help legalize 
problem clips, as well as restore some white to the brightest highlights in an image.

Highlight saturation turned all the way down

Highlight saturation turned up
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´ Shadow Sat.:  This parameter controls the saturation in the shadows of your image. 
You can selectively desaturate the shadows on your image to create deeper looking 
blacks and to eliminate inappropriate color in the shadows of your images for a more 
cinematic look.

Master Contrast Controls
Three additional parameters also affect image contrast. For more information on 
contrast adjustments, see �Using the Primary Contrast Controls� on page 166.
´ Master Lift:  Unlike the primary Shadow contrast slider, the Master Lift parameter only 

functions as an add or subtract operator, making an overall luma adjustment to the 
entire image regardless of how the Limit Shadow Adjustments control is set. For 
more information on lift adjustments, see �Adjusting the Black Point with the Shadow 
Slider� on page 168.

´ Master Gain:  This parameter works exactly like the primary Highlight contrast slider, 
adjusting the white point while leaving the black point at its current level and scaling 
all of the midtones in between the two.

´ Master Gamma:  This parameter works exactly like the primary Midtone contrast 
slider, adjusting the distribution of midtones between 0 and 100 percent.

Advanced Tab 
This tab contains another set of parameters for adjusting each of the three primary 
color channels within each of the three tonal zones. Additionally, there are a set of 
Printer Points controls for colorists who are used to optical color grading for film.

Original image

Shadow saturation turned all the way down
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RGB Controls
These parameters provide per-channel control over contrast and color. These are not 
numerical representations of any of the other controls in the Primary In room. Like the 
parameters in the Basic tab, they�re available as an additional set of controls.

Typically, these parameters are adjusted when the Auto Balance button is used to 
automatically adjust a shot (for more information, see �Auto Balance� on page 206). 
However, you can use them as you see fit.

´ Red, Green, and Blue Lift:  These parameters work exactly like the Master Lift 
parameter, but affect the individual color channels.

´ Red, Green, and Blue Gain:  These parameters work exactly like the Master Gain 
parameter, but affect the individual color channels.

´ Red, Green, and Blue Gamma:  These parameters work exactly like the Master Gamma 
parameter, but affect the individual color channels.

Printer Points Controls
These parameters are available for colorists who are used to working with the printer 
points system for color timing film. Employed by film printing machines, the printer 
points system allows color correction to be performed optically, by shining filtered light 
through the conformed camera negatives to expose an intermediate positive print, in 
the process creating a single reel of film that is the color-corrected print.

The process of controlling the color of individual shots and doing scene-to-scene color 
correction is accomplished using just three controls to individually adjust the amount 
of red, green, and blue light that exposes the film, using a series of optical filters and 
shutters. This method of making adjustments can be reproduced digitally using the 
Printer Points parameters.

� Tip:  These parameters are controllable using knobs on most compatible control surfaces.

What Is a Printer Point?
Each of the red, green, and blue parameters is adjusted in discrete increments called 
printer points (with each point being a fraction of an �-stop, the scale used to measure 
film exposure). Color implements a standard system employing a total range of 50 
points for each channel, where point 25 is the original neutral state for that color 
channel. Technically speaking, each point represents 1/4th of an �-stop of exposure 
(one �-stop represents a doubling of light). Each full stop of exposure equals 12 printer 
points.

Making Adjustments Using Printer Points
Unlike virtually every other control in the Primary In room, the Red, Green, and Blue 
Printer Points parameters make a uniform adjustment to the entire color channel, 
irrespective of image tonality.
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Also unique is the way in which adjustments are made. To emulate the nature of the 
filters employed by these kinds of machines, raising a parameter such as the Printer 
Points Red parameter doesn�t actually boost the red; instead, it removes red, causing 
the image to shift to cyan (the secondary of green and blue). To increase red, you 
actually need to decrease the Printer Points Red parameter.

Increasing or decreasing all three printer points parameters together darkens the 
image (by raising all three parameters) or lightens it (by lowering all three parameters). 
Making disproportionate adjustments to the three channels changes the color balance 
of the image relative to the adjustment, altering the color of the image and allowing 
for the correction or introduction of color casts.

The Printer Points Parameters
´ Printer Points Calibration:  This value calibrates the printer points system according to 

the film gamma standard you wish to use. The default value of 7.8 is derived by 
multiplying the value 12 (points per �-stop) by a value of 0.65 (the default film 
gamma standard used). 0.65 * 12 = 7.8. To recalibrate for a different film gamma 
value, insert your own gamma value into the equation.

´ Printer Points Red:  The value with which to raise or lower the red channel.
´ Printer Points Green:  The value with which to raise or lower the green channel.
´ Printer Points Blue:  The value with which to raise or lower the blue channel.

Note:  There is also a printer points node available in the Color FX room, which works 
identically to the parameters covered in this section.

Auto Balance
The Auto Balance button performs an automatic analysis of the current shot, based on 
the frame at the position of the playhead. This is useful for quickly bringing a problem 
shot with an inobvious color cast to a neutral state, prior to performing further color 
correction.

When you click this button, Color automatically samples the darkest and lightest five 
percent of the image, and the most neutral midtone pixels falling between the two, in 
order to determine how to make shadow, midtone, and highlight adjustments to 
neutralize any available color casts in the image. In addition, image contrast is 
maximized to occupy the widest available range from 0 to 100.

Note:  Unlike the Auto Balance controls in the Final Cut Pro Color Corrector 3-way filter, 
the Auto Balance command is fully automatic, and does not require you to select 
individual areas of the image for analysis.
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To use the Auto Balance button:
1 Move the playhead in the Timeline to a representative frame of the shot you want to 

automatically color balance.

2 Click Auto Balance.

Once the analysis has been performed, the Red, Green, and Blue Lift and Gain 
parameters in the Advanced tab of the Primary In room are automatically set to contain 
the results of these adjustments. The result should render whites, grays, and blacks in 
the image completely neutral.

Since the necessary adjustments are made to the Lift and Gain parameters in the 
Advanced tab, the main Shadow, Midtone, Highlight, and Curves controls remain 
unused and are still available to you for further adjustment of the image.

Where Do I Read About Copying, Saving, and Managing Grades?
For more information on switching among alternate grades, using the �Copy to� 
controls, and taking advantage of the correction and Grades bins to save and apply 
settings to other clips in your project, see Chapter 13, �Managing Corrections and 
Grades,� on page 263.
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10 Secondaries

Secondary color correction controls let you isolate a portion 
of an image and selectively adjust it without affecting the 
rest of the picture.

Once you�ve made your initial corrections using the Primary In room, the next step in 
adjusting any shot is to move on to the Secondaries room to make more targeted 
adjustments.

This chapter covers the following:

´ What Is the Secondaries Room Used For? (p. 209)
´ Where to Start? (p. 211)
´ Choosing a Region to Correct Using the HSL Qualifiers (p. 212)
´ Previews Tab (p. 219)
´ Isolating a Region Using the Vignette Controls (p. 221)
´ Adjusting the Inside and Outside of the Selection (p. 228)
´ Using the Secondary Curves (p. 229)
´ Reset Controls (p. 234)

What Is the Secondaries Room Used For?
The Secondaries room has been designed for maximum flexibility. While its central 
purpose is to facilitate targeted corrections to specific features of the image, it can be 
used for a variety of tasks.
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´ Isolating areas for targeted corrections:  This is the primary reason for the Secondaries 
room�s existence. Using a variety of techniques, you can perform functions such as 
isolating the highlights in an image to change the quality of light, target the color of 
an overly bright sweater to desaturate it without affecting the rest of the image, or 
select an actor�s face to create a post-production sunburn. Once you master the 
ability to selectively adjust portions of the image, the possibilities are endless.

´ Creating vignetting effects:  Traditionally, vignettes used for creative purposes describe 
a darkening around the edges of the image that used to be created with mattes or 
lens filters. You can create any type of vignette you need using either preset or 
custom shapes, to darken or otherwise flag areas of the image. Vignettes can be used 
to focus viewer attention by highlighting a subject in the foreground or by shading 
background features that you don�t want sticking out.

Before After

Before After
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´ Digitally relighting areas of the image:  The same feature can be used in a different way, 
drawing custom shapes to isolate regions of the image and add beams or pools of 
light where previously there were none. This can come in handy in situations where 
the lighting is a bit flat, and you want to add some interest to a feature in the scene.

´ Making modifications changing the Primary In correction:  A somewhat unconventional 
use of the Secondaries room is to apply an additional correction to the entire image 
on top of the original correction you made with the Primary In room. By not using 
any of the secondary qualifiers, adjustments made with the color balance, contrast, 
and saturation controls affect the entire image just as they do in the Primary In room. 
You can use this to keep adjustments for stylized effects separate from the baseline 
corrections you�re making in the Primary In room. For more information on this type 
of workflow, see �Using the Primary, Secondary, and Color FX Rooms Together to 
Manage Each Shot�s Corrections� on page 281.

Where to Start?
The process of secondary color correction is pretty straightforward and involves the 
following steps.

Step 1:  Isolate the region of the image you need to adjust
There are three basic methods you can use to isolate, or qualify, features or areas within 
an image in the Secondaries room:
´ Key on a range of color, saturation, or brightness.
´ Use a shape as a mask.
´ Use one of the secondary curves to selectively adjust a portion of the spectrum.
All these methods are covered in this chapter. Once you�ve selected a region of the 
image to work on, the Control pop-up menu lets you apply separate operations to the 
inside and outside of the selection.

Before After
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Step 2:  Make color balance, contrast, and saturation adjustments
After you�ve qualified an area for correction, you can use the same color balance 
controls, primary contrast sliders, saturation and Lift/Gain/Gamma parameters in the 
Basic tab, as well as the RGB parameters in the Advanced tab that are available in 
the Primary In room. For more information about these controls, see Chapter 9, 
�Primary In,� on page 163.

Note:  There is one additional correction parameter available in the Secondaries room 
that�s not available in the Primary In and Out rooms, and that is the Global Hue 
parameter. Using Global Hue, you can rotate the hue of every single color in the image 
at once. Unlike the other parameters in the Secondaries tab, Global Hue affects every 
pixel of the image, and is not limited by the HSL qualifiers or the Vignette controls.

Step 3:  Move to the next of the eight available tabs to make more corrections
Once you�ve completed the correction at hand, you can move on to the next secondary 
operation you need to perform. The Secondaries room supports up to eight separate 
secondary operations (although you may only have seven if you�re in single-display mode).

In the next few sections, you�ll learn how to isolate areas of the image in different ways.

Choosing a Region to Correct Using the HSL Qualifiers
One of the most common ways of isolating a feature for targeted correction is to use 
the HSL qualifiers (so named because they qualify part of the image for correction) to 
key on the portion you want to color correct. HSL stands for hue, saturation, and 
lightness, which are the three properties of color that together define the entire range 
of color that can be represented digitally. 

HSL qualification is often one of the fastest ways to isolate irregularly shaped subjects, 
or subjects that are moving around in the frame. However, as with any chroma or luma 
key, the subject you�re trying to isolate should have a color or level of brightness that�s 
distinct from the surrounding image. Fortunately, this is not unusual, and reddish skin 
tones, blue skies, richly saturated clothing or objects, and pools of highlights and 
shadows are often ideal subjects for secondary correction.

If you�re familiar with the limit effect controls of the Color Corrector 3-way filter in 
Final Cut Pro, you�ll find that the Secondaries room HSL controls work more or less the 
same way.
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The HSL controls work as a chroma keyer. By selecting ranges of hue, saturation, and 
lightness, you create a matte that is then used to define the region to which corrections 
are applied. Everything outside the matte remains unaffected (although you can also 
specify which portion of the matte you want to adjust, the inside or the outside).

The HSL Qualifier controls always sample image data from the original, uncorrected 
image. This means that no matter what adjustments have been made in the Primary In 
room, the original image values are actually used to pull the key. For example, even if 
you completely desaturate the image in the Primary In room, you can still pull a 
chroma key in the Secondaries room.

� Tip:  It is not necessary to use all three qualifiers when keying on a region of the image. 
Each qualifier has a checkbox and can be turned on and off individually. For example, if 
you turn off the H (hue) and S (saturation) controls, you can use the L (lightness) 
control by itself as a luma keyer. This is a powerful technique that lets you isolate areas 
of an image based solely on image brightness.

Creating Fast Secondary Keys Using the HSL Eyedropper
The Eyedropper, at the top left of the Basic tab, provides a quick and easy way to 
sample color values from images you�re correcting.

Original image HSL qualifier settings

Matte Corrected image
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To use the eyedropper to pull a secondary key:
1 Click the eyedropper.

The eyedropper becomes highlighted, and crosshairs appear superimposed over the 
image in the Preview and Broadcast monitors. You use these crosshairs to sample the 
HSL values from pixels in the image.

2 Move the mouse to position the crosshairs on a pixel with the color you want to key 
on, and click once to sample color from a single pixel.

The crosshairs disappear, and the HSL controls are adjusted to include the sampled 
values in order to create the keyed matte. In addition, the Enabled button turns on 
automatically (which turns on the effect of the secondary operation in that tab). The 
Previews tab becomes selected in the middle of the Secondaries room, showing the 
keyed matte that�s being created by the HSL qualifiers (for more information, see 
�Previews Tab� on page 219).

Once you�ve created the keyed mate, the next step is to use the color correction 
controls at the top of the Secondaries room to actually make the correction. For more 
information, see Chapter 9, �Primary In,� on page 163.
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In addition to sampling individual color values, you can also use the eyedropper to 
sample an entire range of values.

To use the eyedropper to sample a range of values:
m Click the eyedropper, then drag over the range of pixels you want to sample with the 

crosshairs. 

The HSL controls expand to include the entire range of hues, saturation, and lightness 
in the pixels you sampled. As a result, the keyed matte in the Previews tab is much 
more inclusive.

You can also use the eyedropper to expand an existing range of HSL values.

To expand the HSL selection using the eyedropper:
m Click the eyedropper, then hold the Shift key down and either click a single pixel or 

drag over a range of pixels with the crosshairs.

The crosshairs disappear, and the HSL controls are expanded to include the range of 
sampled values you dragged on to expand the keyed matte in the Previews tab.

Note:  When selecting a range of multiple HSL values, you can only select a contiguous 
range of values. You cannot, for example, exclude yellow if you�ve included both red 
and green (assuming you also need to exclude blue, as seen in the screenshot below). 
If you need to select discontiguous HSL ranges, you should use multiple secondary 
operations.

The HSL Controls
You don�t have to use the eyedropper to select a range of HSL values. You can also use 
the HSL controls at the top of the Basic tab to select specific ranges of hue, saturation, 
and lightness directly.

Each of these qualifiers can be turned on and off individually. Each qualifier that�s 
turned on contributes to the keyed matte. Turning a qualifier off means that aspect of 
color is not used.
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Each qualifier has three sets of handles, which correspond to three knobs on 
compatible control surfaces. These handles can also be manipulated directly onscreen 
using the mouse. They are:

´ Center:  A single handle defines the middle of the selected range of values.
´ Range:  An inner pair of handles to the left and right of the center handle define the 

initial range of values that contribute to the keyed matte. These are the solid white 
pixels seen in the matte.

´ Tolerance:  An outer pair of handles define a range of values that surround the range 
values to create falloff, giving a soft edge to the keyed matte. These are the lighter 
gray pixels seen in the matte.

To adjust the center point for any qualifier:
m Drag anywhere within the center of the two range handles.

Range

Center

Tolerance
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To make a symmetric adjustment to the Range handles:
m Drag the Range handles directly, or drag anywhere between the Range and Tolerance 

handles (if the tolerance is wide enough) to widen or narrow the Range.

To make an asymmetric adjustment to the Range handles:
m Hold the Shift key down and drag the handle you want to adjust, while the opposing 

handle remains fixed in place.

When you make an asymmetric adjustment, the center point also readjusts to match 
the new range.

Note:  You cannot make asymmetric adjustments using knobs on a control surface.

To adjust the Tolerance handles:
m Drag anywhere outside of the Center, Range, and Tolerance handles to widen or narrow 

the tolerance.

You can also make asymmetric adjustments to tolerance by holding the Shift key while 
dragging.
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Each Qualifier Explained
´ H (hue):  Defines the range of colors that contribute to the key. Using Hue by itself to 

define a keyed matte can yield similar results to using the Hue, Sat, and Lum 
secondary curves. Because the visible spectrum is represented by a wrap-around 
gradient, the H handles are the only ones that wrap around the ends of this control, 
allowing you to select a complete range of blue to green, when necessary.

´ S (saturation):  Defines the range of saturation that contributes to the key. Using 
saturation by itself to define a keyed matte can be effective for manually limiting 
oversaturated colors. Using saturation and hue, but excluding lightness, lets you 
manually limit specific colors throughout the image.

´ L (lightness):  Defines the range of lightness that contributes to the key. Using 
lightness by itself to define a keyed matte is an extremely powerful technique that 
lets you quickly isolate regions of the highlights, midtones, or shadows to perform 
specific adjustments such as increasing or reducing the specific lightness of shadows, 
or manipulating the color within highlights.

´ Reset button:  Resets all three qualifiers to the default state, which is an all-inclusive 
selection.

The Color Swatches
A set of six swatches underneath the HSL qualifiers let you automatically set the Hue 
qualifier to a narrow range that�s centered on one of the primary red, green, and blue, 
and secondary cyan, magenta, and yellow colors. 

The swatches can be useful when you need to quickly make a Hue selection for a 
feature in the image that corresponds to one of these colors. When you choose one of 
these swatches, the Saturation and Lightness controls remain completely unaffected.

To adjust the Hue qualifier using one of the color swatches:
m Shift-click any of the swatches.

The Hue qualifier resets itself to select the corresponding range of color.

Key Blur
The Key Blur parameter lets you apply a uniform blur to the keyed matte in order to 
soften it. This can go a long way toward making an otherwise noisy or hard-to-pull key 
usable. This parameter defaults to 0, with a maximum possible value of 8.
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Note:  You can manually set the key blur to even higher values by typing them directly 
into the Key Blur field.

One of the nice things about keying for color correction is that, unlike when keying to 
create visual effects, you don�t always have to create keyed mattes with perfect edges 
or completely solid interiors. Oftentimes an otherwise mediocre key will work perfectly 
well, especially when the adjustment is subtle, so long as the effect doesn�t call 
attention to itself. 

Also, it�s important to bear in mind that sometimes a hole in the keyed matte you�ve 
been worrying about might actually correspond to a shadow in the subject you�re 
isolating that you don�t actually want to be part of the correction.

Previews Tab
The Previews tab is a two-part display that helps to guide your adjustments while you 
use the HSL qualifiers and the vignette controls described in this chapter. Two reduced 
resolution images show you different views of the operation you�re performing.

No key blur With key blur

Check Your Secondary Keys During Playback
It�s a good idea to double-check to see how the secondary keys you pull look during 
playback. Sometimes a secondary operation that looked perfectly good while you 
were making the correction exhibits flickering at the edge or �chatter� that is the 
result of noise, or of including a range of marginal values that are just at the edge of 
the selected range (this happens frequently for �hard-to-key� features in an image). In 
these cases, additional adjustments may be necessary to eliminate the problem.

Also, secondary keys that work well in one part of a shot may not work so well a 
couple of seconds later if the lighting changes. Before moving on, it�s always a good 
idea to see how a secondary operation looks over the entire duration of a shot.
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Note:  The Matte Preview Mode and Vignette Outline only appear in the Preview display 
of the Scopes window when the Previews tab in the Secondaries room is selected.

´ Vignette previews:  The left-hand image shows you the position and size of the 
currently selected vignette shape, when enabled. When you use the Square or Circle 
vignettes, this window also contains an onscreen control you can use to move, resize, 
and soften the vignette. If you�ve selected a User Shape in the Geometry room 
instead, you�ll see a non-editable outline of that shape. More information about 
vignettes appears in the next section.

´ HSL qualifier previews:  The right-hand image shows you the matte that�s being 
generated by the HSL qualifiers. This window does not include the mask that�s 
generated by the vignette controls, nor does it display the HSL matte as it appears 
when the key blur parameter is used. (The final HSL matte as it�s modified by both 
vignetting and key blur is only visible in the Preview display when the Matte Preview 
Mode is set to Matte Only.)
The white areas of the mask indicate the parts of the image that are selected with 
the current qualification settings, that will be affected by the adjustments you make. 
The black areas of the image are the parts of the picture that remain unaffected.

´ Matte Preview Mode buttons:  These buttons control what is visible in the Preview 
display in the Scopes window. There are three modes:
´ Final Image:  Shows a preview of how the final effect looks. This is similar to the 

ordinary preview that�s displayed in the Scopes window, except that it also shows 
the vignette outline, when enabled.

´ Desaturated Preview:  The areas of the image that are selected with the current 
qualification settings appear in color, while the areas of the image that remain 
unaffected are desaturated and appear monochrome.

Matte Preview 
Mode buttons

Vignette outline

Vignette preview HSL Qualifier Matte preview
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´ Matte Only:  Shows the actual matte being used to limit the effect. This is similar to 
the image displayed in the HSL qualifier preview display, except that it shows the 
sum of the vignette mask and the HSL mask, as well as the results of the mask as 
it�s modified by the Key Blur parameter.

´ Vignette outline:  When the Vignette button is turned on, this button lets you toggle 
the vignette outline that�s displayed in the Preview window on and off.

Isolating a Region Using the Vignette Controls
The vignette controls are an extremely fast way to isolate areas of the image that are 
geometrically round or rectangular, such as the face of someone in closeup, or a 
window in the background. Vignettes are also useful for isolating subjects that are too 
hard to key using the HSL qualifiers.

On the other hand, if the subject you�re vignetting moves, you need to either keyframe 
the shape to move along with it (see Chapter 14, �Keyframing,� on page 285) or use 
motion tracking to automatically create a path for the shape to follow (for more 
information, see �Tracking Tab� on page 306).

Final image Desaturated preview

Matte only
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Vignettes can also be used to select large regions of the frame for brightening or 
darkening. One common example of this is to use a shape to surround a region of the 
image you want to draw the viewer�s attention to, switch the control pop-up menu to 
Outside, and darken the background outside of this shape using the contrast sliders to 
make the subject �pop out� more, visually.

Lastly, if the square or circle vignettes aren�t sufficient for isolating an irregularly shaped 
subject, you can create a custom User Shape in the Shapes tab of the Geometry room, 
and use that to limit the correction. You could go so far as to rotoscope (the process of 
tracing something frame by frame) complex subjects in order to create highly detailed 
adjustments that are too difficult to isolate using the HSL qualifiers.

User Shapes can only be edited and animated in the Geometry room, but the mattes 
they create can be used to isolate adjustments in any of the eight Secondaries tabs.

Vignette Controls
The vignette controls are located underneath the Previews tab. Some of these controls 
can also be manipulated using the onscreen controls in the Previews tab, above.

Before After vignette adjustment
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Note:  If you have a compatible control surface, you can also use its controls to 
customize the vignette.

´ Vignette button:  This button turns the vignette on or off for that tab.
´ Use Tracker:  If you�ve analyzed one or more motion trackers in the current project, 

you can specify which tracker, by number, to use to automatically animate the 
position of the vignette. To disassociate a vignette from the tracker�s influence, set 
this value to 0.

Note:  When Use Tracker is assigned to a tracker in your project, the position of the 
vignette (the center handle) is automatically moved to match the position of the 
keyframes along that tracker�s motion path. This immediately transforms your 
vignette, and you may have to make additional position adjustments to move the 
vignette into the correct position. This is especially true if the feature you�re 
vignetting is not the feature you tracked.

´ Shape pop-up menu:  Lets you choose a shape to use for the vignette.
´ Square:  A user customizable rectangle. You can use the onscreen controls in the 

Previews tab or the other vignette parameters listed below to modify its position 
and shape. 

´ Circle:  A user customizable oval. You can use the onscreen controls in the Previews 
tab or the other vignette parameters listed below to modify its position and shape. 

´ User Shape:  Choosing User Shape from the Shape pop-up menu automatically 
moves you to the Shapes tab of the Geometry room, where you�re ready to start 
clicking to add points to draw a custom shape to use for the vignette. When you�ve 
finished, click the Attach button, and then go back to the Secondaries room to 
make further adjustments. When you use a User Shape as the vignette, the rest of 
the vignette parameters become unavailable; you can only modify and animate 
that shape from the Shapes tab of the Geometry room. For more information, see 
�Shapes Tab� on page 298.

The following parameters are only available when you use the Square or Circle options 
in the Shape pop-up menu.

´ Angle:  Rotates the current shape. There is no onscreen control for this parameter.
´ X Center:  Adjusts the horizontal position of the shape.
´ Y Center:  Adjusts the vertical position of the shape.
´ Softness:  Blurs the edges of the shape.
´ Size:  Enlarges or shrinks the shape.
´ Aspect:  Adjusts the width-to-height ratio of the shape.
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Using the Onscreen Controls to Adjust Vignette Shapes
The X Center, Y Center, Softness, Size, and Aspect parameters can all be adjusted via on-
screen controls in the left-hand image of the Preview tab.

Note:  Although you can also view the outlines that correspond to these onscreen 
controls in the Preview display of the Scopes window when you turn the Vignette 
Outline button on, this outline has no onscreen controls that you can manipulate. You 
can only use make these adjustments in the Previews tab.

To move the vignette:
m Drag anywhere inside or outside the shape in the Previews tab to move the vignette in 

that direction.

The X Center and Y center parameters are simultaneously adjusted. Color uses the same 
coordinate system as Final Cut Pro to define position.

To resize the vignette:
m Drag any of the four corners of the vignette to resize the vignette relative to the 

opposite corner, which remains locked in position.

m Option-drag to resize the vignette relative to its center, visible as green crosshairs.

m Shift-drag to resize the vignette while locking its aspect, enlarging or reducing the 
shape without changing its width-to-height ratio.

Depending on the operation you perform, the X and Y Center, Size, and Aspect 
parameters may all be adjusted.
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To adjust the softness of the vignette:
m Middle-click and drag to blur the edges of the vignette.

This adjusts the Softness parameter. The degree of softness is visualized in the Previews 
tab with a pair of concentric circles. The inner circle shows where the edge blurring 
begins, and the outer circle shows where the edge blurring ends, along with the shape.

Using a User Shape for Vignetting
The following procedure outlines how you use the User Shape option in the Shape 
pop-up setting of the vignette controls.

1 Open the Secondaries room, click on one of the eight secondaries tabs to select which 
secondary operator to work on, and then select the Enabled and Vignette checkboxes 
to enable the vignette controls.

2 Choose User Shape from the Shape pop-up menu.

The Shapes tab of the Geometry room is immediately opened, with a new shape in the 
shapes list to the right, ready for you to edit.

Animating Vignettes
One of the most common operations is to place an oval over someone�s face and 
then either lighten the person, or darken everything else, to draw more attention to 
the subject�s face. If the subject is standing still, this is easy, but if the subject starts to 
shift around or move, you�ll need to animate the vignette using keyframes so that the 
lighting effect follows the subject. For more information on keyframing, see 
Chapter 14, �Keyframing,� on page 285.

Another option would be to use the motion tracker to automatically track the moving 
subject, and then apply the analyzed motion to the vignette. For more information, 
see �Tracking Tab� on page 306.
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3 Click in the Geometry preview area to add control points outlining the feature you 
want to isolate, then click on the first control point you created to close the shape and 
finish adding points.

The shapes you draw in the Geometry room default to B-spline shapes, which use 
control points that are unattached to the shape they create to push and pull the shape 
into place (similarly to the B-splines used by the curve controls in the Primary In and 
Out rooms). You can also change these shapes to simple polygons if you need a shape 
with hard angles rather then curves, by clicking the Polygon button in the Shapes tab.

Note:  If you�re not sure how many control points to add to create the shape you want, 
don�t hesitate to create a few more then you think you�ll need. It�s easy to edit them 
after they�re created, but you can�t add or remove control points to shapes that have 
already been created.

4 If necessary, edit the shape to better fit the feature you�re trying to isolate by dragging 
the control points to manipulate the shape.
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5 To feather the edge of the shape, increase the value of the Softness parameter.

Two additional editable shapes appear to the inside and the outside of the shape you 
drew. The inner shape shows where the feathering begins, while the outer shape 
shows the very edge of the feathered shape. If necessary, each border can be 
independently adjusted.

6 As an optional organizational step, you can type an identifying name into the Shape 
Name field, and press Enter to accept the change.

7 Click Attach, at the top of the Shapes tab, to attach the shape you�ve just created to the 
tab of the Secondary room you were just in (the number of the secondary tab should 
be displayed in the Current Secondary field at the top of the Shapes tab).

8 If necessary, you can also add keyframes or motion tracking to animate the shape to 
match the motion of the camera or subject, so the shape you created matches the 
action of the shot.

9 When you�ve finished with the shape, open the Secondaries room.
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You�ll see the shape you created within the vignette area of the Previews tab. At this 
point, the matte that�s created by the shape can be used to limit the corrections you 
make, as with any other secondary matte.

When you use a User Shape, the Vignette controls in the secondary tab to which it�s 
assigned become disabled. If at any point you need to edit the shape, you must do so 
in the Geometry room; the secondary corrections that use that shape will automatically 
update to reflect your changes.

Using Secondary Keying and Vignettes Together
When you turn on the vignette controls while also using the HSL qualifiers to create a 
secondary key, the vignette limits the matte that�s created by the key. This can be 
extremely helpful when the best keyed matte you can produce to isolate a feature in 
the frame results in unwanted selections in the background that you can�t eliminate 
without reducing the quality of the matte. In this case, you can use the vignette as a 
garbage matte, to eliminate parts of the keyed matte that fall outside the vignette 
shape.

Adjusting the Inside and Outside of the Selection
You choose whether the color, contrast, and saturation controls affect the inside or the 
outside of the isolated feature using the Control pop-up menu. One of the most 
powerful features of the Secondaries room is the ability to apply separate corrections 
to the inside and outside of a secondary matte in the same tab. This means that each of 
the eight secondary tabs can actually hold two separate corrections.

Whenever you choose another region to work on, the controls update to reflect 
those settings.

The Control pop-up menu also provides additional commands for modifying these 
settings.
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´ Inside:  The default setting. When set to Inside, all adjustments you make affect the 
interior of the secondary matte (the area in white, when looking at the mask itself ).

´ Outside:  When set to Outside, all adjustments you make in that tab affect the 
exterior of the secondary matte (the area in black). Making a darkening adjustment 
to the outside of a softly feathered circle matte that surrounds the entire frame is 
one way of creating a traditional vignette effect.

´ Copy Inside to Outside:  Copies the correction that�s currently applied to the inside of 
the matte to the outside as well. This is a handy operation if you want to copy the 
same correction to the outside as a prelude to making a small change, so that the 
difference between the corrections applied to the inside and the outside is not so 
large.

´ Copy Outside to Inside:  Copies the correction that�s applied to the outside to the 
inside.

´ Swap:  Switches the corrections that are applied to the inside and outside of the 
secondary matte, so that they�re reversed.

Using the Secondary Curves
The secondary curves are a deceptively powerful set of controls that allow you to make 
specific adjustments to the hue, saturation, and luminance of an image based solely on 
regions of hue that you specify using control points on a curve.

Before inside adjustment After

Before outside adjustment After
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Important:  Curves cannot be animated with keyframes, although just about every 
other parameter in the Secondaries room can be.

These curves work much differently than the curves controls of the Primary In room. 
Each of the secondary curve controls defaults to a flat horizontal line running halfway 
through the graph area.

The visible spectrum is represented along the surface of the curve by a wrap-around 
gradient, the ends of which wrap around to the other side of the curve. The control 
points at the left and right of this curve are linked, so that moving one moves the 
other, to ensure a smooth transition if you make any adjustments to the red.

Adding points to the surface of this curve lets you define regions of hue that you want 
to adjust. Raising the curve in these regions increases the value of the particular aspect 
of color that�s modified by a specific curve, while lowering the curve decreases the value.
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For example, if you add four control points to the Saturation curve to lower the green-
through-blue range of the curve, you can smoothly desaturate everything that�s blue 
and green throughout the frame, while leaving all other colors intact.

One of the nicest aspects of these controls is that they allow for extremely specific 
adjustments to narrow or wide areas of color, with exceptionally smooth transitions 
from the corrected to the uncorrected areas of the image. In many instances, the 
results may be smoother than might be achievable with the HSL qualifiers.

Another key advantage these controls have over the HSL qualifiers is that you can 
make simultaneous adjustments to discontiguous ranges of hue. In other words, you 
can boost or lower values in the red, green, and blue areas of an image while 
minimizing the effect of this adjustment on the yellow, cyan, and magenta portions of 
the image.

Before After

Sat curve adjustment
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The secondary curves use B-Splines, just like the primary curve controls. In fact, you 
add and edit control points on the secondary curves in exactly the same way. For more 
information, see �Editing Control Points and B-Splines� on page 191.

Important:  The adjustments that are made using the secondary curves always affect 
the keyframed hues throughout the entire frame, and are not limited with the Vignette 
or HSL controls.

Hue Curve Tab
When you raise or lower part of the secondary hue curve, you make a hue adjustment 
similar to that you make when you use the Global Hue control, except that you only 
rotate the hue value for the selected range of hue specified by the curve. Raising the 
curve shifts the values toward red, while lowering the curve shifts the values toward blue.

This control can be valuable for making narrow, shallow adjustments to the reddish/
orange section of the spectrum that affects skin tones, in order to quickly and smoothly 
add or remove warmth.

Before

Hue curve adjustment

After
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Sat Curve Tab
Raising the saturation curve increases the saturation in that portion of the spectrum, 
while lowering it decreases the saturation. This is a powerful tool for creating stylized 
looks which enhance or subdue specific colors throughout the frame.

Before

Sat curve adjustment

After
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Lum Curve Tab
Raising the luminance curve lightens the colors in that portion of the spectrum, while 
lowering it darkens them. This is a good tool to use when you need to make contrast 
adjustments to specific regions of color.

Reset Controls
The Secondaries room has two reset buttons.
´ Reset Secondary button:  Resets only the currently open secondary tab.
´ Reset All Secondaries button:  Resets every secondary tab in the Secondaries room. 

Use this button with care.

Before

Lum curve adjustment

After
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11 Color FX

When the primary and secondary color correction controls 
aren�t enough to achieve the look you need, Color FX lets you 
create sophisticated effects using a node-based interface.

The Color FX room is a node-based effects environment. It�s been designed as an open-
ended toolkit that you can use to create your own custom looks by processing an 
image with combinations of operations that take the form of nodes. Each node is an 
individual image processing operation, and by connecting these nodes into 
combinations, called node trees, you can create sophisticated effects of greater and 
greater complexity.

This chapter covers the following:

´ The Color FX Interface (p. 235)
´ How to Make Color FX (p. 236)
´ Creating and Connecting Nodes (p. 238)
´ Adjusting Node Parameters (p. 239)
´ Bypassing Nodes (p. 241)
´ Creating Effects in the Color FX Room (p. 242)
´ Using Color FX with Interlaced Shots (p. 247)
´ Saving Favorite Effects in the Color FX Bin (p. 248)
´ Node Reference Guide (p. 249)

The Color FX Interface
The Color FX room is divided into four main areas:
´ Node List:  A list at the left of the Color FX room that contains every image processing 

operation that you can add. Some of these nodes are single input, performing that 
operation to whatever image is input into them, while others are multi-input, taking 
multiple versions of the image and combining them using different methods. All 
nodes are alphabetically organized.



236 Chapter 11    Color FX

´ Node View:  The Node View, at the center of the Color FX room, is the area where 
nodes that you create appear and are connected together and arranged into the 
node trees that create the effect.

´ Parameters tab:  When you select a node in the Node View, its parameters appear in 
this tab so that you can adjust and customize them.

´ Color FX Bin:  This bin works similarly to the correction and Grades bins, giving you a 
way of saving effects that you create for future use.

How to Make Color FX
The Color FX room is not a compositing environment in which you combine multiple 
images together. The only image you can bring into this room for processing is that of 
the current shot.

How Node Trees Work
In the Color image processing pipeline, the Color FX room processes the image as it 
appears after whatever corrections have been applied in the Primary In and Secondaries 
rooms. Unattached node inputs automatically connect to the state of the image as it�s 
affected by the Primary In and Secondaries rooms. This is how each node tree begins, 
with an empty input that�s automatically connected to the corrected image.

Note:  The sole exception to this is the Color node, which generates a frame of solid 
color that you can use with multi-input math nodes to tint an image in different ways.

To perform more operations on an image, you simply add more nodes, connecting the 
outputs of previously added nodes to the inputs of new nodes using noodles.
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You can think of a node tree as a waterfall of image processing data. Image processing 
operations begin at the top, and cascade down, from node to node. Each node exerts 
its effect on the image that�s output from the node above it, until the bottom is 
reached, at which point the image is at its final state.

The very last node in any node tree must be the Output node. This is the node that 
sends the image that�s been processed by the Color FX room back into the Color image 
processing pipeline. If there is no Output node, or if the Output node is disconnected, 
then the node tree will have no effect on that shot, and its effect will not be rendered 
by the Render Queue.

Note:  A CFX bar will only appear in the grades track for clips with connected Output 
nodes.

Node Inputs and Outputs
Single input nodes take the image and perform an operation upon it. Single input 
nodes may only process one incoming image at a time, and so you can only connect a 
single noodle to any one input.

Multi-input nodes are designed to combine multiple variations of the image in 
different ways, in order to produce a single combined effect. These nodes provide 
multiple inputs so that you can connect multiple noodles.



238 Chapter 11    Color FX

Any node�s output, on the other hand, can be connected to multiple nodes in order to 
feed duplicate versions of the image as it appears at that point in the tree to multiple 
operations.

Creating and Connecting Nodes
In this section, you�ll learn the methods used to add, delete, and arrange nodes to a 
tree, to create any effect.

To add a node to the Node View, do one of the following:
m Double-click any node in the node list.

m Select a node from the node list, then click Add.

m Drag a node from the node list into the node view.

New nodes always appear disconnected in the Node View.

To delete one or more nodes from the Node View:
m Select one or more nodes in the Node View, then press Delete or Forward Delete.

The node disappears, and any noodles that were connected to it are disconnected.

To connect the output of one node to the input of another:
m Drag a noodle from the output of one node to the input of another.

Noodles are green while they�re being created, but turn gray once they�re connected.
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Note:  When you position the pointer over any node�s input, a small tooltip appears to 
show you its name.

If you want to eliminate the effect a node is having, you can toggle its Bypass button, 
at the top of the Parameters tab.

To disconnect a node from the one above it:
m Drag a noodle from the input of the node you want to disconnect to any empty area of 

the Node View.

When you�re working on large node trees, it pays to keep them organized so that their 
operation is clear.

To rearrange nodes in the Node View, do one of the following:
m Drag a single node in any direction.

m Drag a selection box over a group of nodes, then drag any of the selected nodes into 
any direction to move them all together.

Adjusting Node Parameters
The operation of most nodes can be customized using parameters that vary from node 
to node, depending on a node�s function. All node parameters appear in the 
Parameters tab, to the right of the Color FX room.

To show any node�s parameters in the Parameters tab:
m Click once on the node you want to edit.
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Selected nodes appear highlighted in cyan, and if that node has any parameters, they�ll 
appear to the right, ready for editing. You can edit node parameters the same way you 
edit parameters in any other room.

You can also choose the point in a node tree at which you want to view the image.

To show the image being processed at any node in the Node View:
m Double-click the node you want to view.

The currently viewed node appears highlighted in yellow, and the image as it appears 
at that node in the tree appears in the Preview and Broadcast displays.

Note:  Because double-clicking a node loads its image and opens its parameters in the 
Parameters tab, it appears with a blue outline as well.

When you�re creating multi-node effects, it�s often valuable to view a node that appears 
at the bottom of the node tree, while you�re adjusting a node that�s farther up the tree. 
This way you can adjust any parameter while viewing its effect on the entire tree�s 
operation.

In the following example, a high-contrast gauzy look is created with a series of nodes 
consisting of the B&W, Curve, and Blur nodes on one side (to create a gauzy overlay), 
and a Bleach Bypass on the other (providing high contrast), with both sides connected 
to a Multiply Node to create the gauzy combination. 
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As you fine-tune this effect, you�ll want to adjust the amount the black and white 
image contributes to the final effect by adjusting the Curve node, but you need to view 
the output of the Multiply node in order to see how far to make the adjustment. In this 
case, you�ll double-click the Multiply node so that it becomes the viewed node 
(highlighted in yellow).

Then, you�ll click the Curve node once to load its parameters into the Parameters tab 
(the node becomes highlighted in cyan).

Bypassing Nodes
Each node has a Bypass button that appears at the top of its list of parameters. Click 
Bypass to turn off the effect that node has on the tree without deleting the node from 
the Node View.
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Bypassed nodes are outlined with an orange dotted line.

If you want to suspend the effect of an entire node tree without deleting it or 
individually turning on each node�s Bypass button, you must disconnect the Output 
node entirely.

Creating Effects in the Color FX Room
This section outlines some of the most common operations you�ll perform in the Color 
FX room.

Using Single Input Nodes
The simplest use of this room is to apply one or two single-input nodes to create a 
stylized effect. In this case, all you need to do is add the nodes you want to use, 
connect them together in the order in which you want them applied, and then add an 
Output node to the very end.
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In the following example, a Bleach Bypass node (which alters the saturation and 
contrast of an image to simulate a chemical film process) is followed by a Curve node 
(to further alter image contrast), which is followed by the Output node that must be 
added to the end of all node trees.

Using Layering Nodes
A more sophisticated use of nodes is to use multi-input nodes to combine two or more 
separately processed versions of the image for a combined effect.

In one of the simplest examples, you can tint an image by attaching a Color node 
(which generates a user definable color) to one input of a Multiply layering node.



244 Chapter 11    Color FX

This multiplies the color with the corrected image (remember, disconnected inputs 
always link to the corrected image data). Because of the way image multiplication 
works, this tints the lightest areas of the image, while progressively darker areas are less 
tinted, and the black areas stay black.

In a slightly more complicated example, the image is processed using three nodes: a 
Duotone node (which desaturates the image and remaps black and white to two 
customizable colors), a Curve node (to darken the midtones), and a Blur node. The 
result is connected to one input of an Add node (with both bias parameters set to 1).

The Duotone, Curve, and Blur nodes tint, darken, and blur the image prior to adding it 
to the corrected image (coming in via input 2), and the result is a diffusion effect with 
hot, glowing highlights.
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Math Layering Nodes Explained
The layering nodes shown in the previous example use simple math to combine two 
differently modified versions of the image together. These mathematical operations 
rely on the following numerical method of representing tonality in each of the three 
color channels of an image:
´ Black = 0 (so black for RGB = 0, 0, 0)
´ Midtone values in each channel are fractional, from .00001 through .999999
´ White = 1 (so white for RGB = 1, 1, 1)

Bear these values in mind when you read the following sections.

Add
The pixels from each input image are added together. Black pixels have a value of 0, so 
black added to any other color results in no change to the image. All other values are 
raised by the sum of both values. The order in which the inputs are connected doesn�t 
matter.

Add operations are particularly well suited to creating aggressive glowing effects, 
because they tend to raise levels very quickly depending on the input images. Bear in 
mind that the best way of controlling which areas of the image are being affected 
when using an Add operation is to aggressively control the contrast of one of the input 
images. The darker an area is, the less effect it will have.

Note:  By default, the Bias parameters of the Add node divide each input image�s values 
by half before adding them together. If the results are not as vivid as you were hoping 
for, change the Source 1 and Source 2 Bias parameters to 1.

Difference
The pixels from the image that�s connected to Source 1 are subtracted from the pixels 
from the image that�s connected to Source 2. Black pixels have a value of 0, so any 
color minus black results in no change to the Source 1 image. The order in which the 
inputs are connected matters.

This node is useful for darkening the Source 1 image based on the brightness of the 
Source 2 image.

Multiply
The pixels from each input image are multiplied together. White pixels have a value of 
1, so white multiplied with any other color results in no change to the other image. 
However, when black (0) is multiplied with any other color, the result is black.

When multiplying two images, the darkest parts of the images remain unaffected, 
while the lightest parts of the image are the most affected. This is useful for tinting 
operations, as seen previously, as well as for operations where you want to combine 
the darkest portions of two images.
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Isolating Portions of an Image
Another common method of creating a layered effect is to use a grayscale matte to 
control where in an image two inputs are added together. The Alpha Blend node has 
three inputs that work together to create exactly this effect.

This node blends the Source 2 input to the Source 1 input in all the areas where the 
Source 3 Alpha input image is white. Where the Alpha input image is black, only the 
Source 1 input is shown.

Any grayscale image can be used to create a matte that you can connect to the Alpha 
input, for a variety of effects. In the following example, a Curve node is used to 
manipulate the contrast of an image so that an Edge Detector node can better isolate 
the edges to create a grayscale matte, a blur node is used to soften the result, and an 
invert node is used to reverse the black and white areas of the matte so that the edges 
of the face become the areas of the matte that are transparent, or not to be adjusted.
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This matte is connected to the Alpha input of the Alpha Blend node (the third input). A 
blur node is then connected to the Source 2 input. 

The Blur node blurs the corrected image, but the matte image that�s connected to the 
alpha input limits its effect to the areas of the image that don�t include the image detail 
around the edges that were isolated using the Edge Detector node.

As you can see, the image that�s connected to the Alpha input of the Alpha Blend 
mode limits the way the Source 1 and Source 2 inputs are combined. This is but one 
example of the power of the Alpha Blend node. You can use this node to limit many 
different effects.

Using Color FX with Interlaced Shots
One of the limitations of the Color FX room is that many effects need to be specially 
assembled when you�re working on interlaced video.

When you�re creating an effect for an interlaced shot, you need to separate each field at 
the beginning of the node tree with two Deinterlace nodes, one set to Even and one 
set to Odd. Once that�s done, you need to process each individual field using identical 
node trees.
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When you�re finished with the effect, you need to reassemble the fields into frames 
using the Interlace node, connecting the Even branch of the node tree to the Even 
input on the left and the Odd branch of the node tree to the Odd input on the right. 
The Output node is attached to the Interlace node, and you�re finished.

If you don�t process each field separately, you may encounter unexpected image 
artifacts, especially when using filtering and transform nodes such as Blur, Sharpen, 
Stretch, and Translate.

Saving Favorite Effects in the Color FX Bin
When you�ve created a Color FX effect you really like, you can save it for future use 
using the Color FX bin. This bin works identically to correction bins in every other room.

To save an effect in the Color FX room:
1 Move the playhead to a shot with a node tree you want to save.

2 Type a name for the effect into the File field underneath the bin (this step is optional, 
but recommended).

3 Click Save.
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The effect is saved with a thumbnail taken from the shot it was saved from. Entering a 
custom name is optional, but recommended, to help you keep track of all your 
corrections. If you don�t enter a name, then saved corrections (and grades) are 
automatically named using the following method.

To apply a saved effect or grade to a single shot:
1 Move the playhead to the shot you want to apply the effect to.

2 Do one of the following:

´ Double-click the effect you want to apply.
´ Select an effect, and click the Load button underneath the bin.
´ Drag the effect onto the shot you want to apply it to.

The selected effect is applied to the shot at the position of the playhead. You can also 
apply a saved correction to multiple shots.

To apply a saved effect to multiple shots:
1 Select all of the shots you want to apply the correction to in the Timeline.

2 Do one of the following:

´ Double-click the effect in the bin.
´ Select a saved effect, and click the Load button underneath the bin.

The effect is then applied to all selected shots in the Timeline.

For more information on saving and managing corrections, see Chapter 13, �Managing 
Corrections and Grades,� on page 263.

Node Reference Guide
This section contains a brief description of each node that appears in the node list.

Layer Nodes
The following nodes have multiple inputs, and are used to combine two or more 
differently processed versions of the corrected image in different ways.

Add
Mathematically adds each pixel from the two input images together. Add operations 
are particularly well suited to creating aggressive glowing effects, because they tend to 
raise levels very quickly depending on the input images. Bear in mind that the best way 
of controlling which areas of the image are being affected when using an Add 
operation is to aggressively control the contrast of one of the input images. The darker 
an area is, the less effect it will have. 
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The order in which the inputs are connected does not matter. Add has two parameters.

´ Source 1 Bias:  Controls how much of the Source 1 image is added to create the final 
result by multiplying the value in each channel by the specified value. Defaults to 0.5.

´ Source 2 Bias:  Controls how much of the Source 2 image is added to create the final 
result by multiplying the value in each channel by the specified value. Defaults to 0.5.

Alpha Blend
This node blends (similar to the Blend node) the Source 2 input to the Source 1 input in 
all the areas where the Source 3 Alpha input image is white. Where the Alpha input 
image is black, only the Source 1 input is shown. The order in which the inputs are 
connected affects the output.

Blend
This node mixes two inputs together based on the Blend parameter. The order in which 
the inputs are connected does not matter. Blend has one parameter:
´ Blend:  When set to 0, only Input 1 is output. When set to .5, Input 1 and Input 2 are 

blended together equally and output. When set to 1, only Input 2 is output.

Darken
Emphasizes the darkest parts of each input. Overlapping pixels from each image are 
compared, and the darkest pixel is preserved. Areas of white from either input result in 
no effect. The order in which the inputs are connected does not matter.

Difference
The pixels from the image that�s connected to Source 1 are subtracted from the pixels 
from the image that�s connected to Source 2. Black pixels have a value of 0, so any 
color minus black results in no change to the image from Source 1. Since this is 
subtraction, the order in which the inputs are connected matters.

Interlace
The images connected to each input are interlaced. The left input is for the Even field, 
the right input is for the Odd field. This node is used at the end of node trees that 
begin with Deinterlace nodes to process effects for projects using interlaced media.

Lighten
Lighten emphasizes the lightest parts of each input. Overlapping pixels from each 
image are compared, and the lightest pixel is preserved. The order in which the inputs 
are connected does not matter.

Multiply
The pixels from each input image are multiplied together. White pixels have a value of 
1, so white multiplied with any other color results in no change to the other image. 
However, when black (0) is multiplied with any other color, the result is black.
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When multiplying two images, the darkest parts of the images remain unaffected, 
while the lightest parts of the image are the most affected. This is useful for tinting 
operations, as seen previously, as well as for operations where you want to combine 
the darkest portions of two images.

RGB Merge
The three inputs are used to insert individual channels into the red, green, and blue 
color channels. You can split the three color channels apart using the RGB Split node, 
process each grayscale channel individually, and then reassemble them into a color 
image again with this node.

Effects Nodes
The following nodes have a single input, and are used to apply a single correction or 
effect to the image.

B&W
Desaturates the image to produce a grayscale, monochrome image consisting of only 
the Luma component.

Bleach Bypass
Raises the contrast and desaturates the image. Simulates laboratory silver-retention 
processes used to raise image contrast in film by skipping the bleaching stage of film 
development, leaving exposed silver grains on the negative which boost contrast, 
increase grain, and reduce saturation.

Blur
Blurs the image. Blur has one parameter:
´ Spread:  The amount of blur. Can be set to a value from 0 (no blur) to 40 (maximum 

blur).

Clamp
Two parameters clip the minimum and maximum values in the image. Clamp has two 
parameters:
´ Min:  The minimum level in the image. Any levels below this value are set to this 

value.
´ Max:  The maximum level in the image. Any levels above this value are set to this 

value.

Curve
A curve that affects image contrast, similar to the Luma curve in the Primary In room. 
Selecting this node reveals a curve control in the Parameters tab that works identically 
to those found in the Primary In room.
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Duotone
Desaturates the image, mapping the black and white points of the image to two user 
customizable colors to create tinted images with dual tints from white to black. 
Duotone has two parameters:
´ Light Color:  The color that the white point is mapped to.
´ Dark Color:  The color that the black point is mapped to.

Edge Detector
A convolution filter that boosts image contrast in such a way as to reduce the image to 
the darkest outlines that appear throughout. Edge Detector has two parameters:
´ B&W:  Desaturates the resulting image. Useful when using this node to generate 

mattes.
´ Scale:  Adjusts the white point. Lowering scale helps increase contrast and crush 

midtone values to emphasize the outlines.
´ Bias:  Adjusts overall contrast. Lowering Bias increases contrast, while raising it lowers 

contrast.

Exposure
Raises the highlights or crushes the shadows, depending on whether you raise or lower 
the Exposure parameter. This node has one parameter:
´ Exposure:  Raising this parameter raises the highlights while keeping the black point 

pinned. Setting this parameter to 0 results in no change. Lowering this parameter 
scales the image levels down, crushing the shadows while lowering the highlights by 
a less severe amount.

Film Grain
Adds noise to the darker portions of an image to simulate film grain or video noise due 
to underexposure. Highlights in the image are unaffected. This node is useful if you 
have to match a clean, well-exposed insert shot into a scene that�s noisy due to 
underexposure. Also useful for creating a distressed film look. This node has three 
parameters:
´ Grain Intensity:  Makes the noise more visible by raising its contrast ratio (inserting 

both light and dark pixels of noise) as well as the saturation of the noise.
´ Grain Size:  Increases the size of each �grain� of noise that�s added. Bear in mind that 

the size of the film grain is relative to the resolution of your project. Film grain of a 
particular size applied to a standard definition shot will appear �grainier� than the 
same-sized grain applied to a high definition shot.

´ Monochrome:  Turning this button on results in the creation of monochrome, or 
grayscale, noise, with no color.
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Film Look
An �all-in-one� film look node. Combines the Film Grain operation described above with 
an �s-curve� exposure adjustment that slightly crushes the shadows and boosts the 
highlights. Contrast in the midtones is stretched, but the distribution of the midtones 
remains centered, so there�s no overall lightening or darkening. This node has three 
parameters:
´ Grain Intensity:  Makes the noise more visible by raising its contrast ratio (inserting 

both light and dark pixels of noise) as well as the saturation of the noise.
´ Grain Size:  Increases the size of each �grain� of noise that�s added. Bear in mind that 

the size of the film grain is relative to the resolution of your project. Film grain of a 
particular size applied to a standard definition shot will appear �grainier� than the 
same-sized grain applied to a high definition shot.

´ Contrast:  Makes an �s-curve� adjustment to contrast, which crushes the shadows and 
boosts the highlights, while leaving the midtones centered. A value of 0 preserves 
the original contrast of the corrected image, while a value of 1 is the maximum 
contrast expansion that is possible with this node.

Gain
Adjusts contrast by raising or lowering the white point of the image while leaving the 
black point pinned in place, and scaling the midtones between the new white point 
and the black point. This node has four parameters:
´ Gain:  Adjusts the red, green, and blue channels simultaneously, for an overall change 

to image highlights and midtones.
´ Red Gain:  Adjusts the red channel only, enabling color correction based on a white 

point adjustment for that channel.
´ Green Gain:  Adjusts the green channel only, enabling color correction based on a 

white point adjustment for that channel.
´ Blue Gain:  Adjusts the blue channel only, enabling color correction based on a white 

point adjustment for that channel.

Gamma
Makes a standard gamma adjustment, which makes a nonlinear adjustment to raise or 
lower the distribution of midtones of the image while leaving the black and white 
points pinned in place. This is a power function, (f(x) = xa). This node has four 
parameters:
´ Gamma:  Adjusts the red, green, and blue channels simultaneously, for an overall 

change to image midtones.
´ Red Gamma:  Adjusts the red channel only, enabling color correction based on a 

gamma adjustment for that channel.
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´ Green Gamma:  Adjusts the green channel only, enabling color correction based on a 
gamma adjustment for that channel.

´ Blue Gamma:  Adjusts the blue channel only, enabling color correction based on a 
gamma adjustment for that channel.

Grain Reduction
Reduces grain and noise in an image by averaging adjacent pixels in that frame 
according to the values specified in the Master, Red, Green, and Blue Scale parameters. 
Edge detection can be used to preserve sharpness in areas of high-contrast detail via 
the Edge Retention parameter, and a sharpening operation can be applied after grain 
reduction to boost overall detail. Because some shots have noise that�s more apparent 
in specific color channels, you can make independent adjustments to each channel. 
This node has six parameters:
´ Master Scale:  Averages the adjacent pixels of every color channel in the image to 

reduce grain and noise, at the expense of a certain amount of image softness.
´ Red Scale:  Selectively averages pixels in the red channel.
´ Green Scale:  Selectively averages pixels in the green channel.
´ Blue Scale:  Selectively averages pixels in the blue channel.
´ Edge Retention:  Uses edge detection to isolate areas of high-contrast detail in the 

image (such as hair, eyes, and lips in an actor�s close-up), and excludes those areas of 
the image from the grain reduction operation to preserve the most valuable image 
detail from softening. Higher values preserve more of the original image in these 
areas.

´ Post Sharpening:  Applies a sharpening convolution filter after the grain reduction 
operation to try and restore some lost detail once the grain has been softened. Use 
this parameter sparingly�if you set this too high, you�ll end up reintroducing the 
grain you�re trying to reduce.

Hue
Rotates the hue of every pixel in the entire image. This node has one parameter:
´ Shift:  The amount by which you want to shift the hue. This is not done in degrees, as 

is represented in the Vectorscope. Instead, you use a value from �1 to 1, where �1, 0, 
and 1 place the hue at the original values.

Invert
Inverts the image. Useful for creating �positives� from image negative. Also useful for 
reversing a grayscale image that you�re using as a matte with the Alpha Blend node, to 
reverse the portions of the matte will be solid and transparent.
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Lift
Lift uniformly lightens or darkens the entire image, altering the shadows, midtones, 
and highlights by the same amount. This node has four parameters:
´ Lift:  Adjusts the red, green, and blue channels simultaneously, for an overall change 

to image brightness.
´ Red Lift:  Adjusts the red channel only, enabling color correction based on a lift 

adjustment for that channel.
´ Green Lift:  Adjusts the green channel only, enabling color correction based on a lift 

adjustment for that channel.
´ Blue Lift:  Adjusts the blue channel only, enabling color correction based on a lift 

adjustment for that channel.

Maximum
Averages adjacent pixels together (how many is based on the Brush Size parameter), to 
produce a single, larger pixel based on the brightest value in that pixel group. Larger 
values result in flattened, almost watercolor-like versions of the image. This node is also 
useful for expanding the white areas and smoothing out grayscale images that you�re 
using as mattes. This node has one parameter:
´ Brush Size:  Defines how many pixels are averaged into a single, larger pixel. 

Extremely large values result in progressively larger, overlapping square pixels of 
uniform color, emphasizing lighter pastel-like tones in the image.

Minimum
Averages adjacent pixels together (how many is based on the Brush Size parameter), to 
produce a single, larger pixel based on the darkest value in that pixel group. Larger 
values result in flattened, darkened versions of the image. This node is also useful for 
expanding the black areas and smoothing out grayscale images that you�re using as 
mattes. This node has one parameter:
´ Brush Size:  Defines how many pixels are averaged into a single, larger pixel. 

Extremely large values result in progressively larger, overlapping square pixels of 
uniform color, emphasizing darker, muddier tones in the image.

Printer Lights
Provides Red, Green, and Blur parameters for color correction that work identically to 
the Printer Points controls in the Advanced tab of the Primary In room. For more 
information, see �Printer Points Controls� on page 205.

Saturation
Raises or lowers overall image saturation, making the image more or less colorful. This 
node has one parameter:
´ Saturation:  The default value of 1 produces no change. 0 is a completely desaturated 

image, while the maximum value of 10 produces an excessively saturated, hyper-
stylized version of the image.
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Scale RGB
Expands or contracts the overall contrast ratio of a shot, from the black point to the 
white point, centering the midpoint of this operation at a percentage of image tonality 
that you specify. This node has two parameters:
´ Scale:  The amount by which to expand or contract the overall contrast ratio in the 

shot. This is a multiplicative operation, so a value of 1 produces no change, while 
larger values increase the contrast ratio, and smaller values decrease the contrast 
ratio.

´ Center:  Specifies the percentage of image tonality upon which the expansion and 
contraction is centered, so the original image values at this percentage remain at 
that percentage. The default value of 0.5 adjusts the white and black points equally 
in both directions (the white point goes up, the black point goes down, and 
whatever values are at 50 percent remain at 50 percent). A value of 0 pins the black 
point while applying the entire adjustment to the white point, and a value of 1 pins 
the white point while applying the entire adjustment to the black point.

Sharpen
Applies a sharpen convolution filter that selectively enhances contrast in areas of image 
detail to provide the illusion of sharpness. Should be used sparingly as this operation 
also increases the sharpness of film grain and video noise. This node has one 
parameter:
´ Sharpen:  Higher values increase image detail contrast. A value of 0 does no 

sharpening.

Smooth Step
Applies a nonadjustable �s-curve� adjustment to slightly crush the blacks and boost the 
whites, leaving the black and white points pinned at 0 and 100 percent. Designed to 
emulate the exposure tendencies of film at the �toe� and �shoulder� of the image. This is 
a similar contrast adjustment to that made by the Film Look node.

Stretch
Provides separate vertical and horizontal scaling operations that let you �squeeze� and 
�stretch� the image. You can change the center pixel at which this scaling is performed. 
This node has four parameters:
´ Horizontal Center:  The pixel at which horizontal scaling is centered. The center pixel 

doesn�t move; instead, the scaling of the image is relative to this position.
´ Vertical Center:  The pixel at which vertical scaling is centered. The center pixel doesn�t 

move; instead, the scaling of the image is relative to this position.
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´ Horizontal Scale:  How much to stretch the image, horizontally. Higher values stretch 
the image outward, while lower values squeeze the image inward. The default value 
at which the image is unchanged is 1.

´ Vertical Scale:  How much to stretch the image, vertically. Higher values stretch the 
image outward, while lower values squeeze the image inward. The default value at 
which the image is unchanged is 1.

Translate
Offsets the image relative to the upper-right corner. This node has two parameters:
´ Horizontal Offset:  Moves the image left.
´ Vertical Offset:  Moves the image down.

Utility Nodes
The following nodes don�t combine images or create effects on their own. Instead, they 
output color channel information or extract matte imagery in different ways. All of 
these nodes are meant to be used in combination with other layering and effect nodes 
to create more complex interactions.

Color
Produces a frame of solid color. This can be used with different layering nodes to add 
colors to various operations. This node has one control:
´ Color:  A standard color control lets you choose the hue, saturation, and lightness of 

the color that�s generated.

Deinterlace
Removes the interlacing of a shot in one of three ways, corresponding to three buttons. 
You can use this node to either remove interlacing by blending the fields together, or 
you can use two Deinterlace nodes to separate the Even and Odd fields of an interlaced 
shot prior to processing each field separately, and reassembling them using the 
Interlace node. This node has three buttons:
´ Merge:  Outputs the blended combination of both fields.
´ Even:  Outputs only the Even field, line doubled to preserve the current resolution.
´ Odd:  Outputs only the Odd field, line doubled to preserve the current resolution.

HSL Key
An HSL keyer that outputs a grayscale matte which you can use to isolate effects using 
the Alpha Blend mode, or simply to combine with other layering nodes in different 
ways. This keyer works identically to that found in the Secondaries room. For more 
information, see �Choosing a Region to Correct Using the HSL Qualifiers� on page 212.
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Output
This must be the last node in any node tree. It outputs the effect created within the 
Color FX room to the main Color image processing pipeline for rendering. If an Output 
node is not connected to the node tree, that effect will not be rendered by the Render 
Queue.

RGB Split
Outputs the red, green, and blue color channels individually, depending on which 
button you click. Each grayscale color channel can then be independently manipulated 
with different node tree branches, before being reassembled using the RGB Merge 
node. This node has three buttons:
´ Red:  Outputs the red channel.
´ Green:  Outputs the green channel.
´ Blue:  Outputs the blue channel.

Vignette
Creates a simple square or circle vignette. This vignette appears as a color against 
grayscale preview if the Vignette node is viewed directly. When the results are viewed 
�downstream,� by viewing a different node that�s processing its output, the true 
grayscale image is seen. This node has nine parameters:
´ Use Tracker:  If you�ve analyzed one or more motion trackers in the current project, 

you can specify which tracker, by number, to use to automatically animate the 
position of the vignette. To disassociate a vignette from the tracker�s influence, set 
this value to 0.

´ Type field:  Lets you choose what shape to use for the vignette. 1 is a circle, 2 is a 
square.

´ Invert:  Click this button to make the white area black, and the black area white.
´ X Center:  Adjusts the horizontal position of the shape.
´ Y Center:  Adjusts the vertical position of the shape.
´ Size:  Enlarges or shrinks the shape.
´ Aspect:  Adjusts the width-to-height ratio of the shape.
´ Angle:  Rotates the current shape. There is no onscreen control for this parameter.
´ Softness:  Blurs the edges of the shape.
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12 Primary Out

The Primary Out room provides an additional set of controls 
for overall color correction, but it can also be used as a tool to 
trim the grades applied to a selected group of shots.

This chapter covers the different uses of the Primary Out room, which shares the same 
controls as the Primary In room. For more information about Primary color correction 
controls, see Chapter 9, �Primary In,� on page 163.

This chapter covers the following:

´ Using the Primary Out Room (p. 259)
´ Making Extra Corrections Using the Primary In Room (p. 260)
´ Understanding the Image Processing Pipeline (p. 260)
´ Using the Ceiling Controls (p. 261)

Using the Primary Out Room
The Primary Out room duplicates the controls and functionality of the Primary In room. 
This includes sharing saved corrections (the Primary In and Out rooms access the same 
saved corrections in their bins).

The Primary Out room is valuable for three main reasons:

´ It provides an extra room that you can use to make additional modifications to a 
shot�s grade, without changing the original grade in the Primary In room.

´ The Primary Out room comes after the Primary In, Secondaries, and Color FX rooms 
in the image processing pipeline, so you can apply adjustments to the overall image 
after the corrections and effects have been added in the other rooms.

´ There are three additional controls in the Primary Out Room that don�t exist in the 
Primary In room. The Ceiling parameters give you one more way to limit the color 
values in a shot to legalize or stylize them.
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Making Extra Corrections Using the Primary In Room
The Color interface was designed for flexibility. The functionality of each of the 
correction rooms overlaps broadly, and although each room has been arranged to 
optimize certain types of operations, you can choose to perform corrections using 
whichever controls you prefer.

In many cases, colorists like to split up different steps of the color correction process 
they follow among different rooms. This is detailed in �Using the Primary, Secondary, 
and Color FX Rooms Together to Manage Each Shot�s Corrections� on page 281.

Using this approach, you might perform a shot�s main correction using the Primary In 
room, use the Secondaries room for stylized �look� adjustments, and then apply one of 
your previously saved �secret sauce� Color FX room effects to give the shot its final grade.

Once your client has had the opportunity to screen the program, you�ll no doubt be 
given additional notes and feedback on your work. It�s at this time that the value of the 
Primary Out room becomes apparent.

Up until now, this room has remained unused, but because of that, it�s a great place to 
easily apply these final touches. Because you can apply these final corrections in a 
completely separate room, it�s easy to clear them if the client changes his or her mind.

Furthermore, it�s easy to use the Primary Out room to apply changes that affect an 
entire scene to multiple clips at once (sometimes referred to as trimming other grades).

To trim one or more selected grades using the Primary Out room:
1 Move the playhead to the shot you want to adjust, then click the Primary Out room.

2 Make whatever adjustments are required using the color and contrast controls.

3 Select all the shots in the Timeline that you want to apply this adjustment to. 

4 Click Copy To Selected.

The correction you�ve made in the Primary Out room of the current shot is applied to 
every shot you�ve selected.

Note:  The Copy To Selected command overwrites any previous settings in the Primary 
Out rooms, so if you need to make a different adjustment, you can simply repeat the 
procedure described above to apply it to each selected shot again.

Understanding the Image Processing Pipeline
Another use of the Primary Out room is to apply corrections to clips after the 
corrections that have been applied in each of the previous rooms.
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As the processed image makes its way from the Primary In to the Secondaries to the 
Color FX rooms, the corrections in each room are applied to the image that�s handed 
off from the previous room. Since the Color FX room is the last correction room in 
every grade, it processes the image that�s output from the Color FX room. You can take 
advantage of this to apply overall corrections to the post-processed image.

In the following example, a series of highly saturated adjustments are made in each of 
the rooms, but the Primary Out room is used to reduce the saturation of the end result, 
a correction that modifies the collective output from every other room.

Using the Ceiling Controls
Lastly, the Primary Out room has a single group of controls that aren�t found in the 
Primary In room. The Enable Clipping button in the Basic tab of the Primary Out room 
lets you enable individual ceiling values for the red, green, and blue color channels of 
the current shot.

This lets you prevent illegal broadcast values in shots to which you�re applying extreme 
Primary, Secondary, or Color FX corrections if you don�t want to turn on Broadcast Safe 
for the entire program.

Note:  If Enable Clipping and Broadcast Safe are both on, the lowest standard is applied. 

´ Enable Clipping button:  Enables the Ceiling Red/Green/Blue controls to take effect.
´ Ceiling Red:  Sets the maximum allowable chroma in the red channel. All values above 

this level will be set to this level.
´ Ceiling Green:  Sets the maximum allowable chroma in the green channel. All values 

above this level will be set to this level.
´ Ceiling Blue:  Sets the maximum allowable chroma in the blue channel. All values 

above this level will be set to this level.
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13 Managing Corrections and Grades

Color provides many tools for managing the corrections and 
grades that you�ve applied. You can work even faster by 
saving, copying, and applying corrections and grades you�ve 
already created to multiple shots at once.

There are three areas of the Color interface where you can save, organize, copy, apply, 
and otherwise manage corrections and grades: the correction bins inside each room, 
the Grades bin and the Shots browser in the Setup room, and the grade track in the 
Timeline. This chapter describes the use of all these areas of the interface in more detail.

This chapter covers the following:

´ The Difference Between Corrections and Grades (p. 263)
´ Saving and Using Corrections and Grades (p. 264)
´ Applying Saved Corrections and Grades to Shots (p. 268)
´ Managing Grades in the Timeline (p. 269)
´ Using the �Copy to� Buttons in the Primary Rooms (p. 272)
´ Using the Copy Grade and Paste Grade Memory Banks (p. 273)
´ Setting a Beauty Grade in the Timeline (p. 274)
´ Disabling All Grades (p. 274)
´ Managing Grades in the Shots Browser (p. 274)
´ Using the Primary, Secondary, and Color FX Rooms Together to Manage Each Shot�s 

Corrections (p. 281)

The Difference Between Corrections and Grades
There is a distinct difference between corrections and grades in Color. Understanding 
the difference is key to learning how to manage each set of adjustments correctly.
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Corrections are adjustments that are made within a single room. You have the option to 
save individual corrections into the bins available in the Primary In and Out, 
Secondaries, and Color FX rooms. Once saved, corrections can be applied to one or 
more shots in your project without changing the settings of any other rooms. For 
example, if there are five shots in a scene to which you want to apply a previously 
saved secondary correction, you can do so without affecting the primary corrections 
that have already been made to those shots. Each room has its own correction bins for 
saving and applying individual corrections, although the Primary In and Primary Out 
rooms share the same saved corrections.

A grade, on the other hand, encompasses multiple corrections across several rooms, 
saving every primary, secondary, and Color FX correction together as a single unit. 
when you save a group of corrections as a grade, you can apply them all together as a 
single preset. Applying a saved grade overwrites any corrections that have already 
been made to the shot or shots you�re applying it to. Saved grades are managed using 
the Grades bin, located in the Setup room.

Saving and Using Corrections and Grades
You can save any correction and grade, in order to apply one shot�s settings to others 
at a later time. Examples of the use of saved corrections and grades include:
´ Saving the finished grade of a shot in your program in order to apply it to other 

shots that are also from the same angle of coverage
´ Saving a correction to a shot from a specific problem reel of tape (for example, a reel 

with a uniformly incorrect white balance) that you�ll want to apply to every other 
shot from the same reel

´ Saving a stylistic �look� correction in the Primary, Secondaries, or Color FX room that 
you want to apply to other scenes or programs

Saving Corrections into Correction Bins
The Primary In, Secondaries, Color FX, and Primary Out rooms all have correction bins 
where you can save corrections that are specific to those rooms for future use. When 
you save corrections in any room, they�re available to every project you open in Color.

To save individual corrections into any room�s bin:
1 Move the playhead to the shot with a correction you want to save.

2 Type a name for the saved correction in the File field underneath the corrections bin 
(this step is optional).
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3 Click Save.

The correction is saved into the current room�s bin with a thumbnail of the shot it was 
saved from. 

Entering a custom name is optional, but recommended, to help you keep track of all 
your corrections. If you don�t enter a name, saved corrections (and grades) are 
automatically named using the following method:

CorrectionType.Day Month Year Hour.Minute.Second TimeZone.extension

The date and time used correspond to the exact second the correction is saved. For 
example, a saved secondary correction might have the following automatic name:

Secondary.01 May 2007 10.31.47EST.scc

Corrections from each room are saved into corresponding directories in the /Users/
username/Library/Application Support/Color directory. For more information, see �How 
Are Grades and Corrections Saved?� on page 68.

Saving Grades into the Grades Bin
Saved grades store the corrections that are applied to the Primary In, Secondaries, 
Color FX, and Primary Out rooms all at once, so there�s one more step.

To save a grade:
1 Click the Grades tab in the Setup room.

2 Move the playhead to the shot with a grade you want to save.
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3 Make the grade you want to save the currently selected grade for that shot.

4 Type a name for the saved correction into the File field underneath the corrections bin 
(this step is optional).

5 Click the Save button (in the bottom right-hand corner of the Grades bin).

The grade is saved to the Grades bin.

The grade is saved with a thumbnail from the shot it was saved from. Once you�ve 
saved a grade, deleting, organizing, and applying grades is identical to deleting, 
organizing, and applying saved corrections, covered previously.

Grades are saved to the /Users/username/Library/Application Support/Color/Grades 
directory.

Deleting Saved Corrections and Grades
You can delete saved corrections you no longer need.

To delete a saved correction or grade:
1 Select a correction in any bin.

2 Press Delete or Forward Delete.

3 When the warning dialog appears, click Yes.

The selected correction is deleted, both from Color and from disk. This is not undoable.
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Organizing Saved Corrections and Grades with Folders in Color
Saved corrections are available to every project you open. For this reason, you may find 
it useful to save your corrections into folders within each room�s bin. There are a 
number of different ways you can use folders to organize your saved corrections:
´ You can create a folder for each new project you work on, saving all the corrections 

that are specific to a particular project within the corresponding folder.
´ You can also create folders for grades that you have saved for use with any project. 

For example, you may create a library of your own stylistic �looks� that you can apply 
to instantly present your clients with different options.

Note:  You can only save corrections in a folder after that folder has been created.

To create a new folder inside a bin:
1 Click New Folder.

2 Type a name for the new folder in the New Folder dialog, then click Create.

A new folder using the name you entered is created inside the corrections bin of that 
room.

Every time you create a folder in a bin, you�re also creating a subdirectory within the 
saved correction directory for that room within the /Users/username/Library/
Application Support/Color directory.
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To save a correction or grade into a folder:
1 Move the playhead to the shot with a correction or grade you want to save.

2 Double-click a folder in the correction or Grades bin to open it.

The Directory pop-up menu updates to display the directory path in the Finder of the 
currently open folder.

3 Type a name for the saved correction or grade in the File field underneath the 
correction bin (this step is optional).

4 Click Save.

The correction or grade is saved within that folder.

Important:  There is no way of moving a saved correction into a folder once it�s been 
saved using the Color interface.

Applying Saved Corrections and Grades to Shots
Once you�ve saved a correction or grade, applying it to one or more shots in your 
project is easy.

To apply a saved correction or grade to a single shot:
1 Move the playhead to the shot you want to apply the correction to.

2 Do one of the following:

´ Double-click the correction or grade you want to apply.
´ Select a correction or grade to apply, and click the Load button underneath the bin.
´ Drag the correction or grade onto the shot you want to apply it to.

The selected grade is applied to the shot at the position of the playhead. You can also 
apply a saved correction to multiple shots.

To apply a saved correction or grade to multiple shots:
1 In the Timeline, select all of the shots you want to apply the correction to.

2 Do one of the following:

´ Double-click the correction or grade in the bin.
´ Select a saved correction or grade, and click the Load button underneath the bin.
The correction or grade is then applied to all selected shots in the Timeline.

Reorganizing Saved Corrections and Grades in the Finder
Since each correction bin simply mirrors the contents of the corresponding 
subdirectories in the /Users/username/Library/Application Support/Color directory, you 
can also use the Finder to reorganize your saved corrections and grades. For more 
information, see �Reorganizing Saved Corrections and Grades in the Finder� on page 69.
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Managing Grades in the Timeline
Each shot may have up to four alternate grades, shown with different colors in the 
grade tracks that are located underneath the video track. The currently selected grade 
for each shot is blue, while unselected grades are gray. The bars that show the 
individual corrections of rooms that have been adjusted for the currently selected 
grade are shown in other colors, underneath each shot�s grade bars.

You can use the grade and correction bars in the grade track to add, switch, and copy 
grades directly in the Timeline.

Adding and Selecting Grades Among Multiple Grades
Each shot in the Timeline can be set to use one of up to four alternate grades. Only the 
currently selected grade actually affects a shot. The other unused grades let you store 
alternate corrections and looks, so that you can experiment with different settings 
without losing the original.

By default, each shot in a project has a single primary grade applied to it, although you 
can add more at any time.

To add a new grade to a shot, do one of the following:
m Move the playhead to the shot you want to add a new grade to, then press Control-1 

through 4.

m Control-click or right-click on a grade, and choose Add New Grade from the shortcut 
menu.

If a grade corresponding to the number of the grade you entered doesn�t already exist, 
one will be created. Whenever a new grade is added, the grade track expands, and the 
new grade becomes the selected grade. New grades are clean slates, letting you begin 
working from the original state of the uncorrected shot.
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To change the selected grade:
1 Move the playhead to the shot you want to change the grade of.

2 Do one of the following:

´ Click the grade you want to switch to.
´ Press Control-1 through 4.
´ Control-click or right-click on a grade, and choose Select Grade X from the shortcut 

menu, where X is the number of the grade you�re selecting.
The shot is updated to use the newly selected grade.

Resetting Grades in the Timeline
If necessary, you can reset any of a shot�s four grades. 

To reset a grade in the Timeline:
1 Move the playhead to the shot you want to switch the grade of.

2 in the grade track of the Timeline, control-click or right-click the grade you want to 
reset to and choose Reset Grade X from the shortcut menu (where X is the number of 
the grade).

Resetting a grade clears all settings from the Primary In, Secondaries, Color FX, and 
Primary Out rooms, bringing that shot to its original state. Pan & Scan settings in the 
Geometry room are left intact.

Copying Corrections and Grades in the Timeline
You can copy individual corrections or entire grades from one shot to another in the 
Timeline.

To copy a correction from one shot to another:
m Drag a single correction bar in the grade track of the Timeline to the shot you want to 

copy it to. 

The shot you�re dragging the correction onto becomes highlighted, and after you�ve 
dropped it, the current grade for that shot appears with the same grade bar.
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Note:  When you copy individual corrections, secondary corrections overwrite other 
secondary corrections of the same number.

To copy a grade from one shot to another:
m Drag a shot�s grade bar in the grade track of the Timeline to a second shot you want to 

copy it to.

The shot you�re dragging the correction onto becomes highlighted, and after you�ve 
dropped it, every correction in the current grade for that shot is overwritten with those 
of the grade you copied.

You can also copy grades to other grades in the same clip. 

To copy a grade to another grade in the same clip:
m Drag a grade bar in the grade track of the Timeline onto another grade bar for the 

same shot.

The copied grade overwrites all previous corrections.

� Tip:  This is a great way to save a shot�s grade at a good state prior to making further 
experimental changes to it. If you don�t like the changes, you can easily switch back to 
the duplicate grade.
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Using the �Copy to� Buttons in the Primary Rooms
The �Copy to Selected� and �Copy to All� buttons in the Primary In and Primary Out 
rooms are powerful tools for applying Primary In room or Primary Out room corrections 
to other shots in your project.

To copy a primary correction to all currently selected shots in the Timeline:
1 Move the playhead to a shot with a grade you want to copy to other shots in your 

program.

2 Set the grade used by that shot to the one you want to copy.

3 Select all the shots in the Timeline you want to copy the current grade to, being careful 
not to move the playhead to another shot.

4 Click �Copy to Selected.�

The grade at the current position of the playhead is copied to all selected shots.

You can also choose to copy the currently selected grade to every single shot in your 
program.
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To copy a primary correction to every single shot in the Timeline:
1 Move the playhead to a shot with a grade you want to copy to other shots in your 

program.

2 Set the grade used by that shot to the one you want to copy.

3 Click �Copy to All.�

The grade at the current position of the playhead is copied to every shot in your 
program.

Note:  The Secondaries and Color FX rooms don�t have �Copy to Selected� or �Copy to 
All� buttons. However, you can accomplish the same task by saving a Secondaries or 
Color FX correction to the Secondaries room bin, then selecting the shots you want to 
apply that correction to, and dragging the correction onto one of the selected shots. For 
more information, see �Applying Saved Corrections and Grades to Shots� on page 268.

Using the Copy Grade and Paste Grade Memory Banks
You can use the Copy Grade and Paste Grade commands to copy grades from one shot 
and paste them to others. Five memory banks are available for copying and pasting 
grades. This means that you can copy up to five different grades�with one in each 
memory bank�and then paste different grades into different shots as necessary.

To copy a grade into one of the five memory banks:
1 Move the playhead to the shot you want to copy a grade from.

2 Make the grade you want to copy the currently selected grade.

3 Choose Grade > Copy Grade > Mem-Bank 1 through 5 (Shift-Control-Option-1 through 5).

Once you�ve copied a grade into one of the available memory banks, you can paste it.

To paste a grade from one of the five memory banks:
1 Move the playhead to the shot you want to copy a grade to.

2 Set the currently selected grade to the grade you want to paste into.

3 Choose Grade > Copy Grade > Mem-Bank 1 through 5 (Shift-Option-1 through 5).

The grade is applied to the shot at the position of the playhead.
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Setting a Beauty Grade in the Timeline
When you�ve set up a project with multiple grades for each shot, it may become 
difficult to keep track of the grade you like best for any given shot. Marking a 
particular grade as the beauty grade lets you keep track of the currently preferred 
grade for each shot.

The beauty grade setting is only a visual marker, intended for reference purposes only. 
The beauty grade does not have to be the currently selected grade.

To mark a grade as the beauty grade:
1 Move the playhead to the shot you want to set the beauty grade for.

2 Select the grade you want to set as the beauty grade.

3 Choose Grade > Set Beauty Grade (Control-B).

The currently selected grade turns red to show that it�s the beauty grade. 

You can change the beauty grade at any time.

Disabling All Grades
It�s often valuable to disable every single correction you�ve applied to a shot, in order to 
see a before and after view of the current state of your grade.

To temporarily disable all grades:
m Press Control-G.

All corrections made with the Primary In, Secondaries, Color FX, and Primary Out rooms 
are disabled. However, all Pan & Scan settings in the Geometry room remain enabled.

Managing Grades in the Shots Browser
The Shots browser provides a different way to navigate and organize the shots in your 
program, in a more nonlinear fashion then the Timeline allows. For example, you can 
use the Find field in list view to search for groups of shots with common names. 
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You can also use the icon view as an organizational tool to rearrange the shots in your 
program into groups based not on their position in the program, but on the angle of 
coverage they�re from or the type of grade you�ll be applying, to give but two 
examples. For more information, see �The Shots Browser� on page 92.

Selecting Shots and Navigating in the Shots Browser in Icon View
When in icon view, you can select one or more shots in the Timeline just as you can 
when in list view. Additionally, you can select which grade a shot uses by expanding a 
shot to reveal all its grades.

To change the current shot in icon view:
m Click the arrow to the right of a shot�s name bar.

The current shot�s name bar appears gray, and the playhead moves to that shot�s first 
frame in the Timeline.

To select a shot:
m Click the shot�s name bar, underneath its icon.

Selected shots appear with a cyan highlight over their name bars, and are 
simultaneously selected in the Timeline.

To select multiple shots:
m Command-click the name bars of all the shots you want to select.

When you�re working on a project with many shots, it can help to zoom out and scroll 
around to find the shots you�re looking for.
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To zoom in or out of the Shots browser when in icon view, do one of the following:
m Press the Control key and drag with the left mouse button.

m Click with the right mouse button and drag up to zoom out, or down to zoom in.

To scroll around the Shots browser when in icon view:
m Middle-click anywhere within the Shots browser, and drag in the direction you want 

to scroll.

You can rearrange shots freely when the Shots browser is in icon view. Rearranging the 
order of shots in icon view does nothing to change the shot order in the Timeline.

To move a shot in icon view:
m Drag the name bar of a shot to another location in the Shots browser.

Choosing Grades in Icon View
You can show all the alternate grades that are available to a shot and select the grade 
that is currently in use.

To show all of a shot�s available grades:
m Double-click the name bar underneath a shot�s icon.

All of the grades available to that shot appear as bars underneath, connected to the 
shot with blue connection lines. Once the grades are revealed, you can change which 
one is selected.
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To select the grade used by a shot:
m Double-click the grade you want to select.

The selected grade turns blue, while the unselected grades remain dark gray.

Note:  Grades that have been rendered are colored green.

Grouping and Ungrouping Shots
A group is an organizational construct that�s only available in the Shots browser when 
it�s in icon view. The purpose of groups is very simple; they provide targets with which 
you can copy a grade to multiple shots at once.

Some examples of ways you might use groups include:

´ You can organize all shots in a particular scene in a single group to facilitate applying 
and updating stylized corrections to every shot in that scene at the same time.

´ You could also organize only those shots within a scene that are from the same angle 
of coverage (and so may be able to share the same corrections), so that you can 
apply and update the same grade to every shot at once.

´ Every shot of a certain type (for example, all head shots of a specific speaker) can be 
grouped together to similarly let you apply corrections or grades to all those shots 
simultaneously.

The uses of groups are endless. To summarize, any time you find yourself wanting to 
apply a single correction or grade to an entire series of shots, that�s a situation in which 
you might consider using groups.

Note:  Shots can only belong to one group at a time.

To create a group:
1 Open the Shots browser in the Setup room.

2 Set the Shots browser to icon view.
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3 Rearrange the shots you want to group within the Shots browser area (this step is 
optional).

Even though this step is not strictly necessary, it can be helpful visually for you to see 
which shots you�re grouping together as a spatially arranged set of icons.

4 Select all the shots you want to group by Command-clicking their name bars.

5 Press G.

A group is created, and a group node appears with blue connection lines showing all 
the shots that belong to that group.
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To add a shot to an already existing group:
m Right-click anywhere on a shot�s name bar, and drag a connection line to the node of 

the group you want to add it to.

Once a group has been created, you can ungroup it at any time.

To ungroup a collection of grouped clips:
m Select the group node you want to delete, and press Delete or Forward Delete.

The node and its connection lines disappear, leaving the shots ungrouped.

To remove a single shot from a group:
m Right-click anywhere on a shot�s name bar, and drag a connection line to an empty 

area of the Shots browser.

When you release the mouse button, that shot will no longer be connected to the 
group.

Working with Groups
Once you�ve created one or more groups of shots, you can use the group node to show 
and hide the shots that are connected to the group, and to copy grades and 
corrections to every shot that�s connected to that group.
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To collapse or expand a group:
m Double-click any group�s node.

When a group is collapsed, the shots that are connected to that group are hidden.

Double-clicking a collapsed group makes all the hidden shots visible again.

Once you�ve created a group, copying a correction or grade to the group is easy.

To copy a grade to a group:
m Drag a grade bar from the Timeline onto any group node.

The grade you dragged overwrites the currently selected grade of every shot in that 
group. Unselected grades are not affected.

You can also copy a correction from one particular room to the same room of the other 
shots in a group.
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To copy an individual correction to a group:
m Drag the correction bar of the room you want to copy from the Timeline onto any 

group node.

The correction you dragged overwrites the settings in the same room of every shot in 
that group.

Important:  You can only copy corrections and grades from the Timeline to groups in 
the Shots browser.

Using the Primary, Secondary, and Color FX Rooms Together 
to Manage Each Shot�s Corrections
Color�s interface for correcting and manipulating the color of your shots is extremely 
flexible. While each room has individual controls that are tailored to specific kinds of 
operations, some functions do overlap, and the Primary In, Secondaries, Color FX, and 
Primary Out rooms collectively contribute to the final appearance of your piece. How 
you use these rooms is entirely up to you.

At minimum, the grading of every project involves the following steps:

Step 1:  Optimize the exposure and color of each shot

Step 2:  Balance every shot in a scene to have similar contrast and color balance

Step 3:  Apply a creative look to the scene

Step 4:  Make modifications due to client feedback

These steps can all be performed within a single room, or they can be broken up 
among several rooms.

Doing Everything in One Room
Excluding special operations such as secondary color corrections and Color FX, each of 
these steps in the grading process could be performed via a single set of adjustments 
within the Primary In room. In fact, for simple programs that don�t require extensive 
corrections, this may be the only room you use.
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This is especially true for projects where the Director of Photography and the crew 
worked to achieve the desired look during the shoot, leaving you with the tasks of 
balancing the shots in each scene and making whatever adjustments are necessary to 
simply expand and perfect the contrast and color that you�ve been provided.

Grading Across Multiple Rooms
On the other hand, there�s no reason you can�t distribute the steps outlined above 
among multiple rooms. This can serve to focus your efforts during each stage of the 
color correction process, and also provides a way of discretely organizing the 
adjustments you make, making each change easier to adjust later on.

This section suggests but one out of countless ways in which the different rooms in 
Color can be used to perform the steps necessary to grade your projects.

Step 1:  Optimize the exposure and color of each shot
You might start by optimizing each shot�s exposure and color in the Primary In room. 
As a way of prepping the project in advance of working with the client in a supervised 
session, you might restrict your adjustments to simply making each shot look as good 
as possible on its own by optimizing its exposure and balancing the color, regardless of 
the later steps you�ll perform.

Step 2:  Balance every shot in a scene to have similar contrast and color balance
After optimizing each clip, you can balance the contrast and color of each shot to 
match the others in that scene using the first tab in the Secondaries room. If you select 
the Enable button of the Secondaries room without restricting the default settings of 
the HSL qualifiers, the adjustments you make are identical to those made in one of the 
Primary rooms.

Important:  If you�re using a secondary tab to affect the entire image, make sure the 
Previews tab is not the selected tab while you work. If the Previews tab is selected, the 
monitored image is modified by the selected Matte Preview Mode, and may exhibit a 
subtle color shift as a result while the Secondaries tab is selected. Clicking the Hue, Sat, 
or Lum Curve tabs, even though you�re not using them, lets you monitor the image 
correctly.

Step 3:  Apply a creative look to the scene
Now that the shots have been optimized and the scenes balanced, you can focus on 
specific creative issues using tabs two through eight in the Secondaries room. You 
might use these tabs to apply a creative look, or you could go further and make 
specific digital relighting adjustments. At this point in the process, you can also use the 
Color FX room to further extend your creative possibilities.
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Step 4:  Make modifications due to client feedback
Once your client has had the opportunity to screen the nearly finished grade of the 
program, you�ll no doubt be given additional notes and feedback on your work. You 
can use the Primary Out room, which up until now has remained unused, to easily 
apply these final touches.

Moreover, because each step of the color grading process was performed in a specific 
room of the Color interface, it will hopefully be easier to identify which client notes 
correspond to the adjustments needing correction.

The steps outlined above are simply suggestions. With time, you�ll undoubtedly 
develop your own way of managing the different processes that go into grading 
programs in Color.
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14 Keyframing

You can create animated grades and other effects using 
keyframes in the Timeline.

The keyframing mechanism in Color is simple, but effective. It�s designed to let you 
quickly animate color corrections, vignettes, Color FX nodes, Pan & Scan effects, and 
user shapes with a minimum number of steps.

This chapter covers the following:

´ Why Keyframe an Effect? (p. 285)
´ How Keyframing Works in Different Rooms (p. 286)
´ Working with Keyframes in the Timeline (p. 288)
´ Keyframe Interpolation (p. 290)

Why Keyframe an Effect?
In many cases, you may work on entire projects where there�s no need to keyframe any 
of your corrections. However, keyframed primary corrections will often let you 
compensate for dynamic changes in exposure or color in shots that might otherwise be 
unusable. You can also use keyframes to create animated lighting and color effects to 
further extend a scene�s original lighting.

Here are some common examples of ways you can use animated keyframes:
´ Correct an accidental exposure change in the middle of a shot.
´ Create an animated lighting effect, such as a light being turned off or on.
´ Correct an accidental white balance adjustment in the middle of a shot.
´ Move a vignette to follow the movement of a subject.
´ Animate a user shape to rotoscope a subject for an intensive correction.
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How Keyframing Works in Different Rooms
You can keyframe effects in the Primary In, Secondaries, Color FX, Primary Out and 
Geometry rooms. Each room has its own separate set of keyframes, stored in individual 
tracks of the keyframe graph of the Timeline. These tracks are hidden until you start 
adding keyframes within a particular room, which makes that room�s keyframe track 
visible.

Keyframes created in each room are visible in the Timeline all at once, but you can only 
edit and delete the keyframes of the room that�s currently open. All other keyframes 
are locked until you open their associated rooms.

Although the ways you create, edit, and remove keyframes are identical for every room, 
keyframes have different effects in each room.

Keyframing Corrections in the Primary In and Out Rooms
You can keyframe every control and parameter in the Primary In and Out rooms. This 
lets you correct inappropriately shifting lighting and color caused by automatic camera 
settings, as well as create animated effects of your own. There are two caveats to 
keyframing corrections in the Primary In and Out rooms:
´ Keyframes in the Primary rooms record the state of every control at once. It�s not 

possible to keyframe individual parameters.
´ Curves cannot be animated with keyframes, although every other parameter in the 

Primary In and Primary Out rooms can be.

Note:  How color adjustments are animated depends on the Radial HSL Interpolation 
setting in the User Prefs tab of the Setup room. Most of the time, you�ll get the best 
results by leaving this option off. For more information, see �User Preferences Tab� on 
page 102.

Keyframing Secondary Corrections
Like parameters and controls in the Primary In and Out rooms, most of the color 
correction parameters and controls in the Secondaries room can be animated. Each of 
the eight secondary tabs has its own keyframe track. Furthermore, each secondary tab�s 
Inside and Outside settings are individually keyframed.
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In addition to the color and contrast controls, the following secondary controls can also 
be animated using keyframes:
´ The enable button that turns the secondary corrections off and on
´ The qualifiers for the secondary keyer
´ The Vignette button that turns vignetting off and on
´ All vignette shape parameters

Note:  Secondary curves cannot be animated with keyframes.

The ability to keyframe all of these controls means you can automate secondary color 
correction operations in extremely powerful ways. For example, you can adjust the 
qualifiers of the secondary keyer to compensate for a change of exposure in the 
original shot that�s causing an unwanted change in the area of isolation.

Keyframing the vignette shape parameters lets you animate vignettes to follow a 
moving subject, or to create other animated spotlight effects.

Keyframing Color FX
You can keyframe node parameters in the Color FX room to create all sorts of effects. 
Even though the Color FX room only has a single keyframe track, each node in your 
node tree has its own keyframes. You can record the state of every parameter within a 
node using a single set of keyframes; however, a node�s parameters cannot be 
individually keyframed.

The only keyframes that are displayed in the Color FX room�s keyframe track are those 
of the node that�s currently selected for editing. All other node keyframes are hidden. 
This can be a bit confusing at first, as keyframes appear and disappear in the Timeline 
depending on which node is currently being edited.

Keyframing Pan & Scan Effects
You can keyframe all the adjustments you make using the Pan & Scan parameters and 
onscreen controls in the Geometry room, creating animated Pan & Scan effects and 
geometric transformations. All parameters are keyframed together.

Keyframing User Shapes
You can keyframe user shapes created in the Shapes tab of the Geometry room to 
rotoscope (isolate by tracing frame by frame) moving subjects and areas of the frame 
for detailed correction in the Secondaries room.

Note:  You can only keyframe shapes after they have been assigned to a tab in the 
Secondaries room.
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Working with Keyframes in the Timeline
It takes a minimum of two keyframes to animate an effect of any kind. Each keyframe 
you create stores the state of the room you�re in at that frame. When you�ve added two 
keyframes with two different corrections to a room, Color automatically animates the 
correction that�s applied to the image from the correction at the first keyframe to the 
correction at the last.

Once you add a keyframe to a shot in a particular room, you can only edit the controls 
and parameters in that room when the playhead is directly over a keyframe. If you 
want to make further adjustments to a keyframed shot, you need to move the 
playhead to the frame at which you want to make an adjustment and add another 
keyframe. Then you can make the necessary adjustments while the playhead is over 
the new keyframe.

To add a keyframe for the currently open room:
m Choose Timeline > Add Keyframe (Control-9).

Once you�ve added one or more keyframes, you can use a pair of commands to quickly 
move the playhead to the next keyframe to the right or left.

To move the playhead from one keyframe to the next in the currently open room, 
do one of the following:

m Press Option-Left Arrow to move to the next keyframe to the left.

m Press Option-Right Arrow to move to the next keyframe to the right.

m Control-click in the keyframe graph of the Timeline, then choose Next Keyframe or 
Previous Keyframe from the shortcut menu.

Keyframes that are at the current position of the playhead appear highlighted. 

You can delete keyframes you don�t need.
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To delete a single keyframe:
1 Move the playhead to the frame with the keyframe you want to delete.

2 Choose Timeline > Remove Keyframe (Control-0).

You can also delete every keyframe applied to a shot in a particular room all at once.

To delete every keyframe in a single room:
1 Click the tab of the room with the keyframes you want to remove.

2 Move the playhead to a frame where the correction or effect in that room is at a state 
you want applied to the entire shot.

3 Control-click the keyframe you want to delete in the Timeline, then choose Remove All 
Keyframes from the shortcut menu.

Every keyframe applied to that room or secondary tab is deleted, and the keyframe 
graph for that room disappears from the Timeline. When you delete all a shot�s 
keyframes at once, the correction or effects settings of the frame at the position of the 
playhead become the settings for the entire shot.

Important:  The Remove All Keyframes command removes all of the keyframes in the 
currently selected room, regardless of which area in the Timeline�s keyframe graph you 
Control-click.

If you want to adjust the timing of keyframes that you�re already created, that�s easy.

To move a keyframe and change its timing:
m Drag it to the left or right.

You can also adjust the timing of a keyframe while previewing the frame you�re moving 
it to.

To move a keyframe while updating the previewed image:
m Press Option while dragging a keyframe to the left or right.

If you need to, you can also make the keyframe graph in the Timeline taller, to make it 
easier to see what you�re doing. For more information, see �Customizing the Timeline 
Interface� on page 123.

You can also use the keyframe graph to navigate to a room with keyframed effects.

To open the room corresponding to a keyframe track:
m Double-click any keyframe track in the Timeline.
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Keyframe Interpolation
The interpolation method that a keyframe is set to determines how settings are 
animated from one keyframe to the next. There are three possible types of 
interpolation:
´ Smooth:  Smooth keyframes begin the transition to the next keyframed state slowly, 

reaching full speed in the middle of the transition and then slowing down to a stop 
at the next keyframe. This �easing� from one keyframe to the next creates transitions 
between color corrections, animated Color FX node parameters, Pan & Scan settings, 
and animated user shapes that look and move smoothly and naturally. However, if 
you have more than two keyframes, your effect will seem to pause for one frame as 
the playhead passes over each keyframe, which may or may not be desirable.

´ Linear:  Linear keyframes make a steady transition from one keyframed state to the 
next, with no acceleration and no slowing down. If you use linear keyframes to 
animate an effect that happens somewhere in the middle of a shot, the animated 
effect may appear to begin and end somewhat abruptly. On the other hand, if you 
are keyframing an animated effect that begins at the first frame and ends at the last 
frame of the shot, the appearance will be of a consistent rate of change.

´ Constant:  Constant keyframes perform no interpolation whatsoever. All effects 
change abruptly to the next keyframed state whenever the playhead reaches the 
next constant keyframe. Constant keyframes are useful when you want an effect to 
change suddenly to another state, such as changing the contrast to simulate a 
lightning strike flashing through the window.
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By default, all new keyframes that you create are smooth, although you can change a 
keyframe�s interpolation at any time. Changing a keyframe�s interpolation only affects 
the way values are animated between it and the next keyframe to the right.

To change a keyframe�s interpolation:
1 Move the playhead to the keyframe you want to change.

2 Choose Timeline > Change Keyframe (Control-0).
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15 Geometry

The Geometry Room provides a way to zoom into shots, 
create pan and scan effects, draw custom mattes for 
vignetted secondary operations, and track moving subjects 
to automate the animation of vignettes and shapes.

The Geometry room is divided into an image preview (which contains the onscreen 
controls for all of the functions in this room), and three tabs to the right. Each tab has 
different tools to perform specific functions. The Pan & Scan tab lets you resize, rotate, 
flip, and flop shots as necessary. The Shapes tab lets you create custom masks to use 
with secondary corrections. Finally, the Tracking tab provides an interface for creating 
and applying motion tracking, to use with vignettes and custom shapes in your project.

This chapter covers the following:

´ Navigating Within the Image Preview (p. 293)
´ The Pan & Scan Tab (p. 294)
´ Shapes Tab (p. 298)
´ Tracking Tab (p. 306)

Navigating Within the Image Preview
Each of the tabs in the Geometry room relies upon onscreen controls in the image 
preview area to the left of the controls tabs. You can zoom in or out and scroll around 
this area to get a better look at your image while you work, and you can even zoom 
and pan around while you�re in the middle of drawing a shape.

To zoom in or out of the image preview:
m Right-click and drag up to zoom out, and down to zoom into the image preview.

To pan around the image preview:
m Middle-click to drag the image preview in any direction.

To reframe the image preview to fit to the current size of the screen:
m Press F.
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The Pan & Scan Tab
The Pan & Scan tab lets you apply basic transformations to the shots in your projects. 
You can use these transformations to blow images up, reposition them to crop out 
unwanted areas of the frame, and rotate shots to create canted angles. You can also 
keyframe these effects to create animated pan and scan effects when you�re 
downconverting a high-resolution widescreen project to a standard definition 4:3 frame.

Importing and Exporting Geometry Settings with Final Cut Pro
When you send a sequence from Final Cut Pro to Color, the following Motion tab 
parameters are translated into their equivalent Color parameters. 

While you grade your program, you can preview the effect these transformations have 
on each shot and make further adjustments as necessary.

Once you�ve finished working on your project in Color, whether or not Color processes 
Pan & Scan adjustments when you render each shot from the Render Queue depends 
on how your project was imported:
´ When projects are sent to Color from Final Cut Pro or imported via XML files, all the 

geometric transformations that are applied to your shots in Color are translated back 
into their equivalent Final Cut Pro Motion settings when the project is sent back to 
Final Cut Pro. You then have the option to further customize those effects in 
Final Cut Pro prior to rendering and output.

´ For 2K digital intermediates using Cineon and DPX image sequences, Pan & Scan 
transformations are processed within Color along with your color corrections when 
rendering the output media.

Motion tab parameters in 
Final Cut Pro Pan & Scan parameters in Color

Scale Scale

Rotation Rotation

Center Position X, Position Y

Aspect Ratio Aspect Ratio
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Working with the Pan & Scan Tab
You can transform shots in your program using two sets of controls. To the left, 
onscreen controls appear within the image preview area, while to the right, numeric 
parameters mirror these adjustments.

Using the Onscreen Controls
The onscreen controls for the Pan & Scan tab consist of an outer bounding box that 
represents the scaled output with four handles at each corner, and a pair of action and 
title safe indicators within. By default, the onscreen control is the same size as the 
resolution of your project.
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The onscreen controls are designed to work in conjunction with the image that�s 
displayed by the Preview and Broadcast displays. In other words, you use the onscreen 
controls to isolate the portion of the image you want to output, and you view the 
actual transformation on the Preview and Broadcast displays.

To resize a shot:
m Drag any of the four corners of the onscreen control to resize the shot relative to its 

center.

The onscreen control shrinks or expands to include less or more of the image, and the 
Preview and Broadcast displays show the result. This also adjusts the Scale parameter.

To rotate a shot:
m Drag just outside the four corner handles, right to rotate left, and left to rotate right.

Because the onscreen control works by selecting a portion of the static source image, 
the onscreen control rotates in the opposite direction of the effect, but the Preview and 
Broadcast displays show the correct result.
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To reposition a shot:
m Drag anywhere within the red bounding box.

The onscreen control moves to select a different portion of the shot, and the Preview 
and Broadcast displays show the result.

Note:  There are no onscreen controls for the Aspect Ratio, Flip, and Flop controls.

Using the Pan & Scan Parameters
Each of the adjustments you make using the onscreen controls is mirrored and 
recorded numerically by the parameters in the Pan & Scan tab to the right. If you want, 
you can directly manipulate these parameters by either entering new values into the 
fields or by middle button dragging within a field to adjust it using the virtual slider.
´ Position X and Y:  Controls the portion of the image that�s viewed when you 

reposition the onscreen control. These parameters translate to the two dimensions of 
the Center parameter in Final Cut Pro.

´ Scale:  Controls the size of the image.
´ Aspect Ratio:  Lets you change the width-to-height ratio of shots to either squeeze or 

stretch them. This parameter has no onscreen control.
´ Rotation:  Lets you spin the shot about the center of the onscreen control.
´ Flip Image:  Lets you reverse the image horizontally. Right and left are reversed.
´ Flop Image:  Lets you reverse the image vertically. Top and bottom are reversed.

Important:  The Flip and Flop parameters are disabled when you�re working with an 
XML project from Final Cut Pro because there are no equivalent parameters in the 
Motion Settings tab.

Animating Pan & Scan Settings with Keyframes and Trackers
If necessary, you can animate Pan & Scan effects in one of two ways:
´ Using keyframes:  You can keyframe all the Pan & Scan transform controls. For more 

information on keyframing in Color, see Chapter 14, �Keyframing,� on page 285
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´ Using a tracker:   You can also use motion tracking to automatically animate a Pan & 
Scan effect, for example, to move to follow a character who is walking across the 
screen.
Once you create a tracker and analyze the shot (in the Tracking tab), you simply 
specify the number of the tracker you want to use in the Use Tracker field, and the 
Position X and Y parameters are automatically animated. If Use Tracker is set to 0, no 
trackers are applied. For more information, see �Tracking Tab� on page 306.

Copying and Resetting Pan & Scan Settings
Three buttons at the bottom of the Pan & Scan tab let you copy and reset the 
adjustments you make with these controls.
´ �Copy to Selected� button:  Select one or more shots in the Timeline, and click this 

button to copy the current Pan & Scan settings to all the selected shots.
´ �Copy to All� button:  Copies the Pan & Scan settings to all the shots in the program. 

This is useful if you�re making a global adjustment when changing the format of a 
program.

´ Reset Geometry button:  Resets all the Pan & Scan parameters to the default scale for 
your project.

Shapes Tab
The Shapes tab lets you draw custom shapes to use as vignettes in the Secondaries 
room for feature isolation, vignetting, or digital relighting. The Shapes tab is not meant 
to be used by itself, nor are you meant to begin operations in the Shapes tab. Instead, 
shapes are initially created by choosing the User Shape option from the Shape pop-up 
menu of the Vignette controls in the Secondaries room.

When you choose this option, you are immediately taken to the Shapes tab of the 
Geometry room, which provides the controls for drawing and editing your own custom 
shapes. For a more thorough explanation of this workflow, see �Using a User Shape for 
Vignetting� on page 225.

Note:  User Shapes can only be used with secondary operations in the Secondaries 
room. They cannot be used in the Color FX room.
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Controls in the Shapes Tab
The Shapes tab has the following controls:
´ Current Secondary:  Lists which of the eight available tabs in the Secondaries room is 

the currently selected secondary operation. When you click the Attach button, this is 
the secondary tab that the currently selected shape will be attached to.

´ Attached Shape:  When you select a shape that has been attached to a shot�s 
secondary tab, this field shows the selected shape�s name, and the grade to which it�s 
been attached using the following format: shapeName.gradeNumber

´ Attach button:  Once you�ve drawn a shape you want to use to limit a secondary 
operation, click Attach to attach it to the currently open secondary tab in the 
Secondaries room (shown in the Current Secondary field).

´ Detach button:  Click Detach to break the relationship of a shape to the secondary 
tab to which it was previously assigned. Once detached, a shape no longer has a 
limiting effect on a secondary operation.

´ Shapes List:  This list shows all the unattached shapes that are available in a project, 
as well as the shapes that have been assigned to the current shot. This list is covered 
in more detail below.

´ Hide Shape Handles:  Click Hide Shape Handles to hide the control points of shapes in 
the Image Preview. The outline of the shape remains visible.

´ Reverse Normals:  When a shape is feathered using the Softness parameter, this 
button reverses which shape defines the inner and outer edges of feathering.

´ Use Tracker:  If you�ve analyzed one or more motion trackers in the current project, 
you can specify which tracker, by number, to use to automatically animate the 
position of the current shape. To disassociate a shape from the tracker�s influence, set 
this value to 0.

´ Softness:  A global feathering operation for the entire shape. When set to 0, the shape 
has a hard (but antialiased) edge. When set to any value above 0, inner and outer 
softness shapes appear along with their own control points. The inner shape shows 
where the feathering begins, while the outer shape shows the very edge of the 
feathered shape. If necessary, each border can be independently adjusted.

´ Shape Name:  This field defaults to �untitled�; however, you can enter your own name 
for the currently selected shape in order to better organize the shots list.

´ New:  Click New to create a new, unassigned shape.
´ Remove:  Choose a shape and click Remove to delete a shape from the shapes list.
´ Close Shape/Open Shape:  This button toggles the currently selected shape between a 

closed and open state.
´ Save button:  Saves the currently selected shape to the shape favorites directory.
´ Load button:  Loads all shapes that are currently saved in the shape favorites 

directory into the shapes list of the current shot.
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´ B-spline/polygon buttons:  Toggles the currently selected shape between B-spline 
mode, which allows for curved shapes, and polygon mode, in which shapes only 
have angled corners.

´ Main/Inner/Outer buttons:  These buttons let you choose which points you want to 
select when dragging a selection box in the Image Preview, without locking any of 
the other control points. You can always edit any control point, no matter what this 
control is set to.

The Shapes List
The Shapes List contains an entry for every unattached shape in the current project, as 
well as for all of the attached shapes used by the shot at the current position of the 
playhead. Clicking a shape in this list displays it in the Image Preview area and updates 
all of the parameters in the Shapes tab with the selected shape�s settings.
´ Name column:  The name of the shape, editable in the Shape Name field.
´ ID column:  An identification number for the shape. ID numbers start at 0 for the first 

shape and are incremented by one every time you create a new shape.
´ Grade column:  When a shape is attached, this column shows the grade to which it�s 

been attached.
´ Sec column:  When a shape is attached, this column shows which of the eight 

secondary tabs the shape has been attached to.

Drawing Shapes
Drawing and editing shapes works in much the same way as other compositing 
applications. Color uses B-splines to draw curved shapes, which are fast to draw and 
edit. These splines work similarly to those used in the curves in the Primary and 
Secondaries rooms.

Saving and Loading Favorite Shapes
You can create a collection of custom shapes to use in other projects by using the 
Save and Load buttons. When you select an unattached shape in the shapes list and 
click Save, it�s saved to the following directory:

/Users/ username /Library/Application Support/Color/BShapes/

Click Load to load all the shapes that are saved within this directory into the shapes 
list of the current shot. Once you decide which shape you want to use, you can 
remove the others.
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B-splines use control points that aren�t actually attached to the shape�s surface to �pull� 
the shape into different directions, like a strong magnet pulling thin wire. For example, 
here�s a curve with a single control point:

The control point hovering above the shape is pulling the entire shape toward itself, 
while the surrounding control points help to keep other parts of the shape in place.

The complexity of a shape is defined by how many control points are exerting 
influence on that shape. If two control points are added to either side, and moved 
down, the curve can be modified as seen below.

To make curves in a shape sharper, move their control points closer together. To make 
curves more gentle, move the control points farther away from one another.

The following procedures describe how to create, remove, and adjust the control points 
that edit curve controls.

To draw a shape:
1 Click on one of the eight tabs in the Secondaries room to use it to make a secondary 

correction, turn on the Enable and Vignette buttons, then choose User Shape from the 
Shape pop-up menu.

The Shapes tab in the Geometry room is automatically opened, and you�re ready to 
draw a shape.

2 Click anywhere within the Image Preview area to add the first control point.

3 Continue clicking within the Image Preview area to add more points.
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4 When you�re ready to finish, close the shape by clicking on the first control point you 
created.

5 Enter a name into the Shape Name field, and press Enter (this step is optional).

6 Click the Attach button to use the shape in the secondary tab.

A duplicate of that shape appears in the list, which shows the number of the grade and 
the secondary tab to which it�s attached (the original shape you drew remains in the 
list above, ready to be recycled at a future time). At this point, you�re ready to use that 
shape in the secondaries tab to which it�s been attached.

To adjust a shape:
m Drag any of its control points in any direction.

Unlike Bezier splines, B-splines have no tangents to adjust. The only adjustments you 
can make require using the number and position of control points relative to one 
another.

To reposition a shape:
m Drag its green center handle in any direction.

The center handle is the point around which keyframing and motion tracking 
transformations are made.

To resize a shape:
1 Make sure the Main button is checked in the Shapes tab.

2 Drag a selection box around every control point you want to resize.
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Selected control points turn green.

You don�t have to select every control point in the shape. You can choose to make a 
partial selection to only resize a portion of the overall shape. The center of all selected 
control points displays a small green + that shows the position of the selected control 
points relative to the center handle.

3 Do one of the following:

´ Drag any of the four corners of the selection box to resize the shape relative to the 
opposite corner, which remains locked in position.

´ Option-drag the selection box to resize the shape relative to its center, visible as 
green crosshairs.

´ Shift-drag the selection box to resize the shape while locking its aspect ratio, 
enlarging or reducing the shape without changing its width-to-height ratio.

To toggle a shape between a curved B-Spline and angled Polygon:
m Click either B-Spline or Polygon in the Shapes tab to change the shape to that type of 

rendering.
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To feather the edge of a shape:
1 Increase its Softness value.

The Softness parameter applies a uniform feathering around the entire shape. This also 
reveals a pair of inside and outside shapes that represent the inner and outer 
boundaries of the feathering effect that�s applied to the shape.

2 If necessary, adjust the shape�s inner and outer shape to create the most appropriate 
feathering outline around the perimeter of the shape.

This lets you create irregularly feathered outlines when you�re isolating a feature where 
one edge should be hard, and another feathered.
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To add control points to a previously existing shape:
1 Select a shape to edit in the Shapes list.

2 Click Open Shape.

3 Click within the Image Preview area to add control points to the end of the selected 
shape.

4 Click the first control point of the shape when you�ve finished adding more control 
points.

Animating Shapes with Keyframes and Trackers
If necessary, you can animate shapes in one of two ways:
´ Using keyframes:  You can keyframe shapes. For more information on keyframing in 

Color, see Chapter 14, �Keyframing,� on page 285
´ Using a tracker:   You can also use motion tracking to automatically animate a shape; 

for example, to move to follow a feature that�s moving because the camera is 
panning. 
Once you create a tracker and analyze the shot (in the Tracking tab), you simply 
select a shape from the Shapes List, and type the number of the tracker you want to 
use in the Use Tracker field, and the shape is automatically animated. If Use Tracker is 
set to 0, no trackers are applied. For more information, see the next section.
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Tracking Tab
Motion tracking is the process of automatically analyzing a shot in order to follow the 
motion of a specific feature in the image to create a motion path. Once you�ve done 
this, you can use these motion tracked camera paths to animate vignettes, Pan & Scan 
operations, user shapes, and even some Color FX nodes to follow these motion paths. 
This way, the corrections you make appear to follow moving subjects, or the motion of 
the camera.

Note:  Color can only use one-point motion tracking. Two- and four-point tracking is 
not supported.

Motion tracking is accomplished by creating a tracker in the Tracking tab of the 
Geometry room. The Tracker List shows every tracker you�ve created and analyzed for a 
given shot, and each tracker has an ID number (they�re numbered in the order in which 
they�re created). 

Each tracker has a single onscreen control which consists of a pair of boxes with a 
crosshair at the center.

When you process a tracker, Color analyzes an area of pixels specified by the outer 
Search Region box of the onscreen control, over the range of frames specified by the 
Mark In and Mark Out buttons. The tracker attempts to �follow� the feature you�ve 
identified (using the inner reference pattern box of the onscreen control) as it moves 
across the frame.

� Tip:  Angular, high-contrast features are ideal reference patterns.
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Using Motion Tracking
After you�ve processed a tracker, you can use that tracker�s analysis to animate a 
Vignette, User Shape, or Pan & Scan setting. When applied to a Vignette or a User 
Shape, the animation of the motion tracker is added to your original positioning of the 
shape. For example, if you�ve used a tracker to follow the movement of someone�s eye, 
and you want to apply that motion to a vignette that highlights that person�s face, you 
need to position the center, angle, and softness of a circle-shaped vignette over the 
person�s face at the first frame of the shot, and then choose the number of the tracker 
from the Use Tracker field. This way, the vignette starts out in the correct position, and 
goes on to follow the path created by the tracker. Because the tracker uses an 
additional transformation, you can still reposition the vignette using the X and Y center 
parameters or the onscreen control in the Previews tab.

If you track a limited range of a shot�s total duration by setting In and Out points for 
the tracker that are shorter then the length of the shot, the vignette stays at the initial 
position you drag it to until the playhead reaches the tracker�s In point, at which time 
the vignette begins to follow the tracker�s motion path. When the playhead reaches the 
Out point, the vignette stops, and remains at that position until the end of the shot.

Controls in the Tracking Tab
The Tracking tab has the following controls:
´ Tracker List:  A list of all the trackers that have been created for the shot at the current 

position of the playhead. This list has three columns:
´ Name:  The name of that tracker. All trackers are named in the following manner: 

tracker.idNumber

´ ID:  The ID number that corresponds to a particular tracker. This is the number you 
enter into any Use Tracker field to specify which tracker to use to animate that 
adjustment.

´ Status:  A progress bar that shows whether or not a tracker has been processed. 
Red means that a tracker is unprocessed, while green means processed.

Will Motion Tracking Solve All Your Problems?
With certain shots where there is a clearly defined target (something high-contrast 
and angular, preferably), motion tracking can be the fastest way to animate an effect 
to follow the motion in a shot, but not always.

If actors or other subjects in the shot pass in front of the feature you�re tracking, if the 
motion of a shot is so fast it introduces motion blur, if there�s excessive noise, or if 
there�s simply not a feature on the subject you want to track that�s well-enough 
defined, using a Manual Tracker may work, although manual keyframing may still be 
your best option. For more information on keyframing, see Chapter 14, �Keyframing,� 
on page 285.
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´ Manual Tracker:  Click to enter manual tracking mode, where you use the pointer to 
click on a feature in the preview area that you want to track. Each click positions the 
onscreen tracker control manually to create a tracking keyframe, and then advances 
the playhead one frame, until you reach the end of the shot. Using this feature, you 
can rapidly hand-track features in shots that automatic tracking can�t resolve.

´ Tracking Curve Smoothness:  Smooths the tracking data to eliminate uneven or 
irregular motion. Higher values smooth the tracked motion path more. You can 
smooth both automatic and manual tracking data.

Note:  The original motion tracker data is retained and never modified via the 
smoothing.

´ Process:  Once you�ve adjusted the onscreen controls to identify a reference pattern 
and search area, click Process to perform the analysis.

´ New:  Creates a new tracker in the Tracker List.
´ Remove:  Deletes the currently selected tracker in the Tracker List.
´ Mark In:  Marks an In point in the current shot at which to begin processing. If you 

don�t set an In point, the first frame of the shot is used.
´ Mark Out:  Marks an Out point in the current shot at which to end processing. If you 

don�t set an Out point, the last frame of the shot is used.

Working with the Tracking Tab
This section describes how to do motion tracking.

To automatically track a feature:
1 Move the playhead to the shot you want to track.

2 Open the Tracker tab in the Geometry room, then click New.

A new, unprocessed tracker appears in the Tracker List, and its onscreen controls 
appear in the Image Preview area.

3 Move the playhead to the first frame of the range you want to track, and click Mark In.

A green In point appears in a new track in the Timeline.

In many cases, this will be the first frame of the shot. However, if the feature is not 
visible or doesn�t start moving until several frames into the shot, you�ll want to set the 
In point to the first frame where the feature you want to track is either visible or just 
before it starts to move.
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4 While the playhead is at this initial frame, drag within the center box of the onscreen 
control to move it so that the crosshairs are centered on the feature you want to track, 
and adjust the handles of the inner box (the reference pattern box) to fit around this 
feature.

5 Adjust the outer box to include as much of the surrounding shot as you judge 
necessary to analyze the shot.

� Tip:  For a successful track, the feature you�ve identified using the reference pattern box 
should never jump outside the search region you�ve defined as the shot proceeds from 
one frame to the next. If the motion in the shot is fast, you�ll want to make the outer 
box larger, even though this increases the length of time required for the analysis. If the 
motion in the shot is slow, you can shrink the search region box to a smaller size to 
decrease the time needed for analysis.

6 Move the playhead to the last frame of the range you want to track, and click Mark Out.

A green Out point appears in the Timeline.
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In many cases, this will be the last frame of the shot. However, if the feature you�re 
tracking becomes obscured, you�ll want to set the out point to the last frame where the 
feature is visible.

7 Click Process.

Color starts to analyze the shot, starting at the In point, and a green progress bar 
moves from the In point to the Out point to show how much of the clip has been 
analyzed. 

When processing is complete, that tracker appears with a green bar in the Status column 
of the Tracker List, and that tracker is ready to be used in your project. That tracker�s 
motion path appears in the Image Preview area whenever that tracker is selected.

If there�s a shot in which the motion is too difficult to track automatically, you might try 
manually tracking the feature.

To manually track a feature:
1 Move the playhead to the shot you want to track.

2 Open the Tracker tab in the Geometry room, then click New.

A new, unprocessed tracker appears in the Tracker List, and its onscreen controls 
appear in the Image Preview area.

3 Move the playhead to the first frame of the range you want to track.

Note:  It is unnecessary to mark In and Out points in Manual Tracker mode.
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4 Click Manual Tracker to enter manual tracking mode.

When you enable manual tracking, the tracker onscreen control disappears.

5 Click a feature in the preview area that you want to track. 

For example, if you were tracking someone�s face for vignetting later on, you might 
click the nose.

Each click positions the onscreen tracker control manually, and then advances the 
playhead one frame.

6 Click the same feature you clicked in the previous frame, as each frame advances, 
until you reach the end of duration of movement that you wanted to track, or the 
end of the shot.

As you add more manual tracking points, a motion path slowly builds following the 
trail of the feature you�re tracking.

7 When you�ve finished manually tracking, stop clicking.

That tracker is ready to be assigned to a parameter elsewhere in your project.

Important:  Don�t turn off the Manual Tracker button unless you want to delete all of 
your manually tracked keyframes.
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Sometimes a motion track is successful, but the resulting motion path is too rough to 
use in its original state. Oftentimes, irregular motion will expose an animated effect 
that you�re trying to keep invisible. These may be seen as jagged motion paths.

In these cases, you can use the Tracking Curve Smoothness slider to smooth out the 
motion path that�s created by the tracker.

To smooth a track:
1 Select a tracker in the Tracker List.

2 Adjust the Tracking Curve Smoothness slider until the motion tracking path is smooth 
enough for your needs.

The Tracking Curve Smoothness slider is nondestructive. This means that the original 
tracking data is preserved, and you can raise or lower the smoothing that�s applied to 
the original data at any time if you need to make further adjustments. Lowering the 
Tracking Curve Smoothness to 0 restores the tracking data at its originally analyzed state.
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Using Trackers in the Secondary, Color FX, and Geometry Rooms
Any adjustment in any room that can be animated by a tracker has a Use Tracker field. 
Once you�ve processed a tracker, you can enter its ID number into this field to 
automatically animate that adjustment based on the tracker�s motion path. Setting a 
Use Tracker field to 0 resets that adjustment so that no tracker is used.
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16 Still Store

The Still Store provides an interface with which to compare 
shots to one another while you do scene-to-scene color 
correction.

Using the Still Store interface, you can save images from different shots in a project to 
use as reference stills for comparison to shots you�re correcting to match. This is a 
common operation in scene-to-scene color correction, when you�re balancing all of the 
shots in a scene to match the exposure and color of one another, so they all look as if 
they were shot at the same place, at the same time.

Using the Still Store, you can save reference stills from any shot in your project, for 
comparison to any other shot. That means if you�re working on a documentary where a 
particular style of headshot is interspersed throughout the program, you can save a 
reference still of the graded master headshot, and recall it for comparison to every 
other headshot in the program.

This chapter covers the following:

´ Saving Images to the Still Store (p. 315)
´ Saving Still Store Images in Subdirectories (p. 317)
´ Removing Images from the Still Store (p. 317)
´ Recalling Images from the Still Store (p. 318)
´ Customizing the Still Store View (p. 318)
´ Controls in the Still Store Bin (p. 319)

Saving Images to the Still Store
To use the Still Store, you must first save one or more images for later recall.

To add an image to the Still Store:
1 Move the playhead to a frame you want to save to the Still Store.

You should choose a graded image that contains the subjects you need to compare, 
and that is representative of the lighting and color you�re trying to match.
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2 If the Still Store is currently enabled, turn it off to make sure you don�t accidentally save 
a still of the currently displayed split screen.

3 Optionally, if you want to save the still with a custom name, you can click the Still Store 
tab and type a name in the File field below the Still Store bin.

If you don�t enter a custom name, each still image you save will be automatically 
named in the following manner:

Still.Day_Month_Year_Hour_Minute_SecondTimezone.sri

The date and time reflect exactly when the still image was saved.

Note:  If you load a still image into the Still Store immediately prior to saving another 
one, the newly saved still image will use the name of the still you loaded, overwriting 
the previously saved still as a result.

4 To save the still, do one of the following:

´ From any room, choose Still Store > Store (Control-I).
´ Click the Still Store tab, and click Save.

A still image of the frame at the position of the playhead is saved as an uncompressed 
DPX file in the /StillStore/ subdirectory within the project bundle itself. It also appears 
within Color as an item in the Still Store bin. When the Still Store is set to icon view, 
each saved still appears with a thumbnail for reference.

Still Store images are saved at the native resolution of the source media from which 
they�re derived, but they�re not saved with the currently applied LUT correction. That 
way, if your project was using a LUT when you saved the images in the Still Store, and 
you clear that LUT from your project, the saved still images will continue to match the 
shots they originated from.
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Important:  Still Store images aren�t updated if the shot they originated from is 
regraded. This means that if you save a Still Store image from a shot, and then later 
regrade that shot to have a different look, the saved Still Store image will no longer be 
representative of that shot and should be removed. If there is any question whether or 
not a still image correctly reflects a shot�s current grade, the date and time the still 
image was saved might provide a hint.

Saving Still Store Images in Subdirectories
By default, whenever you save a still image, it�s saved in your project�s internal StillStore 
subdirectory, and appears in the Still Store bin along with all the other stills you saved. 
All stills in the Still Store bin appear in the order in which they were created, with the 
newest stills appearing last.

You can also organize your saved stills into subdirectories. You might create individual 
subdirectories based on the date of work, the scene stills are saved from, or any other 
organizational means of your own devising.

To create a custom subdirectory in the Still Store bin:
1 Click the Still Store tab.

2 Click New Folder.

3 When the New Folder dialog appears, enter a name in the �Name of new folder� field, 
then click Create.

A new subdirectory appears inside of the StillStore directory within your project 
bundle, and becomes the currently open directory to which all new still images are 
saved.

Important:  You cannot move still images into subdirectories once they�ve been 
created. To save new stills in a subdirectory, you need to navigate the Still Store bin to 
that directory before saving any new stills.

Removing Images from the Still Store
Saved images can stack up pretty quickly in the Still Store, so you�ll want to make sure 
you regularly remove all unnecessary stills.

Why Is My Project Getting So Big?
Because all still images are saved within the StillStore subdirectory inside your project 
bundle, you may notice that your project takes longer to back up than it used to if 
you save a lot of still images. If you need to reduce the size of the project file, you 
should delete as many unused Still Store images as you can.
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To remove an image from the Still Store:
1 Click the Still Store tab.

2 Select the still image you want to remove.

3 Press the Delete or Forward Delete key.

4 Click Yes in the warning dialog that appears, to confirm that you really do want to 
delete the selected still image.

You cannot undo the deletion of a still from the Still Store. 

Recalling Images from the Still Store
Once an image has been added to the Still Store, it can be recalled at any time. To 
display a saved still image, you need to load it into the Still Store, and then enable the 
Still Store to view the image.

To load an image into the Still Store:
1 Click the Still Store tab.

2 Do one of the following:

´ Select the still image you want to load, then click Load.
´ Double-click the still image you want to load.

Once a still is loaded, you still have to turn on Display Loaded Still to make the image 
visible.

To display an image that�s loaded into the Still Store, do one of the following:
m Choose Still Store > Display Loaded Still (Control-U).

m Click the Still Store tab, then select Display Loaded Still.

The currently loaded still image appears both in the preview display and on your 
broadcast monitor. By default, still images appear as a Left to Right split-screen 
comparison, but this can be customized.

Customizing the Still Store View
Different colorists use the Still Store in different ways. Some prefer to flip between two 
full-screen images as they make their comparisons, while others like to create a split 
screen so they can compare the Still Store and the shot being graded side by side. 
Color lets you work either way.
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Each still image has its own settings for how that image will appear when it�s recalled. 
These settings can be found on the right-hand side of the Still Store room.

´ Enable:  Makes the currently loaded Still Store image visible in the preview and video 
output monitors. Identical to Still Store > Enable (Control-U).

´ Transition:  This parameter determines how much of the loaded still is visible 
onscreen. When set to 0, the loaded still is not visible at all. When set to 1, the loaded 
still fills the entire screen. Any value in between creates a split-screen view.

´ Angle:  Changes the angle along which the border of a split screen is oriented. The 
orientation buttons below automatically change the Angle parameter, but the only 
way to create a diagonal split screen is to customize this control yourself.

´ Left to Right:  Changes the Angle parameter to 180 degrees, to create a vertical split 
screen with the still to the left.

´ Right to Left:  Changes the Angle parameter to 0 degrees, to create a vertical split 
screen with the still to the right.

´ Top to Bottom:  Changes the Angle parameter to �90 degrees, to create a horizontal 
split screen with the still at the top.

´ Bottom to Top:  Changes the Angle parameter to 90 degrees, to create a horizontal 
split screen with the still at the bottom.

Controls in the Still Store Bin
The Still Store bin has the following controls:

´ Up Directory:  Clicking this button takes you to the next directory up the current path. 
You cannot exit the project bundle. To keep your project organized you should make 
sure that you save all of your stills within the /StillStore/ directory of your project 
bundle.

´ Home Directory:  Changes the directory path to the StillStore directory within your 
project bundle.

´ Icon View:  Changes the Still Store bin to icon view. Each saved still image is 
represented by a thumbnail, and all stills are organized according to the date and 
time they were saved, with the oldest stills appearing first (from left to right).
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´ List View:  In list view, all still images and directories are represented by two columns; 
the still-image file�s name appears to the left, and the date of its creation appears to 
the right. All stills are organized according to the date and time they were saved, 
with the oldest appearing at the top and the newest at the bottom.

´ Icon Size slider:  When the Still Store bin is in icon view, this slider lets you increase 
and decrease the size of the thumbnails that are displayed for each still.

´ File field:  This field does double duty. When you load a still image, this field displays 
the still image�s name. However, if you enter a custom name and then save another 
still, the new still will be created with the name you entered.

´ Directory pop-up menu:  This pop-up menu shows you the current directory path and 
lets you navigate farther up the current directory structure, if you wish.

´ New Directory button:  Creates a new subdirectory inside the StillStore directory of 
your project bundle.

´ Save button:  Saves the frame at the current position of the playhead as a still image, 
for later recall.

´ Load button:  Loads a still so that it�s available for comparison using the Enable 
button, or the Enable command in the Still Store menu (Control-U).
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17 Render Queue

Once you�ve finished color-correcting your program, the 
controls in the Render Queue let you render the appropriate 
set of media files for the final output of your program, either 
to Final Cut Pro, or for delivery to other compatible systems.

This chapter covers the following:

´ About Rendering in Color (p. 321)
´ Which Effects Does Color Render? (p. 322)
´ The Render Queue Interface (p. 323)
´ How to Render Shots in Your Project (p. 324)
´ Rendering Multiple Grades for Each Shot (p. 326)
´ Gather Rendered Media (p. 328)

About Rendering in Color
Rendering in Color has a different purpose than it does in an application like 
Final Cut Pro. In Color, all effects processing for playback is done on the fly, either 
dropping frames or slowing down as necessary to display your color-corrected output 
at high quality for evaluation purposes. Playback in Color is not cached to RAM, and 
there is no way to �pre-render� your project for playback while you work.

In Color, rendering is treated as the final step in committing your corrections to disk by 
generating a new set of media files. The Render Queue lets you render some or all of 
the shots in your project once they�ve been corrected in Color.

You can use the Render Queue to render your project either incrementally or all at 
once. For example, if you�re working on a high-resolution project with a multi-day or 
multi-week schedule, you may choose to add each scene�s shots to the Render Queue 
as they�re approved, preparing them for an overnight render at the end of each day�s 
session. This distributes the workload over many days, and eliminates the need for a 
single time-consuming render session to output the entire program at once.
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On the other hand, you may need to render the entire program after all, such as when 
you need to generate another set of media in a different format, or if the project is 
short enough that there�s no need to break up the rendering.

Which Effects Does Color Render?
Projects that are imported from XML and EDL project files may have many more effects 
than Color is capable of processing. These include transitions, geometric 
transformations, superimpositions, speed effects, and still images. When rendering your 
finished program, your import/export workflow determines which effects Color renders. 

In particular, if you import an EDL to grade and export 2K DPX image sequences to be 
printed to film, Color renders the shots in your project very differently than if you�ve 
imported an XML file, and are rendering QuickTime files to be sent in a return trip back 
to Final Cut Pro.

In all cases, the corrections you�ve made using the Primary In, Secondary, Color FX, and 
Primary Out rooms are always rendered.

Rendered Effects for 2K Output
When you�ve imported an EDL and are outputting 2K DPX image sequences, all of the 
transformations you’ve made in the Geometry room�s Pan & Scan tab are rendered.

Effects that you need to create to finish the project that aren�t rendered by Color 
include video transitions, speed effects, composites, and titles. These must be created 
in another application such as Shake.

Effects Aren�t Rendered When Sending to Final Cut Pro
When you�re shepherding a project through an XML-based Final Cut Pro to Color round 
trip, all transitions, filters, still images, generators, speed effects, superimposition 
settings, and other non�Color compatible effects from the original Final Cut Pro project 
are preserved within your Color project, even if those effects aren�t visible.

The Graphics Card You�re Using Affects the Rendered Output
Color uses the GPU of the graphics card that�s installed in your computer to render 
the color correction and geometry adjustments that you�ve applied to the shots in 
your program. Different video cards have GPU processors with differing capabilities, 
so it�s entirely possible for the same Color project to look slightly different when 
rendered on computers with different graphics cards. To ensure color accuracy, it�s 
best to render your project on a computer using the same graphics card that was 
used when color correcting that program.
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When you�ve finished grading your program in Color and you render that project as a 
series of QuickTime movies in preparation for returning to Final Cut Pro, any of the 
previously mentioned effects which have been invisibly preserved are not rendered. 
Instead, when you send the finished Color project back to Final Cut Pro, such effects 
reappear in the resulting Final Cut Pro sequence. At that point you have the option of 
making further adjustments and rendering the Final Cut Pro project prior to outputting 
it to tape or as a QuickTime master movie file.

More About Motion Settings and Pan & Scan Adjustments
A subset of the motion settings from Final Cut Pro is translated into the equivalent Pan 
& Scan settings in Color when you first import the project. These settings have a visible 
effect on your Color project, and can be further adjusted as you fine-tune the program. 
However, these effects are not rendered by Color; instead, they�re passed from Color 
back to Final Cut Pro for rendering there. For more information, see �Importing and 
Exporting Geometry Settings with Final Cut Pro� on page 294.

The Render Queue Interface
You specify which shots in the program you want to render using the Render Queue 
list. Whenever you add shots to this list, they�re organized by shot number. The order in 
which shots appear in this column dictates the order in which they�re rendered�the 
topmost unrendered shot in the list is rendered first, and then rendering continues for 
the next unrendered shot on the list, and so on until the end of the list is reached.
´ Number column:  Identifies that shot�s numeric position in the Timeline. All shots in 

the Render Queue are listed in descending order based on their ID number.
´ Shot Name column:  Shows a thumbnail and the name of the shot.
´ In column:  The first frame of media that will be rendered for that shot. This timecode 

is equal to the Project In point plus the current Handles value specified in the Project 
Settings tab of the Setup room.

´ Out column:  The last frame of media that will be rendered for that shot. This 
timecode is equal to the Project Out point plus the current Handles value specified in 
the Project Settings tab of the Setup room.

Note:  If there is no extra media available on disk for handles at the beginning or end 
of shots, then handles will not be added.

´ Grade ID column:  Shows the currently selected grade for that shot. You can queue up 
the same shot up to four times with different grades enabled, in order to render 
media for each grade associated with that shot.

´ Progress column:  This is the column where a render bar appears to let you know how 
long that shot is taking to render. If the shot is not currently rendering, this column 
shows the render status of that shot (queued, rendering, or rendered).
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Render Queue Controls
The following buttons beneath the Render Queue list let you add shots to the queue, 
remove them, and initiate rendering.

´ Add Selected:  Adds all currently selected shots to the Render Queue.
´ Add All:  Adds every shot in the Timeline to the Render Queue. Shots that have 

already been rendered are also placed in the queue, and will be rerendered unless 
they�re first removed. Shots that are rerendered overwrite the previously rendered 
media.

´ Clear Queue:  Removes all shots from the Render Queue.
´ Remove Selected:   Removes only shots that you�ve selected from the Render Queue.
´ Start Render:  Initiates rendering for all the shots that have been placed into the 

Render Queue. This button has the same function as the Render > Start Render 
menu command.

Important:  Once you�ve initiated rendering, you can pause it by pressing either Escape 
or Control-Period.

How to Render Shots in Your Project
The Render Queue is designed to let you manage the rendering of your project any 
way you like. You can add every shot in the program to the render queue in order to 
render everything at once, or you can add only the shots that were completed that day 
as part of a process of rendering your project incrementally.

However you decide to render the media in your project, the process is pretty much 
the same; you check your project and shot settings, add shots to the render queue, and 
then use the Start Render command.

To render one or more shots in your program:

1 Go through the Timeline and choose which grade you want to render for each of the 
shots you�re planning on rendering.

2 Do one of the following to add shots to the Render Queue list:

´ Click Add All.
´ Choose Render > Add All (Control-Shift-Option-A).
´ Select one or more shots, then click Add Selected, or choose Render > Add Selected 

(Command-Shift-A) to add the selected shots.
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Once you add shots to the Render Queue list, the status of each of the shots that you 
add changes to Queued in the Shots browser. In the Timeline, each of the shots that 
you added appears with a yellow status bar over the currently used grade for each 
queued shot, to show you which of the available grades is being rendered.

Note:  You can add a shot to the Render Queue with one grade enabled, then choose 
another grade for that shot and add it to the Render Queue again to render both 
grades for that shot.

3 Double-check your project settings prior to rendering to make sure that you�re using the 
correct render directory, interlacing setting, export codec, and Broadcast Safe settings.

4 If you�re rendering Cineon or DPX media, double-check the Render Proxy pop-up menu 
in the User Prefs tab to make sure you�re rendering at the required resolution.

5 Do one of the following:

´ Click the Start Render button in the Render Queue tab.
´ Choose Render > Start Render.

The shots in the Render Queue start rendering. A green progress bar appears in the 
Progress column of the first unrendered shot in the list, which shows how long that 
shot is taking to render. 
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At the same time, the render bar appearing above the Timeline ruler for the shot being 
rendered in the Timeline updates to reflect the progress bar in the Render Queue.

Once the first shot in the Render Queue has finished rendering, the next one begins, 
and rendering continues from the top to the bottom of the list until the last shot is 
rendered. All rendered shots in the Timeline appear with a green render bar above the 
Timeline ruler, and a green status bar over the grade that was rendered.

Important:  To pause rendering, press Escape. You can click Start Render again to 
resume rendering.

All rendered media is written to that project�s render directory, which is specified in the 
Project Settings tab of the Setup room. The render directory is organized into 
numbered subdirectories, with one subdirectory corresponding to each shot in your 
project�s Timeline. The number of each subdirectory corresponds to each shot�s 
number in the Number column of the Render Queue. Each of these subdirectories 
contains up to four rendered sets of media corresponding to each rendered grade.

Rendering Multiple Grades for Each Shot
Each shot in your Color project uses one of up to four grades. As you work, you have 
the ability to freely change which grade is used by any shot, switching among different 
looks as necessary during the development of the program�s aesthetic. 
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You also have the ability to render each of a shot�s grades individually, or together. This 
way, whenever there�s a scene where the client might approve one of four different 
looks, you can hedge your bets by rendering all versions.

Color keeps track of which grade is currently selected when you send that project back 
to Final Cut Pro, or when you use the Gather Rendered Media command, and makes 
sure that the appropriate render file is used.

Each rendered grade is numbered. For example, if you rendered two different grades in 
a QuickTime-based project for shot number 1, the subdirectory for that shot would 
have two shots, named 1_g1.MOV and 1_g2.MOV, with the number coming 
immediately after the g indicating which grade that file corresponds to.

To render multiple grades for a single shot:
1 Move the playhead to a shot you want to render, and choose the first grade you want 

to render out for that shot.

2 Select that shot, click the Render Queue tab, and then click Add Selected to add that 
shot to the Render Queue.

3 Change the grade used by that shot to the next one you want to render.

4 Click Add Selected again to add that shot to the Render Queue a second time.

Every grade that�s queued for rendering appears with a yellow render bar over the 
grade bar in the Timeline. 

The grade ID column in the Render Queue shows you what grades you�ve selected to 
render for each shot.
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Gather Rendered Media
The Gather Rendered Media command can only be used when you�ve rendered image 
sequence media for a project that was imported via EDL. This command used to 
organize your rendered image sequence media in preparation for delivery to the film 
printer.

It organizes your rendered image sequences in two ways:

´ It places every frame of media for your project within a single directory.
´ It renames every frame of media for your project to create a single, continuous range 

of frames from the first to the last image of the rendered project.

Important:  You cannot gather media in an XML round trip.

To gather rendered media:
1 Chose File > Gather Rendered Media.

2 Choose one of three options for gathering the rendered media for your project:

´ Copy Files:  Makes duplicates of the image sequence files, but leaves the originally 
rendered files in the render directory.

´ Move Files:  Copies the image sequence files, and then deletes the originally rendered 
files from the render directory.

´ Link Files:  Creates aliases of the originally rendered files in the render directory. This is 
useful if you want to process the frames using an application on your computer, and 
you don�t want to duplicate the media unnecessarily. This is not useful if you�re 
intending to transport the media to another facility, since the alias files only point to 
the original media in the render directory, and contain no actual image data.

3 Click Create New Directory if you want to place the gathered media inside of a new 
directory.

4 Click Gather.

Every rendered frame of every shot in your project is renamed, renumbered, and 
placed in the directory you specified, ready for further processing or delivery.
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A Calibrating Your Monitor

When using analog devices, make sure they are calibrated for 
accurate brightness and color so you can color correct your 
video accurately.

About Color Bars
Color bars are an electronically generated video signal that meet very strict 
specifications. Because the luma and chroma levels are standardized, you can use color 
bars passing through different components of a video system to see how each device 
is affecting the signal.

NTSC and PAL each have specific color bar standards, and even within NTSC and PAL 
there are several standards. When you evaluate color bars on a video scope, it is 
important to know which color bars standard you are measuring, or you may make 
improper adjustments. �SMPTE bars� is a commonly used standard.

Calibrating Video Monitors With Color Bars
Editors and broadcast designers shouldn�t rely on an uncalibrated monitor when 
making crucial adjustments to the color and brightness of their programs. Instead, it�s 
important to use a calibrated broadcast monitor to ensure that any adjustments made 
to exposure and color quality are accurate.

When Should You Use Color Bars?
Analog devices always need to be calibrated and adjusted, even if only by minute 
degrees. This is because heat, age, noise, cable length, and many other factors subtly 
affect the voltage of an analog electronic video signal, which affects the brightness 
and color of the video image. Color bars provide a reference signal you can use to 
calibrate the output levels of an analog device.
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Calibrating Your Broadcast Monitor
Monitors are calibrated using SMPTE standard color bars. Brightness and contrast are 
adjusted by eye, using the color bars onscreen. Adjusting chroma and phase involves 
using the �blue only� button found on professional video monitors. This calibration 
should be done to all monitors in use, whether they�re in the field or in the editing 
room.

To calibrate your monitor:
1 Connect a color bars or test pattern generator to the monitor you�re using, or output 

one of the built-in color bars generators in Final Cut Pro.

Important:  Avoid using still image graphics of color bars. For more information, see 
�Y·CBCR Rendering and Color Bars� on page 332.

2 Turn on the monitor and wait approximately 30 minutes for the monitor to �warm up� 
and reach a stable operating temperature.

3 Select the appropriate input on the video monitor so that the color bars are visible on 
the screen.

Near the bottom right corner of the color bars are three black bars of varying 
intensities. Each one corresponds to a different brightness value, measured in IRE. (IRE 
originally stood for Institute of Radio Engineers, which has since merged into the 
modern IEEE organization; the measurement is a video-specific unit of voltage.) These 
are the PLUGE (Picture Lineup Generation Equipment) bars, and they allow you to 
adjust the brightness and contrast of a video monitor by helping you establish what 
absolute black should be.

4 Turn the chroma level on the monitor all the way down.

This is a temporary adjustment which allows you to make more accurate luma 
adjustments. The chroma control may also be labeled color or saturation.

5 Adjust the brightness control of your monitor to the point where you can no longer 
distinguish between the two PLUGE bars on the left and the adjacent black square.

At this point, the brightest of the bars (11.5 IRE) should just barely be visible, while the 
two PLUGE bars on the left (5 IRE and 7.5 IRE) appear to be the same level of black.

6 Now, turn the contrast all the way up so that this bar becomes bright, and then turn it 
back down.
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The point where this bar is barely visible is the correct contrast setting for your monitor. 
(The example shown below is exaggerated to demonstrate.)

When adjusting the contrast, also watch the white square in the lower left. If the 
contrast is too high, the white square appears to �spill� into the surrounding squares. 
Adjust the contrast until the luma of the white square no longer �spills� into 
surrounding squares.

Important:  Contrast should only be adjusted after brightness

7 Once you are finished adjusting luma settings, turn up the chroma control to the 
middle (detent) position.

Note:  Some knobs stop subtly at a default position. This is known as the detent 
position of the knob.

If you�re adjusting a PAL monitor, then you�re finished. The next few steps are color 
adjustments that only need to be made to NTSC monitors.

8 Press the �blue only� button on the front of your monitor to prepare for the adjustment 
of the Chroma and Phase controls.

Note:  This button is usually only available on professional monitors.

9 Make the following adjustments based on the type of video signal you’re monitoring:

´ If you’re monitoring an SDI or component Y·CBCR signal, you’ll only need adjust the 
Chroma control so that the tops and bottoms of the alternating gray bars match. This 
is the only adjustment you need to make, because the Phase control has no effect 
with SDI or component signals.

´ If you’re monitoring a Y/C (also called S-Video) signal, it’s being run through an RGB 
decoder that�s built into the monitor. In this case, adjust both the Chroma and Phase 
controls. The chroma affects the balance of the outer two gray bars; the phase affects 
the balance of the inner two gray bars. Adjustments made to one of these controls 
affects the other, so continue to adjust both until all of the gray bars are of uniform 
brightness at top and bottom.

When monitor brightness and
contrast is properly adjusted, 
this strip should barely be 
visible above black.
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Note:  The step in the second bullet also applies to the monitoring of composite signals, 
but you really, really shouldn’t be monitoring a composite signal if you’re doing color 
correction.

Once your monitor is correctly calibrated, all the gray bars will be evenly gray and all 
the black bars evenly black. 

Y·CBCR Rendering and Color Bars
Y·CBCR rendering must be supported by the codec used in a sequence in order for 
Final Cut Pro to render color bars with a PLUGE (Picture Lineup Generation 
Equipment) area that includes a super-black (4 IRE in NTSC, 2 IRE in PAL) signal for 
calibration. The PLUGE part of the test signal cannot be rendered using an RGB-based 
codec.

When the phase (similar to hue) of 
the monitor is correctly adjusted, 
you should see alternating bars of 
gray and black, as shown.
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Keyboard Shortcuts in Color

The following tables show the various keyboard shortcuts that are available while 
working in Color.

Project Shortcuts
The following keyboard shortcuts are common to many applications, and allow you to 
manage your Color projects.

Command Description

Command-N New project

Command-O Open project

Command-R Revert to last saved state of the current project

Command-S Save project

Option-Command-S Save archive as, allows you to name an archive

Option-Command-A Open archived version of project

Command-I Import clip (opens the file browser in the Setup room)

Option-Command-G Gather Rendered Media (only for Cineon or DPX projects)

Command-Z Undo; press Command-Z a second time to restore the change

Command-X Cut

Command-C Copy

Command-V Paste

Command-A Select All

Command-? Open the user manual
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Switching Rooms and Windows
The following keyboard shortcuts let you navigate the Color interface, moving from 
room to room and window to window.

Playback and Navigation
The following keyboard shortcuts let you play through and navigate around your 
project by moving the playhead through the Timeline.

Command Description

Command-1 Open Setup room

Command-2 Open Primary In room

Command-3 Open Secondaries room

Command-4 Open Color FX room

Command-5 Open Primary Out room

Command-6 Open Geometry room

Command-7 Open Still Store

Command-8 Render Queue

Command-9 Open Project Settings tab in the Setup room

Command-0 Open Shots browser in the Setup room

Shift-1 Select Color window

Shift-2 Select Scopes window

Shift-0 Toggle between single-screen and double-screen mode the next 
time Color is opened

Command Description

Space Bar Toggles between play and stop

J Play backwards

K Stop

L Play forward

Down Arrow Move playhead to next shot

Up Arrow Move playhead to previous shot

Left Arrow Move playhead back one frame

Right Arrow Move playhead forward one frame

Home Go to beginning of Timeline

End Go to end of Timeline

Shift-Control-M Toggle playback mode

I Set In point in Timeline for playback

O Set Out point in Timeline for playback
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Grade Shortcuts
The following keyboard shortcuts let you create, switch, copy, and paste grades for 
shots at the position of the playhead.

Timeline Specific Shortcuts
The following keyboard shortcuts let you modify the Timeline�s display, and can only be 
used when the pointer is within the Timeline area of the interface.

Editing Shortcuts
The following keyboard shortcuts select editing tools when working on projects with 
unlocked video tracks.

Command Description

Control-1 Create new grade/Switch to grade 1

Control-2 Create new grade/Switch to grade 2

Control-3 Create new grade/Switch to grade 3

Control-4 Create new grade/Switch to grade 4

Control-G Toggle grade on/off

Control-Option-Shift-1 
(1 through 5)

Copy current grade to memory bank 1�5

Option-Shift-1(1 through 5) Paste grade from memory bank 1�5

Control-B Set current grade as the beauty grade

Command Description

Command-� Zoom out

� (in numeric keypad) Zoom out

Command-+ Zoom in

+ (in numeric keypad) Zoom in

F Set Timeline Ruler to frames

S Set Timeline Ruler to seconds

M Set Timeline Ruler to minutes

H Set Timeline Ruler to hours

Tab Toggle Timeline Ruler between frames/seconds/minutes/hours

Command Description

Control-S Choose Select tool

Control-R Choose Roll tool

Control-T Choose Ripple tool
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Keyframing Shortcuts
The following shortcuts are for keyframing effects in every room.

Shortcuts in the Shots Browser
The following keyboard shortcuts only work when the pointer is within the Shots 
browser of the Setup room.

Shortcuts in the Geometry Room
The following keyboard shortcut only works when the pointer is within the Geometry 
room.

Control-Y Choose Slip tool

Control-X Choose Split tool

Control-Z Choose Splice tool

Control-V Create an edit at the position of the playhead

Control-B Merge an edit at the position of the playhead

Command Description

Command Description

Control-8 Change keyframe interpolation type at position of playhead

Control-9 Add keyframe at position of playhead

Control-0 Delete keyframe at position of playhead

Option�Left Arrow Move playhead to previous keyframe of current shot in current 
room

Option�Right Arrow Move playhead to next keyframe of current shot in current room

Command Description

G Assign selected shots into a group

F Center the shots browser

Command Description

F Frame the preview image in the Geometry room
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Still Store Shortcuts
The following keyboard shortcuts let you save and enable still frames without having 
the Still Store open.

Render Queue Shortcuts
The following keyboard shortcuts let you add shots to the render queue, and begin 
rendering, without having the Render Queue open.

Command Description

Control-U Enable currently loaded still

Control-I Save frame at the current position of the playhead to the still store

Command Description

Shift-Command-A Add selected shots to the Render Queue

Option-Shift-Command-A Add all shots in the Timeline to the Render Queue

Command-P Start Render
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C Setting Up a Control Surface

Color is compatible with control surfaces from JLCooper and 
Tangent Devices.

A control surface lets you make simultaneous adjustments to multiple parameters 
while you work. Not only is this faster, but it allows you to interactively make complex 
color adjustments to different areas of the image at once. This appendix describes how 
to connect and configure compatible control surfaces to your computer for use with 
Color, and covers the following topics:
´ JLCooper MCS-3000, MCS-Spectrum, MCS-3400, and MCS-3800 Control 

Surfaces (p. 339)
´ Tangent Devices CP100 Control Surface (p. 344)
´ Tangent Devices CP200 Series Control Surface (p. 346)
´ Customizing Control Surface Sensitivity (p. 351)

JLCooper MCS-3000, MCS-Spectrum, MCS-3400, and MCS-
3800 Control Surfaces
JLCooper makes a variety of control surfaces that are compatible with both Color and 
Final Cut Pro. The MCS family of control surfaces have both navigational and color 
correction-specific controls in a variety of configurations.
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To use compatible JLCooper MCS Control Surfaces with Color, you need the following:
´ MCS-3000, MCS-3400, or MCS-3800 with an MCS-Spectrum
´ Have your Controller configured with an Ethernet board supplied in Slot #1
´ Multiport hub, router, or switch
´ Cat-5 Ethernet cables

The Ethernet Connection for the MCS-Spectrum is bridged to the MCS-3000 using an 
Expander Cable. The MCS-3000 then connects to your computer via Ethernet.

Important:  The JLCooper control surfaces cannot be connected to the second Ethernet 
port of your Mac Pro; it must be connected to your computer�s primary Ethernet port, if 
necessary through a hub or switch if you need to share the port with an Internet 
connection.

Configuring the MCS-3000 and MCS-Spectrum Control Surfaces
The following procedures describe how to configure and use these control surfaces 
with Color.

To set up the MCS-3000 and MCS-Spectrum for use with Color:
1 Turn on the MCS-3000 and wait for the unit to power up.

The MCS-3000 works similarly to any other networked computer, so you must enter 
Ethernet IP settings into the device itself so that it can network with your computer.

2 Hold down the SHIFT and ASSIGN/UTILITY buttons simultaneously.

The current IP address settings should appear in the display at the top of the unit.

3 Using the numeric keypad on the MCS-3000, type in the following values:

a Enter an IP Address, then press ENTER to accept and continue. 
For example, you might enter:192.168.001.010 

Note:  The first three period-delimited sets of numbers in the IP address must match 
the first three sets of numbers that are used on your particular network. If you�re not 
sure what values to use, you can check to see what IP address is used by your 
computer (look for your computer�s IP address in the Network settings of System 
Preferences), and base the MCS-3000 IP address on that, making sure you change the 
last three numbers so that this address isn�t used by any other device on your network.

b Enter a gateway address, then press ENTER to accept and continue.

Note:  The first three period-delimited sets of numbers in the gateway address must 
match the IP address you used.

c Enter a Subnet Mask number, then press ENTER to accept and continue.
For example, you might enter: 255.255.255.000
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d Enter a port number, then press ENTER to accept and continue.
For example, you might enter: 49153

Note:  To be safe, use one of the range of values set aside as �dynamic and/or private 
ports� from 49152 through 65535.

4 Turn off both the MCS-3000 and the MCS-Spectrum.

Now that your control surface is configured, you need to set it up within Color.

To use the MCS-3000 and MCS-Spectrum with Color:
1 Turn on the MCS-Spectrum first, then turn on the MCS-3000.

2 Open Color.

If you�re opening Color for the first time, you�ll be presented with the Control Surface 
Startup dialog. If you�ve already opened Color and have disabled the option for making 
this dialog appear, you�ll need to click the Show Control Surface Dialog button in the 
User Prefs tab of the Setup room.

3 When the Control Surface Startup dialog appears:

a Choose �JLCooper - MCS3000/Spectrum� from the Control Surface pop-up menu.
b Type the IP address you entered into the MCS-3000 into the IP Address field, and 

press Enter.
c Type the Port number you entered into the MCS-3000 into the Port field, and press 

Enter.

4 Click Yes.

The MCS-3000 and MCS-Spectrum should now be ready for use with Color.
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Controls for the MCS-3000 and MCS-Spectrum
Many of the controls in the MCS-3000 and MCS-Spectrum are identified by the text 
displays running along the top of each panel. The following sections detail the less 
obvious controls and functions.

MCS-3000

´ Page 1-8:  Selects one of the eight main rooms in Color.
´ F1:  Remove Key Frame
´ F2:  Add Key Frame
´ F3:  Change Key Frame Interpolation
´ Rewind:  Jump to beginning of shot or next shot
´ Forward:  Jump to end of shot or next shot
´ Stop:  Stop playback
´ Play:  Start playback
´ Jog:  Playhead control
´ KeyPad:  Navigation control
´ Locate:  Locate Timecode or Shot ID
´ Mode:  Interchange locate between Timecode and Shot ID
´ Last:  Return to last location
´ Enter:  Cue navigation
´ M1:  Speed control
´ M2:  Inch playback
´ Bank1:  Switch/Copy/Paste Grade Bank 1
´ Bank2:  Switch/Copy/Paste Grade Bank 2
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´ Bank3:  Switch/Copy/Paste Grade Bank 3
´ Bank4:  Switch/Copy/Paste Grade Bank 4
´ Assign:  Toggle Switch/Copy/Paste grade. (LCD Display would indicate which state 

you are in).

Using the Navigational Controls
There are two different ways to navigate in the Timeline using the keypad on the 
MCS-3000.

To toggle between timecode and shot number navigation:
1 Press Mode Locate or Set Locate on the MCS-3000.

2 Hold down Shift (the blue button under the F-buttons), then press Mode Locate. 

The indicators on the MCS-3000 will switch between 00 00 00 00 (Timecode) and 0 
(Shot ID) to let you know what mode you�re in.

To locate a position on the Timeline using timecode (in timecode mode):
1 Press Mode Locate or Set Locate on the MCS-3000.

2 Enter the Timecode you wish to locate, then press enter.

The playhead moves to that timecode location.

To locate a position on the Timeline using shot numbers (in shot number mode):
1 Press Mode Locate or Set Locate on the MCS-3000.

2 Enter the Shot ID you wish to locate, then press enter.

The playhead moves to the shot associated with that ID on the Timeline.

Controls in the MCS-Spectrum

B3R3

B2

B1R1

R2

PAGE 5

PAGE 6

PAGE 8

PAGE 7

PAGE 1

PAGE 2

PAGE 4

PAGE 3



344 Appendix C    Setting Up a Control Surface

´ R1:  Reset Shadow contrast slider
´ B1:  Reset Shadow color control
´ Left joyball:  Shadow color control adjustment
´ Left wheel:  Shadow contrast slider adjustment (black point)
´ R2:  Reset Midtone contrast slider
´ B2:  Reset Midtone color control
´ Center joyball:  Midtone color control adjustment
´ Center wheel:  Midtone contrast slider adjustment (gamma)
´ R3:  Reset HIghlight contrast slider
´ B3:  Reset Highlight color control
´ Right joyball:  HIghlight color control adjustment
´ Right wheel:  HIghlight contrast slider adjustment (white point)

Tangent Devices CP100 Control Surface
The Tangent Devices CP100 is a single, large control surface that combines all available 
functionality into a single device.

Configuring the CP100 Control Surface
The following procedures describe how to configure and use this control surface with 
Color.

Note:  You must be logged in as an administrator to set up the Tangent Devices CP100.

To set up and use the CP100 for use with Color:
1 Connect the CP100 to your computer using an Ethernet cable. 

Important:  The CP100 cannot be connected to the second Ethernet port of your Mac 
pro; it must be connected to your computer�s primary Ethernet port, if necessary 
through a router or switch if you need to share the port with an Internet connection.

2 Turn on the CP100 and wait for the unit to power up.

3 Open Color.
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If you�re opening Color for the first time, you�ll be presented with the Control Surface 
Startup dialog. If you�ve already opened Color and have disabled the option for making 
this dialog appear, you�ll need to click the Show Control Surface Dialog button in the 
User Prefs tab of the Setup room.

4 When the Control Surface Startup dialog appears:

a Choose �Tangent Devices - CP100� from the Control Surface pop-up menu.
b When you�re prompted for your Administrator password, enter it into the field and 

click OK.

The CP100 should now be ready for use with Color.

Controls in the CP100
´ Do:  Copy grade (Mem-Bank 1)
´ Undo:  Paste grade (Mem-Bank 1)
´ Redo:  Copy grade from previous edit on Timeline
´ Cue:  Cue up the navigation (modes are Timecode or Shot ID)
´ Mark:  Create still
´ In:  Set Play marker In
´ Out:  Set play marker out
´ Select:  Toggle playback mode
´ Mix:  Toggle show still
´ Grade:  Toggle show grade
´ Delete:  Return grade to identity or base-mem
´ |<:  Previous event
´ >|�- Next event
´ <:  Play reverse
´ []:  Stop playback
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´ >:  Play forward
´ Button next to jog/shuttle:  Toggle x10 speed control

When Left Alt is held down:
´ |<:  Previous key frame
´ >|�- Next key frame
´ <:  Step backwards one frame
´ >:  Step forward one frame

F-Keys
´ F1:  Toggle key frame interpolation
´ F2:  Create key frame
´ F3:  Delete key frame

Tangent Devices CP200 Series Control Surface
The Tangent Devices CP200 is a modular series of controllers all designed to work 
together.

To use theCP200 series of control surfaces with Color, you need the following:
´ A CP200-BK Trackerball/Knob panel, CP200-TS Transport/Selection Panel, CP200-K 

Knob Panel, and/or CP200-S Selection Panel
´ Multiport hub or switch
´ Cat-5 Ethernet cables

Important:  The CP200 series control surfaces cannot be connected to the second 
Ethernet port of your Mac Pro; they must be connected to your computer�s primary 
Ethernet port, if necessary through a hub or switch if you need to share the port with 
an Internet connection.
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Configuring the CP200 Series Control Surfaces
The following procedures describe how to configure and use these control surfaces 
with Color.

To set up the CP200 series controllers for use with Color:
1 Connect each of the CP200 devices to the router, hub, or switch that�s connected to 

your computer.

2 Before you open Color, turn on each of the CP200 devices you have, and write down 
the two to three character ID numbers that appear on the display of each. 

You�ll use each device�s ID number to set up Color to communicate with these devices.

Note:  The ID numbers that Color uses to connect to the CP200 control surfaces are not 
the Serial Numbers that appear on the back or bottom of your CP200 panels.

3 Open Color.

If you�re opening Color for the first time, you�ll be presented with the Control Surface 
Startup dialog. If you�ve already opened Color and have disabled the option for making 
this dialog appear, you�ll need to click the Show Control Surface Dialog button in the 
User Prefs tab of the Setup room.

4 Choose �Tangent Devices - CP200� from the Control Surface pop-up menu.

Each CP200 device that Color is compatible with appears with an Enabled checkbox 
with two fields: one for the ID number that you wrote down previously, and one for IP 
address. 

5 For each CP200 device you own:

a Select its checkbox.
b Type its ID number into the corresponding field, and press Enter to continue.
c Type an IP address into the corresponding field, and press Enter to continue.
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Note:  The first three period-delimited sets of numbers in the IP address must match 
the first three sets of numbers that are used on your particular network. If you�re not 
sure what values to use, you can check to see what IP address is used by your 
computer, and base the MCS-3000 IP address on that, making sure you change the 
last three numbers so that this address is unique.

6 Click Yes.

After you click Yes, Color connects with the control surfaces on the network. If this is 
successful then each panel�s display should now go blank.

The CP200 series control surfaces are now ready for use with Color.

Controls in the CP200 Series of Controllers
The CP200 has the following controls.

CP200-BK (Trackerball/Knob Panel)

In the Primaries room:
´ Left (Dot) button above wheels:  Reset contrast slider for that zone
´ Right (Circle) button above wheels:  Reset color control for that zone
´ Left joyball:  Shadow color control adjustment
´ Left wheel:  Shadow contrast slider adjustment (black point)
´ Center joyball:  Midtone color control adjustment
´ Center wheel:  Midtone contrast slider adjustment (gamma)
´ Right joyball:  HIghlight color control adjustment
´ Right wheel:  HIghlight contrast slider adjustment (white point)
´ F1:   Toggle key frame Interpolation
´ F2:  Add key frame

F1 F2 F3

F4 F5 F6

F7 F8 F9
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´ F3:  Delete key frame
´ F4:  Alternate panel encoders

In the Secondaries room:
´ F1:  Toggle key frame Interpolation
´ F2:  Add key frame
´ F3:  Delete key frame
´ F4:  Alternate panel encoders
´ F5:  Toggle secondary
´ F6:  Toggle secondary In/Out control
´ F7:  Toggle secondary vignette
´ F8:  Previous secondary
´ F9:  Next secondary

Note:  In secondaries, when switching to preview mode, Vignette controls will override.

In the Geometry room:
´ F1:  Change key frame
´ F2:  Add key frame
´ F3:  Delete key frame
´ F4:  Alternate panel encoders

CP200-TS (Transport/Selection Panel)

´ Do:  Copy grade (mem-bank 1)
´ Undo:  Paste grade (mem-bank 1)
´ Redo:  Copy grade from previous edit on Timeline
´ Cue:  Cue up the navigation (modes are Timecode or Shot ID)
´ Mark:  Create still
´ In:  Set play marker In
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´ Out:  Set play marker out
´ Mem:  Toggle show still
´ Grade:  Toggle show grade
´ Delete:  Return grade to Identity or base-mem
´ |<:  Previous event
´ >|�- Next event
´ <:  Play reverse
´ []- Stop playback
´ >:  Play forward
´ Button next to jog/shuttle:  Toggle x10 speed control

When Left Alt is held down,
´ |<:  Previous key frame
´ >|�- Next key frame
´ <:  Step backward one frame
´ >:  Step forward one frame

CP200-K (Knob Panel)

´ RGB channel controls

Note:  When you open the Previews tab in the Secondaries room, the HSL qualifier 
controls override the RBG channel controls.



Customizing Control Surface Sensitivity
You can customize the sensitivity of the joyballs, knobs, contrast wheels, and the angle 
at which the joyballs adjust color, using settings located in the User Prefs tab of the 
Setup room.

For more information, see �Control Surface Settings� on page 103.
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Digital intermediates

parsing EDLs  56
telecined offline/online workflow  53

Digital intermediate workflow  22, 49
Directory navigation controls  67
Disabling

grades  274
Display controls  67
Display LUT  98
Display modes  70
DPX image sequences  51, 87

converting to QuickTime  51
DPX sequences

converting to QuickTime  88
Drawing shapes  300
Dual display mode  111
Dual monitors  70
Duotone node  252
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E
Edge Detector node  252
Editing

B-Splines  191
control points  191
limitations  37

Editing controls and procedures  133
Editing shortcuts  335
Edits

creating  138
merging  138

EDL files  23
EDL formats  80
EDLs

exporting  82
importing  47, 80
import settings  81
parsing  56

Effects
keyframing  285
saving favorites in COlor FX bin  248

Enable clipping  101
Error messages  102
Evaluation monitor  112
Exporting

codec tips  87
EDLs  82
JPEG files  89
projects  23
self-contained QuickTime files  75
which codecs to use  100
XML files  42
XML files for Final Cut Pro  78

Exposure node  252
External video monitoring  113
Eyedropper

expanding a selection with  215
pulling keys with  213
sampling a range of values  215

F
Feathering shape edges  304
File browser  64, 91

collapsing  64
hiding  65
uncollapsing  65

File controls  68
Film

and chroma subsampling  26
color timing  19

Film Grain node  252
Film Look node  253
Filters

limitations  38

Final Cut Pro
exporting tips  75
Send to Color command  76

Final Cut Pro generators
limitations  38

Final Cut Pro Media Manager  41
Find field  93
FLEx files  54
Floor IRE  100
Folders

creating in a bin  267
using to organize corrections and grades  267

Formats
compatible image types  87
of compatible QuickTime  84
pixels  108

Formats compatible with Color  23
Framerate

maintaining  128
Frame rates

projects and EDLs  81
Frames

moving to first or last  129
relinking to an EDL  56

Freeze Frame clips
limitations  39

Freeze Frames
exporting as self-contained QuickTime files  75

G
Gain node  253
Gamma  31
Gamma node  253
Gamut

defined  116
Garbage matte  228
Gathering rendered media  328
Gather Rendered Media command  53
Generators (Motion)

exporting as self-contained QuickTime files  75
Geometry  293�313

importing and exporting settings  294
shortcuts  336

Geometry room  37
Goto field  93
Grades

adding to shots  131
applying to shots  268
changing on a shot  270
choosing in the Shots browser  276
copying and pasting  273
copying in the Timeline  270
defined  264
deleting  266
disabling  274
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how they are different from corrections  263
in the Timeline  131
managing  263�283
managing in the Shots browser  274
managing in the Timeline  269
moving to other computers  70
organizing into folders  267
reorganizing in the Finder  69, 268
resetting  132
resetting in the Timeline  270
saving and using  264
saving into the Grades bin  265
selecting current  131
shortcuts  335
trimming in Primary Out room  260
versus corrections  67
where they are saved  68

Grades bin  66, 97
Grades track  122
Grading  18
Grain Reduction node  254
Graphics card

how it affects rendering  322
Grouping shots  277
Groups

collapsing and expanding  280
copying corrections into  281
removing shots  279
working with  279

H
Handles  102
Hiding the file browser  65
Hiding Timeline tracks  125
Highlights

color adjustments  187
Highlight slider  172
Histogram scope  155

Luma  156
RGB  155

Home directory  92
HSL

color model  33
controls  215
controls in Secondaries room  213
in 3D Color Space scope  158
qualifier previews  220
qualifiers for adjustment regions  212
using the eyedropper for fast keys  213

HSL Key node  257
Hue  31
Hue Curve tab  232
Hue node  254

I
I bar (in Vectorscope)  154
Icon Size slider  67
Icon view  65, 67
Image detail

described  178
Image formats  87
Image preview

navigating in  293
zooming  293

Images
isolating areas with nodes  246
recalling from the Still Store  318
removing from the Still Store  317
saving to the Still Store  315
viewing at a specific node  240

Image sequences  23
DPX  51
file naming for conforming  57

Importing
and compatible codecs  84
color corrections from another project  89
EDLs  47, 80
media  71�89
media into the Timeline  83
projects and media  23
projects from other applications  47
XML files  77

In and Out points
placing  127
setting  128

Inputs
for nodes  237

Interlace node  250
Interlacing

and Color FX  247
Interpolation

of keyframes  290�291
Invert node  254
IPT (in 3D Color Space scope)  160

J
JKL playback controls  127
JLCooper control surfaces  339
JPEG files  87

exporting  89

K
Key Blur  218
Keyframe graph  123
Keyframes

adding  288
animating Pan & Scan settings  297
animating shapes with  305
changing timing of  289
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deleting  289
interpolation  290�291
navigating  288

Keyframing  285�291
in Color FX  287
in different rooms  286
in the Timeline  288
pan and scan effects  287
shortcuts  336
user shapes  287

L
Layering nodes  243
Lift node  255
Lighten node  250
Limit shadow adjustments  169, 185
Linear keyframe interpolation  290
List view  65, 67
LiveType

exporting as self-contained QuickTime files  75
Lock icon  122
Locking tracks  125
Look up tables (see LUTs)  115
Looping playback  104, 128
Luma  30

example curve  195
luma

adjusting  330
Luma (in Histogram scope)  156
Luma scope  150
Lum Curve tab  234
Luminance  30
LUT  98
LUTs  115�120

clearing  120
creating in the Color application  119
described  116
generating  118
using  119
when to use them  118
where they are saved  119

M
Maintain Framerate  128
Managing corrections and grades  263�283
Managing projects  71�89
Manual tracking  310
Master contrast controls  204
Math layering nodes  245
Matte Preview mode  220
Maximum node  255
MCS-3000  342
MCS-Spectrum  343
Media

compatible formats  84

gathering  328
importing and managing  71�89
importing into Color  23
importing into Timeline  83
notching  48
reconforming  45
relinking QuickTime  82

Memory banks  273
Merging edits  138
Messages tab  102
Midtones

adjusting  171
color adjustment  186

Minimum node  255
Monitoring  111�120

and bit depth  113
broadcast video output  113
Still Store  120
turning video output on and off  113

Monitors
calibrating  329�332
calibrating regularly  115
choosing  114
using single or dual  70

Monochrome scopes  105
Motion tracking  307�313
Mouse

using  61
Movie mode  127
Moving shots in the Timeline  134
Multi-input nodes  237
Multiply node  245, 250

N
Navigating

in image preview  293
Navigation

in the Timeline  128
Node Reference Guide  249
Nodes

adding  238
adjusting parameters  239
bypassing  241
connecting  238�239
creating  238�239
deleting  238
disconnecting  239
inputs and outputs  237
layering  243
math layering  245
multi-input  237, 243
rearranging  239
single input  242

Node trees
described  236
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Node types
Add  245, 249
Alpha Blend  250
B&W  251
Bleach Bypass  251
Blend  250
Blur  251
Clamp  251
Color  257
Curve  251
Darken  250
Deinterlace  257
Difference  245, 250
Duotone  252
Edge Detector  252
Exposure  252
Film Grain  252
Film Look  253
Gain  253
Gamma  253
Grain Reduction  254
HSL Key  257
Hue  254
Interlace  250
Invert  254
Lift  255
Lighten  250
Maximum  255
Minimum  255
Multiply  245, 250
Output  258
Printer Lights  255
RGB Merge  251
RGB Split  258
Saturation  255
Scale RGB  256
Sharpen  256
Smooth Step  256
Stretch  256
Translate  257
Vignette  258

Node view  236
Noodles  236
Notching media  48
Notes

adding to shots  95
removing from a shot  96

NTSC format
color bar standards  329

O
Offline resolution  40
Offset  101
Online resolution  41

Opening
archives  73
projects  72

Optical color timing  19
Output

compatible codecs  86
final video master  43

Output node  258
Outputs

for nodes  237
Overlay scope  149

P
PAL format

color bar standards  329
Pan & Scan

parameters  297
Pan & Scan settings

copying and resetting  298
Pan & Scan tab  294

working in  295
Parade scope  146�148
Parameters

in Pan & Scan tab  297
Pasting

grades  273
Phase  101
Playback

in the Timeline  126
looping  104, 128
modes  127
setting duration  128
settings  106
starting and stopping  126

Playback shortcuts  334
Playhead  122

moving frame to frame  129
moving from shot to shot  129

Play program  126
PLUGE bars  330
Pointer  134
Preedited program masters  48
Pre-rendering

still images and effects  42
Preview display  112

using as evaluation monitor  112
Previews

deinterlacing  99
full and quarter screen  112

Previews tab  219
Primary colors  32
Primary In

color balance  165
contrast  165
described  163
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general process  165
saturation  165

Primary In room  36, 163�207
Primary Out room  36, 259�261

trimming grades in  260
Printer Lights node  255
Printer points  19

defined  205
making adjustments with  205

Printer points controls  204, 205
Printing density  99
Processing

settings  106
Program master

capturing  48
Programs

mixing and matching resolutions  113
Project resolution  81
Projects

conforming  56
contents of  74
creating  72
described  74
dividing into reels  75
exporting  23
frame rate  81
how to render shots  324
importing and managing  71�89
importing from other applications  47
importing into Color  23
moving between final Cut Pro and Color  75
opening  72
reconforming  79
saving  72
sending back to Final Cut Pro  78
settings  98
why is my project so big?  317

Proxies  105
deleting  106
generating  106

Pull list  19, 54

Q
Q bar (in Vectorscope)  155
Qualifiers

explained  218
Qualifying areas to adjust  211
QuickTime

compatible codecs  84
export codecs  100
files  23
relinking media  82
self-contained files  75

R
Range handles

symmetric adjustments  217
Reconforming

EDL-based projects  79
online media  43, 45
projects  79
XML-based projects  79

Recording
limitations  37

Red/Green/Blue Channels scope  149
Reels

dividing a project into  75
Regions

selecting in the Secondaries room  212
Relinking QuickTime media  82
Removing tracks  125
Render bar  122
Render Directory setting  98
Rendering

and your graphics card  322
effects for 2K output  322
multiple grades for each shot  326
settings  102
when sending to Final Cut Pro  322

Render Queue  321�328
controls  324
interface  323
shortcuts  337

Render Queue room  37
Renders

deinterlacing  99
Repositioning

shapes  302
Repositioning shots  297
Reset controls  234
Resetting video scopes  145
Resize tracks  124
Resizing

shapes  302
Resolution

of a project  81
settings  98
viewing  113

Resolution independence
of Color application  22

RGB (in 3D Color Space scope)  157
RGB (in Histogram scope)  155
RGB Additive color model  24
RGB controls  205
RGB Merge node  251
RGB Split node  258
Ripple edits  136
Ripple tool  135
Roll edits  135
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Roll tool  135
Rooms

about  35
Geometry  293

Rotating shots  296
Round trip  47
Ruler  122

units  123

S
Sampling color (in 3D Color Space scope)  161
Sat Curve tab  233
Saturation  32, 165

controls  201
Saturation node  255
Saved effects

applying  249
Saving

archives  72
automatically  73
corrections and grades  264
grades and corrections  68
projects  72
shapes favorites  300

Scale RGB node  256
Scene-to-scene color correction  14
Scopes

accuracy of  143
available types  141
options  144

Scopes window  111
Scrolling in the Timeline  129
Scroll wheel  62
Secondaries room  209�234

why it is used  209
Secondary colors  32
Secondary curves  229
Secondary keys

and vignettes  228
checking during playback  219
creating  213

Secondary room  36
Reset controls  234

Selected shots  93
Selecting shots  130
Select tool  134
Send to Color command  76
Send to Final Cut Pro command  78
Service and Support  11
Settings

auto save  109
Broadcast Safe  100
codec  98
for control surfaces  103
for projects  98

for shots  132
geometry  294
playback  106
processing  106
rendering  102
resolution  98
user interface  104

Setup  91�109
Color Setup Guide  10

Set up control surfaces  339�351
Setup room  36, 91

file browser  64, 91
grades bin  66
shots browser  92

Shadow adjustments  168�170
Shadows

color adjustments of  184
Shadow slider  168
Shape

B-Splines and angled polygons  303
Shapes

adding control points  305
adjusting  302
animating with keyframes and trackers  305
drawing  300
feathering edges  304
repositioning  302
resizing  302
saving and loading favorites  300

Shapes List  300
Shapes tab  298

controls  299
Sharpen node  256
Shortcut menus  62
Shortcuts

editing  335
geometry  336
grade  335
keyframing  336
playback and navigation  334
project  333
Render Queue  337
rooms and windows  334
Shots browser  336
Still Store  337
Timeline  335

Shot mode  127
Shots

adding grades to  131
adding notes to  95
adding to an existing group  279
applying saved corrections and grades  268
copying corrections  272�273
customizing display in the Timeline  124
deleting  134
deselecting all  130
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directory  74
grouping and ungrouping  277
how to render  324
removing from groups  279
removing notes  96
repositioning  297
repositioning in Timeline  134
resizing in Pan & Scan tab  296
revealing after finding  94
rotating  296
searching for  93
selected  93
selecting contiguous  130
selecting current  126
selecting in the Shots browser  96, 275
selecting in the Timeline  129
settings  132
splicing  138
splitting  137

Shots browser  65, 92
column headings  94
customizing  95
managing grades  274
navigating the Timeline with  96
shortcuts  336
sorting in  95
zooming  276

Showing Timeline tracks  125
Single display mode  111
Skin tones  14
Slip edit  137
Slip tool  136
Smooth interpolation  290
Smooth Step node  256
Snapping  139
Source media

backing up  44
capturing  40, 46

Speed effects
limitations  38

Splice tool  137
Splicing shots  138
Split screens  37
Splitting shots  137
Split tool  137
Still image files

limitations  39
Still Store  67, 315�320

controls  319
customizing the view  318
monitoring  120
recalling images from  318
removing images from  317
saving images in  315
shortcuts  337
using subdirectories to organize  317

StillStore directory  74
Still Store room  37
Stretch node  256
Superimpositions

limitations  38
Super-white levels  30
Support

on the Web  11
Swatches  218
Symmetric adjustments of Range handles  217

T
Tabs

navigating to rooms  61
Tangent Devices control surfaces  339
Tape-based workflow  40
Tapeless digital workflow  43
Tape-to-tape color correction  18, 20
Telecine  17

dailies  45
second pass  20

Telecine transfers  22
advantages of  22

Text fields  61
Third-Party codecs  85
TIFF files  87
Timecode

navigating with  62
Timecode fields  62
Timeline  121�139

changing ruler units  123
copying corrections and grades  270
customizing shots display  124
customizing the interface  123
grades track  122
importing media into  83
interface elements  122
keyframe graph  123
keyframing in  288
Lock icon  122
navigating with the Shots browser  96
navigation in  128
playback  126
render bar  122
repositioning shots  134
resetting grades  270
ruler  122
scrolling  129
selecting shots in  129
setting a beauty grade  274
shortcuts  335
tracker area  123
track resize handles  122
using to manage grades  269
video tracks  122
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working with grades  131
zooming  128

Tolerance  216
Tolerance handles

adjusting  217
Tracker area  123
Trackers

animating Pan & Scan settings  297
animating shapes with  305

Tracking  307�313
manually  310
smoothing a track  312

Tracking tab  306
controls  307
working with  308

Tracks
adding  125
locking and unlocking  125
removing  125
resize handles  122
resizing  124
showing and hiding  125
working with  125

Training program  10
Transitions

limitations  38
Translate node  257
Tutorials  10
Two monitors  70

U
Ungrouping shots  277
Units

in TImeline ruler  123
Unlocking tracks  125
User-definable masking  16
User interface

adjusting for best monitoring  115
settings  104

User preferences  102
User shapes

keyframing  287

V
Vectorscope scope  152�155

color targets  153
I bar  154
Q bar  155

Video
and chroma subsampling  26
calibration  329
color bars  329

Video monitor calibration  329
Video scopes  112, 141�162

3D Color Space  157
accuracy of  143
Chroma  151
Histogram  155
Luma  150
options  144
Overlay  149
Parade  146�148
red/green/blue channels  149
repositioning 3D scopes  144
resetting  145
selecting a mode  144
toggling color on and off  145
updating during playback  144
Vectorscopes  152�155
Waveform  145
Y�CbCr  151
zooming  144

Video tracks  122
Vignette  222

adjusting inside and outside  228
adjusting softness  225
and secondary keys  228
animating  225
as garbage matte  228
controls  221�223
effects  210
moving  224
onscreen controls  224
previews  220
resizing  224
shapes  224
user shapes  225

Vignette node  258
Virtual sliders  61

W
Warnings  102
Waveform scope  145
White point

adjusting with highlight slider  172
Workflow

film-to-tape  45
overview  35
tape-based  40

Workflows  35�57
tapeless DI  50
video finishing in FCP  39

X
XML files  23

exporting  42
exporting for Final Cut Pro  78
importing  77
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Y
Y�CbCr (in 3D Color Space scope)  159
Y�CbCr color model  24
Y�CbCr scope  151

Z
Zooming

in the image preview  293
in the Shots browser  276
in the Timeline  128
in video scopes  144
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